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How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information.
» To send comments on articles in the WebSphere Application Server Information Center
1. Display the article in your Web browser and scroll to the end of the article.

2. Click on the Feedback link at the bottom of the article, and a separate window containing an e-mail
form appears.

3. Fill out the e-mail form as instructed, and click on Submit feedback .

* To send comments on PDF books, you can e-mail your comments to: wasdoc@us.ibm.com or fax
them to 919-254-0206.

Be sure to include the document name and number, the WebSphere Application Server version you are
using, and, if applicable, the specific page, table, or figure number on which you are commenting.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information
in any way it believes appropriate without incurring any obligation to you.
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Part 1. Product overview and quick start
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Chapter 1. Overview of installing your application serving
environment

This topic provides links to conceptual overviews of installing the application serving environment.

-;;ﬁ
[‘What is new for installers” on page 6|

This topic provides an overview of new and changed features in installation, migration,
coexistence, and interoperability support.

[Chapter 7, “Planning the installation (diagrams),” on page 51|

This topic describes common product topologies that you can install with WebSphere Application
Server, Version 6 products.

Presentations from [Education on Demand|
- |V6 topology and terminology - Expressj

+ [Installation overview
* |Install Network Deployment and Express|
* |IBM HTTP Server installation
« |Web server plug-in installation|

© Copyright IBM Corp. 2004


http://www.ibm.com/developerworks/websphere/library/tutorials/ondemand/
ftp://ftp.software.ibm.com/software/eod/WAS_6-0/BigPicture/Presentations/WASXv6_Topology_Terminology/player.html
ftp://ftp.software.ibm.com/software/eod/WAS_6-0/Install_Migration/Presentations/WASv6_Dist_Install_Overview/player.html
ftp://ftp.software.ibm.com/software/eod/WAS_6-0/Install_Migration/Presentations/WASv6_Dist_Install_AppServer/player.html
ftp://ftp.software.ibm.com/software/eod/WAS_6-0/Install_Migration/Presentations/WASv6_Dist_Install_IHS/player.html
ftp://ftp.software.ibm.com/software/eod/WAS_6-0/Install_Migration/Presentations/WASv6_Dist_Install_PlugIn/player.html
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Chapter 2. What is new in this release

This topic provides a high level overview of what is new and changed in Version 6. The audience is
anyone who is evaluating or planning to use Version 6, particularly users of previous versions or editions.

-;;ﬁ
Welcome to Version 6, which helps you:

» Rapidly understand and obtain value from new J2EE 1.4 technology

» Make the most of your existing resources and lower your total cost of ownership

» Work more productively, with easier to use installation and administration interfaces
» Support your growing business with a firm foundation to the WebSphere platform

There is now greater consistency in the WebSphere Application Server family from top to bottom, including
in the Express version. Such features include support for J2EE 1.4 across the family, which makes it
easier to develop and deploy applications using industry standard tools, and support for the latest Web
Services standards, making it easier to integrate applications inside the enterprise as well as externally
with customers, partners and supplier.

IBM WebSphere Application Server Version 6 provides customers better scaling so more concurrent users
can access an application built on the software. This can help reduce administrative and licensing costs for
companies and provides better flexibility to quickly bring additional user resources on board.

What is new for administrators

-;;ﬁ
The biggest improvements and changes in system administration, monitoring, and tuning can be
summarized as follows:

* Changes to the default configuration

* Fine grained application update and other deployment improvements
* Enhanced administrative infrastructure, with J2EE 1.4 related changes
* Growing set of administrative commands

* Improved installation and configuration, with profiles

* Improved monitoring and performance tuning

» Default messaging provider

* Even more administrative improvements!

For details about each item, including links to relevant documentation, see the Administration: Operations
PDF.

Improvements to this documentation

* New How do 17... feature gathers documentation, multimedia demonstrations, tutorials, cheat sheets,
and presentations for commonly performed tasks

* Improved installation documentation

* Improved scripting documentation

» Conceptual overviews and what is new topics have better content and are easier to find
* Quick start shortcuts direct you quickly to key materials

* New Learn about WebSphere applications section for studying the programming model
* Improved, task-based table of contents

© Copyright IBM Corp. 2004 5



* Improvements to troubleshooting content and placement

What is new for installers

This topic highlights what is new or changed in Version 6 for users who are going to install, upgrade, or
migrate the product, including coexistence and interoperability concerns.

i

The biggest improvement to installation is that now you can install one copy of the core files
(binary system files and such) on a machine, then use profiles to define multiple application server runtime
environments -- each with its own administrative interfaces -- that share the core files. This has many
positive ramifications for preparing, installing, maintaining, and removing installations, including a
decreased footprint.

Another big change is the introduction of separate installation routines for the Application Server product,
the Web server, the Web server plug-ins, and the clients so that you can install only what you need on a
particular machine.

Redesigned Launchpad to plan and start installation A redesigned launchpad on the product CD launches one
of the installation programs. See [‘Using the launchpad td|
[start the installation” on page 39.The Launchpad also
provides product solution roadmap diagrams to let you
decide on the fly what to install where.

Now you can launch the installation of the developer
toolset from the launchpad.

Install only what you need New, more granular installation procedures simplify
installation and improve installation reliability. Installation
routines exist for the following components on the product
disc.

» WebSphere Application Server products
e IBM HTTP Server

* Web Server plug-ins

» Application clients

Separate installation procedures for the IBM HTTP Server
product and for the Web server plug-ins let you install only
what you need on a particular machine.

Installing WebSphere application server products IBM WebSphere Application Server - Express, Version 6 is
an integrated platform that contains an Application Server,
Web development tools, a Web server, and additional
supporting software and documentation.

Version 6 installs the core product files and a stand-alone
Application Server in a profile named default.

For more information, see:

+ [Chapter 9, “Installing the product and additional|
software,” on page 95|

« [Using the Profile creation wizard” on page 211|
- [wasprofile command” on page 217

6 1BM WebSphere Application Server - Express, Version 6: Installing your application serving environment



Installing IBM HTTP Server

Installing WebSphere Application Server clients

The product installation root has changed

Improved installation documentation

Simplified setup and prerequisites

Smaller footprint

The installation wizard for IBM HTTP Server is redesigned
for Version 6. At the end of the Web server installation,
launch the new Plug-ins installation wizard to configure
the IBM HTTP Server and the Application Server.

See[‘Installing IBM HTTP Server” on page 139.|

A client application processes on a client machine and a
host WebSphere Application Server machine. A client
might provide the GUI, but process data on the host, for
example. The Clients installation wizard installs
environments for running client applications on the client
machine. Some environments perform all necessary
handshaking and protocol. Thin client environments
require client applications to have their own protocols for
such things as JNDI lookups.

See [Installing Application Client for WebSphere|
|Application Server’ on page 198.|

The installation root varies by operating system, as before,
but now includes IBM in the path. The installation root is
the same for all three product editions now -- there is no
longer a separate installation root for the Network
Deployment product edition.

The installation root is now:
» For AIX: /ust/IBM/WebSphere/AppServer
* For Linux and UNIX: /opt/IBM/WebSphere/AppServer

» For Windows: C:\Program
Files\IBM\WebSphere\AppServer

Additional directory structure changes are introduced, as
described in[‘New: Improved installation and configuration |
|with profiles” on page 8.

New installation documentation on the product disc helps
you retrieve relevant information. For an overview of the
installation section, see [‘Overview and new features for|
linstalling an application serving environment” on page 23|

Redesigned product features simplify operating system
setup and reduce prerequisite requirements. For details,
see [Chapter 8, “Preparing the operating system foi|
product installation,” on page 69| and [‘Hardware and|
software requirements” on page 38.

A redesigned installer simplifies the installation of the core
product files for WebSphere Application Server products.
You do not have to install the core product files multiple
times to create multiple standalone Application Servers.
Instead, use the new Profile creation wizard to create an
application server runtime environment that has its own
administrative interface.

See [Chapter 10, “Configuring the product after
installation,” on page 207.|

Chapter 2. What is new in this release 7



Simplified service The installation program installs the system files (shared
binary files), which you do not update until you install a
service fix. Creation and configuration of application
servers do not change the system files.

Easier removal and reinstallation Removal and reinstallation of Application Server
environments is simplified and faster. Application Server
environments are much easier to install and much easier
to uninstall than in Version 5. Uninstalling an Application
Server does not change the shared system files of the
base WebSphere Application Server product.

In Version 5, some scenarios required uninstalling all
traces of the product to produce a clean machine, which
then allowed you to reinstall the product. In Version 6, that
is a thing of the past. Application servers uninstall cleanly,
almost effortlessly.

See|Appendix A, “Uninstalling the product,” on page 271

Better indicators of installation status Improved logging and status indicators let you easily
determine the success or failure of an installation.

Silent installation requires license acceptance You need to set the License Acceptance property to "true”
in the silent installation response file. The property is
silentinstallLicenseAcceptance.value, which is described
further in|‘responsefile.express.txt” on page 130,

New migration wizard A new migration wizard collects data for the migration
command line tools. The wizard also monitors and reports
migration status. Note that the installation program no
longer performs the migration.

New: Improved installation and configuration, with profiles

This topic describes how the product directory structure and use of profiles separates the binary system
files from the installation-specific configuration information, leading to easier installation, maintenance, and
configuration management.

The version 6 product installation program places the files it creates into one of two separate
environments. It installs the binary system files that may be read-only. It also creates an initial profile,
which is a run-time execution environment that includes configuration files, the default location for
deployed applications, logs, and other data. All profiles on a machine can share the same system files, but
do not change the system files.

Administrators can use any of the administrative clients to administer the configuration of each profile. It is
highly recommended that you browse |“wasprofile command” on page 217| for a full introduction to profiles.

Profiles can be exported You can propagate the configuration from one wasprofile
to another by exporting a wasprofile to a configuration
archive and importing it to another wasprofile. This
mechanism works between wasprofiles of the same
installation or different installations. A restriction is that this
mechanism only works for an unfederated wasprofile.

8 IBM WebSphere Application Server - Express, Version 6: Installing your application serving environment



Profiles sharing the same system files may be upgraded  Because the version 6 binary images are installed at a
(or rolled back) individually. different location, it is possible to upgrade each Version 5
cell member individually.

Directory structure changes Files pertaining to a particular application server runtime
environment are in a directory path containing the word
profiles, as well as the particular profile name.

Note also that the product installation root has changed to
include IBM, as described in ['What is new for installers’]

Fast paths for WebSphere Application Server

This topic describes the most quick and simple paths to deploying an application, with links that pinpoint
the relevant information for reaching your goals quickly. It also describes the audience roles and tasks
assumed by this documentation. The fast path described in this topic is intended to help you gain a little
experience. It does not showcase the advanced product features that some users need or want to use in
their production environments.

Overview. Deploying any type of application involves the following tasks.

@ Step 1: Install the product.

The simplest scenario is to perform a typical installation of a single application server onto a
Windows machine. See [‘Operating system central” on page 10| for direct links to installation steps
for Windows (or another operating system of your choice). |Planning information| is available in the
installation section.

@ Step 2: Obtain or develop your application.
In the simplest scenario, you already have a packaged, J2EE 1.4 compliant Web application,
perhaps from a vendor with whom you work. Other than that, a Web application is the most simple
type of application to develop, or refer to the many Samples in the Samples Gallery.

@ Step 3: Deploy and test your application.
In the simplest scenario, you will use the application installation wizard available in the
administrative console. See s PDF for a detailed walkthrough of this task. The task describes
many contingencies, but many of these steps can be disregarded if:

* You are deploying a Web application

* You accept the default settings whenever possible
* Your application does not require data access

* Your application does not require security

Also, in many situations, you can get by without modifying the default application server
configuration.

@ Step 4: Administer your deployed application.
In the simplest scenario, you will monitor your application with the Tivoli Performance Viewer

Chapter 2. What is new in this release 9



functionality built into the administrative console. See "Monitoring performance with Tivoli
Performance Viewer (TPV)" in the Administration: Operations PDF for an overview of this task.

Now you should have some insight into the task flow for successfully deploying your applications.

To solidify and expand your understanding, view the following table. It shows the user role and task
assumptions by which this documentation is organized, for predictability. If you know what role or task you
are performing, you can disregard (at least temporarily) documentation that is labeled for other roles or
tasks. By their nature, role and task models are simplified compared to reality. Also, one person might
perform many roles and tasks in the course of a day.

User role User tasks

L]

__..-"" Install application serving environment
Installer

Migrate deployed applications and their environment

16

Administrator

Administer applications and environment

Monitor and tune applications and their environment

Deploy applications into production

1O

Developer

Develop or migrate application code

Assemble applications for deployment

Deploy applications for testing

1o

Security expert

Secure applications and their environment

C oDV E

1O

Troubleshooter

Use tools to troubleshoot problems

Operating system central

This topic provides links to documentation that is specific to particular operating systems.
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m [“Preparing to install Express on an AIX system” on page 87|

|“Preparing to install Express on an HP-UX system” on page 88|

|“Preparing to install Express on a Linux system” on page 89|

m [“Preparing to install Express on a Solaris system” on page 90|
m [“Preparing to install Express on a Windows system” on page 91|
Tutorials

This topic describes how to find tutorials and their accompanying Samples, for learning how to accomplish
your goals with the product.

Education on Demand tutorials
The |Education on Demand site| provides education resources that you can use at your
convenience. You can find Education on Demand tutorials referenced throughout this
documentation.
» Obtaining help with tasks

Some of the tutorials are presented according to the task that you are performing, such as
administration. The topics tend to be generally based, such as how to use the administrative
tools.

» Exploring particular WebSphere application types

Tutorials also are presented according to the WebSphere application type or technology that
they demonstrate, such as how to do something with Web services.

Tutorials with Technology for Developers Version 6
IA specific set of tutorials on developerWorks|pertain to an early release of Version 6: WebSphere
Application Server Technology for Developers Version 6 in late 2003.

Many of the administrative details of the product have changed since these tutorials were issued.
However, many of them focus on using new aspects of the J2EE 1.4 programming model, which
remain valid for the product release that you are now using. Use these tutorials with care.

Chapter 2. What is new in this release 11
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http://www.ibm.com/developerworks/websphere/downloads/WASTD6Support.html
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Chapter 3. How do | install an application serving
environment?

« [“Install a development environment’]

+ [*Plan and install a production environment” on page 14|

+ [“Configure the product after installation (required)” on page 16|

* [‘Communicate with Web servers” on page 17|

[‘Troubleshoot the installation” on page 19|

% Legend for "How do 1?...” links

Documentation Show me Tell me §
n Guide me Teach me

Refer to the detailed |Watch a brief View the presentation |Be led through the Perform the tutorial
steps and reference | multimedia for an overview console pages with sample code
demonstration

Approximate time: Approximate time: 3 | Approximate time: Approximate time: Approximate time: 1
Varies to 5 minutes 10 minutes+ 1/2 hour+ hour+

Install a development environment

¥

Plan your installation of WebSphere Application Server

IBM WebSphere Application Server, Version 6 is an integrated platform that contains an
Application Server, Web development tools, a Web server, and additional supporting software and
documentation. Diagrams are provided to show several common installation configuration.

Documentation:

¥

Review the Release Notes

Learn about late-breaking changes and limitations, particularly involving installation, migration, and
configuration.

Documentation

© Copyright IBM Corp. 2004 13



ftp://ftp.software.ibm.com/software/eod/WAS_6-0/Install_Migration/Presentations/WASv6_Dist_Install_Overview/player.html

Review the software and hardware prerequisites

Learn which product configurations are supported.

Documentation

V]

Use the launchpad to explore options and start the installation

The launchpad console is the starting point for installing WebSphere Application Server products
and trials.

Documentation

[V]
|—| Learn about WebSphere applications

Use this section as a starting point to investigate the technologies used in and by applications that
you deploy on the application server.

Documentation:
"Learn about
WebSphere
applications” in the
Developing and
Deploying Applications

PDF.ﬁ

Plan and install a production environment

Look at configuration diagrams to determine how you want your application serving environment to be.
Perform the needed installations.

Topology and terminologyl

]

—— Choose a product edition

Learn about the family of WebSphere Application Server products, the package that ships for each
package, and the installable components on each product compact disc.
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http://www.ibm.com/software/webservers/appserv/doc/latest/prereq.html
ftp://ftp.software.ibm.com/software/eod/WAS_6-0/BigPicture/Presentations/WASXv6_Topology_Terminology/player.html

N

Documentation

V]

Plan your application serving environment

Use the diagrams to decide among several popular installation scenarios.

Documentation:
“Planning to install
\WebSphere]
Application Server -
Express” on page 52|

N

¥

Review the Release Notes

Learn about late-breaking changes and limitations, particularly involving installation, migration, and
configuration.

Documentation

¥

Review the software and hardware prerequisites

Learn which product configurations are supported.

Documentation

¥

Obtain an overview of installation

High level steps for installing the product. Tips and knowledge that will make installation easier.

FRoadmap foF|

installing Express” on| "'ll.l

Chapter 3. How do | install an application serving environment? 15
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http://www.ibm.com/software/webservers/appserv/doc/latest/prereq.html
ftp://ftp.software.ibm.com/software/eod/WAS_6-0/Install_Migration/Presentations/WASv6_Dist_Install_Overview/player.html
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Installing the product

Documentation: Show me:

]
« [‘Preparing to install] * [Express| Ehlll:l
Express on an AlX|

system” on page 87| ﬁ(

« |“Preparing to install|
Express on an|
HP-UX system” on|
page 8€_3|
* |“Preparing to install
Express on a Linu
system” on page 89|
« [“Preparing to installl

Express on a|
Solaris system” on|

page 99]

« [“Preparing to installl
Express on al
Windows system’]
on page 91|

N

¥

Take your first steps in using the product

The First steps console is a post-installation ease-of-use tool for directing WebSphere Application
Server elements from one place. You can verify the installation, start a server, view Samples,
register the product, and other activities.

Documentation

Configure the product after installation (required)

Perform configuration. Take your first steps using the product.

¥

Take your first steps in using the product

The First steps console is a post-installation ease-of-use tool for directing WebSphere Application
Server elements from one place. You can verify the installation of a profile, start a server, view
Samples, register the product, and other activities.
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Documentation:
[firststeps command’]

Communicate with Web servers

Perform tasks related to HTTP serving, including installing a complementary Web server available with
your Application Server, and configuring communication between the Application Server and any supported
Web server.

Install IBM HTTP Server as your Web server

Install IBM HTTP Server V6 and its plug-in, or install a plug-in for another supported Web server to
enable the Web server to work with WebSphere Application Server, V6.

Documentation: .
‘Installing IBM HTTPl % Eil'
Server’ on page 139  [Show me| 'l

Plan the Web server plug-ins in your application serving environment

The primary production configuration is an Application Server on one machine and a Web server
on a separate machine. This configuration is referred to as a remote configuration. Contrast the
remote configuration to the local configuration, which consists of the Application Server and the
Web server on the same machine. Either configuration requires the Web server plug-in modules
on the Web server machine.

Documentation:
“Selecting a Web|
server topology
diagram and
roadmap” on page]

Install plug-ins for communicating with Web servers

After installing the Application Server and a Web server, you can install a WebSphere Application
Server plug-in for a supported Web server. The binary plug-in is unique per Web server. The
purpose of the binary plug-in is to provide the communication protocol between the Web server
and the Application Server.
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Documentation: .
“Installing Web servel Eﬁ( Toll me ﬁ“ﬁ:

plug-ins” on page 141| [Show me]

ell me|

N

¥

Configure communication with the Web server

The Web server plug-ins for Web servers running on a distributed platform are provided on a
separate CD from the WebSphere Application Server product. A Web Server Plug-in Installation
Wizard that is also provided on that CD.

Documentation: % E“ Guide me. See
‘.. "Cheat sheets for the
- administrative

console” in the
Administration:
Operations PDF.

T

Configure the HTTP channel within the application server

The HTTP channel provides client applications with persistent HTTP connections to remote hosts
that are either blocked by firewalls and/or require an HTTP proxy server (including authentication).
An HTTP channel is used to exchange application data in the body of an HTTP request and HTTP
response sent to and received from a remote server. HTTP channels enable client-side
applications to poll the remote host and to use HTTP requests to either send data from the client
or to receive data from an application server. In either case, neither the client nor the application
server are unaware that HTTP is being used to exchange the data.

Documentation: See
"Configuring transport
chains” in the
Administration: Setting

up PDF.ﬁ

Enable your Web server to use HTTPS in addition to HTTP

If you intend to use the Secure Sockets Layer (SSL) transport (also known as HTTPS), in addition
to the plug-in files, you must also install the Global Security Kit (GSKit) on the workstation hosting
your Web server. This kit helps the Web server connect to your Application Server.
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Documentation:
Chapter 21, “Gskit|
install images files,’|

N

on page 263

Troubleshoot the installation

Troubleshoot installation problems and apply fixes as needed.

Troubleshoot installation problems

Obtain help with a variety of installation problems.

Documentation:

IAppendix B,
“Troubleshooting|

installation,” on page|

— Review the software and hardware prerequisites

Learn which product configurations are supported.

Documentation

Chapter 3. How do | install an application serving environment?
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Part 2. Planning and preparing
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Chapter 4. Installing your application serving environment >
Distributed operating systems

The installation uses InstallShield for Multiplatforms (ISMP) to perform the installation. You can use the
Installation wizard or perform the installation from a command line, using the silent installation method.

WebSphere Application Server - Express overview

The Express product creates a stand-alone application server process during installation. You can create
other stand-alone application servers using the Profile creation wizard. Each process is created in a
profile, which is the set of files that define the run-time environment for the process. The files include all of
the application files, configuration files, data files, and log files that the Application Server can change.
Each stand-alone application server on a machine shares the same set of core product files, which do not
change unless you install a refresh pack, fix pack, or interim fix to the product.

Creating multiple application servers on a single machine

You can create any number of application servers on a single machine. Although each profile is unique,
with its own configuration, applications, data, logs, and administrative console, all of the servers share one
set of command files and other product binary files. Changes that you make to one server profile do not
affect the other servers. Configuration documents are maintained within each profile. The wasprofile
command and its graphical user interface, the Profile creation wizard create the multiple stand-alone
application servers.

Other installable components on the product disc
The product disc contains IBM HTTP Server, the Web server plug-ins for WebSphere Application Server,
and the Application Clients for WebSphere Application Server. Each installation procedure is described in

this information center and in the IBM HTTP Server information center.

How to buy IBM WebSphere Application Server software

See your IBM representative for licensing information, or visit the [How to buy WebSphere Application|
[Server softwarel Web site.

Overview and new features for installing an application serving
environment

This topic summarizes the contents and organization of the installation documentation, including links to
conceptual overviews and descriptions of new features.

1
&

« 4 [Chapter 1, “Overview of installing your application serving environment,” on page 3|

éﬂ'ﬁﬁ
. [‘What is new for installers” on page 6]

Sections in the installation documentation:

@ [Chapter 5, “Release notes,” on page 25|
This topic highlights known problems, limitations, and workarounds as an addendum to the product
documentation. Briefly review this document before installing the product.
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@ [Chapter 6, “Task overview: Installing,” on page 27|
This topic describes installing and customizing all of the installable components that are on the
product compact disc.

@ |Chapter 7, “Planning the installation (diagrams),” on page 51|
This topic presents installation topologies, with installation roadmaps summarizing the product
components that are needed to install each topology.

@ [Chapter 8, “Preparing the operating system for product installation,” on page 69
This topic shows how to prepare each supported operating system for installation. A series of
operating system-specific topics describe what to do.

@ [Chapter 9, “Installing the product and additional software,” on page 95|
This topic describes how to install the product, as the root user on a Linux platform or on a
UNIX-based platform, or from a user ID that belongs to the administrator group on a Windows
platform.

@ [Chapter 10, “Configuring the product after installation,” on page 207|
This topic describes what you might do after installing the product. Activities include configuring
additional product configuration profiles; migrating a previous product configuration; and securing
certain product files.

@ @lChapter 11, “Communicating with Web servers,” on page 231|

This topic describes how to establish communication between Web servers and application
servers, so that Web servers can route requests to application servers. The WebSphere
Application Server plug-ins for Web servers running on a distributed platform are provided on a
separate CD from the WebSphere Application Server product. It describes how to use the Web
Server Plug-in Installation wizard provided on that CD, and then how to administer the resulting
plug-in configurations.

@ [Appendix A, “Uninstalling the product,” on page 271|
This topic describes how to uninstall the product from the root user on a Linux platform or a
UNIX-based platform, or from a user ID that belongs to the administrator group on a Windows
platform.

@ [Appendix B, “Troubleshooting installation,” on page 291|
This topic describes how to identify and handle a variety of problems that are encountered during
installation activities.
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Chapter 5. Release notes

This section contains the release notes for distributed operating systems. Release notes summarize
late-breaking news and product limitations.

IBM WebSphere Application Server, Version 6.0 Release Notes

This document contains release notes for:

» WebSphere Application Server Express, Version 6

» WebSphere Application Server, Version 6

* WebSphere Application Server Network Deployment, Version 6

Links are provided to the product support Web site, to product documentation, and to last minute updates,
limitations, and known problems for the WebSphere Application Server Version 6 products.

* |*Accessing last-minute updates, limitations, and known problems’1
. :“Accessing hardware and software requirements’]

. :“Accessing product documentation”
. “‘Accessing the product support Web site” on page 26|
» |“Contacting IBM Software Support” on page 26|

Accessing last-minute updates, limitations, and known problems

The Version 6 Release notes are available on the product support site as technotes. To see a list of the
release notes for Version 6.0, go to the [WebSphere Application Server support Web pagel

Accessing hardware and software requirements

The hardware and software requirements for the WebSphere Application Server products are provided on
the [Supported hardware and software Web pagel

Accessing product documentation
The following documentation is installed with WebSphere Application Server.
The readme file.

Several readme files are provided:

* The readme_en.html file in the root directory of the product CD-ROM is a shadow of the Launchpad
application. It provides links to the installation procedures and documentation for all of the installable
components on the product CD. Translated versions of the file are in the launchpad directory.

* Thereadme.html file in the WAS directory points to this more detailed readme in the WAS directory and to
the Getting Started Guide in the WAS/docs directory. This file is not translated.

* Thereadme_en.html in the readme directory of each installable component, such as this file. The
Launchpad links to this file for a description of installing the WebSphere Application Server - Express
product. This file is also available from the readme directory in the root directory of the product
CD-ROM.

Getting Started Guide

The InstallGuide_en.pdf and the InstallGuide_en.html in the WAS/docs directory provide detailed
instructions for installing WebSphere Application Server. The information in the guide is derived from
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information in the online information center. The guide is not translated on the product CD; however,
translated versions of the information center are available online.

Help files

The help files provide detailed instructions for completing tasks and for specifying settings in the graphical
systems management tools. Use the help menus, links, or buttons provided in the tool interfaces to access
the help files.

Documentation on the Web

For the Version 6 information center in all supported languages, go to:
Ihttp://publib.boulder.ibm.com/infocenter/ws60help/index.jsp|

For the entire information center set for all WebSphere Application Server products, go to [the Information
[Center library pagel

For the entire documentation set for all WebSphere Application Server products, including Adobe Acrobat
PDF versions of the information, go to the WebSphere Application Server library page]

All of the Version 6 product documentation is in the V6 information center, including versions of the
installed help files.

Accessing the product support Web site

To search for the latest technotes, downloads, fixes, and other support-related information, go to
[WebSphere Application Server support page]

Contacting IBM Software Support

If you encounter a problem with the WebSphere Application Server, first try the following actions:
* Following the steps described in the product documentation

» Looking for related documentation in the online help

» Looking up error messages in the message reference

If you cannot resolve your problem by any of the preceding methods, contact IBM Technical Support.

Purchase of WebSphere Application Server entitles you to one year of telephone support under the
Passport Advantage program. For details about Passport Advantage, visit|the Passport Advantage pagel

The number for Passport Advantage members to call for WebSphere Application Server support is
1-800-237-5511. Have the following information available when you call:

* Your contract or Passport Advantage number.

* Your WebSphere Application Server version and revision level, plus any installed fixes.

* Your operating system name and version.

* Your database type and version.

» Basic topology data: how many machines are running, how many application servers, and so on.
* Any error or warning messages that are related to your problem.
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Chapter 6. Task overview: Installing

This topic describes installing Version 6 on AIX, HP-UX, Linux, Solaris, and Windows operating systems.

This topic describes installing and customizing all of the installable components that are on the IBM
WebSphere Application Server Express, Version 6.0 product compact disc.

You can obtain the product code to install on distributed platforms in any of the following ways:

* From the product compact disc

» From the Trial download page on the Support site, where you can download a packed installation file
» From the Passport Advantage site, where licensed customers can download installation images

The launchpad application is available on the product CD and on downloaded installation images
(including trials). The launchpad is the recommended method of installing components that are on the
product CD. See [‘Using the launchpad to start the installation” on page 39| for more information about the
launchpad.

If you cannot use the launchpad for some reason, examine the Information center version of the

installation solution diagrams in the launchpad. The planning diagrams in the information center help you
to verify your product selection and to identify and select your installation path. See|Chapter 7, “PIanning|
lthe installation (diagrams),” on page 51|for more information.

If you are already familiar with the types of topologies that you can create with WebSphere Application
Server products, you can use the fastpath installation path on the launchpad to begin installing
components that are on the product CD. If you cannot use the launchpad for some reason, you can find
the installation programs for installable components in the following locations:

Installable component Directory Program
WebSphere Application Server - Express WAS install
IBM HTTP Server IHS install
Web server plug-ins plugin install
Application Clients AppClient install

Locate the installation program for the Rational Web Developer on CD 1 of 3:
Rational Web Developer: /setup/setup.exe

See the description of the product packaging in [‘Packaging” on page 28 for more information about
installable components.

Trial downloads are available for WebSphere Application Server - Express, the IBM HTTP Server, the Web
server plug-ins for WebSphere Application Server, the WebSphere Application Server Clients, and the
Rational Application Developer.

The information center for WebSphere Application Server products also includes information about the IBM
HTTP Server, the application clients, and the Web server plug-ins. The information center also includes
some information about the Rational Web Developer.

Perform the following procedure to learn about and to create a running version of the product components
on your machine. Plan to read through the major topics in the information center Getting Started section
before beginning the installation. If you are planning to migrate from an earlier version, you can install the
WebSphere Application Server product before migrating.
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New for Version 6 is the Migration wizard. See the Migration Guide PDF for more information. for more
information.

1. Review the installation solution diagrams for help in planning a design for your topology.

The planning diagrams in the Information center can help you identify and select your installation path.
See [Chapter 7, “Planning the installation (diagrams),” on page 51|for more information.

Before you start installing products with the launchpad, verify that your operating system is supported
and that you have installed all of the prerequisite patches.

2. Prepare your operating platform for installation.
Use the information in|Chapter 8, “Preparing the operating system for product installation,” on page 69
to verify that your operating system is able to run the WebSphere Application Server products.
After preparing your operating system, you are ready to install the WebSphere Application Server
products.

3. Install the WebSphere Application Server product that you have selected.
See |Chapter 9, “Installing the product and additional software,” on page 95| for specific installation
procedures.

4. Configure the product after installation, as described in [Chapter 10, “Configuring the product after|
fnstallation,” on page 207
You can use the Profile creation wizard to configure additional application server run-time
environments, called profiles.
The Profile creation wizard configures each profile using the wasprofile command-line tool. See
fthe Profile creation wizard” on page 211| and ['wasprofile command” on page 217 for more information.

5. Optional: Consider migrating a previous installation to Version 6, as described in the Migration Guide
PDF..

You can migrate the configuration and applications from a previous installation of another version of
WebSphere Application Server. Version 6 has a new utility to help you perform the migration. The
Migration wizard is described in the Migration Guide PDF.

Packaging

This topic describes the family of WebSphere Application Server products and the ship package for each
product.

The WebSphere software platform for e-business starts with a foundation that is formed from Web
application serving and integration. IBM WebSphere Application Server software provides the core
software to deploy, integrate, and manage your e-business applications.

WebSphere Application Server software supports custom-built applications that are either based on
integrated WebSphere software platform products or on other third-party products. Such applications can
range from dynamic Web presentations to sophisticated transaction processing systems.

IBM WebSphere Application Server - Express, WebSphere Application Server, and WebSphere Application
Server Network Deployment are incrementally related. As you scale up your e-business demand, you can
also scale up your e-business capability by moving from one product to the next.

The Express product is the entry point for a single machine. The base Application Server product differs
from the Express product in licensing and tooling support. The Network Deployment product includes all of
the Application Server functionality of the other two products and also offers multiple machine hosting and
centralized management through a deployment manager process.

The management interface for all three products includes a scripting interface and the administrative

console, which is a Web application. The scripting interface and the administrative console of the
deployment manager are enhanced for managing all of the Application Servers in a distributed network
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cell. From the single point of control of the deployment manager, you can define servers, IBM HTTP
Server processes, and clusters, start and stop servers and cluster members, and deploy applications
anywhere in the cell.

Product offerings for Version 6

IBM WebSphere Application Server products provide a next-generation application server on an
industry-standard foundation. Each product addresses a distinct set of scenarios and needs. WebSphere
Application Server, Version 6 includes the following product offerings:

« |[WebSphere Application Server - Express|
» |WebSphere Application Served
WebSphere Application Server Network Deployment|

WebSphere Application Server - Express

This product offering addresses the basic programming and run-time needs of desktop developers and
single-server production scenarios. The run-time environment addresses standards-based programming for
Web and component-based programming, as well as Web services.

The administration model for this offering is a single-server environment without clustering, and without
centralized administration of multiple server instances.

The Express product package includes the Rational Web Developer tool, which is a fully integrated
development environment (IDE). Rational Web Developer is an enhanced version of the WebSphere
Studio Site Developer in Version 5. The Express package also includes the Application Server Toolkit.

Installing the Express product offering on the same machine as the Rational Web Developer is not
necessary. The IDE contains a replica of the Version 6 Application Server as a test environment.

See [‘Planning to install WebSphere Application Server - Express” on page 52| for diagrams of topologies
that support the Express environment.

WebSphere Application Server

This product offering addresses the basic programming and run-time needs of desktop developers and
single-server production scenarios. The run-time environment addresses standards-based programming for
Web and component-based programming, as well as Web services.

The administration model is a single-server environment without clustering, and without centralized
administration of multiple server instances.

The development environment offering is the Application Server Toolkit and a trial version of the Rational
Application Developer product. The Rational Application Developer is an enhanced version of the
WebSphere Studio Application Developer in Version 5.

WebSphere Application Server Network Deployment

This product offering addresses WebSphere Application Server processes that run in multiple-server
production scenarios. The Network Deployment product can create:

* Deployment managers

The deployment manager provides centralized administration of managed Application Server nodes and
custom nodes as a single cell. The deployment manager provides basic clustering and caching support,
including failover support and workload balancing. Use the Edge components in the Network
Deployment package to further extend the environment with sophisticated caching, load balancing, and
enhanced security functions.

» Application Servers

The Application Server in the Network Deployment product can run in a deployment manager cell as a
managed node or on its own as a stand-alone Application Server.
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» Custom nodes
A custom node is an empty node until you add it to the deployment manager cell for customization. Use
the administrative console of the deployment manager to create servers and clusters on the custom
managed node. Consider the custom node as a production-ready shell, ready for customization to
contain your production-level servers and applications.

New installation and operating model

Version 6 separates the core product binary data from the data that you create as you define and
customize your Application Server run-time environment. You can have multiple sets of customized
run-time environments. Each environment is known as a profile in Version 6.

Application Server environments that are created during product installation

Application Server instances created

Product Default environments .. .
during installation

One stand-alone Application Server profile
WebSphere Application  |and the Profile creation wizard for creating

Server - Express other Application Server profiles on the same servert
machine.
One stand-alone Application Server profile
WebSphere Application | and the Profile creation wizard for creating
- ) serveri
Server other Application Server profiles on the same
machine.
Network Deployment A default run-time environment is not created | From the last installation panel, you can
during installation of the core product files. launch the Profile creation wizard to create

one of the three available profiles:
» Deployment manager profile

» Application Server profile

e Custom profile

Install the Network Deployment product on each machine in a multiple-machine, distributed environment to
give each server process access to a local copy of the core product files.

New and improved launchpad console

The launchpad is the focal point for installing from the product compact disc, with important guidance for
creating typical topology scenarios. Diagrams help you identify the types of systems that you can create.
The launchpad is in the root directory of the product CD.

The launchpad works on installable components in the primary packet of compact discs. Select and launch
any of the components on the product disc or view their HTML documentation on the disc.

Use the launchpad command if the program does not start automatically when you insert the product
disc:

. -E'E- ./launchpad.sh
. m lTaunchpad.bat

See [‘Using the launchpad to start the installation” on page 39|for more information.

If you cannot start the launchpad, see the appropriate locale-specific readme file in the root directory on
the disc. You can also launch the installation programs directly, using the information in the following table:
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Table 1. Installable components on the product CD

Launch Documentation Name of installable component
command
WAS/install WAS/readme/ readme_en.html The name of the component varies per

product offering:

* WebSphere Application Server — Express
* WebSphere Application Server

* WebSphere Application Server Network

WAS/docs/ InstallGuide_en.html

Deployment
IHS/install IHS/readme/ readme_en.htm] IBM HTTP Server
IHS/docs/ InstallGuide_en.html
plugin/install plugin/readme/ readme_en.html Web server plug-ins for WebSphere

Application Server
plugin/docs/ InstallGuide_en.html

AppClient/install|AppClient/readme/ readme_en.html Application Client for WebSphere
Application Server

AppClient/docs/ InstallGuide_en.html

Other directories on the product CD contain components that are automatically installed during one or
more of the installation procedures for the installable components.

-'."EJE- WebSphere Application Server products require that you log on as root on a Linux
or UNIX operating system to install. Set the umask to 022 for security purposes after logging on as root
before you install:

umask 022

Set file permissions to 755 after installation, as in the following example for one file:
chmod 755 setupCmdLine.sh

The IBM HTTP Server tolerates a non-root installation, but you cannot install the Global Services Kit 7
(GSKit 7) that is required for HTTPS security. You can install IBM HTTP Server as a non-root user, then
log on as root to install the GSKit program from the directory on the product disc.

Version 6 package descriptions

Each product package contains three sets of compact discs, which are the primary packet and two
supplemental packets. The product CD is always in the primary packet. The product packages and their
installable components are described in detail in the following sections:

« [Packaging information for IBM WebSphere Application Server - Express|
« [Packaging information for IBM WebSphere Application Server|
« [Packaging information for IBM WebSphere Application Server Network Deployment|
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IBM WebSphere IBM WebSphere
Application Server- IBM WebSphere Application Server
Express Application Server Network Deployment

Media/CD (below):

Product disc in  "yepSphere
Primary disc  Application Server-
packet Express"

"WebSphere
Application Server
Network Deployment"

"WebSphere
Application Server"

Tools disc in  "Rational Web "Application Server "Application Server
Primary disc  Developer" Toolkit" Toolkit"
packet (single use) (unlimited use) (unlimited use)
Tools disk  "pppjication Server "Rational Application "Rational Application
in Supplemental Toolkit" Developer" Developer"
disc packet (unlimited use) (trial) (trial)
DB2 disks A
in Supplemental "DB2 Express" "DB2 Express" DB2 Universal

disc packet Database V8.2

Figure 1. Installation images in WebSphere Application Server packages for Version 6. The graphic shows the
packaging for Version 6, which supports the Java 2 Platform, Enterprise Edition (J2EE) 1.4 specification and the Java
2 SDK 1.4.2 specification.

Packaging information for IBM WebSphere Application Server - Express: The Express package
contains three sets of compact discs:

« [Compact discs in the primary Express packef
+ [Compact discs in the two supplemental packets|

The product disc for the WebSphere Application Server - Express product is in the primary package.

Compact discs in the primary Express packet: The primary Express packet contains the compact discs
that are listed in the following table:

Disc label Versions of the disc Comments
WebSphere Application Six different platform versions of | Each platform-specific CD contains the following

Server - Express this CD are available: installable components:

TR

« AIX * WebSphere Application Server - Express in the
« HP-UX WAS directory.

« Linux * IBM HTTP Server in the IHS directory.

« Linux on iSeries and pSeries |* Web server plug-ins in the plugin directory.
« Solaris * Application Clients in the AppClient directory.

+ Windows In addition, the Windows platform CD has the Data
Direct Java DataBase Connectivity (JDBC) Drivers.

The launchpad application in the root directory lets
you install and view information about any of the
installable components in the primary packet.
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Disc label

Versions of the disc

Comments

Rational Web Developer for
WebSphere Application
Server

Web Developer for WebSphere
Application Server - Express

Four compact discs are available
for each of the following
platforms:

* Linux (Intel)
* Windows

The license for Rational Web Developer is a
single-use license.

See the Application Server Toolkit in the
supplemental package for an integrated
development environment that includes an unlimited
use license.

Compact discs in the two supplemental Express packets:
compact discs that are listed in the following table:

The supplemental Express packets contain the

Disc label

Versions of the disc

Comments

DB2 Universal Database
Express Edition V8.2

I
sy

o o,
T 5
o e,

g “,
"« [ universal Database"Express Edition %,

CPU Option for WebSphere' Application %
Server

Version 8.2

Three different platform versions
of this CD are available:

* Linux (Intel)
* Windows 2000 Server
* Windows 2003 Server

IBM DB2 Universal Database Express Edition is the
lowest priced full-function relational database.

DB2 UDB Express Edition is designed to meet the
needs of small and medium businesses.

DB2 UDB Express Edition features self-tuning and
self-configuring capabilities for ease of
manageability.

Available for Linux and Windows platforms, DB2
supports transparent installation with business
partner applications that you might develop.

See IBM DB2 Universal Database Express Edition|
for more information.

IBM Business Solutions for
WebSphere Application
Server - Express

o

""" IBM Business Solutions
2 for WebSphere’ Application Server - Express

Version 6.0

Six different platform versions of
this CD are available:

AlX
* HP-UX
* Linux (Intel)
* Linux on pSeries
» Solaris
* Windows

This disc contains a production-ready application,
which is the IBM Telephone Directory application.
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Disc label Versions of the disc Comments

o Two different platform versions of | The license for the Application Server Toolkit is an
WebSphere Application this CD are available: unlimited use license.

Server - Express - Linux (Intel)

* Windows

&
g [ Application Server - Express
&

Version 6.0

Application Server Toolkit

Packaging information for IBM WebSphere Application Server: The base WebSphere Application
Server package contains three sets of compact discs:

« [Compact discs in the primary Application Server packef]
+ [Compact discs in the two supplemental packets|

Compact discs in the primary Application Server packet: The primary Application Server packet contains
the compact discs that are listed in the following table:

Disc label Versions of the disc Comments
WebSphere Application Seven different platform versions | Each platform-specific CD contains the following
Server of this CD are available: installable components:

* AIX * WebSphere Application Server in the WAS

« HP-UX directory.

« Linux * IBM HTTP Server in the IHS directory.

* Web server plug-ins in the plugin directory.
* Application Client in the AppClient directory.

» Linux on iSeries and pSeries

¢ Linux on zSeries

» Solaris
m In addition, the Windows platform CD

* Windows 2000 Server and . o
Windows 2003 Server has the Dgta Direct Java Database Connectivity
(JDBC) drivers.

Use the launchpad application in the root directory
to install and view information about any of the
installable components in the primary packet.
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Disc label

Versions of the disc

Comments

WebSphere Application
Server

o

o
9;’” [y Application Server
&

nnnnnn

S
. ’
2y e

Application Server Toolkit

Two different platform versions of
this CD are available:

* Linux (Intel)
* Windows

The license for the Application Server Toolkit is an
unlimited use license.

Compact discs in the two supplemental packets: The supplemental Application Server packets contain
the compact discs that are listed in the following table:

Disc label

Versions of the disc

Comments

Rational Application
Developer Trial for
WebSphere Application
Server

Application Developer Trial

for WebSphere Application S

Three compact discs are
available for Linux (Intel)
platforms and four compact discs
are available for Windows
platforms.

Rational Application Developer is the next
generation of the award-winning IBM WebSphere
Studio Application Developer.

Rational Application Developer is a comprehensive
integrated development environment for visually
designing, constructing, testing, and deploying Web
services, portals, and Java 2 Platform Enterprise
Edition (J2EE) applications.

Rational Application Developer accelerates J2EE
development with a complete set of high-productivity
tools, templates, and wizards.

See the Application Server Toolkit in the primary
package for an integrated development environment
that includes an unlimited use license.

DB2 Universal Database
Express Edition V8.2

hasu,

o e ‘0, :{%%

",
[EEZA universal Database™Express Edition 74,
CPU Option for WebSphere’ Application %
Server

nnnnnn

Three different platform versions
of this CD are available:

e Linux (Intel)
¢ Windows 2000 Server
¢ Windows 2003 Server

IBM DB2 Universal Database Express Edition is the
lowest-priced, full-function relational database.

DB2 UDB Express Edition is designed to meet the
needs of small and medium businesses.

DB2 UDB Express Edition features self-tuning and
self-configuring capabilities for ease of
manageability, Linux or Windows platform choices,
and support for transparent installation with business
partner applications.

See [IBM DB2 Universal Database Express Edition|
for more information.

This DB2 Express Edition is for use with
WebSphere Application Server only.
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Packaging information for IBM WebSphere Application Server Network Deployment: The Network

Deployment package contains three sets of compact discs:

+ [Compact discs in the primary Network Deployment packet

« [Compact discs in the two supplemental packets|

Compact discs in the primary Network Deployment packet: The primary Network Deployment packet
contains the compact discs that are listed in the following table:

Disc label

Versions of the disc

Comments

WebSphere Application
Server Network Deployment

o o
e

e

o
# [[TTISER Application Server

Network Deployment

Version 6.0

Seven different platform versions

of this CD are available:

« AIX

* HP-UX

e Linux

* Linux on iSeries and pSeries
 Linux on zSeries

» Solaris

* Windows 2000 Server and
Windows 2003 Server

Each platform-specific CD contains the following
installable components:

* Network Deployment in the WAS directory.

* IBM HTTP Server in the IHS directory.

* Web server plug-ins in the pTugin directory.
» Application Client in the AppClient directory.

In addition, the Windows platform CD has the Data
Direct Java Database Connectivity (JDBC) drivers.

Use the launchpad application in the root directory
to install and view information about any of the
installable components in the primary packet.

WebSphere Application
Server Network Deployment

5 g
o

o
< [TTISER Application Server

Network Deployment

Version 6.0

810

Application Server Toolkit

One CD is available for each of
the following platforms:

* Windows 2000
* Linux (Intel)

The license for the Application Server Toolkit is an
unlimited use license.

Compact discs in the two supplemental packets: The supplemental Network Deployment packets contain
the compact discs that are listed in the following table:
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Disc label Versions of the disc Comments

WebSphere Application Seven different platform versions | Network Deployment addresses the needs of highly
Server Network Deployment | of this CD are available: available, high-volume environments with the Edge
. AIX components.

* HP-UX The Edge components include sophisticated load
* Linux (Intel) balancing, caching, and centralized security

* Linux on pSeries capabilities.
* Linux on zSeries See [WebSphere Application Server Network

* Solaris [Deployment Edge components|for more
* Windows information.

Edge Components

Nine different platform versions | DB2 Universal Database V8.2 has numerous

DB2 Universal Database of this CD are available: innovative enhancements.
Enterprise Server Edition for AIX 5.2
WebSphere Application ' Improved integration with WebSphere Application
Server Network Deployment |° AIX 5.3 Server Network Deployment, key development
L » AIX for DBCS platforms tools, and platforms help make programmers more
s‘ﬁm::xz:*sz:az;ﬂ?:,v;}:;:;z::zpp.::;?%, * HP-UX efficient than ever.
S * Linux (Intel) A broad array of autonomic or self-managing
 Linux on pSeries capabilities can free more administrator time to
« Linux on zSeries focus on driving business value.
* Solaris The ease of use in DB2 V8.2 and the
* Windows self-managing characteristics might even eliminate

the need for dedicated administrators in smaller
implementations.

Seven different platform versions | The IBM Tivoli Directory Server product is a

Tivoli Directory Server for of this CD are available: powerful Lightweight Directory Access Protocol
WebSphere Application . AIX (LDAP) infrastructure.
Server
* HP-UX Tivoli Directory Server provides a foundation for
:m S + Linux (Intel) deploying comprehensive identity management
; S ppcaton e « Linux on pSeries applications and advanced software architectures.

* Linux on zSeries See [IBM Tivoli Directory Server|for more
» Solaris information.

* Windows
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Disc label Versions of the disc Comments

Rational Application Developer is the next
generation of the award-winning IBM WebSphere

Three CDs for each of two

Rational Application different platform versions are

Developer Trial for available: Studio Application Developer.

WebSphere Application . Linux

Server Rational Application Developer is a comprehensive
» Windows

integrated development environment for visually
designing, constructing, testing, and deploying Web
services, portals, and Java 2 Platform Enterprise
Edition (J2EE) applications.

o,

o
" [ZITIEN Avplication DeveloperTrial

for WebSphere,« Application Server 7,

Version 6.0
Disc1of3

Rational Application Developer accelerates J2EE
development with a complete set of
o high-productivity tools, templates, and wizards.

See the Application Server Toolkit in the primary
package for an integrated development
environment that includes an unlimited use license.

IBM Tivoli Access Manager for e-business
integrates with e-business applications right out of

Six different platform versions of

IBM Tivoli Access Manager |this CD are available:

Servers for WebSphere
Application Server

,»*‘g*
g\f LI Access Manager Servers
4 for WebSphere® Application Server

Version 5.1

* AIX

HP-UX

Linux (Intel)
Linux on zSeries
Solaris

the box, to deliver a secure, unified, and
personalized e-business experience.

By providing authentication and authorization APIs
and integration, Tivoli Access Manager for
e-business helps you secure access to
business-critical applications and data that might be

* Windows spread across the extended enterprise.

See|IBM Tivoli Access Manager for e-business| for
more information.

Hardware and software requirements

This topic describes prerequisites for installing WebSphere Application Server products.

The official statements of support for WebSphere Application Server products are provided on the
Supported hardware and software Web page at the
[http://www.ibm.com/software/webservers/appserv/doc/latest/prereq.htm| IBM Web address. If there is a
conflict between the information provided in this document and the information on the Supported hardware
and software Web address, the information at the Web site takes precedence. The information in this
document is provided as a convenience only.

Required disk space

Disk space requirements are platform-specific. See the following topics for information about required disk
space and how to prepare your operating system for installation:

. mr‘Preparing AlIX systems for installation” on page 69|

. mr‘Preparing HP-UX systems for installation” on page 73|

. [‘Preparing Linux systems for installation” on page 77|

. mr‘Preparing Solaris systems for installation” on page 81|
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. mr‘Preparing Windows systems for installation” on page 84

Additional space is required for the installable components in the secondary packet. Refer to the
documentation for each installable component to determine exact space requirements.

Supported operating systems

The official statements of support for the WebSphere Application Server products are provided on the
Supported hardware and software Web page at the
|http://www.ibm.com/software/webservers/appserv/doc/latest/prereq.html IBM Web address.

The installation programs for WebSphere Application Server products verify that a supported operating
system is installed. The verification includes checking for required patches with the prereqChecker
application.

Although the Installation wizard checks for prerequisite operating system patches, review the prerequisites
on the IBM WebSphere Application Server supported hardware, software, and APls Web site if you have
not already done so. Refer to the documentation for non-IBM prerequisite and corequisite products to learn
how to migrate to their supported versions.

Always consult the IBM WebSphere Application Server supported hardware, software, and APIs Web site
to determine whether your operating system is supported when you receive a message from the
prereqChecker program. The Web site lists all supported operating systems and the operating system
fixes and patches that you must install to have a compliant operating system.

Using the launchpad to start the installation

The launchpad console is the starting point for installing WebSphere Application Server products.

The launchpad is a Web application. Before using the launchpad, you must have a supported Web
browser. The launchpad supports the following browsers:

* Mozilla
* Internet Explorer

The launchpad program is available on the root directory of the product CD in a program named:

. -E'E. launchpad.sh
. m launchpad.bat

Start the launchpad if it does not launch automatically.

Use this topic to learn how to use the launchpad.

WebSphere Application Server is an integrated platform that contains an Application Server, a set of Web
development tools, a Web server, and additional supporting software and documentation. The launchpad is

the single point of reference for installing the entire Application Server environment.

The launchpad opens in the language of the machine locale setting. The launchpad identifies components
on the product disc that you can launch.

The launchpad can install the tools component in the primary packet of discs. The launchpad on the
separate Rational Web Developer disc can install the tool on Windows and Linux (Intel) systems.

The launchpad has diagrams that show the possible application server topologies that you can create with
all of the components in the primary packet.
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A link exists for each installable component on the product compact disc and for the installable tools
component that is on a separate disc in the primary packet of compact discs in the product package.

There is no launchpad for the compact discs in the secondary packet in the product package, such as the
DB2 product. See [‘Packaging” on page 28| for more information about the installable components in each
package.

For example, the installation links on the initial launchpad panel for the Express product are:

* The Welcome panel with its fastpath links that launch the installer programs for the following installable
components:

— Launch the installation wizard for WebSphere Application Server - Express
— Launch the installation wizard for Rational Web Developer on Linux (Intel) and Windows platforms
— Launch the installation wizard for IBM HTTP Server
— Launch the installation wizard for Web server plug-ins
— Launch the installation wizard for WebSphere Application Server Clients
* A navigation frame on the left side of the launchpad has the following links:
— Solution installation diagrams
— WebSphere Application Server - Express installation
— Rational Web Developer installation
— IBM HTTP Server installation
— Web server plug-ins installation
— WebSphere Application Server Clients installation

The launchpad panel for each installable component in the primary packet includes a link to the installation
program for the component and to documentation that describes the product, how to install it, and how to
configure it for use.

For example, the links on the launchpad panel for the Express installable component are:
* Launch the Installation wizard for WebSphere Application Server - Express

* View the product overview for WebSphere Application Server - Express

* View the installation guide for WebSphere Application Server - Express

» View the readme file for WebSphere Application Server - Express

Perform the following procedure to use the launchpad.

1. Log on as root on a Linux or UNIX system, or as a member of the administrator group on a Windows
system.

2. Install the Internet Explorer Web browser or the Mozilla browser if neither browser is installed.

a. -ZE- Install the two prerequisite packages that Mozilla on AIX requires and install Mozilla, as
described in r‘Preparing AlX systems for installation” on page 69.|

b. m Download the latest supported version of Internet Explorer. Download Internet Explorer
from the following location:

[nttp://www.microsoft.com/windows/ie/default. mspx|

c. m m Download and install the Mozilla Web browser. If you do not

have the Mozilla Web browser, download and install the browser from |http:/www.mozilla.org}

d. -E'E- Export the location of the supported browser. Export the location of the
supported browser using the following command:

EXPORT BROWSER=/usr/bin/mozilla
3. Start the launchpad.
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You can start the launchpad manually using a fully qualified command instead of changing directories

to the CD-ROM and running the command locally from the root directory:

* Mount the CD-ROM drive on Linux or UNIX platforms, if necessary. This procedure varies per
platform. See [‘Mounting CD-ROMS on Linux and UNIX operating systems” on page 137 |

* Open a shell window and issue a fully qualified command to start the launchpad:

- -EE- launchpad.sh
- m launchpad.bat

Use the launchpad to access the product overview, the readme file, and the installation guide.

Click Launch the installation wizard for ... to launch the installation wizard for the installable
component that you select.

You can use the launchpad to start the installation and to access information through a browser.

Troubleshooting

If you can start the launchpad, but clicking a link does not resolve to a page in the launchpad, you might
have the media for the wrong operating system in the CD drive. Check the validity of the media.
Otherwise, use the following procedure. If the links do not work at the end of the procedure, open the
readme file for reference and launch the installation programs directly.

If you cannot start the launchpad, use the following procedure to correct any error that is preventing the
launchpad from displaying, then start the launchpad again:

1.
2.

Install Mozilla or Internet Explorer as described in the procedure.
If the product CD is no longer accessible, insert the CD.

Mount the drive as necessary on Linux and UNIX platforms.
Enable the JavaScript function in your browser.

m Mozilla: Click Edit > Preferences > Advanced > Scripts & Plugins:
« Enable JavaScript for: Navigator.
* Allow scripts to select all boxes.

m Internet Explorer: Click Tools > Internet Options > Security > Custom Level for Internet
> Scripting > Active scripting > Enable.

Restart the launchpad by issuing the following command:

. m Jlaunchpad.sh
. m launchpad.bat

If you still cannot use the launchpad console, access the readme file in the root directory of the product
disc or launch each installer program directly. You can launch the following links directly:

Welcome page links

The fastpath links to installable components on the product disc are provided in the following table:

Installable component Directory Program
WebSphere Application Server - Express WAS install
IBM HTTP Server IHS install
Web server plug-ins plugin install
Application clients AppClient install

The fastpath link to the installable component on the Rational Web Developer disc is as follows:
Rational Web Developer: /setup/setup
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Mount the CD for the Rational Web Developer and use the launchpad on that disc.

Solution installation diagrams
See the installation scenarios in ['Planning to install WebSphere Application Server - Express” on

WebSphere Application Server - Express installation
Links on the page include:

Launch the installation wizard...

Installable component Directory Program

WebSphere Application Server - Express WAS install

View the product overview...
/WAS/docs/InstallGuide_en.html#over

This is a section of the Getting Started guide. Language versions of this information are
available only in the online information center in [‘Packaging” on page 28]

View the installation guide...
/WAS/docs/InstallGuide_en.html#install

This is the Getting Started guide. Language versions of the information are available only
in the online information center in [Chapter 9, “Installing the product and additionall
lsoftware,” on page 95.|

View the readme file...
/WAS/readme/readme_en.html

The Getting Started guide is also available in Adobe PDF format. Viewing this document requires
that you have Adobe Acrobat Reader, which is a free download from the |[Adobe Acrobat Web site]
Download the installation guide from:

ffitp://ftp.software.ibm.com/software/webserver/appserv/library/wasvé0express_gs.pdf|

IBM HTTP Server installation
Links on the page include:

Launch the installation wizard...

Installable component Directory Program

IBM HTTP Server IHS install

View the installation guide...
/IHS/docs/InstallGuide_en.html

View the readme file...
/IHS/readme/readme_en.htm]

Web server plug-ins installation
Links on the page include:

Launch the installation wizard...

Installable component Directory Program

Web server plug-ins plugin install

View the installation roadmap...
/plugin/index_roadmap_en.htm]

See [‘Selecting a Web server topology diagram and roadmap” on page 142
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View the installation guide...
/plugin/docs/InstallGuide_en.html

See [Installing Web server plug-ins” on page 141

View the readme file...
/plugin/readme/readme_en.html

See [‘Configuration behavior of the Plug-ins installation wizard” on page 145 for an overview of
how Web server configuration works.

Return to [Chapter 9, “Installing the product and additional software,” on page 95 to continue.

Product version information

The WebSphere Application Server product contains structural differences from previous versions. The
properties/version directory in the install_root contains important data about the product and its installed
components, such as the build version and build date. This information is included in WAS.product and
[component].component files.

This topic describes the XML data files that store product information for Version 6 WebSphere Application
Server products. By default, the document type declarations (DTDs) for these files are in the
properties/version/dtd folder of the install_root, or the server root directory. See the [‘Directory locations’]
section for more information.

This topic includes the following sections:

« [Alist of product information files]

« [Alist of reports for displaying version information|
« [Alist of directory locations|

Product information files

XML files in the in the properties/version directory that store version information:
platform.websphere
One file whose existence indicates that a WebSphere Application Server product is installed. An
example of the file follows:
<?xml version="1.0" encoding="UTF-8"?>

<IDOCTYPE websphere PUBLIC "websphereld" "websphere.dtd">
<websphere name="IBM WebSphere Application Server" version="6.0"/>

The following XML files in the properties/version directory represent installed items and installation

events such as product edition, version, component, and build information.

WAS.product
One file whose existence indicates the particular WebSphere Application Server product that is
installed. The type of product installed is indicated by the <id> tag. Data in the file indicates the
version, build date, and build level.

component-name.component
Any number of component files that each indicate the presence of an installed component, which
is part of the product. Data in the file indicates the component build date, build version, component
name, and product version. For example, the file might be the activity.component file, which
indicates that the activity component is installed. The activity component is part of the Network
Deployment product. An example of the file follows:
<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE component PUBLIC "componentId" "component.dtd">

<component build-date="02/03/05" build-version="s0461.18"
name="activity" spec-version="6.0"/>
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Reports

WebSphere Application Server provides the ability to generate Version reports from the data in the files.
The following report-generation scripts are available in the install_root bin directory.

Product version reports

The following report generation scripts extract data from XML data files in the properties/version folder:

+ |versioninfo script]

Lets you use parameters to create a version report on Linux and UNIX platforms, or on Windows
platforms.

genVersionReport scripll

Generates the versionReport.html report file in the bin directory on Linux and UNIX platforms, or on
Windows platforms. The report includes the list of components.

Directory locations

Product information files are located relative to the WebSphere Application Server product install_root, or
the server root directory.

Default file paths are:
Version directory
install_root/properties/version
DTD directory
install_root/properties/version/dtd
Temporary directory
Specified by the java.io.tmpdir Java system property

versioninfo command

The versioninfo command generates reports from data it extracts from XML files in the
properties/version folder.

Product version information

The /properties/version directory in the installation root contains important data about the product and
its installed components, such as the build version and build date. This information is included in
WAS.product and component.component files.

Restriction: There is one restriction. Do not use the versionInfo.sh or versionInfo.bat script while
installing or uninstalling the product.

Product version reports

The following report generation scripts extract data from XML data files in the properties/version folder:
» versionInfo script

Lets you use parameters to create a version report on Linux and UNIX platforms, or on Windows
platforms.

genVersionReport scripll

Generates the versionReport.html report file in the bin directory on Linux and UNIX platforms, or on
Windows platforms. The report includes the list of components.
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Location of the command file

The command file is a script. On Linux and UNIX platforms, the command file is named versionInfo.sh in

the install root/bin directory. On Windows platforms, the command file is named versionInfo.bat in

the install_root\bin directory.
Syntax for the versioninfo command on a Linux or UNIX platform

The command syntax is:
versionInfo.sh [ -format text | html]

[ -file output file]

[ -Tong ]

[ -efixes ]

[ -efixDetail ]

[ -ptfs ]

[ -ptfDetail ]

[ -components ]

[ -componentDetail ]

versionInfo.sh [ -help | -? | /help | /? | -usage ]
Issue the command from the install_root/bin directory.
Syntax for the versioninfo command on a Windows platform

The command syntax is:
versionInfo [ -format text | html]

[ -file output file]

[ -Tong ]

[ -efixes ]

[ -efixDetail ]

[ -ptfs ]

[ -ptfDetail ]

[ -components ]

[ -componentDetail ]

versionInfo [ -help | -? | /help | /? | -usage ]
Issue the command from the install_root\bin directory.

Parameters

-? or /? (Windows only)
Displays command syntax.

-components
Adds a list of installed components to the report.

-componentDetail
Adds details about installed components to the report.

-efixes
Adds a list of applied interim fixes to the report.

-efixDetail
Adds details about applied interim fixes to the report.

-file fileName

Specifies the output file name. The report goes to standard output (stdout) by default.
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-format text | html
Selects the format of the report. The default is "text”.

-help or /help (Windows only)
Displays command syntax.

-long
Creates the long version of the report.

-ptfDetail
Adds details about applied fix packs to the report.

-ptfs
Adds a list of applied fix packs to the report.

-usage
Displays command syntax.

Logging

As the tool runs, it creates reports instead of log entries. Reports appear on the console unless directed to
a file with the -file filename parameter. There is no default file name. You must specify a file name to
generate a file.

Creating the report

This example shows how to issue the command on a Windows platform, from the bin directory of the
product:

D:\Program Files\IBM\WebSphere\AppServer\bin>versionInfo
WVEROO10I: Copyright (c) IBM Corporation 2002; A1l rights reserved.
WVERQO11I: WebSphere Application Server Release 6.0

WVEROO12I: VersionInfo Reporter Version 1.15, Dated 9/20/03

genVersionReport command

The genVersionReport command generates the versionReport.html report file in the bin directory on
Linux and UNIX platforms, or on Windows platforms.

Product version information

The /properties/version directory in the installation root contains important data about the product and
its installed components, such as the build version and build date. This information is included in
WAS.product and [component].component files.

Product version reports

The following report generation scripts extract data from XML data files in the properties/version folder:
versionlnfo scripf

Lets you use parameters to create a version report on Linux and UNIX platforms, or on Windows
platforms.

» genVersionReport script

Generates the versionReport.html report file in the bin directory on Linux and UNIX platforms, or on
Windows platforms. The report includes the list of components, fixes, and fix packs.

Location of the command file

The command file is a script. On Linux and UNIX platforms, the command file is named
genVersionReport.sh in the install root/bin directory. On Windows platforms, the command file is
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named genVersionReport.bat in the install root\bin directory.
Syntax for the versioninfo command on a Linux or UNIX platform

The command syntax is:
genVersionReport.sh

Issue the command from the install_root/bin directory.
Syntax for the versioninfo command on a Windows platform

The command syntax is:
genVersionReport.bat

Issue the command from the install _root\bin directory.

Logging

As the tool runs, it creates the versionReport.html report file instead of log entries.
Creating the report

This example shows how to issue the command on a Windows platform, from the bin directory of the
product:

D:\Program Files\IBM\WebSphere\AppServer\bin>genVersionReport
WVEROO10I: Copyright (c) IBM Corporation 2002; A1l rights reserved.
WVEROO11I: WebSphere Application Server Release 6.0

WVEROO12I: VersionInfo Reporter Version 1.15, Dated 9/20/03

Installation: Resources for learning

Use the following links to find relevant supplemental information about installation and customization. The
information resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of
the information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

One important link is:

[How to buy WebSphere Application Server software]

This IBM Web site describes pricing and technical details. If you have already purchased the software,
view links to additional information about:

* |Planning, business scenarios, and IT architecture|

* |Programming instructions and examplesl

« [Programming specifications|

e [Administration
* |Suppo

Planning, business scenarios, and IT architecture
IBM WebSphere Application Server supported hardware, software, and APIs|

The official site for determining product prerequisites for hardware, software and APIs for all WebSphere
Application Server products.
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[IBM developerWorks WebSphere]

The home of technical information for developers working with WebSphere products. You can download
WebSphere software, take a fast path to developerWorks zones, such as VisualAge Java or
WebSphere Application Server, learn about WebSphere products through a newcomers page, tutorials,
technology previews, training, and Redbooks, get answers to questions about WebSphere products, and
join the WebSphere community, where you can keep up with the latest developments and technical
papers.

+ [IBM WebSphere Application Server library and information centers Web site]

The IBM WebSphere Application Server Library Web site contains links to all WebSphere Application
Server information centers, for all versions. It also lets you access each information center in your
native language.

« [IBM WebSphere Application Server home page|

The IBM WebSphere Application Server home page contains useful information, including support links
and downloads for fixes, APARs, tools, and trials.
» [IBM WebSphere software platform home page]

The IBM WebSphere software platform home page introduces WebSphere products and describes how
companies can easily transform to an e-business, with software that can grow as fast as the business it
supports.

+ [Information center for WebSphere Application Server Edge components|

The information center for WebSphere Application Server Edge components contains complete

documentation for the Caching Proxy and the Load Balancer in these PDF online books, WebSphere

Application Server Concepts, Planning, and Installation for Edge Components, WebSphere Application

Server Caching Proxy Administration Guide, WebSphere Application Server Load Balancer

Administration Guide, and WebSphere Application Server Programming Guide for Edge Components.
+ [developerWorks: IBM Patterns for e-business|

The IBM developerWorks site is the source for IBM patterns for e-business, a set of tested, reusable
intellectual assets that you can use to design and implement your e-business network and architecture.
+ The[User centered design (UCD) for different project types, part 2|

This Web page is the latest of two articles that describes design activities that IBM scientists have found
most useful in various types of projects. This article defines user interface design elements, including
the design prototype, use case model, and design specification document.

Programming instructions and examples
« [IBM developerWorks]

IBM developerWorks contains many excellent resources for developers, including tutorials on Web
development-related topics. There is an excellent tutorial on the JDBC API.

¢ |IBM Redbooks

The IBM Redbooks site contains many documents that are related to WebSphere Application Server.

Programming specifications
. |J2EE information|

For more information about J2EE specifications, visit the Sun site.

Administration
Best Practices Zone on developerWorkg

The WebSphere Best Practices Zone is a collection of best practices for administering WebSphere
Application Server. Over time, the zone is intended to grow to include best practices for using other
WebSphere software products, and to cover more topics. Use the feedback mechanism to submit your
best practice suggestions.

+ [The IBM Glossary of Computing Terms|

This glossary defines technical terms used in many IBM products. It is not a comprehensive resource of
all IBM computing terms. This resource is provided for information purposes only and is updated
periodically. IBM takes no responsibility for the accuracy of the information it contains.
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Support
« [Ten Steps to Getting Support for WebSphere Application Server|

If you are new to a product, you might have difficulty finding all the information you need. And if you
come across a problem, where do you go for help? Whether you are a new user looking for introductory
information, or an experienced user looking for a workaround for a specific defect, you can benefit
immediately from extensive Web-based support from IBM. You can download fix packs, search on

keywords, look up FAQs, Hints and Tips, and so forth. Always use this Web resource before contacting
IBM Support directly.

« |[WebSphere Application Server Support page|

Take advantage of the Web-based Support and Service resources from IBM to quickly find answers to
your technical questions. You can easily access this extensive Web-based support through the IBM
Software Support portal at URL http://www-3.1ibm.com/software/support/ and search by product
category, or by product name. For example, if you are experiencing problems specific to WebSphere

Application Server, click WebSphere Application Server in the product list. The WebSphere Application
Server Support page displays.

IBM e-server Support: Fix Central|

A Web facility for downloading fixes for the AIX operating system and the OS/400 operating system.
+ [Adobe Acrobat Web sitel

This Adobe Web site offers a free download of the Adobe Acrobat Reader product.
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Chapter 7. Planning the installation (diagrams)

This topic describes common product topologies that you can install with the product.

Use this topic to understand the capabilities of your product package. Knowing what you can do with the
product might influence how you install the product and other installable components on the product disc.

This topic describes topology diagrams and shows you how to create the topologies by showing what
components to install for each topology.

Phased installation roadmap

To install a Version 6 production environment, you install the following components:
» The WebSphere Application Server product on your product CD

» A supported Web server, such as the IBM HTTP Server V6 on the product CD

* A binary plug-in module for your Web server from the product CD

You can also use the product CD to install an application client environment on a client machine. Running
Java 2 Platform, Enterprise Edition (J2EE) and thin application clients that communicate with WebSphere
Application Server requires that elements of the Application Server are installed on the machine on which
the client runs. However, if the machine does not have the Application Server installed, you can install

Application Server clients to provide a stand-alone client run-time environment for your client applications.

You can use the Rational Web Developer CD in the primary packet of discs to install a fully integrated
development environment that includes an exact replica of the Application Server for development testing.

Installation features

Installation features in V6 include:

Feature Description
The Express product includes You can use the Profile creation wizard to create stand-alone application server
Application Server nodes. nodes after installing the Express product. You do not have to reinstall the

product to create additional application servers. All application servers on a
machine share the same core product files.

The product CD includes all of the |You can use the product CD to install the IBM HTTP Server, the Web server
installable components that are plug-ins, and the WebSphere Application Server Clients. You do not have to use
required to create an e-business separate CDs. Separate installation programs exist within component directories
environment. on the product CD.

Each installable component has its | You can use the V6 launchpad to install any installable component on the
own installation program. product CD. Or you can install each component directly using the install
command in each component directory.

The launchpad can install any The launchpad for the Express product can also install the Rational Web
installable product in the primary Developer on Windows and Linux (Intel) systems. Rational Web Developer is on
packet of compact discs. separate CDs, which requires you to change discs to launch the installation.

Review topology diagrams for each of the following installable components to determine which topology
best fits your needs. The diagrams and their accompanying procedures can serve as a roadmap for
installing a similar topology.

This topic describes installation scenarios for the following installable components:
* WebSphere Application Server - Express
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* Web server plug-ins
* Application clients

In addition to product installation diagrams for the installable components, this topic also links to a
roadmap for using the Profile creation wizard, which is new for Version 6. The Profile creation wizard lets
you create run-time environments for application server processes.

Each of the following installation scenarios includes topology diagrams and associated installation steps.
Each step links to a specific procedure for installing a component or to a description of a command or tool.

1. Review the installation scenarios for the Express product, as described in|“Planning to install
WebSphere Application Server - Express.’]

2. Review the installation scenarios for the WebSphere Application Server plug-ins, as described in
['Planning to install Web server plug-ins” on page 57/

3. Review the installation scenarios for the application clients, as described in [‘Planning to install|
WebSphere Application Server Clients” on page 60

4. Review the installation scenarios for the Profile creation wizard, as described in [‘Planning to create]
lapplication server environments” on page 62.|

5. Optional: Review interoperability and coexistence diagrams to know what is possible with Version 6.

WebSphere Application Server V6 can interoperate with your other e-business systems, including other
versions of WebSphere Application Server. Interoperability provides a communication mechanism for
WebSphere Application Server nodes that are at different versions. Coexistence describes multiple
versions or instances running on the same machine, at the same time.

Interoperability support enhances migration scenarios with more configuration options. It often is
convenient or practical to interoperate during the migration of a configuration from an earlier
WebSphere Application Server version to a later one when some machines are at the earlier version
and some machines are at the later version. The mixed environment of machines and application
components at different software version levels requires interoperability and coexistence.

It is often impractical, or even physically impossible, to migrate all the machines and applications within
an enterprise at the same time. Understanding multiversion interoperability and coexistence is
therefore an essential part of a migration between version levels.

6. Optional: Consider performance when designing your network, as described in [‘Queuing network” on|

You can review installation scenarios to identify the specific steps to follow when installing more than one
component on a single machine or on separate machines.

After determining an appropriate installation scenario, you are ready to install the necessary components
and to configure the products for the system that you selected.

Planning to install WebSphere Application Server - Express

This topic describes common installation scenarios and links to component installation procedures for each
scenario.

IBM WebSphere Application Server - Express, Version 6 is an integrated platform that contains an
Application Server, Web development tools, a Web server, and additional supporting software and
documentation.

The following information describes scenarios for installing the product in various topologies on one or
more machines:

» Scenario 1: Single-machine installation of WebSphere Application Server - Express
* Scenario 2: Single-machine installation of WebSphere Application Server - Express and a Web server
* Scenario 3: Two-machine installation of WebSphere Application Server - Express and a Web server
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» Scenario 4: Creating multiple profiles that use one installation of WebSphere Application Server -
Express

» Scenario 5: Single-machine installation of Rational Web Developer

* Scenario 6: Multiple-machine installation of WebSphere Application Server - Express, Rational Web
Developer, and a Web server

Each scenario includes a diagram and a list of detailed installation steps.
» Scenario 1: Install WebSphere Application Server - Express on a single machine.

Installing WebSphere Application Server - Express by itself on a single machine creates a stand-alone
application server, which is server1. Installing Express creates a set of system files and a profile for the
application server. The profile is a separate set of files that define the application server environment.

In this scenario, the application server uses its internal HTTP transport chain for communication, which
is suitable for handling an application with a relatively low request work load. For example, this type of
installation can support a simple test environment or a departmental intranet environment.

Machine A

WebSphere Application Server, Version 6.0

Shared product binaries
(system files)

1. |Install WebSphere Application Server - Express.|
* Scenario 2: Install WebSphere Application Server - Express and a Web server on a single machine.

Installing a Web server, such as IBM HTTP Server, on the same machine as the application server
provides a more robust Web server environment. Installing a Web server plug-in is a requirement for the
Web server to communicate with the application server. This type of installation supports rigorous
testing environments or production environments that do not require a firewall. However, this is not a
typical production environment.

HTTP server
Client
HTTP  Plug-in|

requests optional

optional

J

Application
server

1. |Install WebSphere Application Server - Express.l
2. |Install IBM HTTP Server| or another supported Web server.

3. Install the Web server plug-ins and configure the Web server using the Plug-ins installation wizard.
See the /plugin directory on the installation image or trial download for documentation.

» Scenario 3: Install WebSphere Application Server - Express and a Web server on separate machines.
In the typical production environment, the application server on one machine communicates with a Web
server on a separate (remote) machine through the Web server plug-in. Optional firewalls can provide
additional security for the application server machine.
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1. |Install WebSphere Application Server - Express on Machine A.|
2. |Install IBM HTTP Server| or another supported Web server on Machine B.

3. Install the Web server plug-ins and configure the Web server using the Plug-ins installation wizard
on Machine B.

4. The Plug-ins installation wizard creates a script named configurelleb_server_name in the
plugins_install_root/bin directory on Machine B. Copy the script to the install_root/bin directory on
Machine A.

5. Run the configureieb_server_name script to create a Web server definition in the administrative
console. You can then use the administrative console to manage the Web server.

6. Propagate the plugin-cfg.xml file from the application server to the Web server using the
administrative console. Click Servers > Web server > Propagate Plug-in. (Web servers other than
IBM HTTP Server require manual propagation.)

» Scenario 4: Install multiple stand-alone application servers on one machine and a Web server on a
separate machine.

A profile is a separate data partition containing the files that define the run-time environment for an
application server. A default profile is created during the installation of the Express product. Create
additional profiles using the Profile creation wizard. Each profile defines a separate stand-alone
application server that has its own administrative interface.

After creating a profile and installing a dedicated Web server, use the Plug-ins installation wizard to
install a Web server plug-in and to update the Web server configuration file. The Web server can then
communicate with the application server.

This topology lets each profile have unique applications, configuration settings, data, and log files, while
sharing the same set of core product files. Creating multiple profiles creates multiple application server
environments that you can dedicate to different purposes.

For example, each application server on a Web site can serve a different application. In another
example, each application server can be a separate test environment that you assign to a programmer
or a development team.

Updating the core product files

Another feature of having multiple profiles is enhanced serviceability. When a refresh pack or fix pack
updates the core product files on a machine, all of the application server profiles that were created from
the core product files begin using the updated files. In some situations, you might prefer to not update
all of the application servers on a machine. In such situations, simply install the product a second time
to create a second set of core product files. Create application server profiles from both installations to
manage the product updates incrementally.
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1. [Install WebSphere Application Server - Express on Machine A
2. |install IBM HTTP Server or another supported Web server on Machine B.

3. Install the Web server plug-ins and configure the Web server using the Plug-ins installation wizard
on Machine B.

4. The Plug-ins installation wizard creates a script named configurelleb_server _name in the
plugins_install_root/bin directory on Machine B. Copy the script to the install_root/bin directory on
Machine A.

5. Run the configureleb_server_name script to create a Web server definition in the administrative
console. You can then use the administrative console to manage the Web server.

6. Propagate the plugin-cfg.xml file from the application server to the Web server using the
administrative console. Click Servers > Web server > Propagate Plug-in. (Web servers other
than IBM HTTP Server require manual propagation.)

7. [Create the second Application Server profile using the Profile creation wizard on Machine A| Make
the profile the default profile during the profile creation by selecting the check box on the
appropriate panel.

The script that the Plug-ins installation wizard creates works on the default profile only. So, this

script can only create a Web server definition on the profile that is the default profile at the time
that the script runs.

8. [Install IBM HTTP Server|or another supported Web server on Machine B.

9. On Machine B, install the Web server plug-ins to configure the second Web server using the
Plug-ins installation wizard. Both Web servers share a single installation of the plug-in binaries but
must be configured individually.

10. The Plug-ins installation wizard creates a script named configureleb_server_name for the second
Web server. The script is in the plugins_install_root/bin directory on Machine B. Copy the script to
the install_root/bin directory on Machine A.

11. Run the configurelleb_server_name script to create a Web server definition in the administrative
console. You can then use the administrative console to manage the Web server.

12. Propagate the plugin-cfg.xml file from the second application server to the Web server using the
administrative console. Click Servers > Web server > Propagate Plug-in. (Web servers other
than IBM HTTP Server require manual propagation.)

Scenario 5: Install Rational Web Developer on a single machine.

Install Rational Web Developer by itself to create an integrated development environment. Developers
can test applications in the test environment for V6 that is included in the Rational Web Developer
product.
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Rational Web Developer
(Linux for Intel and Windows only) Testing

environment

Application

environment

1. Install Rational Web Developer.

* Scenario 6: Install WebSphere Application Server - Express, Rational Web Developer, and a Web
server on multiple machines.

In this integrated testing environment, install the application server behind an optional firewall on one
machine and the Web server on a separate (remote) machine. The Web server plug-in lets the
application server and Web server communicate with each other. Install Rational Web Developer on a
separate Linux (Intel) or Windows machine. This type of installation is useful for quality assurance
because the test environment closely mirrors the typical production environment.

Firewall

Machine C

Rational Web Developer
( Linux for Intel and Windows
only)

Testing
environment

Application
development
environment

Machine B Machine A

C

Web client Web server
(browser)
m < Application
data
Data tier
<«— Internet Intranet ——— °
optional

1. |Install WebSphere Application Server - Express on Machine A
2. [Install IBM HTTP Server| or another supported Web server on Machine B.

3. Install the Web server plug-ins and configure the Web server using the Plug-ins installation wizard
on Machine B.

4. The Plug-ins installation wizard creates a script named configurelleb_server_name in the
plugins_install_root/bin directory on Machine B. Copy the script to the install_root/bin directory on
Machine A.

5. Run the configurelleb_server_name script to create a Web server definition in the administrative
console. You can then use the administrative console to manage the Web server.

6. Propagate the plugin-cfg.xml file from the application server to the Web server using the
administrative console. Click Servers > Web server > Propagate Plug-in. (Web servers other than
IBM HTTP Server require manual propagation.)

7. Install Rational Web Developer on Machine C.
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You can review common installation scenarios to find a possible match for the topology that you intend to
install. Each product installation diagram provides a high-level procedure for installing the components that
comprise the topology.

After determining a possible topology, you are ready to follow the detailed installation instructions for each
product that you plan to install.

Planning to install Web server plug-ins

This topic describes common installation scenarios and links to component installation procedures for each
scenario.

The primary production configuration is an application server on one machine and a Web server on a
separate machine. This configuration is referred to as a remote configuration. Contrast the remote
configuration to the local configuration, where the application server and the Web server are on the same
machine.

The Plug-ins installation wizard has four main tasks:
* Installs the binary plug-in module on the Web server machine.

« Configures the Web server configuration file on the Web server machine to point to the binary plug-in
module and to the XML configuration file for the binary module.
 Installs a temporary XML configuration file for the binary module (pTugin-cfg.xml) on the Web server
machine in remote scenarios.
» Creates the configuration for a Web server definition on the application server machine. The wizard
processes the creation of the Web server definition differently depending on the scenario:
— [Recommended remote stand-alone Application Server installation]
Creates a configuration script that you run on the application server machine. Install the Web server
and its plug-in on a different machine than the application server. This configuration is recommended
for a production environment.
— |Local stand-alone Application Server installation:|
Detects the default profile on a local application server machine and creates the Web server
definition for it directly. Install the Web server and its plug-in on the same machine with the
application server. This configuration is for development and test environments.

Select a link to go to the appropriate steps in the following procedure.
» Set up a remote Web server installation.
The remote Web server configuration is recommended for production environments.

The remote installation installs the Web server plug-in on the Web server machine when the application
server is on a separate machine, such as shown in the following graphic:

Firewall
optional
Machine B Machine A
WebSphere
Web server Application
Server

Remote installation scenario
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Table 2. Installation and configuration

Step Machine Task
1 A Install your WebSphere Application Server product. See [Chapter 9, “Installing the|
|product and additional software,” on page 95)
2 B Install IBM HTTP Server or another supported Web server. See [‘Installing IBM HTTP|
|Server’ on page 139/
3 B Install the binary plug-in module using the Plug-ins installation wizard. See|‘Configuring
|a Web server and an application server on separate machines (remote)” on page 154.

The script for creating and configuring the Web server is created under the
plug-ins_install _root/ bin directory.

4 B Copy the configureieb_server_name script to Machine A. If one machine is running
under Linux or UNIX and the other machine is running under Windows, copy the script
from the plug-ins_install _root/ bin/ crossPlatformScripts directory.

5 A Paste the configureleb_server_name script from Machine B to the was_install_root/
bin directory on Machine A.
A Run the script from a command line.
A Verify that the application server is running. Open the administrative console and save

the changed configuration.

8 B
-EE. Run the plug-ins_install_root/setupPluginCfg.sh script for a
Domino Web Server before starting a Domino Web server.Otherwise, start the Web
server.
9 B |[Run the snoop servlet.|

To verify with your own application, regenerate and propagate the plugin-cfg.xml file
after installing the application.

Regeneration of the plugin-cfg.xml file

During the installation of the plug-ins, the temporary plugin-cfg.xml file is installed on Machine B in the
plug-ins_install root/ config/ web_server name directory.

The Web server plug-in configuration service regenerates the plugin-cfg.xml file automatically.

To use the real plugin-cfg.xml file from the application server, propagate the plugin-cfg.xml file as
described in the next section.

Propagation of the plugin-cfg.xml file

The Web server plug-in configuration service propagates the plugin-cfg.xml file automatically for IBM
HTTP Server 6.0 only.

For all other Web servers, propagate the plug-in configuration file manually. Copy the plugin-cfg.xm]
file from the profiles_install_root/ config/ cells/ cell_name/ nodes/ Web_server_name_node/
servers/ web_server_name directory on Machine A. Paste the file into the plug-ins_install_root/
config/ web_server_name directory on Machine B.

+ Set up a local Web server configuration.
The local Web server configuration is recommended for a development or test environment.
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A local installation includes the Web server plug-in, the Web server, and the application server on the
same machine:

Machine A

WebSphere
Web server Application
Server

Local installation scenario

Table 3. Installation and configuration

Step Machine Task
1 A Install your WebSphere Application Server product. See [Chapter 9, “Installing the]
|oroduct and additional software,” on page 95)
2 A Install IBM HTTP Server or another supported Web server. See [‘Installing IBM HTTP|
[Server” on page 139/
3 A Install the binary plug-in module using the Plug-ins installation wizard. See |“Configurin§]

|a Web server and an application server profile on the same machine” on page 167

The Web server definition is automatically created and configured during the installation
of the plug-ins.

4 A Verify that the application server is running. Open the administrative console and save
the changed configuration.

5 B
-IEE- Run the plug-ins_install_root/setupPluginCfg.sh script for a
Domino Web Server before starting a Domino Web server.Otherwise, start the Web
server.
6 B |[Run the snoop servlet |

To verify with your own application, regenerate and propagate the plugin-cfg.xml file
after installing the application.

Regeneration of the plugin-cfg.xml file
The Web server plug-in configuration service regenerates the plugin-cfg.xml file automatically.

The plugin-cfg.xml file is generated in the profiles_install root/ profile name/ config/ cells/
cell _name/ nodes/ Web_server name node/ servers/ web_server name directory. The generation occurs
when the Web server definition is created.

Propagation of the plugin-cfg.xml file
The local file does not require propagation.

You can set up a remote or local Web server by installing Application Server, the Web server, and then the
Web server plug-ins.

See ['‘Web server configuration” on page 150| for more information about the files involved in configuring a
Web server.

See [‘Configuration behavior of the Plug-ins installation wizard” on page 145| for information about the logic
behind the processing scenarios for the Plug-ins installation wizard.
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See [‘Editing Web server configuration files” on page 185| for information about how the Plug-ins installation
wizard configures supported Web servers.

See [‘Installing Web server plug-ins” on page 141|for information about other installation scenarios for
installing Web server plug-ins.

Planning to install WebSphere Application Server Clients

This topic helps you examine typical topologies and uses for WebSphere Application Server Clients.

This topic is one in a series of topics described in|Chapter 7, “Planning the installation (diagrams),” on|
Consider all of the planning scenarios that are mentioned in the parent article to determine the
best approach to installing your e-business network. This topic describes installing and using the
WebSphere Application Server Clients.

In a traditional client server environment, the client requests a service and the server fulfills the request.
Multiple clients use a single server. Clients can also access several different servers. This model persists
for Java clients except that now these requests use a client run-time environment.

In this model, the client application requires a servlet to communicate with the enterprise bean, and the
servlet must reside on the same machine as the WebSphere Application Server.

The Application Client for WebSphere Application Server, Version 6 now consists of the following models:
» ActiveX application client

* Applet client

* J2EE application client

* Pluggable and thin application clients
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The following graphic shows a topology for installing the Application Client and using client applications:
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The example shows two types of application clients installed in a topology that uses client applications to
access applications and data on Machine A:

The ActiveX application client on Machine B is a Windows only client that uses the Java Native
Interface (JNI) architecture to programmatically access the Java virtual machine (JVM) API. The JVM
code exists in the same process space as the ActiveX application (Visual Basic, VBScript, or Active
Server Pages (ASP) files) and remains attached to the process until that process terminates.

The J2EE application client on Machine C is a Java application program that accesses enterprise
beans, Java Database Connectivity (JDBC) APIs, and Java Message Service message queues. The
application program must configure the execution environment of the J2EE application client and use
the Java Naming and Directory Interface (JNDI) name space to access resources.

Use the following procedure as a roadmap for installing the Application Client.

1.

Install the WebSphere Application Server product from your product CD on Machine A to establish the
core product files.

Use the Profile creation wizard to create the additional stand-alone application server profile.
Use the administrative console of each application server to deploy any user applications.

Use the administrative console of each application server to create a Web server configuration for the
Web server.

Use the administrative console of each application server to regenerate each plugin-cfg.xml file in the
local Web server configuration.

Install the IBM HTTP Server from the product CD on Machine A.
Use the Plug-ins installation wizard to install the plug-in for IBM HTTP Server on Machine A.
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The wizard automatically configures the HTTP Server to communicate with the first application server.
8. Install the Application Client from your product CD on Machine B.

a. Select the Custom install type.

b. Select the ActiveX to EJB Bridge feature.

c. Select to add the Java run time to the system path.

d

Select the Java run time as the default JRE, which adds the Java run time path to the beginning of
the system path.

9. Install the Application Client from your product CD on Machine C.
a. Select the Custom install type.
b. Select the J2EE application client feature.

Planning to create application server environments

Application server profiles are the run-time environments for application server processes. This topic
describes common scenarios for creating application server profiles and provides links to profile creation
procedures for each scenario.

Install the core product files for a WebSphere Application Server product before using the Profile creation
wizard to create additional application server run-time environments.

This topic describes how to use the Profile creation wizard to create application server profiles. Each
profile is a run-time environment for the application server that it defines, with data files, configuration files,
applications, and an administrative console.

Create a stand-alone application server, as described in [‘Using the Profile creation wizard to create an|
lapplication server’ on page 212

Step 1: Step 2:
Install the Createthes
core product Application Server
files profile
hdachine A

The installation procedure creates an application server during installation named server1. However, you
can use the Profile creation wizard to create more stand-alone application servers on a machine where
server1 or another application server already exists.

You can create additional application server processes using the Profile creation wizard.

After installing the product and optionally adding more application servers with the Profile creation wizard,
you are ready to deploy applications to test the environment.
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Queuing network

WebSphere Application Server contains interrelated components that must be harmoniously tuned to
support the custom needs of your end-to-end e-business application. These adjustments help the system
achieve maximum throughput while maintaining the overall stability of the system. This group of
interconnected components is known as a queuing network. These queues or components include the
network, Web server, Web container, EJB container, data source, and possibly a connection manager to a
custom back-end system. Each of these resources represents a queue of requests waiting to use that
resource. Various queue settings are described in the Tuning Guide PDF.

.
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server engine container source ~ .

Database

Figure Reference 1: WebSphere queuing network

Most of the queues that make up the queuing network are closed queues. A closed queue places a limit
on the maximum number of requests present in the queue, while an open queue has no limit. A closed
queue supports tight management of system resources. For example, the Web container thread pool
setting controls the size of the Web container queue. If the average servlet running in a Web container
creates 10MB of objects during each request, a value of 100 for thread pools limits the memory consumed
by the Web container to 1GB.

In a closed queue, requests can be active or waiting. An active request is doing work or waiting for a
response from a downstream queue. For example, an active request in the Web server is doing work,
such as retrieving static HTML, or waiting for a request to complete in the Web container. A waiting
request is waiting to become active. The request remains in the waiting state until one of the active
requests leaves the queue.

All Web servers supported by WebSphere Application Server are closed queues, as are WebSphere
Application Server data sources. You can configure Web containers as open or closed queues. In general,
it is best to make them closed queues. EJB containers are open queues. If there are no threads available
in the pool, a new one is created for the duration of the request.

If enterprise beans are called by servlets, the Web container limits the number of total concurrent requests
into an EJB container, because the Web container also has a limit. The Web container limits the number of
total concurrent requests only if enterprise beans are called from the servlet thread of execution. Nothing
prevents you from creating threads and bombarding the EJB container with requests. Therefore, servlets
should not create their own work threads.

Queuing and clustering

Cloning application servers can be a valuable asset in configuring highly-scalable production
environments, especially when the application is experiencing bottlenecks that are preventing full CPU
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utilization of symmetric multiprocessing (SMP) servers. When adjusting the WebSphere Application Server
system queues in clustered configurations, remember that when a server is added to a cluster, the server

downstream receives twice the load.
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Figure Reference 1: Clustering and queuing
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Two servlet engines are located between a Web server and a data source. It is assumed that the Web
server, servlet engines and data source, but not the database, are all running on a single SMP server.

Given these constraints, the following queue considerations must be made:

* Double the Web server queue settings to ensure ample work is distributed to each Web container.
» Reduce the Web container thread pools to avoid saturating a system resource like CPU or another

resource that the servlets are using.

* Reduce the data source to avoid saturating the database server.

* Reduce Java heap parameters for each instance of the application server. For versions of the Java
virtual machine (JVM) shipped with WebSphere Application Server, it is crucial that the heap from all
JVMs remain in physical memory. For example, if a cluster of four JVMs is running on a system,

enough physical memory must be available for all four heaps.

Queue configuration tips

The following section outlines a methodology for configuring the WebSphere Application Server queues.
Moving the database server onto another machine or providing more powerful resources, for example a
faster set of CPUs with more memory, can dramatically change the dynamics of your system.

There are four tips for queuing:

* Minimize the number of requests in WebSphere Application Server queues.

In general, requests wait in the network in front of the Web server, rather than waiting in WebSphere
Application Server. This configuration only supports those requests that are ready for processing to
enter the queuing network. Specify that the queues furthest upstream or closest to the client are slightly
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larger, and queues further downstream or furthest from the client are progressively smaller.
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Figure Reference 1: Upstream queuing network

Queues in the queuing network become progressively smaller as work flows downstream. When 200
client requests arrive at the Web server, 125 requests remain queued in the network because the Web
server is set to handle 75 concurrent clients. As the 75 requests pass from the Web server to the Web
container, 25 requests remain queued in the Web server and the remaining 50 are handled by the Web
container. This process progresses through the data source until 25 user requests arrive at the final
destination, the database server. Because there is work waiting to enter a component at each point
upstream, no component in this system must wait for work to arrive. The bulk of the requests wait in the
network, outside of WebSphere Application Server. This type of configuration adds stability, because no
component is overloaded.

Draw throughput curves to determine when the system capabilities are maximized.

You can use a test case that represents the full spirit of the production application by either exercising
all meaningful code paths or using the production application. Run a set of experiments to determine
when the system capabilities are fully stressed or when it has reached the saturation point. Conduct
these tests after most of the bottlenecks are removed from the application. The goal of these tests is to
drive CPUs to near 100% utilization. For maximum concurrency through the system, start the initial
baseline experiment with large queues. For example, start the first experiment with a queue size of 100
at each of the servers in the queuing network: Web server, Web container and data source. Begin a
series of experiments to plot a throughput curve, increasing the concurrent user load after each
experiment. For example, perform experiments with one user, two users, five, 10, 25, 50, 100, 150 and
200 users. After each run, record the throughput requests per second, and response times in seconds
per request. The curve resulting from the baseline experiments resembles the following typical
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throughput curve shown as follows:

Throughput curve

Saturgtion point

Throughput requests per second

Light load zone Heavy load zone Buckle zone

Concurrent users

The WebSphere Application Server throughput is a function of the number of concurrent requests
present in the total system. Section A, the light load zone, shows that the number of concurrent user
requests increases, the throughput increases almost linearly with the number of requests. At light loads,
concurrent requests face very little congestion within the WebSphere Application Server system queues.
At some point, congestion starts to develop and throughput increases at a much lower rate until it
reaches a saturation point that represents the maximum throughput value, as determined by some
bottleneck in the WebSphere Application Server system. The most manageable type of bottleneck
occurs when the WebSphere Application Server machine CPUs become fully utilized because adding
CPUs or more powerful CPUs fixes the bottleneck.

In the heavy load zone or Section B, as the concurrent client load increases, throughput remains
relatively constant. However, the response time increases proportionally to the user load. That is, if the
user load is doubled in the heavy load zone, the response time doubles. At some point, represented by
Section C, the buckle zone, one of the system components becomes exhausted. At this point,
throughput starts to degrade. For example, the system might enter the buckle zone when the network
connections at the Web server exhaust the limits of the network adapter or if the requests exceed
operating system limits for file handles.

If the saturation point is reached by driving CPU utilization close to 100%, you can move on to the next
step. If the saturation CPU occurs before system utilization reaches 100%, it is likely that another
bottleneck is being aggravated by the application. For example, the application might be creating Java
objects causing excessive garbage collection bottlenecks in the Java code.

There are two ways to manage application bottlenecks: remove the bottleneck or clone the bottleneck.
The best way to manage a bottleneck is to remove it. You can use a Java-based application profiler,
such as Rational Application Developer, Performance Trace Data Visualizer (PTDV), Borland’s
Optimizeit, JProbe or Jinsight to examine overall object utilization.

» Decrease queue sizes while moving downstream from the client.

The number of concurrent users at the throughput saturation point represents the maximum
concurrency of the application. For example, if the application saturates WebSphere Application Server
at 50 users, using 48 users might produce the best combination of throughput and response time. This
value is called the Max Application Concurrency value. Max Application Concurrency becomes the
preferred value for adjusting the WebSphere Application Server system queues. Remember, it is
desirable for most users to wait in the network; therefore, queue sizes should increase when moving
downstream farther from the client. For example, given a Max Application Concurrency value of 48, start
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with system queues at the following values: Web server 75, Web container 50, data source 45. Perform
a set of additional experiments adjusting these values slightly higher and lower to find the best settings.

To help determine the number of concurrent users, view the Servlet Engine Thread Pool and
Concurrently Active Threads metric in the Tivoli Performance Viewer.
Adjust queue settings to correspond to access patterns.

In many cases, only a fraction of the requests passing through one queue enters the next queue
downstream. In a site with many static pages, a number of requests are fulfilled at the Web server and
are not passed to the Web container. In this circumstance, the Web server queue can be significantly
larger than the Web container queue. In the previous example, the Web server queue was set to 75,
rather than closer to the value of Max Application Concurrency. You can make similar adjustments when
different components have different execution times.

For example, in an application that spends 90% of its time in a complex servlet and only 10% of its time
making a short JDBC query, on average 10% of the servlets are using database connections at any
time, so the database connection queue can be significantly smaller than the Web container queue.
Conversely, if the majority of servlet execution time is spent making a complex query to a database,
consider increasing the queue values at both the Web container and the data source. Always monitor
the CPU and memory utilization for both the WebSphere Application Server and the database servers to
verify that the CPU or memory are not saturating.
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Chapter 8. Preparing the operating system for product
installation

This topic describes how to prepare your operating platform for installing one of the WebSphere
Application Server products. Links in the topic exist for each operating system platform. Select your
operating system to view the corresponding procedure.

Before preparing the installation environment, read [‘Planning to install WebSphere Application Server 4
[Express” on page 52

You must install the necessary prerequisites for your operating system. Use the following link to go to the
procedure for your operating platform.

Prepare your operating system for installation.

Select the appropriate procedure:

. mr‘Preparing AIX systems for installation’]

. m|“Preparing HP-UX systems for installation” on page 73|

. [‘Preparing Linux systems for installation” on page 77

. mr‘Preparing Solaris systems for installation” on page 81|

. mr‘Preparing Windows systems for installation” on page 84

You are now ready to install the WebSphere Application Server - Express product.

Preparing AIX systems for installation

This topic describes how to prepare an AlX system for the installation of IBM WebSphere Application
Server, Version 6 products.

The installation uses a InstallShield for Multiplatforms (ISMP) wizard. You can use the graphical interface
of the wizard. You can also use the wizard in silent mode.

Silent mode is a command line invocation with a parameter that identifies an options response file. Edit the
options response file before installing.

If you encounter a problem such as needing more temporary space or missing prerequisite packages on
your operating system, cancel the installation, make the required changes, and restart the installation.

Use the following procedure to prepare the operating system for the installation of WebSphere Application
Server products.

1. Log on as root.
You cannot install the product correctly as a non-root user.

If you create a copy of the product CD-ROM, do so as root. Copies made from non-root users do not
preserve the correct file attributes and do not work.

In addition, verify that the umask setting is 022. To verify the umask setting, issue the following
command:

umask
To set the umask setting to 022, issue the following command:
umask 022
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Stop all WebSphere Application Server-related Java processes on the machine where you are
installing the product.

Stop any Web server process such as the IBM HTTP Server.

Use the System Management Interface Tool (SMIT) to display packages that are installed to
determine whether you must update packages that are described in the following steps.

Download the most current version of the INFOZIP product to avoid problems with zipped files.
Although zipped files are primarily used in the service stream, prepare your AlX operating system by
downloading a current version of the INFOZIP package from the|http://www.info-zip.org| Web site.
Install the prerequisite xIC.rte 6.0 run-time code on AIX 5.2 maintenance level 1.

You must install the x1C.rte 6.0 run-time code before you install the Global Security Kit 7 (GSKit7).
The GSKit is installed as part of the installation of the IBM HTTP Server and also as part of the
installation of Web server plug-ins for WebSphere Application Server. Download the run-time code as
a fix from the [AIX Support site]

If you have AIX 5.2, you can install the x1C.rte 6.0 run-time code from the AIX 5.2 CD.
Provide adequate disk space.

With the JFS file system on AlX, you can allocate expansion space for directories. If the Installation
wizard does not have enough space, ISMP issues a system call for more space that increases the
space allocation dynamically. The message you might see when this occurs for the /usr directory is
similar to the following example:

NOTE: The following file systems will be expanded during the installation:
/usr

Attention:

The Express product requires the following disk space:
930 MB for the /usr/IBM/WebSphere/AppServer directory

The installation root directory includes the core product files. This size includes
the Sample applications. This size includes space for the default Application
Server profile for the server1 process. The requirement does not include space
for applications that you might install.

Each Application Server profile requires approximately 200 MB plus 40 MB of
temp space, and space for any applications that you develop and deploy.

100 MB for the /tmp directory
The temporary directory is the working directory for the installation program.
1030 MB total requirement

This amount is the total space requirement when installing the product from the
CD.

-:E- Manually verify that the required space for creating a profile is available on AlIX. A known
problem in the underlying InstallShield for Multiplatforms (ISMP) code prevents proper space checking
on AIX systems at the time that the product disc was created.

The following space is required for the IBM HTTP Server product:
110 MB for the /usr/IBMIHS directory

The IBM HTTP Server product requires this space.
35 MB for the /usr/ibm/gsk7 directory

The Tivoli Global Security Kit requires this space.

The run-time module is gskkm.rte.

IBM WebSphere Application Server - Express, Version 6: Installing your application serving environment


http://www.info-zip.org
https://techsupport.services.ibm.com/server/aix.fdc

The following space is the maximum amount that is required for the Web server plug-ins for
WebSphere Application Server:

200 MB for the /usr/IBM/WebSphere/plugins directory
The Web server plug-ins require this disk space.
25 MB for the /usr/ibm/gsk7 directory

The Tivoli Global Security Kit requires this space.
The following space is required for the IBM HTTP Server product:

110 MB for the /opt/IBMIHS directory
The IBM HTTP Server product requires this space.
25 MB for the /opt/ibm/gsk7 directory

The Tivoli Global Security Kit requires this space.
The following space is required for the WebSphere Application Server Clients:

150 MB for the /usr/IBM/WebSphere/AppClient directory

The amount of space required to install the application clients is actually less than 150 MB.
The amount of space depends on the clients that you install as features.

The Installation wizard for each component displays required space on the confirmation panel before
you install the product files and selected features. The Installation wizard also warns you if you do not
have enough space to install the product.

If you plan to migrate applications and the configuration from a previous version, verify that the
application objects have enough disk space. As a rough guideline, plan for space equal to 110
percent of the size of the application objects:
* For Version 4.0.x: The size of enterprise archive (EAR) files
e For Version 5.0.x: The size of EAR files
Unmount file systems with broken links to avoid java.lang.NullPointerException errors.
Unmount file systems with broken links before installing.
Installation can fail with the following error when broken links exist to file systems:
An error occurred during wizard bean change notification:
java.lang.NullPointerException
at com.ibm.wizard.platform.aix.AixFileUtils.
getFileSystemData (AixFileUtils.java:388)
at com.ibm.wizard.platform.aix.AixFileUtils.
getPartitionDataWithExecs(AixFileUtils.java:172)
at com.ibm.wizard.platform.aix.AixFileUtils.
getPartitionData(AixFileUtils.java:104)
at com.ibm.wizard.platform.aix.AixFileServiceImpl.
getPartitionNames (AixFileServicelmpl.java:397)

Use the df -k command to check for broken links to file systems. Look for file systems that list blank
values in the 1024-blocks size column. Columns with a value of "-” (dash) are not a problem. The
following example shows a problem with the /dev/1v00 file system:

> df -k

Filesystem 1024-blocks Free %Used Iused %Iused Mounted on
/dev/hd4 1048576 447924  58% 2497 1%/

/dev/hd3 4259840 2835816  34% 484 1% /tmp

/proc - - - - - /proc
/dev/1v01 2097152 229276  90% 3982 1% /storage
/dev/1v00

/dev/hd2 2097152 458632  79% 42910 9% /usr

iw031864:/cdrom/db2_v72_eee_aix32_sbcs
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The /proc file system is not a problem. The 1w031864:/cdrom/db2_v72_eee_aix32_shcs file system is
a definite problem. The /dev/1v00 file system is also a likely problem. Use one of the following
commands to solve this problem:

> umount /cdrom/db2_v72 eee aix32_sbcs
> umount /cdrom

Start the installation again. If the problem continues, unmount any file systems that have blank
values, such as the /dev/1v00 file system in the example. If you cannot solve the problem by
unmounting file systems with broken links, reboot the machine and start the installation again.

9. Verify that prerequisites and corequisites are at the required release levels.

Although the Installation wizard checks for prerequisite operating system patches with the
preregChecker application, review the prerequisites on the|IBM WebSphere Application Server|
|supported hardware, software, and APls Web site| if you have not already done so.

Refer to the documentation for non-IBM prerequisite and corequisite products to learn how to migrate
to their supported versions.

10. Verify the system c¢p command when using emacs or other freeware.

If you have emacs or other freeware installed on your operating system, verify that the system cp
command is used.

a. Type which cp at the command prompt before running the installation program for the WebSphere
Application Server product.

b. Remove the freeware directory from your PATH if the resulting directory output includes freeware.
For example, assume that the output is similar to the following message: .../freeware/bin/cp. If
so, remove the directory from the PATH.

c. Install the WebSphere Application Server product.
d. Add the freeware directory back to the PATH.

If you install with a ¢p command that is part of a freeware package, the installation might appear to
complete successfully, but the Java 2 SDK that the product installs might have missing files in the
install_root/ java directory.

Missing files can destroy required symbolic links. If you remove the freeware cp command from the
PATH, you can install the Application Server product successfully.

Perform the following step to verify that the Java 2 SDK is working correctly.
11. Verify that the Java 2 SDK on your copy of the product CD is functioning correctly.

If you created your own product CD from an ISO image or by copying the actual CD, perform the
following steps to verify that the Java 2 SDK on the product CD-ROM is working correctly.

a. Change directories to the /mnt/JDK/repository/prereq.jdk/java/bin directory on the product
CD-ROM. For example:

cd /mnt/JDK/repository/prereq.jdk/java/bin
b. Verify the Java 2 SDK version. Type the following command:
./java -version
The command completes successfully with no errors when the Java 2 SDK is intact.

12. Optional: Install the Mozilla browser if it is not already installed. The Mozilla browser supports the
launchpad console.

a. Use smit to see if the Mozilla 1.4 or 1.7 or later package is already installed.

b. Download two prerequisites from the AlX Toolbox for Linux Applications (glib & gtk+). Download
the packages from the following locations:

» [ftp://ftp.software.ibm.com/aix/freeSoftware/aixtoolbox/RPMS/ppc/glib/glib-1.2.10-|
2.aix4.3.ppc.rpm|

* [ftp:/ftp.software.ibm.com/aix/freeSoftware/aixtoolbox/RPMS/ppc/gtkplus/gtkplus-1 .2.10-|
4.aix5.1.ppc.rpm|

c. Install the packages after downloading them: Use the following command:
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rpm -Uvh g1ib-1.2.10-2.aix4.3.ppc.rpm gtkplus-1.2.10-4.aix5.1.ppc.rpm

d. Download the latest supported version of Mozilla (1.7 or later) for AIX. Download Mozilla for AIX
from the following location:

[http://www14.software.ibm.com/webapp/download/search.jsp?go=y&rs=mozilla
Download the installp image and install it from smit.

The Mozilla images distributed on the |http://www.mozilla.org| Web site are not provided by IBM.
IBM has not tested and does not support the download from the non-IBM Web site. Download the
Mozilla images from the IBM Web site to verify that the version that you download is tested and
supported.

13. Optional: Export the location of the supported browser.

Export the location of the supported browser using a command that identifies the actual location of
the browser.

For example, if the Mozilla package is in the bin /mozilla directory, use the following command:
EXPORT BROWSER=/usr/bin/mozilla

14. Silent installation only: Make an allowance for a known ISMP problem that causes a call to the
Xwindows service during a silent installation.

The DISPLAY environment variable on your AIX machine might point to an X server that is not logged
in. Two common scenarios can cause this to occur:

* Your AIX machine has an X server running, but the X server is stuck at the graphical login screen
because you have not yet logged in.

* Your AIX machine is configured to display X Windows applications on a remote X server that is not
logged in.

A silent installation can hang in either case as ISMP calls Xwindows services.
Two solutions exist:

* Login to the local X server through the graphical user interface before beginning the silent
installation.

« Export the DISPLAY environment variable to point to null or blank.
EXPORT DISPLAY=null

Preparing HP-UX systems for installation

This topic describes how to prepare an HP-UX system for the installation of IBM WebSphere Application
Server, Version 6 products.

The installation uses a InstallShield for Multiplatforms (ISMP) wizard. You can use the graphical interface
of the wizard. You can also use the wizard in silent mode.

Silent mode is a command line invocation with a parameter that identifies an options response file. Edit the
options response file before installing.

If you encounter a problem such as needing more temporary space or missing prerequisite packages on
your operating system, cancel the installation, make the required changes, and restart the installation.

Use the following procedure to prepare the operating system for the installation of WebSphere Application
Server products.

1. Log on as root.
You cannot install the product correctly as a non-root user.

If you create a copy of the product CD-ROM, do so as root. Copies made from non-root users do not
preserve the correct file attributes and do not work.

In addition, verify that the umask setting is 022. To verify the umask setting, issue the following
command:
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umask
To set the umask setting to 022, issue the following command:
umask 022

Optional: Download and install the Mozilla Web browser so that you can use the launchpad
application on the product disc. If you do not have the Mozilla Web browser, download and install the
browser from |http://www.mozilla.org}

Optional: Export the location of the supported browser. Export the location of the supported browser
using a command that identifies the actual location of the browser.

For example, if the Mozilla package is in the bin /mozilla directory, use the following command:
EXPORT BROWSER=/opt/bin/mozilla

Stop all WebSphere Application Server-related Java processes on the machine where you are
installing the product.

Stop any Web server process such as the IBM HTTP Server.
Provide adequate disk space.

Attention:

The Express product requires the following disk space:
980 MB for the /opt/IBM/WebSphere/AppServer directory

The installation root directory includes the core product files. This size includes
the Sample applications. This size includes space for the default Application
Server profile for the server1 process. The requirement does not include space
for applications that you might install.

Each Application Server profile requires approximately 200 MB plus 40 MB of
temp space, and space for any applications that you develop and deploy.

100 MB for the /tmp directory
The temporary directory is the working directory for the installation program.
1080 MB total requirement

This amount is the total space requirement when installing the product from the
CD.

The following space is required for the IBM HTTP Server product:
110 MB for the /opt/IBMIHS directory

The IBM HTTP Server product requires this space.
25 MB for the /opt/ibm/gsk7 directory

The Tivoli Global Security Kit requires this space.

The run-time module is gsk7bas for HP-UX platforms.

The following space is the maximum amount that is required for the Web server plug-ins for
WebSphere Application Server:

280 MB for the /opt/IBM/WebSphere/plugins directory
The Web server plug-ins require this disk space.
25 MB for the /opt/ibm/gsk7 directory

The Tivoli Global Security Kit requires this space.
The following space is required for the IBM WebSphere Application Server Clients:

150 MB for the /opt/IBM/WebSphere/AppClient directory
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The amount of space required to install the application clients is actually less than 150 MB.
The amount of space depends on the clients that you install as features.

The Installation wizard for each component displays required space on the confirmation panel before
you install the product files and selected features. The Installation wizard also warns you if you do not
have enough space to install the product.

If you plan to migrate applications and the configuration from a previous version, verify that the
application objects have enough disk space. As a rough guideline, plan for space equal to 110
percent of the size of the application objects:

* For Version 4.0.x: The size of enterprise archive (EAR) files

* For Version 5.0.x: The size of EAR files

7. Set kernel values to support Application Server. Several HP-UX kernel values are typically too small
for the product.

To set kernel parameters, perform the following steps:

a. Log into the host machine as root.

b. Determine the physical memory, which you must know to avoid setting certain kernel parameters
above the physical capacity:

1) Start the HP-UX System Administration Manager (SAM) utility.

2) Select Performance Monitors > System Properties > Memory.
3) Note the value for Physical Memory and click OK.

4) Exit from the SAM utility.

c. Set the maxfiles and maxfiles_lim parameters to at least 4096. (The following table recommends
8000 and 8196, respectively. You must first edit the /usr/conf/master.d/core-hpux file, so the
SAM utility can set values greater than 2048:

1) Open the /usr/conf/master.d/core-hpux file in a text editor.
2) Change the line,” *range maxfiles<=2048" to "*range maxfiles<=60000"
3) Change the line, "*range maxfiles_lim<=2048" to "*range maxfiles_lim<=60000"
4) Save and close the file. Old values might be stored in the /var/sam/boot.config file. Force
the SAM utility to create a new boot.config file:
a) Move the existing version of the /var/sam/boot.config file to another location, such as
the /tmp directory.
b) Start the SAM utility.
c) Select Kernel Configuration > Configurable Parameters. When the Kernel Configuration
window opens, a new boot.config file exists.
Alternatively, rebuild the boot.config file with the following command:
# /usr/sam/1bin/getkinfo -b
d. Set new kernel parameter values:
1) Start the SAM utility.
2) Click Kernel Configuration > Configurable Parameters.
3) For each of the parameters in the following table, perform this procedure:
a) Highlight the parameter to change.
b) Click Actions > Modify Configurable Parameter.
¢) Type the new value in the Formula/Value field.
d) Click OK.

Typical kernel settings for running WebSphere Application Server display in the following table:

Parameter Value

dbc_max_pct 25

maxdsiz 805306358

maxdsiz 2048000000 (when running multiple profiles on the same system)
maxfiles_lim 8196 (Change this one before maxfiles.)

maxfiles 8000

maxssiz 8388608
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Parameter Value
maxswapchunks 8192
max_thread_proc 3000
maxuprc 512
maxusers 512
msgmap 2048
msgmax 65535
msgmax 131070 (when running multiple profiles on the same system)
msgmnb 65535
msgmnb 131070 (when running multiple profiles on the same system)
msgmni 50
msgseg 32767
msgssz 32
msgtql 2046
nfile 58145
nflocks 3000
ninode 60000
nkthread 7219
nproc 4116
npty 2024
nstrpty 1024
nstrtel 60
sema 1
semaem 16384
semmap 514
semmni 2048
semmns 16384
semmnu 1024
semume 200
semvmx 32767
shmmax 2147483647
shmem 1
shmmni 1024
shmseg 1024
STRMSGSZ 65535

e.

When WebSphere Application Server and IBM DB2 are on the same machine, some kernel
values are higher than those shown in the preceding table.

See the [Recommended HP-UX kernel configuration parameters for DB2 V8| Web page for more
information.
Click Actions > Process New Kernel.

f. Click Yes on the information window to confirm your decision to restart the machine.
Follow the on-screen instructions to restart your machine and to enable the new settings.
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8.

10.

g. If you plan to redirect displays to non-HP machines, do the following before running the
WebSphere Application Server installation wizard:
1) Issue the following command to obtain information on all the public locales that are accessible
to your application:

# locale -a

2) Choose a value for your system from the output that is displayed and set the LANG
environment variable to this value. Here is an example command that sets the value of LANG
to en_US.is088591

# export LANG=en_US.1is08859
Verify that prerequisites and corequisites are at the required release levels.

Although the Installation wizard checks for prerequisite operating system patches with the
preregChecker application, review the prerequisites on the|IBM WebSphere Application Server|
|supported hardware, software, and APls Web site| if you have not already done so.

Refer to the documentation for non-IBM prerequisite and corequisite products to learn how to migrate
to their supported versions.

Verify the system ¢p command when using emacs or other freeware.

If you have emacs or other freeware installed on your operating system, verify that the system cp
command is used.

a. Type which cp at the command prompt before running the installation program for the WebSphere
Application Server product.

b. Remove the freeware directory from your PATH if the resulting directory output includes freeware.
For example, assume that the output is similar to the following message: .../freeware/bin/cp. If
so, remove the directory from the PATH.

c. Install the WebSphere Application Server product.
d. Add the freeware directory back to the PATH.

If you install with a ep command that is part of a freeware package, the installation might appear to
complete successfully, but the Java 2 SDK that the product installs might have missing files in the
install_root/ java directory.

Missing files can destroy required symbolic links. If you remove the freeware cp command from the
PATH, you can install the Application Server product successfully.

Perform the following step to verify that the Java 2 SDK is working correctly.
Verify that the Java 2 SDK on your copy of the product CD is functioning correctly.

If you created your own product CD from an ISO image or by copying the actual CD, perform the
following steps to verify that the Java 2 SDK on the product CD-ROM is working correctly.

a. Change directories to the /mnt/JDK/repository/prereq.jdk/java/bin directory on the product
CD-ROM. For example:

cd /mnt/JDK/repository/prereq.jdk/java/bin
b. Verify the Java 2 SDK version. Type the following command:
./java -version
The command completes successfully with no errors when the Java 2 SDK is intact.

Preparing Linux systems for installation

This topic describes how to prepare a Linux system for installing IBM WebSphere Application Server,
Version 6 products.

The installation uses a InstallShield for Multiplatforms (ISMP) wizard. You can use the graphical interface
of the wizard. You can also use the wizard in silent mode.

Silent mode is a command line invocation with a parameter that identifies an options response file. Edit the
options response file before installing.
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If you encounter a problem such as needing more temporary space or missing prerequisite packages on
your operating system, cancel the installation, make the required changes, and restart the installation.

Use the following procedure to prepare the operating system for the installation of WebSphere Application
Server products.

1.

78

Log on as root.
You cannot install the product correctly as a non-root user.

If you create a copy of the product CD-ROM, do so as root. Copies made from non-root users do not
preserve the correct file attributes and do not work.

In addition, verify that the umask setting is 022. To verify the umask setting, issue the following
command:

umask
To set the umask setting to 022, issue the following command:
umask 022

Optional: Download and install the Mozilla Web browser so that you can use the launchpad
application on the product disc. If you do not have the Mozilla Web browser, download and install the
browser from |http://www.mozilla.org]

Optional: Export the location of the supported browser. Export the location of the supported browser
using a command that identifies the actual location of the browser.

For example, if the Mozilla package is in the bin /mozilla directory, use the following command:
EXPORT BROWSER=/opt/bin/mozilla

Stop all WebSphere Application Server-related Java processes on the machine where you are
installing the product.

Stop any Web server process such as the IBM HTTP Server.
Provide adequate disk space.

Attention:

The Express product requires the following disk space:
930 MB for the /opt/IBM/WebSphere/AppServer directory

The installation root directory includes the core product files. This size includes the Sample
applications. This size includes space for the default Application Server profile for the serveri
process. The requirement does not include space for applications that you might install.

Each Application Server profile requires approximately 200 MB plus 40 MB of temp space,
and space for any applications that you develop and deploy.

100 MB for the /tmp directory
The temporary directory is the working directory for the installation program.
1030 MB total requirement

This amount is the total space requirement when installing the product from the CD.

The following space is the maximum amount that is required for the Web server plug-ins for
WebSphere Application Server:

200 MB for the /usr/IBM/WebSphere/plugins directory
The Web server plug-ins require this disk space.
25 MB for the /usr/ibm/gsk7 directory
The Tivoli Global Security Kit requires this space.

The run-time module is gskkm.rte.
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The following space is required for the IBM HTTP Server product:
110 MB for the /opt/IBMIHS directory

The IBM HTTP Server product requires this space.
25 MB for the /opt/ibm/gsk7 directory

The Tivoli Global Security Kit requires this space.

The run-time module is gsk7bas.i386.rpm for Linux distributed platforms and
gsk7bas.s390.rpm for Linux for S/390 platforms.

The following space is required for the IBM WebSphere Application Server Clients:
150 MB for the /opt/IBM/WebSphere/AppClient directory

The amount of space required to install the application clients is actually less than 150 MB.
The amount of space depends on the clients that you install as features.

Attention:

The following space is required for the Rational Web Developer:
2.5 GB maximum for the /opt/IBM/RSPD/6.0 directory

The amount of space that is required to install the Rational Web Developer is
actually less than 2.5 GB, depending on the optional features you select during
installation.

The amount of space that is required depends on the features that you install. For
example, without the language pack feature for support of national languages, the
space required is approximately 1.7 GB. Included in the 1.7 GB is approximately
550 MB of disk space for the integrated test environment for Version 6. An
integrated test environment for Version 5 is on disc 4.

The integrated test environment lets you install Rational Web Developer without
installing the Express product on your development machine. The test
environment is an exact replica of the product code that is sufficient for
developing and testing applications.

After installation, additional disk space is required for developer work space. The
size required by the work space depends on the size of the applications under
development.

The Installation wizard for each component displays required space on the confirmation panel before
you install the product files and selected features. The Installation wizard also warns you if you do not
have enough space to install the product.

If you plan to migrate applications and the configuration from a previous version, verify that the
application objects have enough disk space. As a rough guideline, plan for space equal to 110
percent of the size of the application objects:

* For Version 4.0.x: The size of enterprise archive (EAR) files

* For Version 5.0.x: The size of EAR files

Verify that prerequisites and corequisites are at the required release levels.

Although the Installation wizard checks for prerequisite operating system patches with the
prereqChecker application, review the prerequisites on the|IBM WebSphere Application Served
|supported hardware, software, and APls Web site| if you have not already done so.

Refer to the documentation for non-IBM prerequisite and corequisite products to learn how to migrate
to their supported versions.
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8.

10.

11.

80

Provide necessary prerequisites for Red Hat Enterprise Linux V3.0. A known limitation exists in the
prerequisites checker program when examining prerequisite packages on Linux systems. Although not
all of the following packages are required for Version 6, the packages are required if you install
Version 6 to coexist with a Version 5.x installation.

You must install the following packages on Red Hat Enterprise Linux V3.0 for xSeries platforms:

e compat-gcc-7.3-2.96.122

e compat-libstdc++-7.3-2.96.122

e compat-libstdc++-devel-7.3-2.96.122

* compat-glibc-7.x-2.2.4.32.5

e compat-gcc-c++-7.3-2.96.122

e compat-db-4.0.14-5

* rpm-build-4.2.1-4.2

The following package is required for Red Hat Enterprise Linux V3.0 for pSeries platforms:
rpm-build-4.2.1-4.2.

You must install the following packages on Red Hat Enterprise Linux V3.0 for S/390 (z/VM and
VM/ESA) platforms:

e compat-db-4.0.14-5

* compat-pwdb-0.62-3

e compat-libstdc++-7.2-2.95.3.77

* rpm-build-4.2.1-4.2

You can install a later release of any of these packages.

Upgrade Red Hat Enterprise Linux V3.0 to service level 2 (update 2) or service level 3 (update 3).
Upgrade the RHEL 3.0 service level by downloading and installing the service updates from Red Hat.

If you do not upgrade the service level, certain national language issues in the released version of
GLIBC included in Red Hat Enterprise Linux V3 might cause Java virtual machine (JVM) failures due
to segmentation faults. These failures can occur during installation when the locale is set to anything
other than an English locale.

Do not install, log off, and log back on when you are installing from the operator console attached to
the machine. This can produce segmentation faults that cause the installation to fail.

See [Appendix B, “Troubleshooting installation,” on page 291|for more information.

Prepare the SuSE Linux Enterprise Server 8.0 - Powered by UnitedLinux 1.0 operating platform for
WebSphere Application Server installation.
a. Install SP3 for the United Linux 1.0 operating platform to let you use the Launchpad.

It is your responsibility to install this service pack. The prereqChecker function of the installer
cannot detect service pack versions definitively on United Linux. Kernel unames and versions
between 8.0 and 8.0.3 are identical. No signature RPM denotes a service pack install.

b. Use the IBM Developer Kit that WebSphere Application Server provides to support the Java 2
SDK on the SuSE SLES 8.0 operating system to avoid potential problems when uninstalling an
interim fix or a fix pack. To use the IBM Developer Kit, remove the java2-jre-1.3.1-524 and
java2-1.3.1-524 RPMs from the machine before installing WebSphere Application Server.

Correct font problems on SuSE Linux Enterprise Server 8.0 in Simplified Chinese and Traditional
Chinese locales.

On the Linux for Power platform that SUSE Linux Enterprise Server 8.0 provides, a missing package
causes a font problem. The ttf-hanyi package is not installed during the normal product installation
of the SuSE 8.0 operating system. The missing package causes the Installation wizard for
WebSphere Application Server products to display garbled characters in the Simplified Chinese locale
and in the Traditional Chinese locale.

Copy the ttf-hanyi-2021016-0.noarch.rpm package on the SuSE 8.0 for i386 CD to the Power PC
system. Install the package on the Power PC machine and reboot the machine to solve the problem.
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12. Verify the system c¢p command when using emacs or other freeware.

If you have emacs or other freeware installed on your operating system, verify that the system cp
command is used.

a. Type which cp at the command prompt before running the installation program for the WebSphere
Application Server product.

b. Remove the freeware directory from your PATH if the resulting directory output includes freeware.
For example, assume that the output is similar to the following message: .../freeware/bin/cp. If
so, remove the directory from the PATH.

c. Install the WebSphere Application Server product.
d. Add the freeware directory back to the PATH.

If you install with a ep command that is part of a freeware package, the installation might appear to
complete successfully, but the Java 2 SDK that the product installs might have missing files in the
install_root/ java directory.

Missing files can destroy required symbolic links. If you remove the freeware cp command from the
PATH, you can install the Application Server product successfully.

Perform the following step to verify that the Java 2 SDK is working correctly.
13. Verify that the Java 2 SDK on your copy of the product CD is functioning correctly.

If you created your own product CD from an ISO image or by copying the actual CD, perform the
following steps to verify that the Java 2 SDK on the product CD-ROM is working correctly.

a. Change directories to the /mnt/JDK/repository/prereq.jdk/java/bin directory on the product
CD-ROM. For example:

cd /mnt/JDK/repository/prereq.jdk/java/bin
b. Verify the Java 2 SDK version. Type the following command:
./java -version
The command completes successfully with no errors when the Java 2 SDK is intact.

Preparing Solaris systems for installation

This topic describes how to prepare Solaris systems for the installation of IBM WebSphere Application
Server, Version 6 products.

The installation uses a InstallShield for Multiplatforms (ISMP) wizard. You can use the graphical interface
of the wizard. You can also use the wizard in silent mode.

Silent mode is a command line invocation with a parameter that identifies an options response file. Edit the
options response file before installing.

If you encounter a problem such as needing more temporary space or missing prerequisite packages on
your operating system, cancel the installation, make the required changes, and restart the installation.

Use the following procedure to prepare the operating system for the installation of WebSphere Application
Server products.

1. Log on as root.
You cannot install the product correctly as a non-root user.

If you create a copy of the product CD-ROM, do so as root. Copies made from non-root users do not
preserve the correct file attributes and do not work.

In addition, verify that the umask setting is 022. To verify the umask setting, issue the following
command:

umask
To set the umask setting to 022, issue the following command:
umask 022
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Optional: Download and install the Mozilla Web browser so that you can use the launchpad
application on the product disc. If you do not have the Mozilla Web browser, download and install the
browser from |http://www.mozilla.org|

Optional: Export the location of the supported browser. Export the location of the supported browser
using a command that identifies the actual location of the browser.

For example, if the Mozilla package is in the bin /mozilla directory, use the following command:
EXPORT BROWSER=/opt/bin/mozilla

Stop all WebSphere Application Server-related Java processes on the machine where you are
installing the product.

Stop any Web server process such as the IBM HTTP Server.
Provide adequate disk space.

Attention:

The Express product requires the following disk space:
930 MB for the /opt/IBM/WebSphere/AppServer directory

The installation root directory includes the core product files. This size includes
the Sample applications. This size includes space for the default Application
Server profile for the server1 process. The requirement does not include space
for applications that you might install.

Each Application Server profile requires approximately 200 MB plus 40 MB of
temp space, and space for any applications that you develop and deploy.

100 MB for the /tmp directory
The temporary directory is the working directory for the installation program.
1030 MB total requirement

This amount is the total space requirement when installing the product from the
CD.

The following space is required for the IBM HTTP Server product:
110 MB for the /opt/IBMIHS directory

The IBM HTTP Server product requires this space.
25 MB for the /opt/ibm/gsk7 directory

The Tivoli Global Security Kit requires this space.

The following space is the maximum amount that is required for the Web server plug-ins for
WebSphere Application Server:

200 MB for the /opt/IBM/WebSphere/plugins directory
The Web server plug-ins require this disk space.
35 MB for the /opt/ibm/gsk7 directory

The Tivoli Global Security Kit requires this space.
The following space is required for the IBM WebSphere Application Server Clients:

150 MB for the /opt/IBM/WebSphere/AppClient directory

The amount of space required to install the application clients is actually less than 150 MB.
The amount of space depends on the clients that you install as features.

The Installation wizard for each component displays required space on the confirmation panel before
you install the product files and selected features. The Installation wizard also warns you if you do not
have enough space to install the product.
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If you plan to migrate applications and the configuration from a previous version, verify that the
application objects have enough disk space. As a rough guideline, plan for space equal to 110
percent of the size of the application objects:

* For Version 4.0.x: The size of enterprise archive (EAR) files

* For Version 5.0.x: The size of EAR files

Set kernel values to support Application Server. Several Solaris kernel values are typically too small.
Before installing, review the machine configuration:

sysdef -i

The kernel values are set in the /etc/systen file, as shown in the following example.
set shmsys:shminfo_shmmax = 4294967295
set shmsys:shminfo_shmseg = 1024

set shmsys:shminfo_shmmni = 1024

set semsys:seminfo_semaem = 16384

set semsys:seminfo_semmni = 1024

set semsys:seminfo_semmap = 1026

set semsys:seminfo_semmns = 16384

set semsys:seminfo_semmsl = 100

set semsys:seminfo_semopm = 100

set semsys:seminfo_semmnu = 2048

set semsys:seminfo_semume = 256

set msgsys:msginfo_msgmap = 1026

set msgsys:msginfo_msgmax = 65535

set rlim_fd_cur=1024

You can change kernel values by editing the /etc/system file then rebooting the operating system.
For more information about setting up the Solaris system, see the [Solaris System Administration|
documentation|. For example, the [Solaris Tunable Parameters Reference Manual

Queue managers are generally independent of each other. Therefore system kernel parameters, for
example shmmni, semmni, semmns, and semmnu need to allow for the number of queue managers
in the system.

Verify that prerequisites and corequisites are at the required release levels.

Although the Installation wizard checks for prerequisite operating system patches with the
prereqChecker application, review the prerequisites on the [IBM WebSphere Application Server|
[supported hardware, software, and APIs Web site] if you have not already done so.

Refer to the documentation for non-IBM prerequisite and corequisite products to learn how to migrate
to their supported versions.

Solaris 9 SPARC workstations require the following patches to fix certain :
* 112874-16 SunOS 5.9: patch libc

* 113319-12 SunOS 5.9: libnsl nispasswdd patch

* 115545-01 SunOS 5.9: nss_files patch

* 115542-01 SunOS 5.9: nss_user patch

e 115544-01 SunOS 5.9: nss_compat patch

Solaris 8 SPARC workstations require the following patches to fix certain :
* 115827-01 SunOS 5.8: /sbin/sulogin and /sbin/netstrategy patch

e 115583-01 SunOS 5.8: /usr/lib/nss_user.so.1 patch

* 108820-02 SunOS 5.8: nss_compat.so.1 patch

* 113648-02 SunOS 5.8: /usr/sbin/mount patch

* 108993-27 SunOS 5.8: LDAP2 client, libc, libthread and libnsl libraries patch
* 108528-24 SunOS 5.8: kernel update patch

Refer to the [BM WebSphere Application Server supported hardware, software, and APIs Web site| for
a complete list of required patches and to determine whether your operating system is supported
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when you receive a message from the prereqChecker program. The Web site lists all supported
operating systems and the operating system fixes and patches that you must install to have a
compliant operating system.

9. Verify the system ¢p command when using emacs or other freeware.

If you have emacs or other freeware installed on your operating system, verify that the system cp
command is used.

a. Type which cp at the command prompt before running the installation program for the WebSphere
Application Server product.

b. Remove the freeware directory from your PATH if the resulting directory output includes freeware.
For example, assume that the output is similar to the following message: .../freeware/bin/cp. If
so, remove the directory from the PATH.

c. Install the WebSphere Application Server product.
d. Add the freeware directory back to the PATH.

If you install with a ep command that is part of a freeware package, the installation might appear to
complete successfully, but the Java 2 SDK that the product installs might have missing files in the
install_root/ java directory.

Missing files can destroy required symbolic links. If you remove the freeware cp command from the
PATH, you can install the Application Server product successfully.

Perform the following step to verify that the Java 2 SDK is working correctly.
10. Verify that the Java 2 SDK on your copy of the product CD is functioning correctly.

If you created your own product CD from an ISO image or by copying the actual CD, perform the
following steps to verify that the Java 2 SDK on the product CD-ROM is working correctly.

a. Change directories to the /mnt/JDK/repository/prereq.jdk/java/bin directory on the product
CD-ROM. For example:

cd /mnt/JDK/repository/prereq.jdk/java/bin
b. Verify the Java 2 SDK version. Type the following command:
./java -version
The command completes successfully with no errors when the Java 2 SDK is intact.

Preparing Windows systems for installation

This topic describes how to prepare your Windows systems for the installation of IBM WebSphere
Application Server, Version 6 products.

The installation uses a InstallShield for Multiplatforms (ISMP) wizard. You can use the graphical interface
of the wizard. You can also use the wizard in silent mode.

Silent mode is a command line invocation with a parameter that identifies an options response file. Edit the
options response file before installing.

If you encounter a problem such as needing more temporary space or missing prerequisite packages on
your operating system, cancel the installation, make the required changes, and restart the installation.

Use the following procedure to prepare the operating system for the installation of WebSphere Application
Server products.

1. Log on to a user ID that belongs to the administrator group.

Log on as a member of the administrator group to successfully install the product. You cannot create
Windows services from a user ID that does not belong to the administrator group. The creation of
Windows services requires the user to have the advanced user rights Act as part of the operating
system and Log on as a service.
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Optional: Download the latest supported version of Internet Explorer so that you can use the
launchpad on the product disc. Download Internet Explorer 6 from the following location:

[http://www.microsoft.com/windows/ie/default. mspx

Stop all WebSphere Application Server-related Java processes on the machine where you are
installing the product.

Stop any Web server process such as the IBM HTTP Server.
Stop all instances of the process_spawner.exe program.
Provide adequate disk space.

Attention:

The Express product requires the following disk space:
930 MB for the C:\Program Files\IBM\WebSphere\AppServer directory

The installation root directory includes the core product files. This size includes the Sample
applications. This size includes space for the default Application Server profile for the serveri
process. The requirement does not include space for applications that you might install.

Each Application Server profile requires approximately 200 MB plus 40 MB of temp space, and
space for any applications that you develop and deploy.

100 MB for the C:\temp directory
The temporary directory is the working directory for the installation program.
1030 MB total requirement

This amount is the total space requirement when installing the product from the CD.
The following space is required for the IBM HTTP Server product:

110 MB for the C:\Program Files\IBM HTTP Server directory
The IBM HTTP Server product requires this space.
25 MB for the C:\Program Files\ibm\gsk7 directory

The Tivoli Global Security Kit requires this space.

The following space is the maximum amount that is required for the Web server plug-ins for
WebSphere Application Server:

200 MB for the C:\Program Files\IBM\WebSphere\Plugins directory
The Web server plug-ins require this disk space.
25 MB for the C:\Program Files\ibm\gsk7 directory

The Tivoli Global Security Kit requires this space.
The following space is required for the Application Client for WebSphere Application Server:

150 MB for the C:\Program Files\IBM\WebSphere\AppClient directory

The amount of space required to install the application clients is actually less than 150 MB.
The amount of space depends on the clients that you install as features.

Attention:

The following space is required for the Rational Web Developer:
2.5 GB maximum for the C:\Program Files\IBM\RSPD\6.0 directory
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The amount of space that is required to install the Rational Web Developer is
actually less than 2.5 GB, depending on the optional features you select during
installation.

The amount of space that is required depends on the features that you install. For
example, without the language pack feature for support of national languages, the
space required is approximately 1.7 GB. Included in the 1.7 GB is approximately
550 MB of disk space for the integrated test environment for Version 6. An
integrated test environment for Version 5 is on disc 4.

The integrated test environment lets you install Rational Web Developer without
installing the Express product on your development machine. The test environment
is an exact replica of the product code that is sufficient for developing and testing
applications.

After installation, additional disk space is required for developer work space. The
size required by the work space depends on the size of the applications under
development.

The Installation wizard for each component displays required space on the confirmation panel before
you install the product files and selected features. The Installation wizard also warns you if you do not
have enough space to install the product.

If you plan to migrate applications and the configuration from a previous version, verify that the
application objects have enough disk space. As a rough guideline, plan for space equal to 110 percent
of the size of the application objects:

* For Version 4.0.x: The size of enterprise archive (EAR) files

* For Version 5.0.x: The size of EAR files

Verify that prerequisites and corequisites are at the required release levels.

Although the Installation wizard checks for prerequisite operating system patches with the
prereqChecker application, review the prerequisites on the [[BM WebSphere Application Server]
lsupported hardware, software, and APls Web site|if you have not already done so.

Refer to the documentation for non-IBM prerequisite and corequisite products to learn how to migrate
to their supported versions.

m Download Windows Script 5.6 to create Start menu items correctly on Windows 2000.

Download Windows Script 5.6 from the following Microsoft Web page: [http://www.microsoft.com/|
downloads/ details.aspx? Familyld= C717D943-7E4B-4622-86EB-95A22B832CAA|

Verify that the Java 2 SDK on your copy of the product CD is functioning correctly.

If you created your own product CD from an ISO image or by copying the actual CD, perform the
following steps to verify that the Java 2 SDK on the product CD-ROM is working correcily.

a. Change directories to the \win\WAS\jdk\java\bin directory on the product CD-ROM. Type the
following command:

cd CD_Drive_D:\WAS\jdk\java\bin
b. Verify the version of the Java 2 SDK. Type the following command:
.\java -version
The command completes successfully with no errors when the Java 2 SDK is intact.

This procedure results in preparing the operating system for installing the product.

After preparing the operating system for installation, you can install the WebSphere Application Server
product.

Go to |“Preparing to install Express on a Windows system” on page 91| for the next step in the overall
procedure, which is selecting the type of installation to perform.
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Preparing to install Express on an AIX system

This topic describes how to get started installing the IBM WebSphere Application Server - Express,
Version 6 product on an AlX system.

Before using this topic to prepare for installing the Express product, decide the sort of topology you want
to install and prepare your operating system. See the following topics for more information:

* [‘Planning to install WebSphere Application Server - Express” on page 52
* |“Preparing AIX systems for installation” on page 69|

Log on as root to successfully install the product. You cannot install the product correctly from a non-root
user.

After verifying prerequisites, verifying the product CD, and setting your installation goals, you can start
installing. Use the following procedure to link to the type of installation procedure that you require. Then
install the WebSphere Application Server - Express product on your operating system.

» Perform a typical installation.

The typical installation of the Express product installs all of the features. The features include the core
product files (required), the Javadoc (optional), and the Sample applications (optional).

See [Installing Express with full installation options” on page 103.|
* Perform a custom installation.

The custom installation lets you select features to install.

See [Installing Express with custom options” on page 107.|
* Perform a silent installation.

A silent installation requires you to edit the example response file to contain all of your installation
choices. After creating a valid response file, issue the install command with the silent parameter from a
command window.

See [Installing silently” on page 119.|
* Install additional features to an existing product.

After using a custom installation to omit one or both of the optional features, you can install the product
again to add the features. Select a missing feature to install it.

See [Installing additional features on an existing Express installation” on page 113.|
» Upgrade a trial to the Express product.

After installing a trial, you can install the actual product to upgrade the trial to the real product.See
[‘Upgrading the Express trial to the Express product” on page 117.|

This procedure results in the Installation wizard installing WebSphere Application Server - Express into the
installation root directory. The Installation wizard creates a profile named default that provides the run-time
environment for the server1 application server.

Further configuration is not necessary at this time. However, you can create additional stand-alone
application servers with the Profile creation wizard. Each profile is created in the install_root/profiles
directory by default.

See [‘Using the Profile creation wizard” on page 211|for more information.

m Manually verify that the required space for creating a profile is available on AIX. A known
problem in the underlying InstallShield for Multiplatforms (ISMP) code prevents proper space checking on
AIX systems at the time that the product disc was created.

Deploy an application to get started!
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See [‘Fast paths for WebSphere Application Server” on page 9 to get started deploying applications.

Preparing to install Express on an HP-UX system

This topic describes how to get started installing the IBM WebSphere Application Server - Express,
Version 6 product on an HP-UX operating system.

Before using this topic to prepare for installing the Express product, decide the sort of topology you want
to install and prepare your operating system. See the following topics for more information:

* [‘Planning to install WebSphere Application Server - Express” on page 52|
* |“Preparing HP-UX systems for installation” on page 73|

Log on as root to successfully install the product. You cannot install the product correctly from a non-root
user.

After verifying prerequisites, verifying the product CD, and setting your installation goals, you can start
installing. Use the following procedure to link to the type of installation procedure that you require. Then
install the WebSphere Application Server - Express product on your operating system.

» Perform a typical installation.

The typical installation of the Express product installs all of the features. The features include the core
product files (required), the Javadoc (optional), and the Sample applications (optional).

See [Installing Express with full installation options” on page 103.|
* Perform a custom installation.

The custom installation lets you select features to install.

See [Installing Express with custom options” on page 107.|
* Perform a silent installation.

A silent installation requires you to edit the example response file to contain all of your installation
choices. After creating a valid response file, issue the install command with the silent parameter from a
command window.

See [Installing silently” on page 119
* Install additional features to an existing product.

After using a custom installation to omit one or both of the optional features, you can install the product
again to add the features. Select a missing feature to install it.

See [Installing additional features on an existing Express installation” on page 113.|
» Upgrade a trial to the Express product.

After installing a trial, you can install the actual product to upgrade the trial to the real product.See
[‘Upgrading the Express trial to the Express product” on page 117.|

This procedure results in the Installation wizard installing WebSphere Application Server - Express into the
installation root directory. The Installation wizard creates a profile named default that provides the run-time
environment for the server1 application server.

Further configuration is not necessary at this time. However, you can create additional stand-alone
application servers with the Profile creation wizard. Each profile is created in the install_root/profiles
directory by default.

See [‘Using the Profile creation wizard” on page 211|for more information.

Deploy an application to get started!

See [‘Fast paths for WebSphere Application Server” on page 9 to get started deploying applications.
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Preparing to install Express on a Linux system

This topic describes how to get started installing the IBM WebSphere Application Server - Express,
Version 6 product on a Linux operating system.

Before using this topic to prepare for installing the Express product, decide the sort of topology you want
to install and prepare your operating system. See the following topics for more information:

* [‘Planning to install WebSphere Application Server - Express” on page 52
* |“Preparing Linux systems for installation” on page 77|

Log on as root to successfully install the product. You cannot install the product correctly from a non-root
user.

After verifying prerequisites, verifying the product CD, and setting your installation goals, you can start
installing. Use the following procedure to link to the type of installation procedure that you require. Then
install the WebSphere Application Server - Express product on your operating system.

» Perform a typical installation.

The typical installation of the Express product installs all of the features. The features include the core
product files (required), the Javadoc (optional), and the Sample applications (optional).

See [Installing Express with full installation options” on page 103.|
* Perform a custom installation.

The custom installation lets you select features to install.

See [Installing Express with custom options” on page 107.|
* Perform a silent installation.

A silent installation requires you to edit the example response file to contain all of your installation
choices. After creating a valid response file, issue the install command with the silent parameter from a
command window.

See [Installing silently” on page 119.|
* Install additional features to an existing product.

After using a custom installation to omit one or both of the optional features, you can install the product
again to add the features. Select a missing feature to install it.

See [Installing additional features on an existing Express installation” on page 113.|
» Upgrade a trial to the Express product.

After installing a trial, you can install the actual product to upgrade the trial to the real product.See
[‘Upgrading the Express trial to the Express product” on page 117.|

This procedure results in the Installation wizard installing WebSphere Application Server - Express into the
installation root directory. The Installation wizard creates a profile named default that provides the run-time
environment for the server1 application server.

Further configuration is not necessary at this time. However, you can create additional stand-alone
application servers with the Profile creation wizard. Each profile is created in the install_root/profiles
directory by default.

See [‘Using the Profile creation wizard” on page 211|for more information.

Deploy an application to get started!

See [‘Fast paths for WebSphere Application Server” on page 9 to get started deploying applications.
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Preparing to install Express on a Solaris system

This topic describes how to get started installing the IBM WebSphere Application Server - Express,
Version 6 product on a Solaris operating system.

Before using this topic to prepare for installing the Express product, decide the sort of topology you want
to install and prepare your operating system. See the following topics for more information:

* [‘Planning to install WebSphere Application Server - Express” on page 52|
* [‘Preparing Solaris systems for installation” on page 81|

Log on as root to successfully install the product. You cannot install the product correctly from a non-root
user.

After verifying prerequisites, verifying the product CD, and setting your installation goals, you can start
installing. Use the following procedure to link to the type of installation procedure that you require. Then
install the WebSphere Application Server - Express product on your operating system.

» Perform a typical installation.

The typical installation of the Express product installs all of the features. The features include the core
product files (required), the Javadoc (optional), and the Sample applications (optional).

See [Installing Express with full installation options” on page 103.|
* Perform a custom installation.

The custom installation lets you select features to install.

See [Installing Express with custom options” on page 107.|
» Perform a silent installation.

A silent installation requires you to edit the example response file to contain all of your installation
choices. After creating a valid response file, issue the install command with the silent parameter from a
command window.

See [Installing silently” on page 119
» Install additional features to an existing product.

After using a custom installation to omit one or both of the optional features, you can install the product
again to add the features. Select a missing feature to install it.

See [Installing additional features on an existing Express installation” on page 113.|
» Upgrade a trial to the Express product.

After installing a trial, you can install the actual product to upgrade the trial to the real product.See
[‘Upgrading the Express trial to the Express product’ on page 117,

This procedure results in the Installation wizard installing WebSphere Application Server - Express into the
installation root directory. The Installation wizard creates a profile named default that provides the run-time
environment for the server1 application server.

Further configuration is not necessary at this time. However, you can create additional stand-alone
application servers with the Profile creation wizard. Each profile is created in the install_root/profiles
directory by default.

See [‘Using the Profile creation wizard” on page 211|for more information.

Deploy an application to get started!

See [‘Fast paths for WebSphere Application Server” on page 9 to get started deploying applications.
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Preparing to install Express on a Windows system

This topic describes how to install IBM WebSphere Application Server - Express, Version 6 on a Windows
operating system.

Before using this topic to prepare for installing the Express product, decide the sort of topology you want
to install and prepare your operating system. See the following topics for more information:

* [‘Planning to install WebSphere Application Server - Express” on page 52
* |“Preparing Windows systems for installation” on page 84|

Log on as a member of the administrator group to successfully install the product. Creating a Windows
service for the server1 process requires you to have the following advanced user right: Act as part of the
operating system.

During the procedure, you can assign another ID or the one you are using to install, as the user who will
log on the Windows service. That user requires the advanced user right: Log on as a service.

However, if you do not have this advanced user right or if the user ID that is to log on the Windows
service does not have the advanced user right, the Installation wizard assigns the advanced right to the
user.

After verifying prerequisites, verifying the product CD, and setting your installation goals, you can start
installing. Use the following procedure to link to the type of installation procedure that you require. Then
install the WebSphere Application Server - Express product on your operating system.

* Perform a typical installation.

The typical installation of the Express product installs all of the features. The features include the core
product files (required), the Javadoc (optional), and the Sample applications (optional).

See [Installing Express with full installation options” on page 103.|
» Perform a custom installation.

The custom installation lets you select features to install.

See [Installing Express with custom options” on page 107.|
* Perform a silent installation.

A silent installation requires you to edit the example response file to contain all of your installation
choices. After creating a valid response file, issue the install command with the silent parameter from a
command window.

See [nstalling silently” on page 119
* Install additional features to an existing product.

After using a custom installation to omit one or both of the optional features, you can install the product
again to add the features. Select a missing feature to install it.

See f‘lnstalling additional features on an existing Express installation” on page 113.|
» Upgrade a trial to the Express product.

After installing a trial, you can install the actual product to upgrade the trial to the real product.See
|“Upgrading the Express trial to the Express product” on page 117.|

This procedure results in the Installation wizard installing WebSphere Application Server - Express into the
installation root directory. The Installation wizard creates a profile named default that provides the run-time
environment for the server1 application server.

Further configuration is not necessary at this time. However, you can create additional stand-alone

application servers with the Profile creation wizard. Each profile is created in the install_root/profiles
directory by default.
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See [‘Using the Profile creation wizard” on page 211|for more information.

Deploy an application to get started!

See [‘Fast paths for WebSphere Application Server’ on page 9 to get started deploying applications.
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Part 3. Installing
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Chapter 9. Installing the product and additional software

This topic describes how to install WebSphere Application Server - Express as the root user on a Linux
platform or on a UNIX platform, or from a user ID that belongs to the administrator group on a Windows
platform. This topic also describes installing IBM HTTP Server and the application clients.

Read through this topic and its related topics to prepare for installation and to make yourself familiar with
installation options, before you start to use the installation tools. Review the hardware and software
requirements on the [[IBM WebSphere Application Server supported hardware and software Web site|to get
started.

The launchpad is the preferred method of starting the installation. Use the Launchpad to access the
product overview, the installation guide, and the readme file. Of course, the main purpose of the launchpad
is to launch the installation procedure.

See [‘Using the launchpad to start the installation” on page 39|for more information.

If you encounter a problem such as needing more disk space or temporary space or missing prerequisite
packages on your Linux or UNIX system, cancel the installation, make the required changes, and restart
the installation.

m Log on as a member of the administrator group to successfully install the product. You cannot
install the product correctly from a user ID that does not belong to the administrator group. Some steps of
the installation procedure require the administrator group ID to have the following advanced user rights,
Act as part of the operating system and Log on as a service.

This topic provides an overview of installation procedures. Use the information in this topic to learn about
the types of installation available. This topic has links to more detailed installation topics.

The Installation wizard performs the following actions:

» Automatically checks prerequisites

» Looks for a previous WebSphere Application Server V6 installation, to determine whether to let you add
features to the product binaries or to install a new set of product binaries

* Looks for a previous V6 installation, to determine whether to let you upgrade from a trial installation to
the real product

» Creates a stand-alone application server node

Perform the following procedure to start your installation.
1. Plan iour installation, as described in [‘Planning to install WebSphere Application Server - Express” on|

2. Prepare your operating platform for installation, as described in [Chapter 8, “Preparing the operating
[system for product installation,” on page 69

3. Review the roadmap for installing the Express product, as described in ['Roadmap for installing
[Express” on page 100/
4. Install the Express product.
Choose an installation scenario to continue the installation:
 Perform a typical installation with the wizard, as described in|“Installing Express with full installation|
[options” on page 103
The typical installation of the Express product installs all of the features.
+ Perform a custom installation with the wizard, as described in [“Installing Express with custom|
[options” on page 107
The custom installation lets you select features to install.
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 Perform a silent installation, as described in [Installing silently” on page 119

A silent installation requires you to edit the response file that contains all of your installation choices.
After creating a valid response file, you issue the install command with the silent parameter from a
command window.

« Install additional features to an existing installation, as described in [Installing additional features on|
[an existing Express installation” on page 113]

After installing Express, you can install it again to update the system files by installing previously
uninstalled features.

» Upgrade a trial version to a product version.
The installer program does not support the ISMP -console installation method at this time.
5. Optional: Install IBM HTTP Server.

After installing a WebSphere Application Server product, you can use the application server to serve
applications over the Internet. It is not necessary to install the IBM HTTP Server or another Web
server. It is also necessary to install Web server plug-ins. You also do not need the application clients
unless the application you are deploying was designed to run as a client application. You also do not
have to install an integrated development environment. The development environment is for developers
of Web applications.

The installation solution diagrams in [Planning to install WebSphere Application Server - Express” on|
show the components that are present in different types of environments.

See [Installing IBM HTTP Server{ for more information about installing IBM HTTP Server.
6. Optional: Install Web server plug-ins for IBM HTTP Server or another supported Web server.

If you install the IBM HTTP Server or another Web server, you must install a binary module for the
Web server to enable it to communicate with WebSphere Application Server products. Before you can
install a Web server plug-in, you must install the Web server.

After installing a Web server plug-in, the Plug-ins installation wizard configures a new element in the
application server configuration called a Web server definition. You can then manage applications for
the Web server using the administrative console.

See [Installing Web server plug-ins| for more information.
7. Optional: Install the application clients.

See [Installing Application Client for WebSphere Application Server for more information.
8. Optional: Install the Rational Web Developer.

See ['Roadmap for installing Rational Web Developer’] for more information.

This procedure results in installing IBM WebSphere Application Server - Express, Version 6.

You can also install IBM HTTP Server, the Web server plug-ins for WebSphere Application Server, and the
application clients for WebSphere Application Server.

Roadmap for installing Rational Web Developer

This topic provides an overview of how to install Rational Web Developer. Rational Web Developer is part
of the IBM WebSphere Application Server - Express, Version 6 product.

Rational Web Developer is part of the integrated suite of Rational Developer tools, powered by Eclipse
technology release 3.0.

Important: IBM does not recommend installing the Express server on the same machine with Rational

Web Developer. Rational Web Developer installs its own copy of the Express server for a
totally functional test environment.
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Hardware and software requirements

The hardware and software requirements for Rational Web Developer are different than those for the IBM
WebSphere Application Server - Express, Version 6 product.

The official statements of support for hardware and software for the IBM WebSphere Application Server -
Express, Version 6 product are on the|IBM WebSphere Application Server supported hardware andl
ﬁ

oftware| Web site. The Web site lists all supported operating systems and the operating system fixes and
patches that you must install to have a compliant operating system.

The official list of supported hardware and software for Rational Web Developer are in the readme.html file
on the first Rational Web Developer compact disc. The readme file states that you must have 2.5 GB of
free space on your operating system to install the entire product and to have room for developing
applications. You can reduce the space requirement somewhat by not installing all available features.

Using the launchpad

The launchpad has links to the installation guide (install.html) on the product disc and to the
readme.html file. The launchpad is in the root directory of the first product CD.

Use the launchpad to launch the installation procedure for Rational Web Developer. See
launchpad to start the installation” on page 39/

Start the launchpad with the launchpad.bat command. The installation guide on the Rational Web
Developer disc refers to the launchpad program as the Taunchpad.exe file. The Taunchpad.exe program is
replaced in the Rational Web Developer packaging for Express by the WebSphere Application Server -
Express launchpad. The command to start the launchpad is actually:

B ./launchpad.sh

. m lTaunchpad.bat

The launchpad requires a supported browser. Supported browsers are:
* Internet Explorer, Version 5.5 with SP 2 or later
¢ Mozilla browser, Version 1.4 or later

Roadmap overview

The steps for creating a fully integrated development environment using Rational Web Developer are:
1. Insert and mount the disc 1 of the Rational Web Developer on a Windows or Linux (Intel) system.
2. Start the launchpad.

3. Launch the installation program for the Rational Web Developer product.

4. Install the Rational Web Developer product.

No further steps are necessary to create a fully integrated development environment. Start the tutorial on
the product Welcome page to learn how to use Rational Web Developer.

Installing Rational Web Developer

You can install Rational Web Developer from the CD-ROM or from electronic images that you download.
You can also install Rational Web Developer from the default graphical user interface, using a command
prompt, or using the Installation wizard in silent mode. A silent installation reads values for installation
fields from a response file and does not provide prompts in a graphical interface.

The interactive console mode can be better suited for persons with accessibility requirements. The
accessibility mode command line option (-accessibility) makes the run-time console mode Wizard more
friendly for screen readers.
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The recommended method of starting the Installation wizard is by using the launchpad. You can also start
the installation with any of the following commands:

e [nstallation wizard command:

- setup\setup

- m setup\setup.exe

* Console mode:
- setup/setup -is:javaconsole -log @NONE -accessibility

- MSetup\setup.exe -is:javaconsole -log @NONE -accessibility
» Silent mode:

- setup/setup -silent

- MSetup\setup.exe -silent

See the install.html file on the product disc for detailed information about installing Rational Web
Developer.

Starting Rational Web Developer on Linux platforms after the
installation is complete

Start Rational Web Developer by going to the Start menu and selecting IBM Rational >IBM Rational Web
Developer 6.0. You can also select IBM Rational > Rational Software Development Platform to start
the product.

The first time that you start Rational Web Developer, a dialog box opens with the default workspace
directory already specified. By default, your work is stored in a directory called workspace, located in
$HOME/IBM/rationalsdp6.0 directory. To save your work elsewhere, change the name of the workspace. If
you clear the Use this as the default and do not ask again check box, this dialog box opens every time
you start Rational Web Developer. This lets you change work spaces.

Tip: If the Use this as the default and do not ask again check box is selected, the dialog box does not
open again. Rational Web Developer uses the last workspace from the previous session. To open the
dialog box again, change this option in Rational Web Developer in the Window > Preferences >
Workbench > Startup and Shutdown page. Click OK. A one time delay occurs while the workspace
structure is created.

Starting Rational Web Developer on Windows platforms after the
installation is complete

Start Rational Web Developer by selecting Start > Programs > IBM Rational >IBM Rational Web
Developer 6.0 > Rational Web Developer. You can also select Start > Program > IBM Rational >
Rational Software Development Platform to start the product.

The first time that you start Rational Web Developer, a dialog box opens with the default workspace
directory already specified. By default, your work is stored in a directory called workspace, located in
c:\Documents and Settings\youruserid\IBM\rationalsdp6.0\workspace directory. To save your work
elsewhere, change the name of the workspace. If you clear the Use this as the default and do not ask
again check box, this dialog box opens every time you start Rational Web Developer. This option lets you
change work spaces.

Tip: If the Use this as the default and do not ask again check box is selected, the dialog box does not
open again. Rational Web Developer uses the last workspace from the previous session. To open the
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dialog box again, change this option in Rational Web Developer in the Window > Preferences >
Workbench > Startup and Shutdown page. Click OK. A one time delay occurs while the workspace
structure is created.

Differences in Rational Web Developer for the Express product

Several installation differences exist between the Rational Web Developer that is bundled in the Express
product and the full Rational Web Developer product. The first difference is the name of the program that
starts the launchpad, as described earlier. Other differences include:

Integrated test environment for WebSphere Application Server - Express Version 5.x
The Express Version 6 test environment is included with the Rational Web Developer installation
image. The Version 6 test environment is installed by default. Normally is the only test
environment that you need.

Suppose, however, that you are migrating from WebSphere Application Server - Express Version
5.x and there is a need to test an application with the Version 5.x test environment. You can install
the Express Version 5.x test environment from the supplemental disc in the Rational Web
Developer package.

1. Install Rational Web Developer.
2. From the supplemental disc run the following command:

. 5xTestEnv/setup/setup

. m5xTestEnv\setup\setup.exe

3. Follow the installation wizards to complete the installation.
The installer program locates the Rational Web Developer and installs the Version 5.x test
environment into the proper directory.

Agent Controller
The Agent Controller is a daemon that is typically used to communicate between Rational Web
Developer and Version 5.x Express servers. The communication mechanism for Version 6 servers
does not rely on Agent Controllers.

The Installation Guide for Rational Web Developer has detailed information on installing the Agent
Controller. If you must install the Agent Controller, follow the directions in the guide with these
important exceptions:

The Agent Controller for the Windows, Linux, and AIX platforms is included on the Rational Web
Developer supplemental disc under the IBM_Agent_Controller. These platforms are the same as
those supported for the Agent Controller in the Express 5.x product.

Launch the Agent Controller installer program using the following commands:
. T IBM_Agent _Controller/aix/aix_powerpc/setup.bin

. IBM_Agent_Controller/linux_ia32/setup.bin

. m IBM_Agent_Controller\win_ia32/setup.exe

If you find that the full Rational Web Developer product is a better fit, you can purchase the product for a
small upgrade charge.

What to do when an installation problem occurs

If you encounter a problem such as not having enough space or not having the right prerequisite updates
on your system, cancel the installation, make the required changes, and restart the installation. The
installation procedure has a description of more comprehensive troubleshooting procedures.
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Cancelling a console installation is difficult. Cancelling the installation after the wizard begins copying files
to disk is also difficult. See the install.html file for more information.

You can reinstall into the same directory to add features that you did not select during the initial
installation. For example, if you find that you must create applications for languages other than English,
you might reinstall to install the language pack feature.

Getting the latest information

This topic is available on the product CD-ROM and online in an information center. The information center
always has the most current information. The information center displays in the language of your machine
locale if possible.

The information center for Version 6 is at the |http:/publib.boulder.ibm.com/infocenter/ws60help/index.jsp|
IBM Web site.

The Getting Started PDF is updated occasionally. Download a new Getting Started guide from
thefftp://ftp.software.ibm.com/software/webserver/appserv/library/wasv60ex_gs.pdf IBM Web site.

The HTML version of the Getting Started guide is not available for downloading because you can
download and install the entire information center for the Express product. See [Using this documentation|

for more information.
What to do next

After installing the Express product or the Rational Web Developer, the next step is to use either product.

If you install the Express product, you can start the application server and use the administrative console
to deploy an existing application. See [Fast paths for WebSphere Application Server|for more information.

If you install Rational Web Developer, you can use the tutorial on the product CD to begin learning how to
develop and deploy applications.

Roadmap for installing Express

This topic provides an overview of how to install IBM WebSphere Application Server - Express, Version 6.

See [Chapter 9, “Installing the product and additional software,” on page 95| for information about installing
any of the products in the WebSphere Application Server family of products. This topic describes installing
the Express product.

Using the launchpad

The launchpad gives you important clues about creating typical topologies. The installation solution
diagrams identify some of the system topologies that you can create. The launchpad is in the root
directory of the product CD.

Use the launchpad to launch the installation program for each of the installable components in the primary
disc packet. See|“Using the launchpad to start the installation” on page 39.|

The launchpad also provides access to the documentation for each of the installable components on the
product CD.

Start the launchpad with the launchpad command:

. -E'JE. ./Taunchpad.sh
. m launchpad.bat
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The launchpad requires a supported browser. Supported browsers are:
* Internet Explorer, Version 5.5 with SP 2 or later
*  Mozilla browser, Version 1.4 or later

Installing the Express product

Install the Express server to create a single stand-alone application server named serveri. You can use
the Profile creation wizard to create multiple stand-alone application servers on the machine.

Install the Rational Web Developer to create an integrated development environment.

Installing a stand-alone application server
The installation of the Express server creates a stand-alone application server. Just start the application
server named server1 to begin using the server:

1. Insert the product disc.

2. Start the launchpad.

3. Run the installation program to install the Express server.

4. Change directories to the install_root/profiles/default/bin directory:

. -E'E- ./cd /opt/I1BM/WebSphere/AppServer/profiles/default/bin

. mm C:\IBM\WebSphere\AppServer\profiles\default\bin

5. Start the application server named server1 with the Start Menu on Windows systems, from the First
steps console, or with the startServer command:

. -E'E- ./startServer.sh serverl
. MStartServer.bat serverl

See the description of the [startServer command| for more information.

Creating multiple application servers on a single machine
Two different wizards create an application server:

* The Installation wizard creates one stand-alone application server profile.
» Each use of the Profile creation wizard also creates one stand-alone application server profile.

Installing the Express product again on the same machine is not necessary. Simply use the Profile
creation wizard to create additional application server profiles. Each profile contains one server1
application server.

Each application server profile is a unique run-time environment, with its own configuration, applications,
data, logs, and administrative interface. All of the application server instances on a machine share the
same set of core product files.

For example, the following procedure shows the basic steps for creating two profiles on one machine:
1. Insert and mount the product disc.
2. Start the launchpad.
3. Launch the installation program for the WebSphere Application Server - Express product.
4. Change directories to the install_root/profiles/default/bin directory:

. -EE- ./cd /opt/IBM/WebSphere/AppServer/profiles/default/bin

. m cd C:\IBM\WebSphere\AppServer\profiles\default\bin
5. Start the application server named server1 with the startServer command:

. -EE- ./startServer.sh serverl
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. MStartServer.bat serverl

6. Change directories to the install_root/firststeps directory.
7. Start the First steps console with the firststeps command:

. -EJE- ./firststeps.sh
. Mﬁrststeps.bat

8. Select the Profile creation wizard option and create a new application server profile.
Give the new profile a unique name, such as Profile02.
9. Change directories to the install_root/profiles/Profile02/bin directory:

. -EJE- ./cd /opt/IBM/WebSphere/AppServer/profiles/Profiled2/bin

. m cd C:\IBM\WebSphere\AppServer\profiles\Profile02\bin
10. Start the application server named server1 with the startServer command:

. -EE- ./startServer.sh serverl
. MStartServer.bat serverl

Installing Rational Web Developer

Important: IBM does not recommend installing the Express server on the same machine with Rational
Web Developer. Rational Web Developer installs its own copy of the Express server for a
totally functional test environment.

The following procedure creates a fully integrated development environment using Rational Web
Developer:

1. Insert and mount the disc 1 of the Rational Web Developer on a Windows or Linux (Intel) system.
2. Start the launchpad.

3. Launch the installation program for the Rational Web Developer product.

4. Install the Rational Web Developer product.

No further steps are necessary to create a fully integrated development environment. Start the tutorial on
the product disc to learn how to use Rational Web Developer.

Understanding what you can do with the Express product

Select the Solution installation diagrams link in the navigation area on the launchpad to view typical
topologies for installing the Express product. The diagrams are also in [‘Planning to install WebSphere]
[Application Server - Express” on page 52,|where the installation steps for each solution are described in
detail.

WebSphere Application Server - Express uses ISMP to install products

The installation program uses the InstallShield for Multiplatforms (ISMP) product to perform the installation.
You can use the Installation wizard or perform the installation from a command line, using the silent
installation method.

What to do when an installation problem occurs

If you encounter a problem such as not having enough space or not having the right prerequisite updates
on your system, cancel the installation, make the required changes, and restart the installation. The
installation procedure has a description of more comprehensive troubleshooting procedures.
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Getting the latest information

This topic is available on the product CD-ROM and online in an information center. The information center
always has the most current information. The information center displays in the language of your machine
locale if possible.

The information center for Version 6 is at the |http:/publib.boulder.ibm.com/infocenter/ws60help/index.jsp|
IBM Web site.

The Getting Started PDF is updated occasionally. Download a new Getting Started guide from the
Iftp://ftp.software.ibm.com/software/webserver/appserv/library/wasv60ex_gs.pdf| IBM Web site. The name of
the file is different than the one on your product CD to keep from overlaying other PDF files you might
download. (All of the PDF files on the product CD have the same file name.)

The HTML version of the Getting Started guide is not available for downloading because you can
download and install the entire information center for the Express product. See |Using this documentation|
for more information.

What to do next

After installing the Express product or the Rational Web Developer, the next step is to use either product.

If you install the Express product, you can start the application server and use the administrative console
to deploy an existing application. See [Fast paths for WebSphere Application Server|for more information.

If you install Rational Web Developer, you can use the tutorials on the product Welcome page to begin
learning how to develop and deploy applications.

Installing Express with full installation options

This topic describes how to install IBM WebSphere Application Server - Express, Version 6 with full
installation options.

This is one of the installation paths available for any platform. Other installation paths include:
« [“Installing Express with custom options” on page 107|

« [“Installing additional features on an existing Express installation” on page 113]

« [‘Upgrading the Express trial to the Express product’ on page 117

+ [“Installing silently” on page 119

Select the appropriate installation path before you begin the installation.

Before starting the installation, see[‘Using the launchpad to start the installation” on page 39 for
information about the Installation solutions diagrams. The diagrams show typical topologies for the product.
The solutions are also in|“PIanning to install WebSphere Application Server - Express” on page 52.

Perform the following installation to install all features for the WebSphere Application Server - Express
product and to accept default characteristics for the application server profile.

1. Log on as root on a Linux or UNIX operating system, or as a member of the administrator group on a
Windows system.

-E'E. In addition, verify that the umask setting is 022. To verify the umask setting,
issue the following command:

umask
To set the umask setting to 022, issue the following command:
umask 022
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m Some steps of the installation on a Windows platform require the administrator group user
to have the following advanced user rights:

* Act as part of the operating system

* Log on as a service

For example, on some Windows systems, click Administrative Tools > Local Security Policy >

User Rights Assignments to see the advanced options. See your Windows documentation for more
information.

m The installation wizard grants your Windows user ID the advanced user rights, if the user
ID belongs to the administrator group. The silent installation does not grant these rights. If you create
a new user ID on a Windows platform to perform a silent installation, you must restart the system to
activate the proper authorizations for the user ID before you can perform a successful silent
installation.

m When installing the WebSphere Application Server as a Windows service, do not use a
user ID that contains spaces. A user ID with spaces cannot be validated. Such a user ID is not
allowed to continue the installation. To work around this problem, install with a user ID that does not
contain spaces, or do not choose to install Windows services.

2. Insert the product CD-ROM labeled WebSphere Application Server - Express into the CD-ROM
drive and mount the drive if necessary, as described in [Mounting CD-ROMS on Linux and UNIX|
[operating systems” on page 137/

3. Start the installation with the launchpad.sh command on Linux and UNIX platforms or the
launchpad.bat on Windows platforms.

You can also start the installation using the install command:

. BT \vAS/install
. T \waS\install

If you have a problem starting the launchpad, use the troubleshooting information in
[launchpad to start the installation” on page 39|to correct the problem.

When using the launchpad, launch the Installation wizard for Express server.

After launching the Installation wizard from the launchpad or from the command line, the InstallShield
MultiPlatform (ISMP) wizard initializes and then displays the Welcome panel.

4. Click Next to continue.

The license agreement displays.

5. Click the radio button beside the | accept the terms in the license agreement message to agree to
the license agreement, then click Next to continue.

After you accept the licensing terms, the Installation wizard checks for a supported operating system
and prerequisite patches.

If you encounter a problem such as not having the right prerequisite updates on your system, cancel
the installation, make the required changes, and restart the installation.

Although the Installation wizard checks for prerequisite operating system patches with the
prereqChecker application, review the prerequisites on the|IBM WebSphere Application Served
|supported hardware, software, and APIs Web site| if you have not already done so.

The Web site lists all supported operating systems and the operating system fixes and patches that
you must install to have a compliant operating system.

Refer to the documentation for non-IBM prerequisite and corequisite products to learn how to migrate
to their supported versions.

6. After confirming that your operating system is supported and that you have installed all necessary
patches, click Next to continue.

The Installation wizard checks for a previous installation at the same product level.
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If the wizard detects a previous installation, it displays the Existing installation panel. The panel lets
you add features to the existing installation, perform a new installation to another directory, or perform
an upgrade of a trial installation to the full product.

If a Version 6 product exists:

* See r‘lnstalling additional features on an existing Express installation” on page 113|for the
installation scenario that adds features to an existing product.

* See r‘Upgrading the Express trial to the Express product” on page 117|for the installation scenario
that upgrades a trial to the full Express product.

This scenario assumes that there is no existing V6 product on the machine.

The wizard displays a panel that prompts you for the location of the installation root directory for the
core product files.

Specify the destination of the installation root directory, then click Next.

Specify the location of the installation root directory for the core product files, which are also known
as the shared system files or the product binaries. The system files do not change unless you add
features; install service such as refresh packs, fix packs, or interim fixes; or install a product that
extends the Express product.

The following list shows default installation locations for supported platforms:

. -3_/usr/IBM/NebSphere/AppServer
. m m /opt/IBM/WebSphere/AppServer

. mc:\Program Files\IBM\WebSphere\AppServer

Important: Do not use symbolic links as the destination directory. Symbolic links are not supported.

-IEE- Spaces are not supported in the name of the installation directory on Linux
and UNIX systems.

Deleting the default target location and leaving an installation directory field empty prevents you from
continuing.

Non-ASCII special characters are not supported in the name of the installation directory.

The installer program checks for required space at the beginning of the installation. If you do not have

enough space, stop the installation program, free space by deleting unused files and emptying the
recycle bin, and restart the installation.

m The installation directory path must be no longer than 60 characters to successfully create
the application server profile on a Windows 2000 system.

The wizard displays the Installation options panel. The panel lets you choose whether to do a full
installation or a custom installation. A custom installation displays the Features selection panel. Use
the panel to select which features to install. This procedure documents using the full installation,
which does not display the Features selection panel..

Choose a type of installation, then click Next.

Select Full installation to install all features. Choose this option to install everything you need to run
Web applications on your serve. Use this option if you are new to WebSphere Application Server -
Express and are unsure of what to install.

The wizard displays the pre-installation summary panel for you to review before installing the product.

Review the summary information, then click Next to install the product code or Back to change your
specifications.

The Installation wizard creates the uninstaller program and then displays a progress panel that shows
which components are being installed. At the end of the installation, the wizard displays the
Installation completion panel.
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10. Verify the success of the installer program by examining the completion panel and the log files for

installation status.

If problems occur, consult the following applicable log files. See [Appendix B, “Troubleshooting|

[installation,” on page 291| for the complete list of log files.

Log files for WebSphere Application Server products: The following table shows the installation
logs, content, and indicators of success and failure for WebSphere Application Server products for

Version 6.

Table 4. Installation logs for WebSphere Application Server products

Log

Content

Indicators

install_root / 1ogs / log.txt

Logs all installation events

INSTCONFFAIL
Total installation failure.

INSTCONFSUCCESS
Successful installation.

INSTCONFPARTIALSUCCESS
Installation errors occurred but the
installation is still usable. Additional
information identifies the errors.

install_root / logs /
wasprofile / wasprofile _
create _ profile name.log

» Traces all events that occur
during the creation of the
named profile

» Created when using the Profile

creation wizard or the
wasprofile command

INSTCONFFAIL
Total profile creation failure.

INSTCONFSUCCESS
Successful profile creation.

INSTCONFPARTIALSUCCESS
Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

install_root / 1ogs /

wasprofile / wasprofile _

delete _ profile_name.log

» Traces all events that occur
during the deletion of the
named profile

+ Created when using the Profile

creation wizard or the
wasprofile command

INSTCONFFAIL
Total profile deletion failure.

INSTCONFSUCCESS
Successful profile deletion.

INSTCONFPARTIALSUCCESS
Profile deletion errors occurred but the
profile is still deleted. Additional
information identifies the errors.

install_root / profiles /
profile_name / logs /
pctlog.txt

Logs all profile creation events
that occur when using the Profile
creation wizard

INSTCONFFAIL
Total profile creation failure.

INSTCONFSUCCESS
Successful profile creation.

INSTCONFPARTIALSUCCESS
Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

If the installation of the core product files fails, fix the error and reinstall.
If the creation of a profile fails, fix the error and frun the Profile creation tool|to recreate the profile.

Troubleshoot the installation if the install_root/1ogs/10g.txt file or the
install_root/10gs/wasprofile/wasprofile_create_default.log file does not contain a record of any
problems, but problems exist.

See |Appendix B, “Troubleshooting

installation,” on page 291|and [‘Installation component

[troubleshooting tips” on page 307| for more information.
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2000 m Examine the Start menu entry. The menu is an indication of a successful
installation:

. m Programs > IBM WebSphere > Application Server, Express V6

. m All Programs > IBM WebSphere > Application Server, Express V6

If problems exist that cause you to reinstall the product, correct the errors, uninstall the product as
described in|Appendix A, “Uninstalling the product,” on page 271 | reboot a Windows machine or log
off and back on as root on a Linux or UNIX machine, and reinstall.

11. Click Finish to close the Installation wizard.

This procedure results in the Installation wizard installing WebSphere Application Server - Express into the
installation root directory. The Installation wizard creates a profile named default that provides the run-time
environment for the server1 application server.

Further configuration is not necessary at this time. However, you can create additional stand-alone
application servers with the Profile creation wizard. Each profile is created in the install_root/profiles
directory by default.

See [‘Using the Profile creation wizard” on page 211|for more information.

Deploy an application to get started!

See [‘Fast paths for WebSphere Application Server” on page 9 to get started deploying applications.

Installing Express with custom options

This topic describes how to use the custom installation path to install IBM WebSphere Application Server -
Express, Version 6.

This is one of the installation paths available for any platform. Other installation paths include:
« [“Installing Express with full installation options” on page 103

+ [“Installing additional features on an existing Express installation” on page 113

« [‘Upgrading the Express trial to the Express product’ on page 117

* [“Installing silently” on page 119

Select the appropriate installation path before you begin the installation.

Before starting the installation, see[‘Using the launchpad to start the installation” on page 39 for
information about the Installation solutions diagrams. The diagrams show typical topologies for the product.
The solutions are also in[“Planning to install WebSphere Application Server - Express” on page 52.

Perform the following installation to select features for the WebSphere Application Server - Express
product and to select characteristics for the application server profile.

1. Log on as root on a Linux or UNIX operating system, or as a member of the administrator group on a
Windows system.

-E'JE- In addition, verify that the umask setting is 022. To verify the umask setting,
issue the following command:

umask
To set the umask setting to 022, issue the following command:
umask 022
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m Some steps of the installation on a Windows platform require the administrator group user
to have the following advanced user rights:

* Act as part of the operating system

* Log on as a service

For example, on some Windows systems, click Administrative Tools > Local Security Policy >

User Rights Assignments to see the advanced options. See your Windows documentation for more
information.

m The installation wizard grants your Windows user ID the advanced user rights, if the user
ID belongs to the administrator group. The silent installation does not grant these rights. If you create
a new user ID on a Windows platform to perform a silent installation, you must restart the system to
activate the proper authorizations for the user ID before you can perform a successful silent
installation.

m When installing the WebSphere Application Server as a Windows service, do not use a
user ID that contains spaces. A user ID with spaces cannot be validated. Such a user ID is not
allowed to continue the installation. To work around this problem, install with a user ID that does not
contain spaces, or do not choose to install Windows services.

2. Insert the product CD-ROM labeled WebSphere Application Server - Express into the CD-ROM
drive and mount the drive if necessary, as described in [Mounting CD-ROMS on Linux and UNIX|
[operating systems” on page 137/

3. Start the installation with the launchpad.sh command on Linux and UNIX platforms or the
launchpad.bat on Windows platforms.

You can also start the installation using the install command:

. BT \vAS/install
. T \waS\install

If you have a problem starting the launchpad, use the troubleshooting information in
[launchpad to start the installation” on page 39|to correct the problem.

When using the launchpad, launch the Installation wizard for Express server.

After launching the Installation wizard from the launchpad or from the command line, the InstallShield
MultiPlatform (ISMP) wizard initializes and then displays the Welcome panel.

4. Click Next to continue.

The license agreement displays.

5. Click the radio button beside the | accept the terms in the license agreement message to agree to
the license agreement, then click Next to continue.

After you accept the licensing terms, the Installation wizard checks for a supported operating system
and prerequisite patches.

If you encounter a problem such as not having the right prerequisite updates on your system, cancel
the installation, make the required changes, and restart the installation.

Although the Installation wizard checks for prerequisite operating system patches with the
prereqChecker application, review the prerequisites on the|IBM WebSphere Application Served
|supported hardware, software, and APIs Web site| if you have not already done so.

The Web site lists all supported operating systems and the operating system fixes and patches that
you must install to have a compliant operating system.

Refer to the documentation for non-IBM prerequisite and corequisite products to learn how to migrate
to their supported versions.

6. After confirming that your operating system is supported and that you have installed all necessary
patches, click Next to continue.

The Installation wizard checks for a previous installation at the same product level.
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If the wizard detects a previous installation, it displays the Existing installation panel. The panel lets
you add features to the existing installation, perform a new installation to another directory, or perform
an upgrade of a trial installation to the full product.

If a Version 6 product exists:

* See r‘lnstalling additional features on an existing Express installation” on page 113|for the
installation scenario that adds features to an existing product.

* See r‘Upgrading the Express trial to the Express product” on page 117|for the installation scenario
that upgrades a trial to the full Express product.

This scenario assumes that there is no existing V6 product on the machine.
The wizard displays a panel that prompts you for the location of the installation root directory for the
core product files.

7. Specify the destination of the installation root directory, then click Next.

Specify the location of the installation root directory for the core product files, which are also known
as the shared system files or the product binaries. The system files do not change unless you add
features; install service such as refresh packs, fix packs, or interim fixes; or install a product that
extends the Express product.

The following list shows default installation locations for supported platforms:

. m/usr/IBM/NebSphere/AppServer
. m m /opt/IBM/WebSphere/AppServer

. mc:\Program Files\IBM\WebSphere\AppServer

Important: Do not use symbolic links as the destination directory. Symbolic links are not supported.

-EE. Spaces are not supported in the name of the installation directory on Linux
and UNIX systems.

Deleting the default target location and leaving an installation directory field empty prevents you from
continuing.

Non-ASCII special characters are not supported in the name of the installation directory.

The installer program checks for required space at the beginning of the installation. If you do not have
enough space, stop the installation program, free space by deleting unused files and emptying the
recycle bin, and restart the installation.

m The installation directory path must be no longer than 60 characters to successfully create
the application server profile on a Windows 2000 system.

The wizard displays the Installation options panel. The panel lets you choose whether to do a full
installation or a custom installation. A custom installation displays the Features selection panel. Use
the panel to select which features to install. This procedure documents using the full installation,
which does not display the Features selection panel..

8. Choose a type of installation, then click Next.
Select Custom installation to select features to install.
The wizard displays the Features selection panel.

9. Select features to install and click Next.

Table 5. Features for the Express product

Feature Description
Core product files Installs the product binary code.
Application Server Samples Installs the Sample applications.
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Table 5. Features for the Express product (continued)

Feature Description

Installs the Javadoc documentation of
Javadoc WebSphere Application Server -
Express classes.

Performance considerations

For better performance in either a development or production environment, do not install the
Samples. By omitting the Samples, you can improve application server startup time by 60 percent
and save 15 percent of disk space. You can save up to 30 percent of process footprint (based on a
maximum heap size of 256 MB).

10. Verify that the ports in the server that you are creating do not conflict with existing ports on the Ports
selection panel.
Use the netstat -a command to display all ports in use. Programs and products must run to use
ports. The netstat command only displays ports in use by active applications.
The Installation wizard displays the Node and host names panel.
11. Specify the node and host names for the application server and click Next.
A good practice is to use unique names for each application server that you create. However, unique
names are important only at the profile name level in the configuration directory.
Reserved names: Avoid using reserved folder names as field values. The use of reserved folder
names can cause unpredictable results. The following words are reserved:
« cells
* nodes
* servers
e clusters
* applications
* deployments
Field name Default value Constraints Description
Node name DefaultNode Avoid using reserved folder | Pick any name except for the reserved
names. names. To help organize your installation, use
a unique name if you plan to create more
than one application server on the machine.
However, a unique name for a stand-alone
application server is not required.
Host name DNS name of your | See the following Use the actual DNS name or IP address of
machine considerations for the host |your machine to enable communication with
name field. your machine. See additional information
about the host name following this table.
Node name considerations
m The installation directory path must be no longer than 60 characters.
Host name considerations
The host name is the network name for the physical machine on which the node is installed. The host
name must resolve to a physical network node on the server. When multiple network cards exist in
the server, the host name or IP address must resolve to one of the network cards. Remote nodes use
the host name to connect to and to communicate with this node. Selecting a host name that other
machines can reach within your network is extremely important. Do not use the generic localhost
identifier for this value.
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12.

13.

If you define coexisting nodes on the same computer with unique IP addresses, define each IP
address in a domain name server (DNS) look-up table. Configuration files for stand-alone Application
Servers do not provide domain name resolution for multiple IP addresses on a machine with a single
network address.

The value that you specify for the host name is used as the value of the hostName property in
configuration documents for the stand-alone Application Server. Specify the host name value in one of
the following formats:

* Fully qualified domain name servers (DNS) host name string, such as
xmachine.manhattan.ibom.com

* The default short DNS host name string, such as xmachine
* Numeric IP address, such as 127.1.255.3

The fully qualified DNS host name has the advantage of being totally unambiguous and also flexible.
You have the flexibility of changing the actual IP address for the host system without having to
change the Application Server configuration. This value for host name is particularly useful if you plan
to change the IP address frequently when using Dynamic Host Configuration Protocol (DHCP) to
assign IP addresses. A format disadvantage is being dependent on DNS. If DNS is not available, then
connectivity is compromised.

The short host name is also dynamically resolvable. A short name format has the added ability of
being redefined in the local hosts file so that the system can run the Application Server even when
disconnected from the network. Define the short name to 127.0.0.1 (local loopback) in the hosts file to
run disconnected. A format disadvantage is being dependent on DNS for remote access. If DNS is not
available, then connectivity is compromised.

A numeric IP address has the advantage of not requiring name resolution through DNS. A remote
node can connect to the node you name with a numeric IP address without DNS being available. A
format disadvantage is that the numeric IP address is fixed. You must change the setting of the
hostName property in Express configuration documents whenever you change the machine IP
address. Therefore, do not use a numeric IP address if you use DHCP, or if you change IP addresses
regularly. Another format disadvantage is that you cannot use the node if the host is disconnected
from the network.

m After specifying application server characteristics, the wizard displays the Windows
service definition panel, if you are installing on a Windows platform.

m Choose whether to run the application server as a Windows service on a Windows
platform and click Next.

Version 6 attempts to start Windows services for application server processes started by a
startServer command. For example, if you configure an application server as a Windows service and
issue the startServer command, the wasservice command attempts to start the defined service.

If you chose to install a local system service, you do not have to specify your user ID or password. If
you create a specified user type of service, you must specify the user ID and the password for the
user who is to run the service. The user must have Log on as a service authority for the service to
run properly.

To perform this installation task, the user ID must not have spaces in its name. The ID must also
belong to the administrator group and must have the advanced user rights Act as part of the
operating system and Log on as a service. The Installation wizard grants the user ID the advanced
user rights if it does not already have them, if the user ID belongs to the administrator group.

You can also create other Windows services after the installation is complete, to start other server
processes. See the Administration: Setting up PDF for more information.

The installation wizard shows which components are selected for installation in a pre-installation
summary panel.

Review the summary information, then click Next to install the product code or Back to change your
specifications.
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The Installation wizard creates the uninstaller program and then displays a progress panel that shows
which components are being installed. At the end of the installation, the wizard displays the
Installation completion panel.

14. Verify the success of the installer program by examining the completion panel and the log files for

installation status.

If problems occur, consult the following applicable log files. See IAppendix B, “Troubleshooting|

installation,” on page 291 for the complete list of log files.

Log files for WebSphere Application Server products: The following table shows the installation
logs, content, and indicators of success and failure for WebSphere Application Server products for

Version 6.

Table 6. Installation logs for WebSphere Application Server products

Log

Content

Indicators

install_root / 1ogs / log.txt

Logs all installation events

INSTCONFFAIL
Total installation failure.

INSTCONFSUCCESS
Successful installation.

INSTCONFPARTIALSUCCESS
Installation errors occurred but the
installation is still usable. Additional
information identifies the errors.

install_root / 1ogs /

wasprofile / wasprofile _

create _ profile_name.log

Traces all events that occur
during the creation of the
named profile

Created when using the Profile
creation wizard or the
wasprofile command

INSTCONFFAIL
Total profile creation failure.

INSTCONFSUCCESS
Successful profile creation.

INSTCONFPARTIALSUCCESS
Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

install_root / 1ogs /
wasprofile / wasprofile _
delete _ profile_name.log

Traces all events that occur
during the deletion of the
named profile

Created when using the Profile
creation wizard or the
wasprofile command

INSTCONFFAIL
Total profile deletion failure.

INSTCONFSUCCESS
Successful profile deletion.

INSTCONFPARTIALSUCCESS
Profile deletion errors occurred but the
profile is still deleted. Additional
information identifies the errors.

install_root / profiles /
profile name / logs /
pctLog.txt

Logs all profile creation events
that occur when using the Profile
creation wizard

INSTCONFFAIL
Total profile creation failure.

INSTCONFSUCCESS
Successful profile creation.

INSTCONFPARTIALSUCCESS
Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

If the installation of the core product files fails, fix the error and reinstall.
If the creation of a profile fails, fix the error and frun the Profile creation tool| to recreate the profile.
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Troubleshoot the installation if the install_root/1ogs/10g.txt file or the
install_root/10gs/wasprofile/wasprofile create default.log file does not contain a record of any
problems, but problems exist.

See Appendix B, “Troubleshooting installation,” on page 291| and [‘Installation component
Itroubleshooting tips” on page 307| for more information.

[ 2000 m Examine the Start menu entry. The menu is an indication of a successful
installation:

- ET Programs > IBM WebSphere > Application Server, Express V6

. m All Programs > IBM WebSphere > Application Server, Express V6

If problems exist that cause you to reinstall the product, correct the errors, uninstall the product as
described in|Appendix A, “Uninstalling the product,” on page 271 | reboot a Windows machine or log
off and back on as root on a Linux or UNIX machine, and reinstall.

15. Click Finish to close the Installation wizard.

This procedure results in the Installation wizard installing WebSphere Application Server - Express into the
installation root directory. The Installation wizard creates a profile named default that provides the run-time
environment for the server1 application server.

Further configuration is not necessary at this time. However, you can create additional stand-alone
application servers with the Profile creation wizard. Each profile is created in the install_root/profiles
directory by default.

See [‘Using the Profile creation wizard” on page 211|for more information.

Installing additional features on an existing Express installation

This topic describes how to install additional features to an existing IBM WebSphere Application Server -
Express, Version 6 installation.

This procedure is one of the installation paths available for any platform. Other installation paths include:
« [“Installing Express with full installation options” on page 103

« [“Installing Express with custom options” on page 107|

« [‘Upgrading the Express trial to the Express product’ on page 117

+ [“Installing silently” on page 119

Select the appropriate installation path before you begin the installation.

Before starting the installation, see[‘Using the launchpad to start the installation” on page 39 for
information about the Installation solutions diagrams. The diagrams show typical topologies for the product.
The solutions are shadowed in r‘PIanning to install WebSphere Application Server - Express” on page 52| in
the information center.

Perform the following installation to add features to an existing WebSphere Application Server - Express
installation.

1. Log on as root on a Linux or UNIX operating system, or as a member of the administrator group on a
Windows system.

-E'E- In addition, verify that the umask setting is 022. To verify the umask setting,
issue the following command:

umask
To set the umask setting to 022, issue the following command:
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umask 022

m Some steps of the installation on a Windows platform require the administrator group user
to have the following advanced user rights:

* Act as part of the operating system

* Log on as a service

For example, on some Windows systems, click Administrative Tools > Local Security Policy >

User Rights Assignments to see the advanced options. See your Windows documentation for more
information.

m The installation wizard grants your Windows user ID the advanced user rights, if the user
ID belongs to the administrator group. The silent installation does not grant these rights. If you create
a new user ID on a Windows platform to perform a silent installation, you must restart the system to
activate the proper authorizations for the user ID before you can perform a successful silent
installation.

m When installing the WebSphere Application Server as a Windows service, do not use a
user ID that contains spaces. A user ID with spaces cannot be validated. Such a user ID is not
allowed to continue the installation. To work around this problem, install with a user ID that does not
contain spaces, or do not choose to install Windows services.

2. Insert the product CD-ROM labeled WebSphere Application Server - Express into the CD-ROM
drive and mount the drive if necessary, as described in [Mounting CD-ROMS on Linux and UNIX|
[operating systems” on page 137

3. Start the installation with the launchpad.sh command on Linux and UNIX platforms or the
launchpad.bat on Windows platforms.

You can also start the installation using the install command:

. BT /\AS/install
. T \waS\install

If you have a problem starting the launchpad, use the troubleshooting information in
[launchpad to start the installation” on page 39|to correct the problem.

When using the launchpad, launch the Installation wizard for Express server.

After launching the Installation wizard from the launchpad or from the command line, the InstallShield
MultiPlatform (ISMP) wizard initializes and then displays the Welcome panel.

4. Click Next to continue.
The license agreement displays.

5. Click the radio button beside the | accept the terms in the license agreement message to agree to
the license agreement, then click Next to continue.
After you accept the licensing terms, the Installation wizard checks for a supported operating system
and prerequisite patches.
If you encounter a problem such as not having the right prerequisite updates on your system, cancel
the installation, make the required changes, and restart the installation.
Although the Installation wizard checks for prerequisite operating system patches with the
prereqChecker application, review the prerequisites on the|IBM WebSphere Application Served
|supported hardware, software, and APls Web sitel if you have not already done so.
The Web site lists all supported operating systems and the operating system fixes and patches that
you must install to have a compliant operating system.
Refer to the documentation for non-IBM prerequisite and corequisite products to learn how to migrate
to their supported versions.

6. After confirming that your operating system is supported and that you have installed all necessary
patches, click Next to continue.

The Installation wizard checks for a previous installation at the same product level.
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This task describes the scenario where a previous installation exists and you are adding features with
an incremental installation.

If the wizard detects a previous installation, it displays the Existing installation panel. The panel lets
you add features to the existing installation, perform a new installation to another directory, or perform
an upgrade of a trial installation to the full product.

7. Install additional features. Click Next to continue to the Features selection panel.
Do not change the installation directory unless another existing installation is in another directory. An
incremental installation adds features to the shared binaries identified in the location field.
You can add features to the binaries at any time, by running the Installation wizard again. Installing
additional features does not affect profiles that you might have already created. (Profiles are run-time
environments that are described in a later step.)
When adding features during an incremental installation, the wizard displays the Features selection
panel.
8. Select features to install and click Next.
Table 7. Features for the Express product
Feature Description
Core product files Installs the product binary code.
Application Server Samples Installs the Sample applications.

Installs the Javadoc documentation of
Javadoc WebSphere Application Server -
Express classes.

Performance considerations

For better performance in either a development or production environment, do not install the
Samples. By omitting the Samples, you can improve application server startup time by 60 percent
and save 15 percent of disk space. You can save up to 30 percent of process footprint (based on a
maximum heap size of 256 MB).

Review the summary information and click Next to install the product code or Back to change your
specifications.

The disk space shown on the pre-installation summary panel includes space for the Java Virtual
Machine (JVM). Subtract the size of the JVM for your operating system to determine the installed size
on disk for the features that you selected.

Table 8. JVM sizes

AIX HP-UX Linux Solaris Windows
59 MB pa-risc: 109 MB ia32: 83 MB 81 MB ia32: 75 MB
64 bit: 137 MB 64 bit: 133 MB 64 bit: 71 MB

Verify that you have the total amount of free space shown before installing. Space is required for a
working copy of the JVM during the installation.
The Installation wizard creates the uninstaller program and then displays a progress panel that shows
which components are being installed. At the end of the installation, the wizard displays the
Installation completion panel.
At the end of the installation, the wizard displays the Installation completion panel.

10. Verify the success of the installer program by examining the completion panel and the log files for

installation status.

If problems occur, consult the following applicable log files. See IAppendix B, “Troubleshooting|
installation,” on page 291| for the complete list of log files.

Chapter 9. Installing the product and additional software 115



Log files for WebSphere Application Server products: The following table shows the installation
logs, content, and indicators of success and failure for WebSphere Application Server products for

Version 6.

Table 9. Installation logs for WebSphere Application Server products

Log

Content

Indicators

install_root / 1ogs / log.txt

Logs all installation events

INSTCONFFAIL
Total installation failure.

INSTCONFSUCCESS
Successful installation.

INSTCONFPARTIALSUCCESS
Installation errors occurred but the
installation is still usable. Additional
information identifies the errors.

install_root / logs /
wasprofile / wasprofile _
create _ profile_name.log

Traces all events that occur
during the creation of the
named profile

Created when using the Profile

creation wizard or the
wasprofile command

INSTCONFFAIL
Total profile creation failure.

INSTCONFSUCCESS
Successful profile creation.

INSTCONFPARTIALSUCCESS
Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

install_root / logs /
wasprofile / wasprofile _
delete _ profile_name.log

Traces all events that occur
during the deletion of the
named profile

Created when using the Profile

creation wizard or the
wasprofile command

INSTCONFFAIL
Total profile deletion failure.

INSTCONFSUCCESS
Successful profile deletion.

INSTCONFPARTIALSUCCESS
Profile deletion errors occurred but the
profile is still deleted. Additional
information identifies the errors.

install_root / profiles /
profile_name / logs /
pctLog.txt

Logs all profile creation events
that occur when using the Profile
creation wizard

INSTCONFFAIL
Total profile creation failure.

INSTCONFSUCCESS
Successful profile creation.

INSTCONFPARTIALSUCCESS
Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

If the installation of the core product files fails, fix the error and reinstall.
If the creation of a profile fails, fix the error and [run the Profile creation tool| to recreate the profile.

Troubleshoot the installation if the install_root/10gs/10g.txt file or the
install_root/10gs/wasprofile/wasprofile create default.log file does not contain a record of any
problems, but problems exist.

See |Appendix B, “Troubleshooting

installation,” on page 291|and [‘Installation componentf

[troubleshooting tips” on page 30

for more information.

[ 2000 m Examine the Start menu entry. The menu is an indication of a successful

installation:

- ET Programs > IBM WebSphere > Application Server, Express V6
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. m All Programs > IBM WebSphere > Application Server, Express V6

If problems exist that cause you to reinstall the product, correct the errors, uninstall the product as
described in|Appendix A, “Uninstalling the product,” on page 271,[reboot a Windows machine or log
off and back on as root on a Linux or UNIX machine, and reinstall.

11. Click Finish to close the Installation wizard.

The Installation wizard installs the new features in the existing installation root directory. The Installation
wizard configures the WebSphere Application Server - Express product for the new features.

Further configuration is not necessary at this time. However, you can create additional stand-alone
application servers with the Profile creation wizard. Each profile is created in the install_root/profiles
directory by default.

See [‘Using the Profile creation wizard” on page 211|for more information.

Upgrading the Express trial to the Express product

This topic describes how to upgrade a trial installation of the Express product to the actual Express
product.

This is one of the installation paths available for any platform. Other installation paths include:
+ [“Installing Express with full installation options” on page 103

+ [“Installing Express with custom options” on page 107|

+ [“Installing additional features on an existing Express installation” on page 113

+ [“Installing silently” on page 119

Select the appropriate installation path before you begin the installation.

Before starting the installation, see[‘Using the launchpad to start the installation” on page 39 for
information about the Installation solutions diagrams. The diagrams show typical topologies for the product.
The solutions are also in[“Planning to install WebSphere Application Server - Express” on page 52.

Perform the following installation to upgrade a trial installation to the actual WebSphere Application Server
- Express product.

1. Log on as root on a Linux or UNIX operating system, or as a member of the administrator group on a
Windows system.

-E'JE- In addition, verify that the umask setting is 022. To verify the umask setting,
issue the following command:

umask
To set the umask setting to 022, issue the following command:
umask 022

m Some steps of the installation on a Windows platform require the administrator group user
to have the following advanced user rights:

* Act as part of the operating system
* Log on as a service

For example, on some Windows systems, click Administrative Tools > Local Security Policy > User
Rights Assignments to see the advanced options. See your Windows documentation for more
information.

m The installation wizard grants your Windows user ID the advanced user rights, if the user
ID belongs to the administrator group. The silent installation does not grant these rights. If you create a
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new user ID on a Windows platform to perform a silent installation, you must restart the system to
activate the proper authorizations for the user ID before you can perform a successful silent
installation.

m When installing the WebSphere Application Server as a Windows service, do not use a
user ID that contains spaces. A user ID with spaces cannot be validated. Such a user ID is not allowed
to continue the installation. To work around this problem, install with a user ID that does not contain
spaces, or do not choose to install Windows services.

2. Insert the product CD-ROM labeled WebSphere Application Server - Express into the CD-ROM
drive and mount the drive if necessary, as described in[‘Mounting CD-ROMS on Linux and UNIX|
foperating systems” on page 137

3. Start the installation with the launchpad.sh command on Linux and UNIX platforms or the
launchpad.bat on Windows platforms.

You can also start the installation using the install command:

. BT /\WAs/install
. BT \waS\nstall

If you have a problem starting the launchpad, use the troubleshooting information in
faunchpad to start the installation” on page 39|to correct the problem.

When using the launchpad, launch the Installation wizard for Express server.

After launching the Installation wizard from the launchpad or from the command line, the InstallShield
MultiPlatform (ISMP) wizard initializes and then displays the Welcome panel.

4. Click Next to continue.
The license agreement displays.

5. Click the radio button beside the | accept the terms in the license agreement message to agree to
the license agreement, then click Next to continue.

After you accept the licensing terms, the Installation wizard checks for a supported operating system
and prerequisite patches.

If you encounter a problem such as not having the right prerequisite updates on your system, cancel
the installation, make the required changes, and restart the installation.

Although the Installation wizard checks for prerequisite operating system patches with the
prereqChecker application, review the prerequisites on the [[BM WebSphere Application Server]
lsupported hardware, software, and APls Web site|if you have not already done so.

The Web site lists all supported operating systems and the operating system fixes and patches that
you must install to have a compliant operating system.

Refer to the documentation for non-IBM prerequisite and corequisite products to learn how to migrate
to their supported versions.

6. After confirming that your operating system is supported and that you have installed all necessary
patches, click Next to continue.

The Installation wizard checks for a previous installation at the same product level.

If the wizard detects a previous installation, it displays the Existing installation panel. The panel lets
you add features to the existing installation, perform a new installation to another directory, or perform
an upgrade of a trial installation to the full product.

This task describes the scenario where a previous installation of the Express Trial exists and you are
installing the actual Express product to upgrade the trial.

Select the Upgrade option and click Next. The installer program installs the new license files and
updates the system properties to indicate that the actual product is installed.

The wizard completes the upgrade and exits at then end of the upgrade without presenting another panel.
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This procedure results in upgrading a trial installation to the actual WebSphere Application Server -
Express product.

You can install the Express product again to add features. Or you can use the Profile creation wizard to
create more stand-alone application servers.

Further configuration is not necessary at this time. However, you can create additional stand-alone
application servers with the Profile creation wizard. Each profile is created in the install_root/profiles
directory by default.

See [‘Using the Profile creation wizard” on page 211|for more information.

If you have already created the topology that you require, try deploying an application in your environment.

Deploy an application to get started!

See [‘Fast paths for WebSphere Application Server” on page 9 to get started deploying applications.

Installing silently

This topic describes how to perform a silent installation of the product.

This is one of the installation paths available for any platform. Other installation paths include:
+ [“Installing Express with full installation options” on page 103

+ [“Installing Express with custom options” on page 107|

+ [“Installing additional features on an existing Express installation” on page 113

+ [“‘Upgrading the Express trial to the Express product” on page 117

Select the appropriate installation path before you begin the installation.

Before starting the silent installation, see [‘Using the launchpad to start the installation” on page 39| for
information about the Installation solution diagrams. The diagrams show typical topologies for the product.

The solutions are also in[“Planning to install WebSphere Application Server - Express” on page 52.

Use this procedure to perform a silent installation of the WebSphere Application Server - Express product.

A silent installation uses the Installation wizard to install the product in silent mode, without the graphical
user interface. Instead of displaying a wizard interface, the silent installation causes the installation
program to read all of your responses from a file that you provide.

1. Log on as root on a Linux or UNIX operating system, or as a member of the administrator group on a
Windows system.

-EE- In addition, verify that the umask setting is 022. To verify the umask setting,
issue the following command:

umask
To set the umask setting to 022, issue the following command:
umask 022

m Some steps of the installation on a Windows platform require the administrator group user
to have the following advanced user rights:

* Act as part of the operating system
* Log on as a service
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For example, on some Windows systems, click Administrative Tools > Local Security Policy > User
Rights Assignments to see the advanced options. See your Windows documentation for more
information.

m The installation wizard grants your Windows user ID the advanced user rights, if the user
ID belongs to the administrator group. The silent installation does not grant these rights. If you create a
new user ID on a Windows platform to perform a silent installation, you must restart the system to
activate the proper authorizations for the user ID before you can perform a successful silent
installation.

m When installing the WebSphere Application Server as a Windows service, do not use a
user ID that contains spaces. A user ID with spaces cannot be validated. Such a user ID is not allowed
to continue the installation. To work around this problem, install with a user ID that does not contain
spaces, or do not choose to install Windows services.

2. Copy the response file as myoptionsfile to your disk drive and customize it, as described in
['‘Customizing the options response file for Express” on page 122

The name of the original file is [‘responsefile.express.txt” on page 130

3. Issue the proper command to use your custom response file. For example, issue one of the following
commands:

. mmnt_cdrom/WAS/instaH -options /tmp/WAS/myoptionsfile.txt -silent

. m "CD_drive_D:\WAS\install” -options "C:\temp\WAS\myoptionsfile.txt” -silent
You can find the sample options response file in the WAS directory on the product CD.

The Installation wizard and the Profile creation wizard record installation events in the following log files:

Log files for WebSphere Application Server products: The following table shows the installation logs,
content, and indicators of success and failure for WebSphere Application Server products for Version 6.

Table 10. Installation logs for WebSphere Application Server products

Log Content Indicators

install_root / logs / log.txt Logs all installation events INSTCONEFAIL

Total installation failure.

INSTCONFSUCCESS
Successful installation.

INSTCONFPARTIALSUCCESS
Installation errors occurred but the
installation is still usable. Additional
information identifies the errors.

install_root / 1ogs / + Traces all events that occur INSTCONFFAIL

wasprofile / wasprofile _ during the creation of the Total profile creation failure

create _ profile_name.log named profile ’
INSTCONFSUCCESS

« Created when using the Profile
creation wizard or the
wasprofile command INSTCONFPARTIALSUCCESS

Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

Successful profile creation.
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Table 10. Installation logs for WebSphere Application Server products (continued)

Log Content Indicators
install_root / Togs / + Traces all events that occur INSTCONFFAIL
wasprofile / wasprofile _ during the deletion of the Total profile deletion failure
delete _ profile_name.log named profile '

INSTCONFSUCCESS

» Created when using the Profile Successful profile deletion.

creation wizard or the
wasprofile command INSTCONFPARTIALSUCCESS

Profile deletion errors occurred but the

profile is still deleted. Additional
information identifies the errors.

msta(l_root / profiles / Logs all profile crealltlon events. INSTCONEFAIL
profile_name / logs / that occur when using the Profile Total orofile creation failure
pctlLog.txt creation wizard P )
INSTCONFSUCCESS
Successful profile creation.
INSTCONFPARTIALSUCCESS

Profile creation errors occurred but the

profile is still functional. Additional
information identifies the errors.

Log more information when InstallShield for MultiPlatforms (ISMP) cannot start the Installation

wizard.

Verify or troubleshoot the installation if the install_root/1ogs/10g.txt file or the

profiles_install_root/profile_name/logs/pctLog.txt file does not contain a record of any problems, but

problems exist. If the profiles_install_root/profile_name directory exists, the pctlLog. txt file is in the Togs
directory. If the error happens early in the installation, look for the logs in the system temporary area. The
installation program copies the logs from the system temporary area to the 1ogs directory at the end of the

installation.

If the profiles_install_root/profile_name directory does not exist, the pctlLog.txt file is in the USER_HOME
directory and is named .$%pctlLog.txt. Issue the env command to display the USER_HOME directory on
Linux and UNIX systems. See the environment variable settings on Windows system to display the value

of the variable.

Certain events can prevent ISMP from starting the Installation wizard. Such an event is not enough disk
space to launch the Installation wizard, for example. If your installation fails and there is no information in
the installation logs, use the -log parameter to record entries for events that cause the ISMP program to

fail to start the installation wizard. The syntax of the install command for logging such events is:

install -options fully qualified options_response_file_name
-silent
-log # !fully_qualified_log_file_name @ALL

The following example is for AIX systems:
install -options "/usr/IBM/WebSphere/silentFiles/myresponsefile.txt"
-silent -log # !/usr/IBM/WebSphere/myOptionFiles/log.txt @ALL
The following example is for Linux systems, HP-UX systems, and Solaris systems:
install -options "/opt/IBM/WebSphere/silentFiles/myresponsefile.txt"
-silent -log # !/opt/IBM/WebSphere/myOptionFiles/log.txt @ALL

The following example is for Windows systems:
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install.exe -options "C:\IBM\WebSphere\silentFiles\myresponsefile.txt"
-silent -log # !C:\IBM\WebSphere\silentFiles\log.txt @ALL

Customizing the options response file for Express

This topic describes how to customize the response file for installing the WebSphere Application Server -
Express product from a command line without using the graphical user interface of the Installation wizard.

Before using the install -options myoptionsfile -silent command on a Linux or UNIX platform, or the
install.exe -options myoptionsfile -silent command on a Windows platform to invoke a silent
installation, you must customize the response file to add your selections.

Use the response file to supply values to the Installation wizard as the wizard runs in silent mode. The
wizard does not display interactive panels when it runs in silent mode, but reads values from the response
file instead.

Be precise when supplying values in the file: Customize the options response file precisely to let the
installation program read the option values that the file contains. Incorrect specifications affect the silent
interface of the Installation wizard. For example, always enclose values in double quotation marks.

If you customize the response file incorrecily, the Installation wizard cannot install the product with the
-options or -silent parameters. If the error is an invalid option value, ISMP displays a warning message
that you must confirm and stops the installation.

Compare your options response file to the responsefile.express.txt file that is shipped with the product
to make the necessary corrections. After correcting the file, reinstall.

Guidance: The options response file has comments that describe each directive in the file. Read the
explanations in the file to further understand the purpose of each directive.

See [‘responsefile.express.txt” on page 130| for an example of the comments and directives in the response

file.

Use the following description of options as a worksheet to plan your values. Refer to the individual
descriptions of directives in the following list to help plan your responses:

-W silentInstalllLicenseAcceptance.value="false"

# -W detectedexistingcopypanelInstallWizardBean.choice="addFeatures"

Platform specific: -P wasProductBean.installlLocation="/usr/IBM/WebSphere/AppServer"

Platform specific: -P wasProductBean.installlLocation="/opt/IBM/WebSphere/AppServer"

Platform specific: -P wasProductBean.installLocation="C:\Program Files\IBM\WebSphere\AppServer"

# -W detectedexistingcopypanelInstallWizardBean.choice ="upgrade"

# -W detectedexistingcopypanelInstallWizardBean.upgradeMatchInstalllLocations = "EXPRESS TRIAL INSTALL
setuptypepanelInstallWizardBean.selectedSetupTypeld="Custom"

-W
-P
-P
-W
-W
-W
-W
-W
-W
-W
-W
-W
-W
-W
-W
-W
-W
-W
-W

samplesProductFeatureBean.active="true"
javadocsProductFeatureBean.active="true"
defaultprofileportspanelInstallWizardBean
defaultprofileportspanelInstallWizardBean

defaultprofileportspanelInstallWizardBean

defaultprofileportspanelInstallWizardBean

.WC_defaulthost="9080"
.WC_adminhost="9060"

defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstalllWizardBean. _SSL_ o
.CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS="9402"
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
.SIB_MQ_ENDPOINT_SECURE_ADDRESS="5578"
nodehostandcellnamepanelInstallWizardBean.
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WC_defaulthost_secure="9443"
WC_adminhost_secure="9043"
BOOTSTRAP_ADDRESS="2809"
SOAP_CONNECTOR_ADDRESS="8880"
SAS_SSL_SERVERAUTH_LISTENER ADDRESS="9401"
CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS="9403"

ORB_LTSTENER ADDRESS="9100"
DCS_UNICAST ADDRESS="9353"
SIB_ENDPOINT ADDRESS="7276"
SIB_ENDPOINT SECURE_ADDRESS="7286"
SIB_MQ_ENDPOINT ADDRESS="5558"

nodeName="nodeName"
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-W nodehostandcelTnamepanelInstallWizardBean.hostName="hostName"
-W winservicepanelInstallWizardBean.winServiceQuery="true"
-W winservicepanelInstallWizardBean.accountType="1ocalsystem"

Platform specific:
Platform specific:
Platform specific:
Platform specific:
Platform specific:

-W winservicepanelInstallWizardBean.startupType="manual"

-W winservicepanelInstallWizardBean.userName="YOUR_USER_NAME"
-W winservicepanelInstallWizardBean.password="YOUR_PASSWORD"

-W silentinstallLicenseAcceptance.value="false"”
Valid values are true or false. You must accept the license agreement before you are allowed to
install the product.

Default value

Description

Your value

false

By changing the silentinstallLicenseAcceptance.value in this
response file to "true”, you agree that you have reviewed and
agree to the terms of the IBM International Program License
Agreement accompanying this program, which is located at
CD_ROOT\WAS\lafiles. If you do not agree to these terms, do
not change the value or otherwise download, install, copy,
access, or use the program and promptly return the program
and proof of entitlement to the party from whom you acquired
it to obtain a refund of the amount you paid.

Change the value to true to accept the license agreement and
install the product. You cannot install the product with the
default value.

-W detectedexistingcopypanellnstallWizardBean.choice= "addFeatures”
The only valid value for this directive is addFeatures. Leave the line commented if you are not

adding features to a previous installation.

Default value

Description

Your value

Commented out

Uncomment the line to add features to an existing installation
in an incremental migration.

Change the value of the following -P
wasProductBean.installLocation= directive to the directory of
the existing installation.

To avoid problems, set the feature active properties for
currently installed features to false. To install a new feature,
set the feature active property to true.

For example, suppose that you have an existing installation of
the product with the Javadocs feature installed, but not the
Samples feature. To install the Samples feature, set the
following directives accordingly:

» -P samplesProductFeatureBean.active="true”
» -P javadocsProductFeatureBean.active="false”

The feature selection options are described after the
installation type option.

-P wasProductBean.installLocation=

. -JE- -P wasProductBean.installLocation= "/usr/IBM/WebSphere/AppServer”

m m -P wasProductBean.installLocation=

"lopt/IBM/WebSphere/AppServer”
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. m -P wasProductBean.installLocation= "C:\Program Files\IBM\WebSphere\AppServer”

Default value Description Your value
Varies per The installation root directory for the product. Specify a valid
product disc directory unless you are upgrading. If you are upgrading,

comment this directive.

The default installation location is for a Windows system.
Comment the Windows line to install on a Linux or UNIX
operating system.

Uncomment the line that describes your platform and optionally
change the location. The installation path must be 80
characters or less.

Important: Do not use symbolic links as the destination
directory. Symbolic links are not supported.

m Spaces are also not supported in the

name of the installation directory.

m On a Windows system, the directory can contain
spaces. Enclose a directory name with spaces within double
quotation marks as shown in the Windows example.

m To create a profile successfully on Windows
systems during product installation, the installation directory
path must be no longer than 60 characters. The C:\Program
Files\IBM\WebSphere\AppServer path is 40 characters, for
example. If you use a name longer than 60 characters, shorten
the values of the node name and the cell name directives.

-W detectedexistingcopypanellnstallWizardBean.choice ="upgrade”
The only valid value is upgrade.

Default value Description Your value

Commented out | Leave this directive commented if you do not have a trial
installation that you intend to upgrade.

Uncomment the line to upgrade the configuration and
applications of a product trial installation to the actual
WebSphere Application Server - Express product that you are
installing.

You must also use the next directive to specify the location of
the existing trial.

-W detectedexistingcopypanellnstallWizardBean.upgradeMatchinstallLocations = "EXPRESS TRIAL
INSTALL LOCATION"
The only valid value is the absolute file path to the installation root directory of the trial Express
product.
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Default value Description Your value

Commented out | Leave this directive commented if you are not upgrading an
existing trial to the actual Express product that you are
installing.

Uncomment the line to upgrade the product trial installation to
the WebSphere Application Server - Express product. Replace
the value "EXPRESS TRIAL INSTALL LOCATION" with the
installation root directory of the existing trial.

During an upgrade, all other installation options are ignored.
Only the upgrade occurs.

-W setuptypepanelinstallWizardBean.selectedSetupTypeld="Custom”
The only valid value is Custom.

Default value Description Your value

Typical Do not change the value of this directive.

A custom installation of the Express product is required when
using an options response file. A custom installation accepts
values for all of the options that you have specified in the
response file.

-P samplesProductFeatureBean.active="true”
Valid values are true or false.

Default value Description Your value

true This option installs the Samples feature.

Change the value to false to skip the installation of the Samples
feature.

Change the value to false during an incremental installation if
the Samples feature is already installed.

Do not use a value of true if the Samples feature is already
installed.

-P javadocsProductFeatureBean.active="true"”
Valid values are true or false.

Default value |Description Your value

true This option installs the Javadocs feature.

Change the value to false to skip the installation of the Javadocs
feature.

Change the value to false during an incremental installation if the
Javadocs feature is already installed.

Do not use a value of true if the Javadocs feature is already
installed.

-W defaultprofileportspanelinstallWizardBean.WC_*=*
The following port assignment directives use default values. It is your responsibility to specify
values that are not in conflict with other ports in use on your operating system. Use the netstat -a
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command to display ports in use on your system. The resulting display shows ports in use at the
current time. If applications or products are not running, the ports that they use do not appear in
the list.

Default port assignments are shown in the following list:

-W defaultprofileportspanelInstallWizardBean.WC defaulthost="9080"

-W defaultprofileportspanelInstallWizardBean.WC_adminhost="9060"

-W defaultprofileportspanelInstallWizardBean.WC defaulthost secure="9443"
-W defaultprofileportspanelInstallWizardBean.WC adminhost secure="9043"

-W defaultprofileportspanelInstallWizardBean.BOOTSTRAP_ADDRESS="2809"

-W defaultprofileportspanelInstallWizardBean.SOAP_CONNECTOR_ADDRESS="8880"

defaultprofileportspanelInstallWizardBean.SAS SSL SERVERAUTH LISTENER ADDRESS="9401"
-W
defaultprofileportspanelInstallWizardBean.CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS="9403"
-W
defaultprofileportspanelInstallWizardBean.CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS="9402"
-W defaultprofileportspanelInstallWizardBean.ORB_LISTENER_ADDRESS="9100"

-W defaultprofileportspanelInstallWizardBean.DCS_UNICAST_ADDRESS="9353"

-W defaultprofileportspanelInstallWizardBean.SIB_ENDPOINT ADDRESS="7276"

-W defaultprofileportspanelInstallWizardBean.SIB_ENDPOINT SECURE_ADDRESS="7286"

-W defaultprofileportspanelInstallWizardBean.SIB_MQ_ENDPOINT_ADDRESS="5558"

-W defaultprofileportspanelInstallWizardBean.SIB_MQ_ENDPOINT_ SECURE_ADDRESS="5578"

Default value Description Your value

WC_defaulthost="9080" Default port assignment for the virtual

host named defaulthost. This virtual
host serves Samples and the default
application, including the snoop
servlet.

WC_adminhost="9060" Default port assignment for the virtual

host named adminhost. This virtual
host serves the administrative
console application.

WC_defaulthost_secure="9443" Secure port assignment for the
defaulthost.

WC_adminhost_secure="9043" Secure port assignment for the
adminhost.

126 1BM WebSphere Application Server - Express, Version 6: Installing your application serving environment




Default value

Description

Your value

BOOTSTRAP_ADDRESS="2809"

SOAP_CONNECTOR_ADDRESS="8880"

SAS_SSL_SERVERAUTH_LISTENER_ADDRESS="9401"

CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS="9403"

CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS="9402"

ORB_LISTENER_ADDRESS="9100"

DCS_UNICAST_ADDRESS="9353"

SIB_ENDPOINT_ADDRESS="7276"

SIB_ENDPOINT_SECURE_ADDRESS="7286"

SIB_MQ_ENDPOINT_ADDRESS="5558"

SIB_MQ_ENDPOINT_SECURE_ADDRESS="5578"

These port assignments do not
normally change unless they are
already in use on your system.

All port assignments must be unique
on a machine to avoid conflicts with
other products and applications on
your machine.

Other installations of WebSphere
Application Server can use conflicting
port assignments.

Multiple profiles (V6 Application
Servers) on the machine must each
have unique port assignments.

-W nodehostandcellnamepanelinstallWizardBean.nodeName="nodeName”
Replace nodeName with a valid and meaningful name for your system. WebSphere Application
Server - Express configuration files use the value as a folder name in the configuration and also

within certain XML configuration files.

Reserved names: Avoid using reserved folder names as field values. The use of reserved folder
names can cause unpredictable results. The following words are reserved:

+ cells

* nodes

* servers

* clusters

* applications
* deployments

Default value Description

Your value

nodeName

The nodeName value is not a variable. The Installation wizard
replaces the value with the short DNS form of the machine
name when you use the graphical interface without a response
file.

You can change the value to any unique value other than the
reserved words. The node name is used in the administration of
the WebSphere Application Server - Express product.

MThe installation directory path must be no longer
than 60 characters.

-W nodehostandcellnamepanellnstallWizardBean.hostName="hostName”
Replace hostName with the actual host name of your machine in long or short DNS format. You
can also specify the IP address.
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Default value Description Your value

hostName The hostName value is not a variable. The Installation wizard
replaces the value with the short local host name when you use
the graphical interface without a response file.

Every Application Server environment in WebSphere Application
Server products must be addressable through a host name on a
network file system. See [Installing Express with custom|
loptions” on page 107|for more information about the field.

m -W winservicepanellnstallWizardBean.winServiceQuery="true”
Valid values are true or false.

Default value Description Your value

true A true value creates a Windows service that starts or stops the
application server that is named serveri. A value of false skips
the creation of the Windows service.

When you create a Windows service, WebSphere Application
Server - Express attempts to start the Windows service
whenever you start or stop the server that the service controls.
This attempt to start or stop the service occurs even though you
might select a startup type of manual.

m -W winservicepanellnstallWizardBean.accountType="localsystem”
Valid values are localsystem or specifieduser. The user account must belong to the administrator
user group and have the advanced user rights Act as part of the operating system and Log on as

a service.
Default value Description Your value
localsystem You can install the service on the local system account or on
the specified user account that you identify.

m -W winservicepanellnstallWizardBean.startupType="manual”
Valid values are

automatic
Indicates that you choose to let Windows start the server1 process whenever there is an

abnormal stop or whenever Windows is rebooted.

manual
Indicates that you choose to start the service manually and do not intend to let Windows

restart the service for you.

disabled
Indicates that the service is disabled and cannot start.
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Default value Description Your value

manual You can start the service automatically or manually or disable
the service.

When you create a Windows service, WebSphere Application
Server attempts to start the Windows service whenever you
start or stop the server that the service controls. This attempt to
start or stop the service occurs even though you might select a
startup type of manual.

No attempt is made to start or stop a disabled Windows service.

m -W winservicepanellnstallWizardBean.userName="YOUR_USER_NAME"
Valid values are your user account that belongs to the administrator user group.

Default value Description Your value
YOUR_ You must specify your user account.
USER_NAME

The user account must belong to the administrator user group
and have the advanced user rights Act as part of the operating
system and Log on as a service.

m -W winservicepanellnstallWizardBean.password="YOUR_PASSWORD"
Valid values are the password for your user account.

Default value Description Your value
YOUR_ You must specify your password if you have password
PASSWORD protection enabled on the Windows operating system.

The password is not recorded in a file other than this one. After
installing the product, edit the response file and remove the
password.

Perform the following procedure to edit the response file.

1. Locate the sample options response file. The file is named responsefile.express.txt in the WAS
directory on the product CD-ROM.

2. Copy the file to preserve it in its original form. For example, copy it as myoptionsfile on your disk drive.

3. Edit the copy in your flat file editor of choice, on the target operating system. Read the directions within
the response file to choose appropriate values.

Important: To prepare the file for a silent installation on AlIX, use UNIX line-end characters (OxODOA)
to terminate each line of the options response file. The safest method of preparing the file
is to edit the file on the target operating system.

4. Include custom option responses that reflect parameters for your system.
Read the directions within the response file to choose appropriate values.
5. Save the file.

6. Log on as root on a Linux or UNIX operating system, or as a member of the administrator group on a
Windows system.

-I.IEI In addition, verify that the umask setting is 022. To verify the umask setting,
issue the following command:

umask
To set the umask setting to 022, issue the following command:
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umask 022

m Some steps of the installation on a Windows platform require the administrator group user
to have the following advanced user rights:

* Act as part of the operating system
* Log on as a service
For example, on some Windows systems, click Administrative Tools > Local Security Policy > User

Rights Assignments to see the advanced options. See your Windows documentation for more
information.

m The installation wizard grants your Windows user ID the advanced user rights, if the user
ID belongs to the administrator group. The silent installation does not grant these rights. If you create a
new user ID on a Windows platform to perform a silent installation, you must restart the system to
activate the proper authorizations for the user ID before you can perform a successful silent
installation.

m When installing the WebSphere Application Server as a Windows service, do not use a
user ID that contains spaces. A user ID with spaces cannot be validated. Such a user ID is not allowed
to continue the installation. To work around this problem, install with a user ID that does not contain
spaces, or do not choose to install Windows services.

7. Issue the proper command to use your custom response file. For example, issue one of the following
commands:

. mmnt_cdr‘om/WAS/instaH -options /tmp/WAS/myoptionsfile.txt -silent
. m "CD_drive_D:A\WAS\install” -options "C:\temp\WAS\myoptionsfile.txt” -silent
You can find the sample options response file in the WAS directory on the product CD.

This procedure results in creating a customized response file and using the file to start a silent installation.

Edit the version of the file that ships with the WebSphere Application Server - Express product. The
example in [‘responsefile.express.txt’ is not guaranteed to be an accurate representation of what ships with
the product.

responsefile.express.txt
This topic describes the response file for installing the WebSphere Application Server - Express product.

Install the product with an options response file after logging on as root on a Linux or UNIX platform, or a
user that belongs to the administrator group on a Windows platform. Some steps of the installation
procedure on a Windows platform require the user to belong to the administrator group and to have the
advanced user rights Act as part of the operating system and Log on as a service.

Verify that you have the required disk space as specified in the topic that describes preparing your

operating system for installation. See |Chapter 8, “Preparing the operating system for product installation,’]
Hn page 69.

Location of the response file: The sample options response file is named responsefile.express.txt.
The file is in the WAS directory on the product disc or in the downloaded installation image.

Modes of use: The installation wizard can read an existing options response file and run silently without
displaying the graphical user interface.

Installing silently: Use the options file to run the Installation wizard in silent mode, which is referred to as
installing silently or as a silent installation. The wizard reads the options file to determine responses and
does not display the graphical user interface. Use the following command to use a copy of the options file
named myresponsefile.txt for a silent installation:
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install -options "myresponsefile.txt" -silent
Logging:
The Installation wizard and the Profile creation wizard record installation events in the following log files:

Log files for WebSphere Application Server products: The following table shows the installation logs,
content, and indicators of success and failure for WebSphere Application Server products for Version 6.

Table 11. Installation logs for WebSphere Application Server products

Log Content Indicators

install_root / logs / log.txt Logs all installation events INSTCONEFAIL

Total installation failure.

INSTCONFSUCCESS
Successful installation.

INSTCONFPARTIALSUCCESS
Installation errors occurred but the
installation is still usable. Additional
information identifies the errors.

install_root / Togs / + Traces all events that occur INSTCONFFAIL

wasprofile / wasprofile _ during the creation of the Total profile creation failure

create _ profile_name.log named profile ’
INSTCONFSUCCESS

+ Created when using the Profile
creation wizard or the
wasprofile command INSTCONFPARTIALSUCCESS

Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

Successful profile creation.

install_root / Togs / « Traces all events that occur INSTCONFFAIL

wasprofile / wasprofile _ during the deletion of the Total profile deletion failure

delete _ profile_name.log named profile )
INSTCONFSUCCESS

» Created when using the Profile
creation wizard or the
wasprofile command INSTCONFPARTIALSUCCESS

Profile deletion errors occurred but the
profile is still deleted. Additional
information identifies the errors.

Successful profile deletion.

install_root / profiles / Logs all profile creation events
profile_name / logs / that occur when using the Profile INSTCO':II_F::?IL i tion fail
pctlLog.txt creation wizard otal protile creation falure.
INSTCONFSUCCESS
Successful profile creation.
INSTCONFPARTIALSUCCESS

Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

Information that ISMP can log when it cannot start the Installation wizard
Verify or troubleshoot the installation if the install_root/10gs/10g.txt file or the

profiles_install_root/profile_name/logs/pctLog.txt file does not contain a record of any problems, but
problems exist. If the profiles_install_root/profile_name directory exists, the pctlLog. txt file is in the Togs
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directory. If the error happens early in the installation, look for the logs in the system temporary area. The
installation program copies the logs from the system temporary area to the Togs directory at the end of the
installation.

If the profiles_install_root/profile_name directory does not exist, the pctLog.txt file is in the USER_HOME
directory and is named .$"pctLog.txt. Issue the env command to display the USER_HOME directory on

Linux and UNIX systems. See the environment variable settings on Windows system to display the value

of the variable.

If the profiles_install_root/profile_name directory does not exist, the pctLog.txt file is in the USER_HOME
directory and is named .$“pctlLog.txt. Issue the env command to display the USER_HOME directory on

Linux and UNIX systems. See the environment variable settings on Windows system to display the value

of the variable.

Certain events can prevent ISMP from starting the Installation wizard. Such an event is not enough disk
space to launch the Installation wizard, for example. If your installation fails and there is no information in
the installation logs, use the -log parameter to record entries for events that cause the ISMP program to
fail to start the installation wizard. The syntax of the install command for logging such events is:
install -options fully qualified options_response_file_name

-silent

-log # !fully qualified _log_file_name @ALL

The following example is for AIX systems:

install -options "/usr/IBM/WebSphere/silentFiles/myresponsefile.txt"
-silent -log # !/usr/IBM/WebSphere/myOptionFiles/log.txt @ALL

The following example is for Linux systems, HP-UX systems, and Solaris systems:

install -options "/opt/IBM/WebSphere/silentFiles/myresponsefile.txt"
-silent -log # !/opt/IBM/WebSphere/myOptionFiles/log.txt @ALL

The following example is for Windows systems:

install.exe -options "C:\IBM\WebSphere\silentFiles\myresponsefile.txt"
-silent -log # !C:\IBM\WebSphere\silentFiles\log.txt @ALL

See|Appendix B, “Troubleshooting installation,” on page 291| and [‘Installation component troubleshooting|
tips” on page 307|for more information.

Usage notes:

» The file is not a read-only file.

» Edit this file directly with your flat file editor of choice, such as WordPad on a Windows platform.

» The file must exist to perform a silent installation. The installation program reads this file to determine
installation option values when you install silently.

« Save the file in a location that you can identify when you specify the fully qualified path as part of the
installation command.

. m If you are installing on a Windows platform, your user ID must belong to the administrator
group and must have the advanced rights Act as part of the operating system and Log on as a service.
If you select the following option when your user ID does not comply, the installation fails:

-W winservicepanelInstallWizardBean.winServiceQuery="true"

. m Windows 2000 considerations:

m The installation directory path must be no longer than 60 characters.
» Avoid using reserved folder names when providing values for the following directives:

-P wasProductBean.installlLocation
-W nodehostandcellnamepanelInstallWizardBean.nodeName
-W setcellnameinglobalconstantsInstallWizardBean.value
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Reserved names: Avoid using reserved folder names as field values. The use of reserved folder
names can cause unpredictable results. The following words are reserved:

— cells

— nodes

— servers

— clusters

— applications

— deployments

Example responsefile.express.ixt:
igddaddaddaddaddadtadsastddpadsdtsddadtadtasadadsataadagadagagagagadaadiiad

S S S 3 3 S Sk e 3 I S S R 3 I I H

InstallShield Options File

Wizard name: Install
Wizard source: setup.jar

This file can be used to configure Install with the options specified below
when the wizard is run with the "-options" command line option. Read each
setting's documentation for information on how to change its value.

A common use of an options file is to run the wizard in silent mode. This lets
the options file author specify wizard settings without having to run the
wizard in graphical or console mode. To use this options file for silent mode
execution, use the following command line arguments when running the wizard:

-options "D:\installImage\WAS\responsefile.express.txt" -silent

tH######### A A A A A A A A A A A A A A A A A A A A A A A A A

#H###### A #H R A F AR A A AR A AR A A AR A A A A A A A A A A A A A A A

S S S 3 I3 3 S Sk 3 I3 I S o 3 3 I IR I

License Acceptance

Valid Options : true Accepts the Ticense. Will install the product.
false Declines the Ticense. Install will not occur.

If no install occurs, this will be logged to a temporary log file in the user's
temporary directory.

By changing the silentInstalllLicenseAcceptance.value in this response file to
"true", you agree that you

have reviewed and agree to the terms of the IBM International Program License
Agreement accompanying this

program, which is located at CD_ROOT\WAS\T1afiles. If you do not agree to these
terms, do not change

the value or otherwise download, install, copy, access, or use the program and
promptly return the

program and proof of entitlement to the party from whom you acquired it to obtain a
refund of the amount you paid.

-W silentInstallLicenseAcceptance.value="false"

idgaddaadsdpaddaddaadddadspadddadddaaddgaddaadddadsdpdddpagddaagdandaaadddid
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Incremental Install

If you are installing additional features on top of an existing installation,
(e.g. incremental install), uncomment the following Tine. This will notify
the installer that you are doing an incremental install.

-W detectedexistingcopypanelInstallWizardBean.choice="addFeatures"
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PTease make sure installlLocation is set to your existing install location.

For already installed features, you need to set the feature active property
to false. For new features you want to install, you need to set the active
properties to true.

For example, you have installed core product feature, now you want to install
samples feature, the active properties should be:

-P samplesProductFeatureBean.active="true"
-P javadocsProductFeatureBean.active="false"

e e e 3 I I IR I I

lfgddtzsddssdddssddssaddssdassdddsaddssdddsgaddssadadissdsdgadigsddsgadisddaaai
IBM WebSphere Application Server - Express, V6.0 Install Location

The install Tocation of the product. Specify a valid directory into which the
product should be installed. If the directory contains spaces, enclose it in
double-quotes as shown in the Windows example below. Note that spaces in the
install Tocation is only supported on Windows operating systems.

Below is the Tist of default install Tocations for each supported operating
system. By default, in this response file, the Windows install Tocation is
used. If you want to use the default install location for another operating
system, uncomment the appropriate default install location entry (by removing '#') and
then comment out (by adding '#') the Windows operating system entry below.

AIX Default Install Location:

-P wasProductBean.installLocation=/usr/IBM/WebSphere/AppServer

HP-UX, Solaris or Linux Default Install Location:

-P wasProductBean.installLocation=/opt/IBM/WebSphere/AppServer

Windows Default Install Location:

S S e S 3R S S S 3R 3R SR S S 3 3 3 S R 3 3 3 e R 3R I I H

-P wasProductBean.installlLocation="C:\Program Files\IBM\WebSphere\AppServer"

lgddaddadtadtadtastadtadpddpatsdtagtadtadtadadaadsatagdaadadagatagddadaadidiad
#

# IBM WebSphere Application Server - Express, V6.0 UPGRADE from Express Trial

#

# NOTE - : DO NOT Set this Option if you do not have any Express Trial installed
You can not do an upgrade if you do not have at Teast

one Express Trial installed

To setup an upgrade install, UNcomment the following entry
( do not change the "upgrade" value )

-W detectedexistingcopypanelInstallWizardBean.choice="upgrade"

S S S 3 I R O IR I I

# Additionally, specificy the installation lTocation where the Express Trial
# (which you want to upgrade)

# is installed, by UNcommenting the following entry and by replacing

# "EXPRESS TRIAL INSTALL LOCATION" with the a

# actual installation directory

#
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#-W detectedexistingcopypanelInstallWizardBean.upgradeMatchInstalllLocations=
# "EXPRESS TRIAL INSTALL LOCATION"

NOTE - : In an Upgrade the following entries will be skipped and only an upgrade
of the specified Express Trial
to Express will occur

e S H I I H H

iddgsszadddddsssaddddssdadddddssadddddddasaddddddasaddddddssaddddddaaadddad
#

# Setup Type

#

# This value is required for the installation. Do not change this!
#

-W setuptypepanelInstallWizardBean.selectedSetupTypeId="Custom"

iz zaddddssssdaddddsadaddddsssiddddddtaddddddsdddddddssaddddddaaadddad
#

# "Core Product Files" feature

#

# This feature is required by Application Server and will be installed by default.
# Selection is not required.

#
iddgaszaddddssasaddddsdaddddsssidddddddsdddddddasdddddddsaddddddadaadddad

"Application Server samples" feature

The selection state of the "Application Server samples" feature. Legal values
are:

true - Indicates that the feature is selected for installation
false - Indicates that the feature is not selected for installation

For example, to select "Application Server samples" for installation, use

-P samplesProductFeatureBean.active="true"

e e e e 3 I 3 S S 3 I I R H

-P samplesProductFeatureBean.active="true"

ldggddzsddssdddsaddssaddsadddsdddsaddssdddsaddssaddssddsdddsaddasdddsaddsaddsid
"Javadocs" feature
The selection state of the "Javadocs" feature. Legal values are:

true - Indicates that the feature is selected for installation
false - Indicates that the feature is not selected for installation

For example, to select "Javadocs" for installation, use

-P javadocsProductFeatureBean.active="true"

S S e 3 I HR I I W

-P javadocsProductFeatureBean.active="true"
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Port value assignment

They are currently set to the defaults.

e S e 3 I I I

defaultprofileportspanelInstallWizardBean
defaultprofileportspanelInstallWizardBean

defaultprofileportspanelInstallWizardBean

L I T T T T e T T S I A I B |
EEE=E=E=E=E===Z=Z=Z=Z=Z= =

defaultprofileportspanelInstallWizardBean.
.WC_adminhost="9060"

.WC_defaulthost_secure="9443"
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean. _SSL_ o
.CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS="9402"
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.
defaultprofileportspanelInstallWizardBean.

The following entries are used to reset port numbers used in the configuration

PTlease check to make sure there are no Port Conflicts

WC_defaulthost="9080"

WC_adminhost_secure="9043"
BOOTSTRAP_ADDRESS="2809"
SOAP_CONNECTOR_ADDRESS="8880"
SAS_SSL_SERVERAUTH_LISTENER_ADDRESS="9401"
CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS="9403"

ORB_LISTENER ADDRESS="9100"
DCS_UNICAST ADDRESS="9353"
SIB_ENDPOINT ADDRESS="7276"
SIB_ENDPOINT SECURE_ADDRESS="7286"
SIB_MQ_ENDPOINT ADDRESS="5558"
SIB_MQ_ENDPOINT SECURE_ADDRESS="5578"

g ddddddddddddddaadaaaaaa s a s a Rk

Node name

has to be unique.

R T T

-W nodehostandcellnamepanelInstallWizardBean.

Please select the node name for the Application Server. Node name under one cell

Replace YOUR_NODE_NAME with the actual node name.

nodeName="YOUR_NODE_NAME"

tH######### AR A AR A AR A A AR A A A AR A A A A A A A A A A A A A A A

Host name

the default value.

e S S 3 I I IR I

-W nodehostandcellnamepanellInstallWizardBean.

Specify the host name for the Application Server. The host name is the domain
name system (DNS) name (short or Tong) or the IP address of this computer.

Replace YOUR_HOST_NAME with the actual host name. Comment the line to use

hostName="YOUR_HOST_NAME"

ifgdddaadddaaddaaddaadddadadpdddpaddsaasdgagaspadddaddpdidpagddaagdagdtaadddid

Cell name

If you would Tike to override the resolved

He e S e ¥ I I HE I Ik
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You should not Modify this, unless absolutely necessary.

The Wizard would set this to short Tocal host name + "Node##Cell" by default.

cell name value, uncomment the line and

replace YOUR CELL_NAME with <YOUR OWN_VALUE>.

-W setcellnameinglobalconstantsInstallWizardBean.value="YOUR_CELL_NAME"
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#

# Run WebSphere Application Server as a Windows service

# (Windows ONLY)

The selection state of the service installation. Legal values are:

true - Indicates that you choose to install the service
false - Indicates that you not choose to install the service

SR SR SR SR S

-W winservicepanelInstallWizardBean.winServiceQuery="true"

Specify account type of the service. Legal values are:

#

#

# localsystem - Indicates that you choose to use Local System account.

# specifieduser - Indicates that you choose to use specified user account.
#

-W winservicepanelInstallWizardBean.accountType="1ocalsystem"

Specify startup type of the service. Legal values are:

automatic - Indicates that you choose to use automatic startup type
manual - Indicates that you choose to use manual startup type

#
#
#
#
# disabled - Indicates that you choose to use disabled startup type
#

-W winservicepanelInstallWizardBean.startupType="manual"

# Specify your user name and password. Your user name

# must belong to the administrator group to be authorized

# to install a Windows service. Your user name must have

# the "Log On as a Service" user right for the service to run properly.
#

# Replace YOUR_USER_NAME with your username.

# Replace YOUR_PASSWORD with your valid password.

-W winservicepanelInstallWizardBean.userName="YOUR_USER_NAME"
-W winservicepanelInstallWizardBean.password="YOUR_PASSWORD"

#H#####H A FH A A F AR A AR AR AR

Mounting CD-ROMS on Linux and UNIX operating systems

The following sections describe how to mount the CD-ROM on Linux and UNIX operating systems.

After inserting a CD-ROM into a drive, some Linux and UNIX operating systems require you to mount the
drive.

Use these procedures to mount the product discs.

* Mounting the CD-ROM on AIX To mount the CD-ROM on AIX using the System Management Interface
Tool (SMIT), perform the following steps:

1. Log in as a user with root authority.
2. Insert the CD-ROM in the drive.
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Create a CD-ROM mount point by entering the mkdir -p /cdrom command, where cdrom represents
the CD-ROM mount point directory.

Allocate a CD-ROM file system using SMIT by entering the smit storage command.

After SMIT starts, click File Systems > Add / Change / Show / Delete File Systems > CDROM
File Systems > Add CDROM File System.

In the Add a File System window:

— Enter a device name for your CD-ROM file system in the DEVICE Name field. Device names for
CD-ROM file systems must be unique. If there is a duplicate device name, you may need to
delete a previously-defined CD-ROM file system or use another name for your directory. The
example uses /dev/cd0 as the device name.

— Enter the CD-ROM mount point directory in the MOUNT POINT window. In our example, the
mount point directory is /cdrom.

— In the Mount AUTOMATICALLY at system restart field, select yes to enable automatic
mounting of the file system.

— Click OK to close the window, then click Cancel three times to exit SMIT.
Next, mount the CD-ROM file system by entering the smit mountfs command.
In the Mount a File System window:

— Enter the device name for this CD-ROM file system in the FILE SYSTEM name field. In our
example, the device name is /dev/cdo.

— Enter the CD-ROM mount point in the Directory over which to mount field. In our example, the
mount point is /cdrom.

— Enter cdrfs in the Type of Filesystem field. To view the other kinds of file systems you can
mount, click List.

— In the Mount as READ-ONLY system field, select yes.
— Accept the remaining default values and click OK to close the window.

Your CD-ROM file system is now mounted. To view the contents of the CD-ROM, place the disk in
the drive and enter the c¢d /edrom command where cdrom is the CD-ROM mount point directory.

* Mounting the CD-ROM on HP-UX Because the product contains several files with long file names, the
mount command can fail. The following steps successfully mount the product CD-ROM on the HP-UX
platform:

1.
2.

5.

Log in as a user with root authority.
In the /etc directory, add the following line to the pfs_fstab file:
/dev/dsk/c0t2d0 mount_point pfs-rrip ro,hard

where mount_point represents the mount point of the CD-ROM.
Start the pfs daemon by entering the following commands (if they are not already running):

/usr/sbin/pfs_mountd &
/usr/sbin/pfsd 4 &

Insert the CD-ROM in the drive and enter the following commands:

mkdir /cdrom
/usr/sbin/pfs_mount /cdrom

The /cdrom variable represents the mount point of the CD-ROM.
Log out.

* Mounting the CD-ROM on Linux To mount the CD-ROM on Linux:

1.
2.
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Log in as a user with root authority.

Insert the CD-ROM in the drive and enter the following command:
mount -t is09660 -o ro /dev/cdrom /cdrom

The /cdrom variable represents the mount point of the CD-ROM.
Log out.
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Some window managers can automatically mount your CD-ROM for you. Consult your system
documentation for more information.

* Mounting the CD-ROM on Solaris To mount the CD-ROM on Solaris:
1. Log in as a user with root authority.
2. Insert the CD-ROM into the drive.

3. If the Volume Manager is not running on your system, enter the following commands to mount the
CD-ROM:

mkdir -p /cdrom/unnamed_cdrom
mount -F hsfs -o ro /dev/dsk/c0t6d0s2 /cdrom/unnamed cdrom

The /cdrom/unnamed_cdrom variable represents the CD-ROM mount directory and the
/dev/dsk/c0Ot6d0s2 represents the CD-ROM drive device.

If you are mounting the CD-ROM drive from a remote system using NFS, the CD-ROM file system
on the remote machine must be exported with root access. You must also mount that file system
with root access on the local machine.

If the Volume Manager (vold) is running on your system, the CD-ROM is automatically mounted as:
/cdrom/unnamed_cdrom
4. Log out.

Installing IBM HTTP Server

Install the IBM HTTP Server Version 6 product and its plug-in, or install a plug-in for another supported
Web server to enable the Web server to work with WebSphere Application Server, Version 6.

Before using this topic to install the IBM HTTP Server, see the|Information center for IBM HTTP Server

To use a Web server other than IBM HTTP Server Version 6, install and configure the Web server before
or after installing the WebSphere Application Server product, but before installing the Web server plug-ins
for WebSphere Application Server.

The Plug-ins installation wizard configures supported Web servers. You can also manually configure
supported Web servers for WebSphere Application Server, Version 6, as described in [‘Editing Web server|
[configuration files” on page 185.]

See the information center for IBM HTTP Server Version 6 for more information.

After installing the Web server and the Application Server, install the appropriate Web server plug-in for a
supported, installed Web server. No further configuration is required for most Web servers.

This topic describes installing IBM HTTP Server.

1. Prepare your operating platform for installing IBM HTTP Server as you would for installing any of the
installable components on the product disc. SeelChapter 8, “Preparing the operating system fod
[product installation,” on page 69,

2. Insert the product disc and mount the disc if necessary. See [Packaging” on page 28| for information
about identifying the product disc. See [‘Mounting CD-ROMS on Linux and UNIX operating systems’]
on page 137|for information about mounting the product disc, if you are installing IBM HTTP Server
on a Linux or UNIX platform.

3. Start the installation with the launchpad.sh command on Linux and UNIX platforms or the
launchpad.bat on Windows platforms. You can also start the installation using the /IHS/install
command, where IHS is the installable component directory on the product disc:

) BT /15 /instalT
. M\IHS\instaH
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If you have a problem launching the launchpad, use the troubleshooting information in
[launchpad to start the installation” on page 39|to correct the problem.

When using the launchpad, launch the Installation wizard for IBM HTTP Server:

After launching the Installation wizard from the launchpad or from the command line, the ISMP wizard
initializes and then displays the Welcome panel.

Separate installation procedures for the WebSphere Application Server product, the IBM HTTP Server
product, and the Web server plug-ins let you install only what you need on a particular machine.
Installation of the product code is simplified and faster than in Version 5. The installation program
installs the system files (shared binary files), which you do not update until you install a service fix.
Creation and configuration of application servers do not change the system files.

4. Click Next to display the License agreement panel.
5. Accept the license agreement and click Next to display the installation root directory panel.
6. Specify the root directory information and click Next to display the feature type selection panel.

The panel lets you bypass features selection by accepting typical features. Selecting Custom lets you
select features in the Features selection panel.

7. Click Custom to select features and click Next to display the Features selection panel.

8. m Select features to install and click Next to display the Windows service authorization
panel, when installing IBM HTTP Server on a Windows platform.

9. m Specify your user ID and password information and click Next when installing IBM HTTP
Server on a Windows platform.

10. Review the confirmation panel to verify your selections. Click Back to change any of your
specifications. Click Next to begin installing IBM HTTP Server.

11. Review the confirmation panel to verify your selections. Click Back to change any of your
specifications. Click Next to begin installing IBM HTTP Server.

After displaying installation status, the wizard displays the Completion status panel that indicates a
successful installation.

12. Click Next to display the Web server plug-ins prompt panel.

13. Click Next to launch the Plug-ins installation wizard. See [‘Installing Web server plug-ins” on page 141
to continue the installation.

If the plugin directory does not exist at the same level as the IHS directory, the prompt panel for
selecting the plug-ins installer does not display and the installation is finished. In that case, launch the
Plug-ins installation wizard using the launchpad.

You can install the IBM HTTP Server product.

You can get started easily with Secure Sockets Layer (SSL) connections, by making only a few
configuration changes, as described in [Configuring IBM HTTP Server for SSL mutual authentication] If you
are using the IBM HTTP Server on a Windows platform, you can configure the Fast Response Cache
Accelerator to boost performance. You can also make many other configuration changes with Apache
directives. Refer to the [Information center for IBM HTTP Server at http://www-|
|3.ibm.com/software/webservers/httpservers/library.html|, for a description of configuring the Web server for
SSL, the Fast Response Cache Accelerator, or Apache directives.

Return to |Chapter 9, “Installing the product and additional software,” on page 95| to continue.

140 1BM WebSphere Application Server - Express, Version 6: Installing your application serving environment


http://www-3.ibm.com/software/webservers/httpservers/library.html
http://www-3.ibm.com/software/webservers/httpservers/library.html

Installing Web server plug-ins

This topic describes installing a Web server plug-in for WebSphere Application Server. WebSphere
Application Server products supply a unique binary plug-in module for each supported Web server. The
plug-in configuration file that the WebSphere Application Server products supply is associated with the
binary module. The Plug-ins installation wizard installs required files and configures the Web server and
the application server to allow communication between the servers.

You must install a supported Web server before you can install a plug-in for the Web server. If the Web
server is not already installed, you cannot install the plug-in for it. If the WebSphere Application Server
product is not installed, you can still install the plug-in.

The Plug-ins installation wizard installs the plug-in module, configures the Web server for communicating
with the application server, and creates a Web server configuration definition in the application server, if
possible.

Some topologies, such as the Web server on one machine and the application server on another machine,
prevent the Plug-ins installation wizard from creating the Web server definition in the application server
configuration on the remote machine. In such a case, the Plug-ins installation wizard creates a script that
you can copy to the application server machine. Run the script to create the Web server configuration
definition within the application server configuration.

Select one of the following topology scenarios and follow the steps below the diagram to install the plug-in
and configure both the Web server and the application server.

* Scenario 1: Remote Install the Web server plug-ins when the application server and the Web server
are on separate machines.

<—— Internet Intranet ———

Firewall Firewall
1 1
| |
i i
1 1
E Machine B E Machine A Data tier, optional
i i
| |
i i
H Web server H
Web client i 1 Application
|
(browsen : m : server
1 1
i H Application
H 1 data
i i
| |
i i
1 1
h i
i

See [‘Configuring a Web server and an application server on separate machines (remote)” on page 154
for the procedure that explains how to create this Web server topology.

* Scenario 2: Remote Install the Web server plug-ins when multiple stand-alone application servers are
on one machine, and each application server has a dedicated Web server on a separate machine.
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See [‘Configuring multiple Web servers and remote stand-alone Application Servers” on page 160 for the
procedure that explains how to create this Web server topology.

» Scenario 3: Local Application Server profile Install the Web server plug-ins when the application
server and the Web server are on a single machine.

Machine A Data tier, optional
Web client Web server ]
(browser) ;
Application
data

See [‘Configuring a Web server and an application server profile on the same machine” on page 167|for
the procedure that explains how to create this Web server topology for an application server profile.

Selecting a Web server topology diagram and roadmap

This topic helps you use the Plug-ins installation wizard to install Web server plug-ins for WebSphere
Application Server. This topic is the information center version of the roadmap that is displayed when you
use the Plug-ins installation wizard.

The primary production configuration is an application server on one machine and a Web server on a
separate machine. This configuration is referred to as a remote configuration. Contrast the remote
configuration to the local configuration, where the application server and the Web server are on the same
machine.

The Plug-ins installation wizard has four main tasks:
* Installs the binary plug-in module on the Web server machine.

» Configures the Web server configuration file on the Web server machine to point to the binary plug-in
module and to the XML configuration file for the binary module.

 Installs a temporary XML configuration file for the binary module (plugin-cfg.xml) on the Web server
machine in remote scenarios.

» Creates the configuration for a Web server definition on the application server machine. The wizard
processes the creation of the Web server definition differently depending on the scenario:

- |Recommended remote stand-alone application server installation:|
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Creates a configuration script that you run on the application server machine. Install the Web server
and its plug-in on a different machine than the application server. This configuration is recommended
for a production environment.

— [Local stand-alone application server installation:|

Detects the default profile on a local application server machine and creates the Web server
definition for it directly. Install the Web server and its plug-in on the same machine with the
application server. This configuration is for development and test environments.

Select a link to go to the appropriate steps in the following procedure.
» Set up a remote Web server installation.
The remote Web server configuration is recommended for production environments.

The remote installation installs the Web server plug-in on the Web server machine when the application
server is on a separate machine, such as shown in the following graphic:

achine B

Firewall
optional

Machine A

Web server

WebSphere
Application
Server

Remote installation scenario

Table 12. Installation and configuration

Step Machine Task

1 A Install your WebSphere Application Server product. See [Installing the product and|
|additional software|

2 B Install IBM HTTP Server or another supported Web server. See [Installing IBM HTTP|

3 B Install the binary plug-in module using the Plug-ins installation wizard. See |“Configuring|
|a Web server and an application server on separate machines (remote)” on page 154.]
The script for creating and configuring the Web server is created under the
plug-ins_install_root/ bin directory.

4 B Copy the configurelleb_server_name script to Machine A. If one machine is running
under Linux or UNIX and the other machine is running under Windows, copy the script
from the plug-ins_install_root/ bin/ crossPlatformScripts directory.

5 A Paste the configureWeb_server_name script from Machine B to the was_install_root/
bin directory on Machine A.

A Start the application server, then run the script from a command line.
A Verify that the application server is running. Open the administrative console and save
the changed configuration.

8 B

-EE- Source the plug-ins_install_root/setupPluginCfg.sh script for
a Domino Web Server before starting a Domino Web server.
Start the Web server.
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Table 12. Installation and configuration (continued)

Step Machine Task

9 B |Run the snoop servlet.|

To verify with your own application, regenerate and propagate the plugin-cfg.xml file
after installing the application.

Regeneration of the plugin-cfg.xml file

During the installation of the plug-ins, the temporary pTugin-cfg.xml file is installed on Machine B in the
plug-ins_install _root/ config/ web_server_name directory.

The Web server plug-in configuration service regenerates the plugin-cfg.xml file automatically.

To use the real plugin-cfg.xml file from the application server, propagate the plugin-cfg.xml file as
described in the next section.

Propagation of the plugin-cfg.xml file

The Web server plug-in configuration service propagates the plugin-cfg.xml file automatically for IBM
HTTP Server 6.0 only.

For all other Web servers, propagate the plug-in configuration file manually. Copy the pTlugin-cfg.xml
file from the profiles install root/ config/ cells/ cell name/ nodes/ Web_server name_node/
servers/ web_server_name directory on Machine A. Paste the file into the plug-ins_install _root/
config/ web_server_name directory on Machine B.

» Set up a local Web server configuration.
The local Web server configuration is recommended for a development or test environment.

A local installation includes the Web server plug-in, the Web server, and the Application Server on the
same machine:

Machine A

WebSphere
Web server Application
Server

Local installation scenario

Table 13. Installation and configuration

Step Machine Task
1 A Install your WebSphere Application Server product. See [Installing the product and|
|additional software|
2 A Install IBM HTTP Server or another supported Web server. See [Installing IBM HTTP|
3 A Stop the application server if it is running, then install the binary plug-in module using

the Plug-ins installation wizard. See[‘Configuring a Web server and an application|
[server profile on the same machine” on page 167/

The Web server definition is automatically created and configured during the installation
of the plug-ins.

4 A Verify that the application server is running. Open the administrative console and save
the changed configuration.
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Table 13. Installation and configuration (continued)

Step Machine Task
5 B

-IEE- Run the plug-ins_install_root/setupPluginCfg.sh script for a
Domino Web Server before starting a Domino Web server.Otherwise, start the Web
server.

6 B |[Run the snoop serviet.|

To verify with your own application, regenerate and propagate the plugin-cfg.xml file
after installing the application.

Regeneration of the plugin-cfg.xml file
The Web server plug-in configuration service regenerates the plugin-cfg.xml file automatically.

The plugin-cfg.xml file is generated in the profiles_install root/ profile name/ config/ cells/
cell_name/ nodes/ Web_server_name_node/ servers/ web_server_name directory. The generation occurs
when the Web server definition is created.

Propagation of the plugin-cfg.xml file
The local file does not require propagation.

Configuration behavior of the Plug-ins installation wizard

This topic describes installing the Web server plug-ins for WebSphere Application Server. The Plug-ins
installation wizard installs a binary plug-in module and a plug-in configuration file for the Web server. The
Plug-ins installation wizard configures the supported Web server for the Application Server. The Plug-ins
installation wizard also creates a Web server definition in the configuration of the application server.

This topic describes the two ways that the Plug-ins installation wizard configures a Web server to locate
the plugin-cfg.xml file, which is the plug-in configuration file.

Configuration flows
The Plug-ins installation wizard resolves all configurations of the Web server and WebSphere Application

Server to two scenarios: remote plug-in configuration or local plug-in configuration. The logic implemented
in determining which scenario applies to a configuration is shown in the following diagram.
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Web server plug-ins for WebSphere Application Server

Installation
type?

Remote

No Default

profile?

Default
Application Server
with Web server
definition?

Yes

A\ J

Scenario A. Scenario B.

Remote plug-in Local stand-alone

configuration plug-in configuration
Legend:

Default application server with Web server definition?
If the default profile has an existing Web server definition, then the installation is considered a
remote plug-in configuration. You cannot have more than one Web server definition in a
stand-alone application server.

Use the same name for the Web server to configure a new Web server to use the existing Web
server definition.

Default profile?
If the product is installed but the default profile is accidentally deleted or otherwise missing, the
scenario is considered to be a remote installation. Create a profile before running the script.

Installation type?
The installation type is either remote or local.

Scenario A. Remote plug-in configuration

The Plug-ins installation wizard does not automatically create a Web server definition within the default
distributed profile on a remote machine. The wizard creates the configurelleb_server_name script instead.

The Plug-ins installation wizard configures the Web server to use the plugin-cfg.xml file that is
maintained on the Web server machine in the plugins_install root/config/web_server name directory.
This file requires periodic propagation. Propagation is copying the current plugin-cfg.xml file from the
application server machine to replace the plugins_install _root/ config/ web_server_name/
plugin-cfg.xm]l file.

After installing the binary plug-in for the local Web server, you do not have to run the script before you can

start the application server and the Web server. However, you do not have the benefits of a Web server
definition in the application server node until you run the script.
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Four configurations qualify for the remote application server scenario:

Creation of Web |Web server already defined in

Profile type server Application Server
definition? configuration?

Any profile anywhere if you select a remote installation type in | By script N/A

the Plug-ins installation wizard

No default profile detected By script N/A

Default stand-alone application server profile with an existing By script Yes

Web server definition

Testing the application server without a Web server definition: The following overview shows the
procedure for verifying the temporary plugins_install_root/ config/ web_server_name/ plugin-cfg.xm]
file.

The Web server communicates with the remote application server using the temporary plugin-cfg.xml file.

If the application server has an HTTP Transport port assignment other than 9080, the test is not
successful. Continue to the next section to create the Web server definition on the application server and
to complete your test of the configuration.

1. Start the Web server with the proper procedure for your Web server.
For example, start the IBM HTTP Server from a command line:

. -EJE- ./IHS install root/bin/apachectl start

. mIHS_instaZZ_root\bin\apache

2. Start the application server on the remote machine.

Change directories to the install_root/profiles/profile_name/bin directory and run the startServer
command:

. -EJE. ./was_install_root/profiles/default/bin/startServer.sh serverl

. m was_install_root\profiles\default\bin\startServer serverl

3. Point your browser to http://Tocalhost:9080/snoop to test the internal HTTP transport provided by
the application server. Point your browser to http://Host_name_of_Web_server_machine/snoop to test
the Web server plug-in.

4. Verify that both Web addresses display the Snoop Servlet - Request/Client Information page.

Completing the installation by configuring a Web server definition: The following overview shows the
procedure for completing the configuration. The configuration is not complete until the Web server
definition exists in the configuration of the application server node. The Web server definition is a central
element in the regeneration of a valid plug-in configuration file, plugin-cfg.xml.

1. Create the Web server definition in the application server.

Run the script to manually create the Web server definition within the configuration of the application
server node:

a. Copy the script from the plug-ins_install _root/bin directory to the remote was_install root/bin
directory.

b. Open a command window and run the script:

. -E'JE- ./configureWeb_server_name.sh
. mconﬁgureh/eb_server_name.bat

If you have enabled security or changed the default JMX connector type, edit the script and include the
appropriate parameters.
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2. Copy the current plug-in configuration file, pTugin-cfg.xml, in the profiles install root/
profile name/ config/ cells/ cell _name/ nodes/ Web server name node/ servers/
web_server_name directory. Paste the file on the Web server machine to replace the temporary
plug-ins_install_root/ config/ web_server_name/plugin-cfg.xml file. The IBM HTTP Server
supports automatic propagation. Other Web servers require manual propagation.

3. Start the Web server with the proper procedure for your Web server. Open the administrative console
and save the changed configuration.

4. Point your browser to http://Tocalhost:9080/snoop to test the internal HTTP transport provided by
the application server. Point your browser to http://Host_name_of Web_server_machine/snoop to test
the Web server plug-in.

5. Verify that both Web addresses display the Snoop Servlet - Request/Client Information page.
Scenario B. Local stand-alone plug-in configuration

In this scenario, the Plug-ins installation wizard creates a Web server definition within the application
server profile directly, without the use of a script.

The Plug-ins installation wizard configures the Web server to use the plugin-cfg.xml file that is within the
application server profile. The application server regenerates the plugin-cfg.xml file in the install_root/
profiles/ profile_name/ config/ cells/ cell_name/ nodes/ Web_server_name node/ servers/
Web_server_name directory. Regeneration occurs whenever a change occurs in the application server
configuration that affects deployed applications.

After installing the binary plug-in for the local Web server, you can start the application server and the Web
server immediately upon completion of the installation.

Only one configuration qualifies for the local application server scenario:

- Automatic creation of Web server |Web server already defined in
Profile type N L . .
definition? application server configuration?
Application Server Yes No

Redirection to Scenario A

A default application server profile that has an existing Web server definition is processed as a remote
plug-in configuration.

An existing Web server definition on an application server profile causes the Plug-ins installation wizard to
follow the remote installation path. An application server can have just one Web server definition. Specify
the same nick name for the Web server to configure a new Web server to use the existing Web server
definition.

You can use the plugin-cfg.xml file that is within the Web server definition in the configuration of the
application server. Simply click Browse on the appropriate panel in the Plug-ins installation wizard to
select the file. This file must exist. Otherwise, the Plug-ins installation wizard displays a warning and
prevents you from proceeding until you select an existing file. The Web server is configured to use this
existing plugin-cfg.xml file.

See Scenario A for a description of this type of node.

Overview of the verification procedure

The following overview shows the procedure for verifying the Web server configuration after installing the
binary plug-in module:
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1. Start the Web server with the proper procedure for your Web server.
For example, start the IBM HTTP Server from a command line:

. -EE- ./IHS install_root/bin/apachectl start

. mIHS_instaZZ_root\bin\apache

2. Start the application server.

Change directories to the install_root/profiles/profile_name/bin directory and run the startServer
command:

. -E'JE- ./WAS install root/profile/default/bin/startServer.sh serverl

. MWAS_instalZ_r'oot\proﬁ1e\defau1t\bin\startServer serverl
Open the administrative console and save the changed configuration.

3. Point your browser to http://1ocalhost:9080/snoop to test the internal HTTP transport provided by
the Application Server. Point your browser to http://Host_name _of Web_server machine/snoop to test
the Web server plug-in.

4. Verify that both Web addresses display the Snoop Servlet - Request/Client Information page.
Summary

Two scenarios exist for Web server plug-ins for WebSphere Application Server. Each scenario revolves
around a unique location for the plug-in configuration file, plugin-cfg.xml.

The application server generates the plug-in configuration file. The purpose of the file is to publish the
location of all of the application server objects that are relevant to a Web server and to control binary
plug-in configuration options. The file identifies such objects as applications and virtual hosts for serving
applications, for example.

If the Web server cannot access the file on the application server machine, you must copy the file to the
Web server. That process is called propagation. Propagation is reserved for the remote plug-in
configuration scenario, which is Scenario A in this topic.

In the local scenario, the Web server can access the plugin-cfg.xml file because the Web server is on
the same machine as the file.

The configuration scheme for Version 6 of WebSphere Application Server puts the plug-in configuration file
in a Web server definition that is within a Web server node. All Scenario B configurations have the Web
server definition within its own Web server node.

Limited management options do not let you create or delete the one Web server definition in the
administrative console of a stand-alone Application Server. The inability of a stand-alone application server
to create a Web server definition is the basis for the configuration scripts created by the Web server
plug-ins for WebSphere Application Server. Without the scripts you could not easily create a Web server
definition on a stand-alone application server node.

The location of the plugin-cfg.xml file for each configuration described in this topic is shown in the
following table:
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Table 14. Plug-in configuration file locations

Location of the plugin-cfg.xml
file

Plug-ins__ install_ | Profiles_

root install_ root:
within the Web
server node

Scenario Profile type

Any profile anywhere if you select a remote installation type in

the Plug-ins installation wizard X
A No default profile detected X
Defag!t application server profile with an existing Web server X
definition
B Default application server profile X

Legend:

Plug-ins_install_root
plug-ins_install_root/config/
Web_server_name/plugin-cfg.xml

Profiles_ install_ root: within the Web server node
was_install_root/profiles/profile_name
/config/cells/cell_name/nodes/
Web_server_name_node/servers/
Web_server_name/plugin-cfg.xml

Web server configuration

After installing a supported Web server, you must install a binary plug-in module for the Web server. The
plug-in module lets the Web server communicate with the application server. The Plug-ins installation
wizard installs the Web server plug-in. The wizard configures the Web server. The wizard also creates a
Web server definition in the configuration of the application server.

The Plug-ins installation wizard uses five files to configure a plug-in for the Web server you select:

* The Web server configuration file on the Web server machine, such as the httpd.conf file for IBM
HTTP Server.

* The binary Web server plug-in file that the Plug-ins installation Wizard installs on the Web server
machine.

* The plug-in configuration file, plugin-cfg.xml, on the application server machine that you propagate
(copy) to a Web server machine.

* The default (temporary) plug-in configuration file, plugin-cfg.xml, on the Web server machine.

* The configurelWeb_server_name script that you copy from the Web server machine to the application
server machine.

See the following descriptions of each file.
Web server configuration file
The Web server configuration file is installed as part of the Web server. The wizard must reconfigure the

configuration file for a supported Web server. Reconfiguration consists of adding directives that identify file
locations of two files:

* The binary plug-in file
e The plugin-cfg.xml configuration file
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The binary Web server plug-in file

See |Web server plug-ins|for a description of the binary plug-in module. An example of a binary plug-in
module is the mod_ibm_app_server_http.d11 file for IBM HTTP Server on the Windows platform.

The binary plug-in file does not change. However, the configuration file for the binary plug-in is an XML
file. The application server changes the configuration file whenever you change the configuration of
deployed applications.

The binary module reads the XML file to adjust settings and to locate deployed applications for the Web
server.

The plug-in configuration file, plugin-cfg. xml

The plug-in configuration file is an XML file with settings that you can tune in the administrative console.
The file lists all of the applications installed on the Web server definition. The binary module reads the
XML file to adjust settings and to locate applications for the Web server.

The stand-alone application server regenerates the plugin-cfg.xml file in the install_root/ profiles/
profile_name/config/ cells/ cell_name/ nodes/ Web_server_name node/ servers/ Web_server_name
directory. Regeneration occurs whenever a change occurs in the application server configuration that
affects deployed applications.

After regeneration, you must propagate (copy) the file to the Web server machine. The binary plug-in then
has access to the most current copy of its configuration file.

The Version 6 Web server plug-in configuration service automatically regenerates the plugin-cfg.xml file
whenever the configuration changes. The configuration service automatically propagates the
plugin-cfg.xml file to an IBM HTTP Server machine. You must manually copy the file on other Web
servers.

See |Web server plug-in configuration service properties settings| for more information.

Default plug-in configuration file, plugin-cfg.xml

The Plug-ins installation wizard creates the temporary plugin-cfg.xml file in the
plugins_install_root/P1ugins/config/Web_server_name directory. The wizard creates the file for every
remote installation scenario. The wizard creates the file at the same time that it installs the binary plug-in
module for the Web server.

The default file is a placeholder that you must replace with the plugin-cfg.xml file from the Web server
definition on the application server. The default file is a replica of the file that the application server creates
for a default stand-alone application server that has the samples installed.

Run the configureleb server _name script from the was_install_root/bin directory of the application server
machine for a remote installation, or directly from the plugins_install_root/bin directory for a local
installation. The script creates the Web server definition in the configuration files of the default profile. To
configure a different profile than the default, edit the configurelleb_server name script. Use the
-profileName parameter to identify a different profile than the default.

After the Web server definition is created, the Web server plug-in configuration service within the
application server creates the first pTugin-cfg.xml file in the Web server definition on the application
server machine. If you install an application, create a virtual host, or do anything that changes the
configuration, you must propagate the updated plugin-cfg.xml file from the application server machine to
the Web server machine to replace the default file.
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The configure Web_server_name script

The Plug-ins installation wizard creates the configurelleb_server name script on the Web server machine
in the plugins_install_root/bin directory. If one machine in a remote scenario is running under Linux or
UNIX and the other machine is running under Windows, use the script created in the
install_root/PTugins/bin/crossPlatformScripts directory. The script is created for remote installation
scenarios only.

Copy the script from the Web server machine to the was_install_root/bin directory on a remote application
server machine. You do not have to copy the script on a local installation. Run the script to create a Web
server definition in the configuration of the application server.

When using the IBM HTTP Server, configure the IBM HTTP Administration Server also. The IBM HTTP
Administration Server works with the administrative console to manage Web server definitions. Also, use
the administrative console to update your Web server definition with remote Web server management
options. Click Servers > Web servers > Web_server to see configuration options. For example, click
Remote Web server management to change such properties as:

* Host name

* Administrative port

e User ID

¢ Password

Important: Always open a new command window before running this script. You can avoid a potential
problem by using a new command window to run this script.

The problem is a potential conflict between a shell environment variable, the
WAS_USER_SCRIPT environment variable, and the actual default profile. The script always
works against the default profile. However, if the WAS_USER_SCRIPT environment variable is
set, a conflict arises as the script attempts to work on the profile identified by the variable.

The variable is easy to set accidentally. Issue any command from the
profiles_install_root/profile_name/bin directory of any profile and the variable is set to that
profile.

If you have more than one profile on your system, the potential exists that the default profile

and the profile identified by the variable are different profiles. If so, a conflict occurs and the

script might not create the Web server definition in the correct profile, or might not create the
Web server definition at all.

Reset the variable in either of two ways:

* Close the command window where the variable is set and open a new one.

» Change directories to the profiles_install_root/profile_name/bin directory of the default
profile and source the setupCmdLine.sh script:
- source install_root/bin/setupCmdLine.sh

- -EJE. . install_root/bin/setupCmdLine.sh (Source the command with a space
between the period and the installation root directory.)

- m install_root\bin\setupCmdLine.bat

If a Web server definition already exists for a stand-alone application server, running the script does not
add a new Web server definition. Each stand-alone application server can have only one Web server
definition.
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You cannot use the administrative console of a stand-alone application server to add or delete a Web
server definition. However, you can do both tasks using the administrative scripting interface:

* Add a Web server definition through the wsadmin facility using the configure Web_server_name script.
The script uses a Java Command Language (Jacl) script named configureWebserverDefintion.jacl to
create and configure the Web server definition.

* Delete a Web server definition using wsadmin commands. The Web server is named webserver1 in the
following example:
$AdminTask deleteServer { -serverName webserverl -nodeName webserverl node }

$AdminTask removeUnmanagedNode { -nodeName webserverl node }
$AdminConfig save

Replacing the default plug-in configuration file with the file from the Web server definition
(propagation)

The default file uses the following fixed parameter values that might not match the parameter values in the
actual file on the application server. The default file is a placeholder only.

The file cannot reflect changes that occur in the application server configuration. The file also cannot
reflect non-default values that might be in effect on the application server.

The application server must have the following values in the actual pTugin-cfg.xml file. If so, the default
file can successfully configure the binary plug-in module. Then, the plug-in module can successfully
communicate with the Web server and the application server.

Suppose that the application server does not have the following values in the actual plugin-cfg.xml file. In
that case, the default file configures the binary plug-in module incorrectly. The plug-in module can always
communicate with the Web server. But with an improper configuration file, the plug-in module cannot
communicate successfully with the application server.

Fixed parameter values in the temporary plug-in configuration file

Virtual host name
default_host

The default_host value is the default virtual host. This virtual host is configured to serve the
DefaultApplication and the Sample applications. This value is probably the same as the value in
the real plugin-cfg.xml file. However, suppose that you create another virtual host for serving
applications and install the DefaultApplication on it. If so, the actual plugin-cfg.xml file is
regenerated. The Web server cannot access the DefaultApplication. (The application includes the
snoop servlet and the hitcount servlet.)

To access applications on the new virtual host, propagate the real plugin-cfg.xml file.
Propagation is copying the updated file from the application server machine to the Web server
machine.

HTTP transport port
9080

The 9080 value is the default value for the HTTP transport port for the default_host virtual host.
This value is probably the same as the value in the updated file. However, this value changes for
every profile on the application server machine. The HTTP transport port value must be unique for
every application server.

To communicate over a different port, propagate the real plugin-cfg.xml file.

Web server listening port
80
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The 80 value is the default value for the port that controls communication with the Web server.
However, each application server profile must have a unique port value to communicate to a Web
server. The actual port value might be 81 or another number.

To communicate over a different port, propagate the real plugin-cfg.xml file.

HTTPS transport port
9443

The 9443 value is the default value for the HTTPS (secure) transport port for the default_host
virtual host. This value is probably the same as the value in the updated file. However, this value
changes for every profile on the application server machine. The HTTPS transport port value must
be unique for every application server.

To communicate over a different secure port, propagate the real plugin-cfg.xml file.

Applications installed on the server1 application server
All of the default servlets and applications are included in the default file, including the WSsamples
application and the SamplesGallery application.

The default file lists all of the default applications and samples. The list can be inaccurate. If you
performed a custom installation and did not install the samples, for example, the list is inaccurate.

To serve an application that you developed with the Web server, propagate the real
plugin-cfg.xml file.

Configuring a Web server and an application server on separate
machines (remote)

This topic describes installing a Web server plug-in that WebSphere Application Server provides to
communicate with a particular brand of Web server. This procedure describes installing the Web server
and its Web server plug-in for WebSphere Application Server on one machine and the Application Server
on another.

If the WebSphere Application Server product family supports a particular brand of Web server, such as
IBM HTTP Server or Microsoft Internet Information Services (IIS), then your WebSphere Application Server
product provides a binary plug-in for the Web server that you must install.

If the WebSphere Application Server product family does not provide a binary plug-in for a particular brand
of Web server, then the Web server is not supported. The purpose of the binary plug-in is to provide the
communication protocol between the Web server and the application server.

Suppose that you create a new profile. Suppose also that you want to use a Web server. You must install
a new Web server for the new profile and use the Plug-ins installation wizard to install the binary plug-in
module and to configure both the Web server and the application server.

If the Web server is not already installed, you can still install the plug-ins for future use. If the WebSphere
Application Server product is not installed, you can still install the plug-ins. However, it is recommended
that you install the Web server and the WebSphere Application Server product before installing the
plug-ins for the supported Web server.

The Plug-ins installation wizard installs the plug-in module, configures the Web server for communicating
with the application server, and creates a Web server configuration definition in the application server, if
possible.

This procedure configures the application server profile that is the default profile on the machine. A
one-to-one relationship exists between a Web server and the application server.

This topic describes how to create the following topology:
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This topic describes the installation of a Web server on one machine and the application server on a
separate machine. In this situation, the Plug-ins installation wizard on one machine cannot create the Web
server definition in the application server configuration on the other machine.

In such a case, the Plug-ins installation wizard creates a script on the Web server machine that you can
copy to the application server machine. Run the script on the application server machine to create the
Web server configuration definition within the application server configuration.

Perform the following procedure to install the plug-in and configure both the Web server and the
application server.

1.

3.

Log on as root on a Linux or UNIX operating system, or as a member of the administrator group on a
Windows system.

-E'JE. In addition, verify that the umask setting is 022. To verify the umask setting,
issue the following command:

umask
To set the umask setting to 022, issue the following command:
umask 022

m Some steps of the installation on a Windows platform require the administrator group user
to have the following advanced user rights:

* Act as part of the operating system
* Log on as a service
For example, on some Windows systems, click Administrative Tools > Local Security Policy >

User Rights Assignments to see the advanced options. See your Windows documentation for more
information.

m The installation wizard grants your Windows user ID the advanced user rights, if the user
ID belongs to the administrator group. The silent installation does not grant these rights. If you create
a new user ID on a Windows platform to perform a silent installation, you must restart the system to
activate the proper authorizations for the user ID before you can perform a successful silent
installation.

m When installing the WebSphere Application Server as a Windows service, do not use a
user ID that contains spaces. A user ID with spaces cannot be validated. Such a user ID is not
allowed to continue the installation. To work around this problem, install with a user ID that does not
contain spaces, or do not choose to install Windows services.

Install WebSphere Application Server - Express on Machine A.
See |Chapter 9, “Installing the product and additional software,” on page 95.|
Install the IBM HTTP Server or another supported Web server on Machine B.
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See [‘Installing IBM HTTP Server’ on page 139|or refer to the product documentation for your Web
server for more information.

Launch the Plug-ins installation wizard on the machine with the Web server.

Select the Plug-ins installation wizard from the launchpad or change directories to the plugin
directory on the product disc or in the downloaded installation image and issue the install command.

The installation of the plug-ins tolerates installing as a non-root user. However, the automated
installation of the required Global Services Kit (GSKit) fails if you install as non-root.

If you decide to install the plug-in as a non-root user, log on as root after the entire procedure is
complete. Reinstall the GSKit from the GSKit directory on the product disc.

Clear the check box for the roadmap or select the check box to view the roadmap, then click Next.

If you are unsure of which installation scenario to follow, display the roadmap instead. Print and keep
the roadmap as a handy overview of the installation steps.

Press Ctrl-P to print the roadmap if the Web browser navigation controls and the menu bar are not
present on the browser window that displays the Plug-ins roadmap. Press Ctrl-W to close the
browser window if the navigation controls and the menu bar do not display. Or close the browser
window with the window control in the title bar.

Read the license agreement and accept the agreement it if you agree to its terms. Click Next when
you are finished.

If your system does not pass the prerequisites check, stop the installation, correct any problems, and
restart the installation. If your system passes the prerequisites check, click Next.

Look for the appropriate log file for information about missing prerequisites:

* If you stop the installation, see the temporaryPTuginInstalllLog.txt file in the temporary directory
of the user who installed the plug-ins. For example, the /tmp/temporaryPluginInstalllog.txt file
might exist if the root user installed the plug-ins on a Linux or UNIX system.

» If you continue the installation in spite of warnings about missing prerequisites, see the
plugins_install_root/1ogs/install/1og.txt file after the installation is complete.

See [Appendix B, “Troubleshooting installation,” on page 291|for more information about log files.
Select the type of Web server that you are configuring and click Next.

The Plug-ins installation wizard panel prompts you to identify the Web servers to configure. Actually
you can select only one Web server each time you run the Plug-ins installation wizard.

Stop any Web server while you are configuring it. A step later in the procedures directs you to start
the Web server as you begin the snoop servlet test.

If you select the Web server identification option labeled None, the Web server installs the binary
plug-ins but does not configure the Web server. A known problem in the wizard panel causes the
English word None to appear in translated versions of the wizard. However, the selectable option is
functional in every locale in spite of the missing translation.

Select Web server machine (remote) and click Next.
Accept the default location for the installation root directory for the plug-ins. Click Next.

You can type another new directory or click Browse to select an empty directory. The fully qualified
path identifies the plug-ins installation root directory.

The default location is:

. -EE- /usr/I1BM/WebSphere/Plugins
. [ HP-UX | m /opt/IBM/WebSphere/Plugins

. m C:\Program Files\IBM\WebSphere\Plugins
A possibility exists that the Web server might run on a platform that WebSphere Application Server
does not support.

Click Browse to select the configuration file for your Web server, verify that the Web server port is
correct, and then click Next when you are finished.

IBM WebSphere Application Server - Express, Version 6: Installing your application serving environment



12.

13.

14.

15.

16.

Select the file and not just the directory of the file. Some Web servers have two configuration files
and require you to browse for each file.

The following list shows configuration files for supported Web servers:

Apache HTTP Server
apache_install_root/config/httpd.conf

Domino Web Server
names.nsf and Notes.jar

The wizard prompts for the notes. jar file. The actual name is Notes. jar.

The Plug-ins installation wizard verifies that the files exist but the wizard does not validate
either file.

IBM HTTP Server
ihs_install_root/conf/httpd.conf

Microsoft Internet Information Services (IIS)
The Plug-ins installation wizard can determine the correct files to edit.

Sun ONE Web Server 6.0 or Sun Java System Web Server, V6.1
obj.conf and magnus.conf

The wizard displays a naming panel for the nickname of the Web server definition.
Specify a nickname for the Web server. Click Next when you are finished.

The wizard uses the value to name configuration folders in the plug-ins installation root directory. The
wizard also uses the name in the configuration script for the application server to name the Web
server definition.

If the application server profile already has a Web server definition, specify a nickname that matches
the name of the existing Web server definition. Using the same name configures the Web server to
use the Web server definition on the application server.

Accept the default location for the plugin-cfg.xml file that the wizard creates on the Web server
machine, then click Next.

You can type a change to the value or click Browse to select a file in another location. If you do
accept the default location, the pTugin-cfg.xml file must exist.

Identify the host name or IP address of Machine A, which is the application server machine, then click
Next.

Examine the summary panel. Click Next when you are finished.

The panel notifies you that you have manual steps to perform to complete the installation and
configuration. The type of Web server, the nickname of the Web server, and the location of the
plugin-cfg.xml file displays on the panel.

The Plug-ins installation wizard creates the configureWeb server name script in the
plug-ins_installation_root/bin/ directory on Machine B.

The Plug-ins installation wizard also creates the plugin-cfg.xml file in the plug-
ins_installation_root/config/Web_server_name directory.

The Web server reads the pTlugin-cfg.xml file to determine the applications that the application
server on Machine A can serve to the Web server on Machine B. Whenever the configuration
changes, the application server regenerates the file. When regeneration occurs, propagate, or copy
the actual plugin-cfg.xml file from the application server machine to the Web server machine. You
can automatically propagate the file to the IBM HTTP Server product.

Click Next on the pre-installation summary panel to begin the installation or click Back to change any
characteristics of the installation.

The panel specifies the plug-ins installation root directory, the Web server plug-ins feature, and the
disk size of the code that installs when you click Next.
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17. After the wizard installs the code and creates the uninstaller program, examine the post-installation
summary panel. Click Next when you are finished to display the Plug-ins installation roadmap.

The Plug-ins installation wizard installs the binary plug-in module. On a Linux system, for example,
the installation creates the /opt/IBM/WebSphere/Plugins directory. The
/opt/1BM/WebSphere/Plugins/config/Web_server name directory contains the plugin-cfg.xml file.

The wizard displays the name and location of the configuration script and the plugin-cfg.xml file.
The wizard also displays the type of Web server that is configured and the nickname of the Web
server.

If a problem occurs and the installation is unsuccessful, examine the logs in the plug-
ins_install _root/logs directory. Correct any problems and reinstall.

18. Close the road map and click Finish to exit the wizard.
Log files from the installation are in the plug-ins_install_root/10gs/install directory.

19. Copy the configureWeb_server name.sh script on Linux and UNIX systems or the
configureleb_server_name.bat script on Windows systems from Machine B to the
was_install_root/bin directory on Machine A.

For example, on a Linux system with an IBM HTTP Server named webserver1 in the default location,
copy /opt/IBM/WebServer/Plugins/bin/configurewebserverl.sh from Machine B to the
/opt/IBM/WebSphere/AppServer/bin directory on Machine A.

If one platform is a Linux or UNIX system and the other is a Windows platform, copy the script from
the crossPlatformScripts directory. For example:

. -E'JE- plug-ins_install_root/bin/configurelWeb_server_name.sh

o m plug-ins_install_root/bin/crossPlatformScripts/configureWeb_server name.bat
20. Start the application server on Machine A.
Use the startServer command, for example:

o mprofi/es_install_root/pr'ofiZe_name/bin/startServer.sh serverl

. mprofiles_insta/l_root\profiZe_name\bin\startServer serverl

21. Run the script on Machine A to create the Web server definition in the configuration for the application
server.

Open a command window to run the script that you copied to Machine A.

As soon as the Web server definition is created, the application server creates a plugin-cfg.xml file
for the Web server. For example, the file on a Linux system might have this file path: /opt / IBM /
WebSphere / AppServer / profiles / default / config / cells / cellname / nodes /
webserverl node / servers / webserverl / plugin-cfg.xml.

22, ST Domino Web Server only: Set the WAS_PLUGIN_CONFIG_FILE
environment variable.

mTo configure Domino, you must set the WAS_PLUGIN_CONFIG_FILE
environment variable. On Linux and UNIX-based platforms, sourcing a script to the parent shell allows
child processes to inherit the exported variables. On Windows systems, run the script as you would
run any other command. Sourcing is automatic on Windows systems.

a. Open a command window.
b. Change directories to the plug-ins installation root directory.
c. lIssue the appropriate command for the plug-ins_install_root/bin/setupPluginCfg.sh script:

. -E'JE- . plug-ins_install root/bin/setupPluginCfg.sh (Notice the space between the
period and the installation root directory.)

. source plug-ins_install root/bin/setupPluginCfg.sh
The script is also in the lotus_install_root/notesdata directory on Linux and UNIX systems.
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Issue the appropriate command for the script before starting the Domino Web Server.

Start the Snoop servlet to verify the ability of the Web server to retrieve an application from the
Application Server.

Test your environment by starting your Application Server, your Web server, and using the snoop
servlet with an IP address.

a. Start the Application Server.

Change directories to the install_root/profiles/profile_name/bin directory and run the
startServer command:

. m ./startServer.sh serverl
. MStartServer serverl

b. Start the IBM HTTP Server or the Web server that you are using.

Use a command window to change the directory to the IBM HTTP Server installed image, or to
the installed image of your Web server. Issue the appropriate command to start the Web server,
such as these commands for IBM HTTP Server:

To start the IBM HTTP Server from the command line:
Access the apache and apachectl commands in the IBMHttpServer/bin directory.

. -EE. ./apachectl start
. mapache

c. Point your browser to http://Tocalhost:9080/snoop to test the internal HTTP transport provided
by the Application Server. Point your browser to http://Host _name_of Web server _machine/snoop
to test the Web server plug-in.

The HTTP Transport port is 9080 by default and must be unique for every profile. The port is
associated with a virtual host named default_host, which is configured to host the installed
DefaultApplication and any installed Samples. The snoop servlet is part of the DefaultApplication.
Change the port to match your actual HTTP Transport port.

d. Verify that snoop is running.
Either Web address should display the Snoop Servlet - Request/Client Information page.

e. Remote IBM HTTP Server only: Verify that the automatic propagation function can work on a
remote IBM HTTP Server by using the following steps. This procedure is not necessary for local
Web servers.

1) Run the htpasswd command on the Web server machine to create the administrative user ID
and password information.

2) Use the administrative console of the Application Server to enter the User ID and password
information that you created for the administrative user of IBM HTTP Server. Go to Servers >
Web server > Web_server_definition > Remote Web server administration.

Regenerate the plugin-cfg.xml file on Machine A using the administrative console. Click Servers >
Web server. Select the Web server, then click Generate Plug-in.

During the installation of the plug-ins, the temporary pTlugin-cfg.xml file is installed on Machine B in
the plugins_install _root/config/web_server name directory. The Web server plug-in configuration
service regenerates the plugin-cfg.xml file automatically. To use the real plugin-cfg.xml file from
the application server, propagate the plugin-cfg.xml file as described in the next step.

This step shows you how to regenerate the plugin-cfg.xml file. WebSphere Application Server
products are configured to automatically regenerate the file each time a significant event occurs. Such
events include installing applications on the application server and the Web server, for example.
Creating a new virtual host is another such event.

Propagate the plugin-cfg.xml file from the application server to the Web server using the
administrative console. Click Servers > Web server. Select the Web server, then click Propagate
Plug-in. Web servers other than IBM HTTP Server require manual propagation.
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The Web server plug-in configuration service propagates the plugin-cfg.xml file automatically for
IBM HTTP Server 6.0 only. For all other Web servers, propagate the plug-in configuration file by
manually copying the plugin-cfg.xml file from the
profiles_install_root/config/cells/cell_name/nodes/node_name/servers/web_server_name
directory on Machine A to the plugins_install_root/config/web_server_name directory on Machine B.

This procedure results in the installation of the Web server plug-ins for WebSphere Application Server on a
Web server machine. The Plug-ins installation wizard also configures the Web server to support an
application server on a separate machine.

The installation of the binary plug-in modules results in the creation of the Plugins directory and several
subdirectories. The following directories are among those created on a Linux system, for example:

» /opt/IBM/WebSphere/PTugins/ uninstPlugin/_jvmForPlugin contains the WebSphere Application Server
SDK, Java technology edition used to uninstall the product

* /opt/IBM/WebSphere/Plugins/_uninstPlugin contains the uninstaller program

* /opt/IBM/WebSphere/Plugins/bin contains the binary plug-ins for all supported Web servers

e /opt/IBM/WebSphere/Plugins/Togs contains log files

* /opt/IBM/WebSphere/Plugins/properties contains version information

» /opt/1BM/WebSphere/Plugins/roadmap contains the roadmap for the Plug-ins installation wizard

See [‘Selecting a Web server topology diagram and roadmap” on page 142 for an overview of the
installation procedure.

See ['Web server configuration” on page 150 for more information about the files involved in configuring a
Web server.

See [‘Configuration behavior of the Plug-ins installation wizard” on page 145| for information about the
location of the plug-in configuration file.

See [‘Editing Web server configuration files” on page 185| for information about how the Plug-ins installation
wizard configures supported Web servers.

Configuring multiple Web servers and remote stand-alone Application
Servers

This topic describes installing a Web server plug-in that WebSphere Application Server provides to
communicate with a particular brand of Web server. This procedure describes installing multiple Web
servers and their Web server plug-ins for WebSphere Application Server on one machine and multiple
application servers on another.

If the WebSphere Application Server product family supports a particular brand of Web server, such as
IBM HTTP Server or Microsoft Internet Information Services (IIS), then your WebSphere Application Server
product provides a binary plug-in for the Web server that you must install.

If the WebSphere Application Server product family does not provide a binary plug-in for a particular brand
of Web server, then the Web server is not supported. The purpose of the binary plug-in is to provide the
communication protocol between the Web server and the application server.

Suppose that you create a new profile. Suppose also that you want to use a Web server. You must install

a new Web server for the new profile and use the Plug-ins installation wizard to install the binary plug-in
module and to configure both the Web server and the application server.

160 1BM™ WebSphere Application Server - Express, Version 6: Installing your application serving environment



If the Web server is not already installed, you can still install the plug-ins for future use. If the WebSphere
Application Server product is not installed, you can still install the plug-ins. However, it is recommended
that you install the Web server and the WebSphere Application Server product before installing the
plug-ins for the supported Web server.

The Plug-ins installation wizard installs the plug-in module, configures the Web server for communicating
with the application server, and creates a Web server configuration definition in the application server, if
possible.

This topic describes how to create the following topology:

Firewall Firewall
'
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data
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/ i
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Perform the following procedure to install the plug-ins and configure both Web servers and both
application servers.

This topology lets each profile have unique applications, configuration settings, data, and log files, while
sharing the same set of system files. Creating multiple profiles creates multiple application server
environments that you can then dedicate to different purposes.

For example, each application server on a Web site can serve a different application. In another example,
each application server can be a separate test environment that you assign to a programmer or a
development team.

1. Log on as root on a Linux or UNIX operating system, or as a member of the administrator group on a
Windows system.

-E'E- In addition, verify that the umask setting is 022. To verify the umask setting,
issue the following command:

umask
To set the umask setting to 022, issue the following command:
umask 022

m Some steps of the installation on a Windows platform require the administrator group user
to have the following advanced user rights:

* Act as part of the operating system
* Log on as a service

For example, on some Windows systems, click Administrative Tools > Local Security Policy >
User Rights Assignments to see the advanced options. See your Windows documentation for more
information.
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m The installation wizard grants your Windows user ID the advanced user rights, if the user
ID belongs to the administrator group. The silent installation does not grant these rights. If you create
a new user ID on a Windows platform to perform a silent installation, you must restart the system to
activate the proper authorizations for the user ID before you can perform a successful silent
installation.

m When installing the WebSphere Application Server as a Windows service, do not use a
user ID that contains spaces. A user ID with spaces cannot be validated. Such a user ID is not
allowed to continue the installation. To work around this problem, install with a user ID that does not
contain spaces, or do not choose to install Windows services.

2. Install WebSphere Application Server - Express on Machine A.
See |Chapter 9, “Installing the product and additional software,” on page 95.|
3. Install the IBM HTTP Server or another supported Web server on Machine B.

See |“Insta||ing IBM HTTP Server” on page 139|or refer to the product documentation for your Web
server for more information.

4. Launch the Plug-ins installation wizard on the machine with the Web server.
Select the Plug-ins installation wizard from the launchpad or change directories to the plugin
directory on the product disc or in the downloaded installation image and issue the install command.

The installation of the plug-ins tolerates installing as a non-root user. However, the automated
installation of the required Global Services Kit (GSKit) fails if you install as non-root.

If you decide to install the plug-in as a non-root user, log on as root after the entire procedure is
complete. Reinstall the GSKit from the GSKit directory on the product disc.

5. Clear the check box for the roadmap or select the check box to view the roadmap, then click Next.

If you are unsure of which installation scenario to follow, display the roadmap instead. Print and keep

the roadmap as a handy overview of the installation steps.

Press Ctrl-P to print the roadmap if the Web browser navigation controls and the menu bar are not

present on the browser window that displays the Plug-ins roadmap. Press Ctrl-W to close the

browser window if the navigation controls and the menu bar do not display. Or close the browser
window with the window control in the title bar.

6. Read the license agreement and accept the agreement it if you agree to its terms. Click Next when
you are finished.

7. If your system does not pass the prerequisites check, stop the installation, correct any problems, and
restart the installation. If your system passes the prerequisites check, click Next.

Look for the appropriate log file for information about missing prerequisites:

« If you stop the installation, see the temporaryPTuginInstalllLog.txt file in the temporary directory
of the user who installed the plug-ins. For example, the /tmp/temporaryPluginInstalllog.txt file
might exist if the root user installed the plug-ins on a Linux or UNIX system.

» If you continue the installation in spite of warnings about missing prerequisites, see the
plugins_install_root/1ogs/install/1og.txt file after the installation is complete.

See [Appendix B, “Troubleshooting installation,” on page 291|for more information about log files.

8. Select the type of Web server that you are configuring and click Next.

The Plug-ins installation wizard panel prompts you to identify the Web servers to configure. Actually

you can select only one Web server each time you run the Plug-ins installation wizard.

Stop any Web server while you are configuring it. A step later in the procedures directs you to start
the Web server as you begin the snoop servlet test.

If you select the Web server identification option labeled None, the Web server installs the binary
plug-ins but does not configure the Web server. A known problem in the wizard panel causes the
English word None to appear in translated versions of the wizard. However, the selectable option is
functional in every locale in spite of the missing translation.

9. Select Web server machine (remote) and click Next.
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10.

1.

12.

13.

14.

15.

Accept the default location for the installation root directory for the plug-ins. Click Next.

You can type another new directory or click Browse to select an empty directory. The fully qualified
path identifies the plug-ins installation root directory.

The default location is:

. -EE- /usr/I1BM/WebSphere/Plugins

. - HP-UX | m /opt/IBM/WebSphere/Plugins

. m C:\Program Files\IBM\WebSphere\Plugins

A possibility exists that the Web server might run on a platform that WebSphere Application Server
does not support.

Click Browse to select the configuration file for your Web server, verify that the Web server port is
correct, and then click Next when you are finished.

Select the file and not just the directory of the file. Some Web servers have two configuration files
and require you to browse for each file.

The following list shows configuration files for supported Web servers:

Apache HTTP Server
apache_install_root/config/httpd.conf

Domino Web Server
names.nsf and Notes. jar

The wizard prompts for the notes.jar file. The actual name is Notes. jar.

The Plug-ins installation wizard verifies that the files exist but the wizard does not validate
either file.

IBM HTTP Server
ihs_install_root/conf/httpd.conf

Microsoft Internet Information Services (IIS)
The Plug-ins installation wizard can determine the correct files to edit.

Sun ONE Web Server 6.0 or Sun Java System Web Server, V6.1

obj.conf and magnus.conf
The wizard displays a naming panel for the nickname of the Web server definition.
Specify a nickname for the Web server. Click Next when you are finished.

The wizard uses the value to name configuration folders in the plug-ins installation root directory. The
wizard also uses the name in the configuration script for the application server to name the Web
server definition.

If the application server profile already has a Web server definition, specify a nickname that matches
the name of the existing Web server definition. Using the same name configures the Web server to
use the Web server definition on the application server.

Accept the default location for the plugin-cfg.xml file that the wizard creates on the Web server
machine, then click Next.

You can type a change to the value or click Browse to select a file in another location. If you do
accept the default location, the plugin-cfg.xml file must exist.

Identify the host name or IP address of Machine A, which is the application server machine, then click
Next.

Examine the summary panel. Click Next when you are finished.

The panel notifies you that you have manual steps to perform to complete the installation and
configuration. The type of Web server, the nickname of the Web server, and the location of the
plugin-cfg.xml file displays on the panel.
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16.

17.

18.

19.

20.

21.

22.

164

The Plug-ins installation wizard creates the configureieb_server_name script in the
plug-ins_installation_root/bin/ directory on Machine B.

The Plug-ins installation wizard also creates the plugin-cfg.xml file in the plug-
ins_installation_root/config/Web_server_name directory.

The Web server reads the plugin-cfg.xml file to determine the applications that the application
server on Machine A can serve to the Web server on Machine B. Whenever the configuration
changes, the application server regenerates the file. When regeneration occurs, propagate, or copy
the actual plugin-cfg.xml file from the application server machine to the Web server machine. You
can automatically propagate the file to the IBM HTTP Server product.

Click Next on the pre-installation summary panel to begin the installation or click Back to change any
characteristics of the installation.

The panel specifies the plug-ins installation root directory, the Web server plug-ins feature, and the
disk size of the code that installs when you click Next.

After the wizard installs the code and creates the uninstaller program, examine the post-installation
summary panel. Click Next when you are finished to display the Plug-ins installation roadmap.

The Plug-ins installation wizard installs the binary plug-in module. On a Linux system, for example,
the installation creates the /opt/IBM/WebSphere/Plugins directory. The
/opt/IBM/WebSphere/Plugins/config/Web server_name directory contains the plugin-cfg.xml file.

The wizard displays the name and location of the configuration script and the plugin-cfg.xml file.
The wizard also displays the type of Web server that is configured and the nickname of the Web
server.

If a problem occurs and the installation is unsuccessful, examine the logs in the plug-
ins_install_root/logs directory. Correct any problems and reinstall.

Close the road map and click Finish to exit the wizard.
Log files from the installation are in the plug-ins_install_root/10gs/install directory.

Copy the configureWeb_server name.sh script on Linux and UNIX systems or the
configureWeb_server_name.bat script on Windows systems from Machine B to the
was_install_root/bin directory on Machine A.

For example, on a Linux system with an IBM HTTP Server named webserver1 in the default location,
copy /opt/IBM/WebServer/Plugins/bin/configurewebserverl.sh from Machine B to the
/opt/IBM/WebSphere/AppServer/bin directory on Machine A.

If one platform is a Linux or UNIX system and the other is a Windows platform, copy the script from
the crossPlatformScripts directory. For example:

. -EJE- plug-ins_install_root/bin/configureWeb_server name.sh

o m plug-ins_install_root/bin/crossPlatformScripts/configureWeb_server name.bat
Start the application server on Machine A.
Use the startServer command, for example:

. -EE- profiles_install_root/profile_name/bin/startServer.sh serverl

. mprofiles_insta/l_root\profiZe_name\bin\startServer serverl

Run the script on Machine A to create the Web server definition in the configuration for the application
server.

Open a command window to run the script that you copied to Machine A.

As soon as the Web server definition is created, the application server creates a plugin-cfg.xml file
for the Web server. For example, the file on a Linux system might have this file path: /opt / IBM /
WebSphere / AppServer / profiles / default / config / cells / cellname / nodes /
webserverl node / servers / webserverl / plugin-cfg.xml.

ST pomino Web Server only: Set the WAS_PLUGIN_CONFIG_FILE
environment variable.
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23.

mTo configure Domino, you must set the WAS_PLUGIN_CONFIG_FILE
environment variable. On Linux and UNIX-based platforms, sourcing a script to the parent shell allows
child processes to inherit the exported variables. On Windows systems, run the script as you would
run any other command. Sourcing is automatic on Windows systems.

a. Open a command window.
b. Change directories to the plug-ins installation root directory.
c. lIssue the appropriate command for the plug-ins_install_root/bin/setupPluginCfg.sh script:

. -EE- . plug-ins_install root/bin/setupPluginCfg.sh (Notice the space between the
period and the installation root directory.)

. source plug-ins_install_root/bin/setupPluginCfg.sh
The script is also in the lotus_install_root/notesdata directory on Linux and UNIX systems.
Issue the appropriate command for the script before starting the Domino Web Server.

Start the Snoop servlet to verify the ability of the Web server to retrieve an application from the
Application Server.

Test your environment by starting your Application Server, your Web server, and using the snoop
servlet with an IP address.

a. Start the Application Server.

Change directories to the install_root/profiles/profile _name/bin directory and run the
startServer command:

. m ./startServer.sh serverl
. MStar‘tServer serverl

b. Start the IBM HTTP Server or the Web server that you are using.

Use a command window to change the directory to the IBM HTTP Server installed image, or to
the installed image of your Web server. Issue the appropriate command to start the Web server,
such as these commands for IBM HTTP Server:

To start the IBM HTTP Server from the command line:
Access the apache and apachectl commands in the IBMHttpServer/bin directory.

. m ./apachectl start
. Mapache

c. Point your browser to http://Tocalhost:9080/snoop to test the internal HTTP transport provided

by the Application Server. Point your browser to http://Host _name_of Web server _machine/snoop
to test the Web server plug-in.
The HTTP Transport port is 9080 by default and must be unique for every profile. The port is
associated with a virtual host named default_host, which is configured to host the installed
DefaultApplication and any installed Samples. The snoop servlet is part of the DefaultApplication.
Change the port to match your actual HTTP Transport port.

d. Verify that snoop is running.

Either Web address should display the Snoop Servlet - Request/Client Information page.

e. Remote IBM HTTP Server only: Verify that the automatic propagation function can work on a
remote IBM HTTP Server by using the following steps. This procedure is not necessary for local
Web servers.

1) Run the htpasswd command on the Web server machine to create the administrative user ID
and password information.
2) Use the administrative console of the Application Server to enter the User ID and password

information that you created for the administrative user of IBM HTTP Server. Go to Servers >
Web server > Web_server_definition > Remote Web server administration.
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24. Regenerate the plugin-cfg.xml file on Machine A using the administrative console. Click Servers >
Web server. Select the Web server, then click Generate Plug-in.

During the installation of the plug-ins, the temporary plugin-cfg.xml file is installed on Machine B in
the plugins_install_root/config/web_server_name directory. The Web server plug-in configuration
service regenerates the plugin-cfg.xml file automatically. To use the real plugin-cfg.xml file from
the application server, propagate the plugin-cfg.xml file as described in the next step.

This step shows you how to regenerate the plugin-cfg.xml file. WebSphere Application Server
products are configured to automatically regenerate the file each time a significant event occurs. Such
events include installing applications on the application server and the Web server, for example.
Creating a new virtual host is another such event.

25. Propagate the plugin-cfg.xml file from the application server to the Web server using the
administrative console. Click Servers > Web server. Select the Web server, then click Propagate
Plug-in. Web servers other than IBM HTTP Server require manual propagation.

The Web server plug-in configuration service propagates the plugin-cfg.xml file automatically for
IBM HTTP Server 6.0 only. For all other Web servers, propagate the plug-in configuration file by
manually copying the plugin-cfg.xml file from the
profiles_install_root/config/cells/cell_name/nodes/node_name/servers/web_server_name
directory on Machine A to the plugins_install_root/config/web_server_name directory on Machine B.

26. Create the second application server profile using the Profile creation wizard on Machine A. Make the
profile the default profile during the profile creation by selecting the check box on the appropriate
panel.

The script that the Plug-ins installation wizard creates works on the default profile only. So, this script
can create only a Web server definition on the profile that is the default profile at the time that the
script runs.

27. Install a second IBM HTTP Server or another supported Web server on Machine B.

28. On Machine B, install the Web server plug-ins to configure the second Web server using the Plug-ins
installation wizard. Both Web servers share a single installation of the plug-in binaries but must be
configured individually.

29. The Plug-ins installation wizard creates a script named configurelleb_server_name for the second
Web server. The script is in the plugins_install_root/bin directory on Machine B. Copy the script to
the install_root/bin directory on Machine A.

30. Start the second application server.

31. Run the configurelWeb_server_name script to create a Web server definition in the administrative
console. You can then use the administrative console to manage the Web server.

32. Propagate the plugin-cfg.xml file from the second application server to the Web server using the
administrative console. Click Servers > Web server > Propagate Plug-in. Web servers other than
IBM HTTP Server require manual propagation.

33. Run the snoop servlet on the second Web server to verify that it is operational.

This procedure results in installing two or more application servers on one machine and installing
dedicated Web servers on another machine. This procedure installs the Web server plug-ins for both Web
servers and configures both Web servers and both application servers.

See [‘Selecting a Web server topology diagram and roadmap” on page 142| for an overview of the
installation procedure.

See ['Web server configuration” on page 150| for more information about the files involved in configuring a
Web server.

See |“Editing Web server configuration files” on page 185| for information about how the Plug-ins installation
wizard configures supported Web servers.
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Configuring a Web server and an application server profile on the
same machine

This topic describes installing a Web server plug-in that WebSphere Application Server provides to
communicate with a particular brand of Web server. This procedure describes installing the Web server
and its Web server plug-in for WebSphere Application Server and the Application Server on the same
machine .

If the WebSphere Application Server product family supports a particular brand of Web server, such as
IBM HTTP Server or Microsoft Internet Information Services (IIS), then your WebSphere Application Server
product provides a binary plug-in for the Web server that you must install.

If the WebSphere Application Server product family does not provide a binary plug-in for a particular brand
of Web server, then the Web server is not supported. The purpose of the binary plug-in is to provide the
communication protocol between the Web server and the application server.

Suppose that you create a new profile. Suppose also that you want to use a Web server. You must install
a new Web server for the new profile and use the Plug-ins installation wizard to install the binary plug-in
module and to configure both the Web server and the application server.

If the Web server is not already installed, you can still install the plug-ins for future use. If the WebSphere
Application Server product is not installed, you can still install the plug-ins. However, it is recommended
that you install the Web server and the WebSphere Application Server product before installing the
plug-ins for the supported Web server.

This procedure configures the application server profile that is the default profile on the machine. A
one-to-one relationship exists between a Web server and the application server.

This topic describes how to create the following topology:

Machine A Data tier, optional
Web client Web server B olication
(browser) r;
Application
data

The wizard performs three steps to properly configure a Web server for Version 6. The wizard performs
the steps in the following order:

1. The wizard installs the unique binary plug-in module for the supported Web server after collecting the
following information:

* The type of Web server
» The location of the configuration file for the Web server that the wizard configures
* The plug-ins installation root directory for the Web server plug-in modules that the wizard installs

* The installation root directory of the WebSphere Application Server product, where the wizard
creates a Web server definition

2. The wizard prompts you for the location of the configuration file or files for the Web server. You must
browse for and select the correct file.

The wizard edits the configuration file or files for a Web server by creating directives that point to the
location of the binary plug-in module and the plug-in configuration file.
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The name of the binary plug-in module varies per Web server type. The plug-in configuration file is
always the plugin-cfg.xml file.

The wizard creates a Web server definition in the configuration of the application server unless one
already exists.

You can use the administrative console to manage the Web server configuration. For example, when
you install an application on the application server, you can also choose to install it on the Web server
definition. If so, the updated plugin-cfg.xml file shows that the new application is available. When the
Web server reads the updated plug-in configuration file, the Web server becomes aware of the new
application that it can serve to Web clients.

If you choose not to install the new application on the Web server definition, the application is not
added to the plug-in configuration file. The Web server is not aware of the application and cannot
serve it to Web clients.

Use the following procedure to install the Web server plug-in, configure the Web server, and create a Web
server definition in the default application server profile.

1.

Log on as root on a Linux or UNIX operating system, or as a member of the administrator group on a
Windows system.

-E'E- In addition, verify that the umask setting is 022. To verify the umask setting,
issue the following command:

umask
To set the umask setting to 022, issue the following command:
umask 022

m Some steps of the installation on a Windows platform require the administrator group user
to have the following advanced user rights:

* Act as part of the operating system

» Log on as a service

For example, on some Windows systems, click Administrative Tools > Local Security Policy >

User Rights Assignments to see the advanced options. See your Windows documentation for more
information.

m The installation wizard grants your Windows user ID the advanced user rights, if the user
ID belongs to the administrator group. The silent installation does not grant these rights. If you create
a new user ID on a Windows platform to perform a silent installation, you must restart the system to
activate the proper authorizations for the user ID before you can perform a successful silent
installation.

m When installing the WebSphere Application Server as a Windows service, do not use a
user ID that contains spaces. A user ID with spaces cannot be validated. Such a user ID is not
allowed to continue the installation. To work around this problem, install with a user ID that does not
contain spaces, or do not choose to install Windows services.

Install WebSphere Application Server - Express on Machine A.
See |Chapter 9, “Installing the product and additional software,” on page 95.|
Install the IBM HTTP Server or another supported Web server on Machine B.

See [‘Installing IBM HTTP Server’ on page 139|or refer to the product documentation for your Web
server for more information.

Launch the Plug-ins installation wizard on the machine with the Web server.

Select the Plug-ins installation wizard from the launchpad or change directories to the plugin
directory on the product disc or in the downloaded installation image and issue the install command.

The installation of the plug-ins tolerates installing as a non-root user. However, the automated
installation of the required Global Services Kit (GSKit) fails if you install as non-root.
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10.
11.

If you decide to install the plug-in as a non-root user, log on as root after the entire procedure is
complete. Reinstall the GSKit from the GSKit directory on the product disc.

Stop the stand-alone application server before installing the Web server plug-ins. For example,
assuming that the profile name is default, use one of the following commands.

. -IE- /usr/ IBM/ WebSphere/ AppServer/ profiles/ default/ bin/ stopServer.sh serverl
. -EJE- /opt/ IBM/ WebSphere/ AppServer/ profiles/ default/ bin/

stopServer.sh serverl

. m C:\ Program Files\ IBM\ WebSphere\ AppServer\ profiles\ default\ bin\
stopServer.sh serverl

Clear the check box for the roadmap or select the check box to view the roadmap, then click Next.

If you are unsure of which installation scenario to follow, display the roadmap instead. Print and keep
the roadmap as a handy overview of the installation steps.

Press Ctrl-P to print the roadmap if the Web browser navigation controls and the menu bar are not
present on the browser window that displays the Plug-ins roadmap. Press Ctrl-W to close the
browser window if the navigation controls and the menu bar do not display. Or close the browser
window with the window control in the title bar.

Read the license agreement and accept the agreement it if you agree to its terms. Click Next when
you are finished.

If your system does not pass the prerequisites check, stop the installation, correct any problems, and
restart the installation. If your system passes the prerequisites check, click Next.

Look for the appropriate log file for information about missing prerequisites:

* If you stop the installation, see the temporaryPTuginInstalllLog.txt file in the temporary directory
of the user who installed the plug-ins. For example, the /tmp/temporaryPluginInstalllog.txt file
might exist if the root user installed the plug-ins on a Linux or UNIX system.

 If you continue the installation in spite of warnings about missing prerequisites, see the
plugins_install_root/1ogs/install/log.txt file after the installation is complete.

See [Appendix B, “Troubleshooting installation,” on page 291| for more information about log files.
Select the type of Web server that you are configuring and click Next.

The Plug-ins installation wizard panel prompts you to identify the Web servers to configure. Actually
you can select only one Web server each time you run the Plug-ins installation wizard.

Stop any Web server while you are configuring it. A step later in the procedures directs you to start
the Web server as you begin the snoop servlet test.

If you select the Web server identification option labeled None, the Web server installs the binary
plug-ins but does not configure the Web server. A known problem in the wizard panel causes the
English word None to appear in translated versions of the wizard. However, the selectable option is
functional in every locale in spite of the missing translation.

Select Application Server machine (local) and click Next.
Accept the default location for the installation root directory for the plug-ins. Click Next.

You can type another new directory or click Browse to select an empty directory. The fully qualified
path identifies the plug-ins installation root directory.

The default location is:

. -JE- /usr/1BM/WebSphere/Plugins
. m m /opt/IBM/WebSphere/Plugins

. m C:\Program Files\IBM\WebSphere\Plugins

A possibility exists that the Web server might run on a platform that WebSphere Application Server
does not support.
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12. Click Browse on the Application Server installation location panel to browse for the location of the
Application Server profile, if necessary. Click Next when the installation root directory is correct.

The fully qualified path identifies the installation root directory for the WebSphere Application Server
product.

The default location is:
. -EE- /usr/1BM/WebSphere/AppServer
. [ HP-UX m /opt/IBM/WebSphere/AppServer

. mc:\Program Files\IBM\WebSphere\AppServer

13. Click Browse to select the configuration file for your Web server, verify that the Web server port is
correct, and then click Next when you are finished.

Select the file and not just the directory of the file. Some Web servers have two configuration files
and require you to browse for each file.

The following list shows configuration files for supported Web servers:

Apache HTTP Server
apache_install_root/config/httpd.conf

Domino Web Server
names.nsf and Notes.jar

The wizard prompts for the notes.jar file. The actual name is Notes.jar.

The Plug-ins installation wizard verifies that the files exist but the wizard does not validate
either file.

IBM HTTP Server
ihs_install_root/conf/httpd.conf

Microsoft Internet Information Services (lIS)
The Plug-ins installation wizard can determine the correct files to edit.

Sun ONE Web Server 6.0 or Sun Java System Web Server, V6.1
obj.conf and magnus.conf
The wizard displays a naming panel for the nickname of the Web server definition.
14. Specify a nickname for the Web server. Click Next when you are finished.

The wizard uses the value to name configuration folders in the plug-ins installation root directory. The
wizard also uses the name in the configuration script for the application server to name the Web
server definition.
If the application server profile already has a Web server definition, specify a nickname that matches
the name of the existing Web server definition. Using the same name configures the Web server to
use the Web server definition on the application server.

15. Specify the location for the pTugin-cfg.xml file and click Next.
This is a critical selection.
See |“Configuration behavior of the Plug-ins installation wizard” on page 145| for a description of the
logic that determines what path is configured by default. The following possibilities exist for the default
location of the plug-in configuration file. The wizard determines the characteristics of the application
server to determine the best path for the file:
* An application server that has an existing Web server definition has the following path:

plug-ins_install_root/config/
web_server_name/plugin-cfg.xml

« A stand-alone application server that does not have a Web server definition has the following path:
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16.

17.

18.

19.

was_install_root/profiles/profile_name
/config/cells/cell_name/nodes/
Web_server_name_node/servers/
Web_server_name/plugin-cfg.xml

You can accept the default value if the application server does not have a Web server definition.
Using an existing Web server definition

If the application server has a Web server definition, the wizard cannot create a new Web server
definition within the application server configuration. However, the wizard can reconfigure the Web
server. Click Browse and select the existing plugin-cfg.xml file in the application server
configuration.

To find the plug-in configuration file in a stand-alone application server, follow this file path:

was_install_root/profiles/profile_name

/config/cells/cell_name/nodes/

Web_server_name_node/servers/

Web_server_name/plugin-cfg.xml
If the existing Web_server_name is different than the nickname that you gave the Web server in the
wizard, click Back to return to the naming panel for the Web server and change the name to match
the existing Web server definition name.

If you cannot find an existing plugin-cfg.xml file after all, you must install the temporary
plugin-cfg.xml file. In such a case, type the path to the plug-ins installation root directory so that the
wizard can install the temporary plug-in configuration file:
plug-ins_install_root/config/

web_server_name/plugin-cfg.xml
Click Next after verifying the characteristics of the plug-ins installation or click Back to make
changes.
Once created, a Web server definition on a stand-alone application server node cannot be removed
except through scripting. (See[“‘Uninstalling the Web server plug-ins for WebSphere Application|
[Server” on page 183|for the procedure.)
You can, however, reuse the same definition for a different type of Web server. Run the Plug-ins
installation wizard to configure a new Web server in that situation. The Plug-ins installation wizard
configures the new Web server to use the existing plugin-cfg.xml file.
Click Next on the pre-installation summary panel to begin the installation or click Back to change any
characteristics of the installation. The wizard begins installing the plug-ins and configuring the Web
server and the application server.
The wizard shows an installation status panel as it installs the plug-ins.
The wizard displays the Installation summary panel at the completion of the installation.
Verify the success of the installation on the Installation summary panel and click Finish to exit the
wizard.
If a problem occurs and the installation is unsuccessful, examine the logs in the plug-
ins_install _root/logs directory. Correct any problems and reinstall.

-EE. Domino Web Server only: Set the WAS_PLUGIN_CONFIG_FILE
environment variable.

-IEE. To configure Domino, you must set the WAS_PLUGIN_CONFIG_FILE
environment variable. On Linux and UNIX-based platforms, sourcing a script to the parent shell allows
child processes to inherit the exported variables. On Windows systems, run the script as you would
run any other command. Sourcing is automatic on Windows systems.

a. Open a command window.
b. Change directories to the plug-ins installation root directory.
c. lIssue the appropriate command for the plug-ins_install_root/bin/setupPluginCfg.sh script:
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. -E'JE- . plug-ins_install root/bin/setupPluginCfg.sh (Notice the space between the
period and the installation root directory.)

. source plug-ins_install root/bin/setupPluginCfg.sh
The script is also in the lotus_install_root/notesdata directory on Linux and UNIX systems.
Issue the appropriate command for the script before starting the Domino Web Server.

20. Start the Snoop servlet to verify the ability of the Web server to retrieve an application from the
Application Server.

Test your environment by starting your Application Server, your Web server, and using the snoop
servlet with an IP address.

a. Start the Application Server.

Change directories to the install_root/profiles/profile_name/bin directory and run the
startServer command:

. -EE- ./startServer.sh serverl
. MStartServer serverl

b. Start the IBM HTTP Server or the Web server that you are using.

Use a command window to change the directory to the IBM HTTP Server installed image, or to
the installed image of your Web server. Issue the appropriate command to start the Web server,
such as these commands for IBM HTTP Server:

To start the IBM HTTP Server from the command line:
Access the apache and apachectl commands in the IBMHttpServer/bin directory.

. -EE- ./apachectl start
. Mapache

c. Point your browser to http://Tocalhost:9080/snoop to test the internal HTTP transport provided
by the Application Server. Point your browser to http://Host_name_of Web_server _machine/snoop
to test the Web server plug-in.

The HTTP Transport port is 9080 by default and must be unique for every profile. The port is
associated with a virtual host named default_host, which is configured to host the installed
DefaultApplication and any installed Samples. The snoop servlet is part of the DefaultApplication.
Change the port to match your actual HTTP Transport port.

d. Verify that snoop is running.
Either Web address should display the Snoop Servlet - Request/Client Information page.

e. Remote IBM HTTP Server only: Verify that the automatic propagation function can work on a
remote IBM HTTP Server by using the following steps. This procedure is not necessary for local
Web servers.

1) Run the htpasswd command on the Web server machine to create the administrative user ID
and password information.

2) Use the administrative console of the Application Server to enter the User ID and password
information that you created for the administrative user of IBM HTTP Server. Go to Servers >
Web server > Web_server_definition > Remote Web server administration.

The installation of the binary plug-in modules results in the creation of the Plugins directory and several
subdirectories. The following directories are among those created on a Linux system, for example:

» /opt/I1BM/WebSphere/Plugins/ uninstPlugin/_jvmForPlugin contains the WebSphere Application Server
SDK, Java technology edition used to uninstall the product

» /opt/IBM/WebSphere/PTlugins/_uninstPlugin contains the uninstaller program
» /opt/IBM/WebSphere/Plugins/bin contains the binary plug-ins for all supported Web servers
* /opt/IBM/WebSphere/Plugins/Togs contains log files
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» /opt/I1BM/WebSphere/Plugins/properties contains version information
* /opt/IBM/WebSphere/Plugins/roadmap contains the roadmap for the Plug-ins installation wizard

The Plug-ins installation wizard creates a Web server definition within the application server profile unless
one already exists.

The Plug-ins installation wizard configures the Web server to use the
profiles_install_root/profile_name/plugin-cfg.xml file.

The application server regenerates the Web server plug-in configuration file, pTugin-cfg.xml whenever an
event occurs that affects the file. Such events include the addition or removal of an application, server, or
virtual host. The stand-alone application server regenerates the file in the following location:
was_install_root/profiles/profile_name

/config/cells/cell_name/nodes/

Web_server_name_node/servers/

Web_server_name/plugin-cfg.xml

You can start a stand-alone application server and the Web server immediately after installing of the binary
plug-in for the local Web server. Open the administrative console of the application server after you start
the server and save the changed configuration.

See [‘Selecting a Web server topology diagram and roadmap” on page 142 for an overview of the
installation procedure.

See [‘Configuration behavior of the Plug-ins installation wizard” on page 145| for information about the
location of the plug-in configuration file.

See ['‘Web server configuration” on page 150 for information about the files involved in configuring a Web
server.

See [‘Editing Web server configuration files” on page 185| for information about how the Plug-ins installation
wizard configures supported Web servers.

See [‘Installing Web server plug-ins” on page 141|for information about other installation scenarios for
installing Web server plug-ins.

Related concepts

[‘Configuration behavior of the Plug-ins installation wizard” on page 145

This topic describes installing the Web server plug-ins for WebSphere Application Server. The Plug-ins
installation wizard installs a binary plug-in module and a plug-in configuration file for the Web server.
The Plug-ins installation wizard configures the supported Web server for the Application Server. The
Plug-ins installation wizard also creates a Web server definition in the configuration of the application
server.

[“‘Web server configuration” on page 150|

After installing a supported Web server, you must install a binary plug-in module for the Web server.
The plug-in module lets the Web server communicate with the application server. The Plug-ins
installation wizard installs the Web server plug-in. The wizard configures the Web server. The wizard
also creates a Web server definition in the configuration of the application server.

responsefile.txt

This topic describes the response file for performing a silent installation of the Web server plug-ins for
WebSphere Application Server.

Install the product silently using an options response file.
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The responsefile.txt file has directives that set installation options. Comments in the file describe how to
set the string value for each directive.

Use the options file to run the Plug-ins installation wizard in silent mode, which is referred to as installing
silently. The wizard reads the options file to determine responses and does not display the graphical user
interface. Use the following command to use a copy of the options file named myresponsefile.txt for a
silent installation:

install -options "myresponsefile.txt" -silent

Location of the response file
The sample options response file is named responsefile.txt. The file is in the plugin directory on the
product disc or in the downloaded installation image.

Mode of use
The Plug-ins installation wizard can read an existing options response file and run silently without
displaying the graphical user interface.

Installing silently: The options file supplies the values to the Plug-ins installation wizard when installing
silently. The wizard reads the options file to determine responses and does not display the graphical user
interface. Use the following command to use a copy of the options file named myresponsefile.txt for a
silent installation:

install -options "myresponsefile.txt" -silent

Creating an operational environment: The installation of the plug-ins is a three-step process:

1. Installing the binary plug-in modules for supported Web servers

2. Configuring the Web servers to use the binary module to communicate with the application server
3. Creating a Web server definition in the application server

As you install an application, you can install it on the Web server definition in addition to the
application server. All applications on the Web server definition are listed in its plug-in configuration file.
After propagation, the real Web server can access the applications.

The granular assignment of applications to a Web server is new in Version 6.

The sample options response file, responsefile.txt, controls installing the binary plug-ins, configuring the
Web server, and creates a script for creating the Web server definition on a remote application server
machine. The script is customized according to values supplied in the responsefile.txt file. The script is
generated to run on the application server machine to create the Web server definition.

If the Web server is on the same machine as a stand-alone application server, the responsefile.txt file
can create the Web server definition directly without creating a script.

To edit and use the response file for installing the plug-ins and configuring the Web server and application
server, perform the following procedure:

1. Copy the responsefile.txt file from the plugins directory on the product disc to a place that you can
easily identify on your machine.

2. Edit the file to customize the values for your installation.
3. Save the file.
4. Start the installation. For example:

install -options /tmp/plugins/myresponsefile.txt -silent
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m On non-Windows operating systems, silent installations run in a synchronous process. The
process does not return until the silent installation finishes. For a silent installation to run
synchronously on Windows, issue the first of the following commands:

* Synchronous processing:START /WAIT install.exe -options "C:\temp\myresponsefile.txt”
-silent

* Asynchronous processing:install -options "C:\temp\plugins\myresponsefile.txt” -silent
5. After the installation, examine the logs for success.

Logging

If no installation logs exist, refer to temporary log file, temporaryPTuginInstalllog.txt in your temporary
directory. You can also cause ISMP to record status about a problem that is preventing the installation
from occurring, as described in the following section.

For example, if you start the silent installation without accepting the license in the -W
silentinstallLicenseAcceptance.value="true"” directive, the installation does not occur. The fact that the
license entry was not accepted is recorded in temporaryPTuginInstalllLog.txt in the user temporary
directory.

For example, the root user on a Linux system would normally find the file in the
/tmp/temporaryPluginInstalllog.txt directory.

If any response file validation results in a failure, the failure is listed in the temporaryPTuginInstalllLog.txt
file, then the installation fails.

If all validations pass, the installation occurs. Then, the Plug-ins installation wizard records installation
events in the following log files. The log files are in the plug-ins_install_root/1ogs/install directory:

log. txt
Records all of the ISMP events that occur during the installation. The log also describes whether
the installation was local or remote. Messages at the end of the file indicate whether manual
configuration steps are required to complete the installation.

Key elements to look for in the installation record are:
Manual steps warning

When the wizard requires you to run a script to create the Web server definition, the
wizard refers to the fact that manual steps are required.

If manual steps are required, the name and location of the script that you must run are
written in the log file at the end of the installation record.

Web server type

The log has a record of the Web server type, such as IHS for the IBM HTTP Server, for
example.

Location of the plug-in configuration file

The log has a record of the plugin-cfg.xml file location currently in the Web server
configuration.

masterConfigurationLog.txt
Lists all of the configuration events that occur during the installation.

installGSKit.log
Lists events that occur during the installation of the GSKit code.

The command line for the installation is listed when the installation occurs. The GSKit 7 installation
record is written after the GSKIT 7 : entry in the log.
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mThe GSKit 4 installation record is written after the GSKIT 4: entry in the log.
installWeb_server_typePlugin.log

Records events that occur during the installation of a Web server plug-in. The name of the file

varies to reflect the Web server:
* instalTAPACHEPTugin.Tog

e installIHSPlugin.log

* installIISPlugin.log

* installSunOnePlugin.log

* installDomino5PTugin.log

e installDomino6Plugin.log

Each log lists the following critical information:
* The plug-in binary module that is currently installed

» The current location of the plug-in configuration file that is configured for the Web server

configure_Web_server_type_webserver.log

Lists events that occur during the configuration of a Web server plug-in. The name of the file

varies to reflect the Web server:

» configure_ APACHE_webserver.log

* configure IHS webserver.log

e configure IIS webserver.log

» configure_SUNJAVASYSTEM webserver.log
* configure_DOMINO_webserver.Tlog

The configureleb_server type webserver.log file reports the actions that the Plug-ins installation

wizard performs as it updates the Web server configuration file.

In a remote scenario, this log is not present because you must run the script to create the Web

server definition manually.
Information that ISMP can log when it cannot start the Plug-ins installation wizard

Verify or troubleshoot the installation if the install_root/product/1ogs/1o0g.txt file or the

install_root/product/1ogs/pctLog.txt file does not contain a record of any problems, but problems exist.

If the error happens early in the installation, look for the logs in the system temporary directory. The
installation program copies the logs from the system temporary directory to the logs directory at the end of

the installation.

Certain events can prevent ISMP from starting the Installation wizard. Such an event is not enough disk
space to launch the Installation wizard, for example. If your installation fails and there is no information in
the installation logs, use the -log parameter to record entries for events that cause the ISMP program to

fail to start the installation wizard. The syntax of the install command for logging such events is:

install -options fully qualified options_response_file_name
-silent
-log # !fully qualified log file_name GALL

The following example is for AIX systems:
install -options "/usr/IBM/WebSphere/silentFiles/myresponsefile.txt"
-silent -log # !/usr/IBM/WebSphere/myOptionFiles/log.txt @ALL

The following example is for Linux systems, HP-UX systems, and Solaris systems:
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install -options "/opt/IBM/WebSphere/silentFiles/myresponsefile.txt"
-silent -log # !/opt/IBM/WebSphere/myOptionFiles/log.txt @ALL

The following example is for Windows systems:

install.exe -options "C:\IBM\WebSphere\silentFiles\myresponsefile.txt"
-silent -log # !C:\IBM\WebSphere\silentFiles\Tog.txt @ALL

See|Appendix B, “Troubleshooting installation,” on page 291| and I“Installation component troubleshooting|
ltips” on page 307|for more information.

Response file user entry validation
In a silent install, responsefile validation has been coded into the install. If response file validation does not
pass, the failure is recorded in the temporaryPTuginInstalllog.txt file.

Accepted license agreement

Default directive setting
-W silentinstallLicenseAcceptance.value="false”

Valid setting
You must set this directive to true to accept the license and install the plug-ins.

Error identifier in temporaryPlugininstallLog.txt
INSTCONFFAILED : LICENSE _ NOT _ ACCEPTED.

Valid install type

Default directive setting
-P pluginSettings.installType="Ilocal”

Valid setting
You must set this directive to remote or local. Any other value fails validation.

Error identifier in temporaryPlugininstallLog.txt
INSTCONFFAILED : INVALID _ PLUGIN _ INSTALL _ TYPE _ SCENARIO _ SELECTED.

Valid WAS V6.0 install location

Default directive setting
-W websphereLocationWizardBean.wasExistingLocation= "C: \ Program Files \ IBM \
WebSphere \ AppServer”

The setting varies per operating system.

Valid setting
If you set the -P pluginSettings.installType="" directive above to local, this validation
checks that the path is a valid WebSphere Application Server V6 directory. Any other path
fails validation for a local installation type.

Error identifier in temporaryPlugininstallLog.txt
INSTCONFFAILED : NON _ WAS6 _ DIRECTORY

Valid Web server configuration file 1

Default directive setting
-P pluginSettings.webServerConfigFile1= "C:\ Program Files \ IBM HTTP Server \ conf \
httpd.conf”
The setting varies per operating system. Valid file names for each Web server are:
e IBM HTTP Server: httpd.conf
* Apache: httpd.conf
e Domino 5: notes.jar
¢ Domino 6: notes.jar
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e Sun Java System Web Server: obj.conf

Valid setting
Validation checks that the file exists. A known problem in ISMP validates a directory
specification. However, you must identify the file to establish a working configuration.

Error identifier in temporaryPlugininstallLog.txt
INSTCONFFAILED : NON _ EXISTENT _ WS _ CONFIG _ FILE.

Valid Web server configuration file 2

Default directive setting
-P pluginSettings.webServerConfigFile2=""

Valid file names for affected Web servers are:
e Domino 5: names.nsf
¢ Domino 6: names.nsf
e Sun Java System Web Server: magnus.conf

Valid setting
Validation checks that the file exists. A known problem in ISMP validates a directory
specification. However, you must identify the file to establish a working configuration.

Error identifier in temporaryPlugininstallLog.txt
INSTCONFFAILED : NON _ EXISTENT _ WS _ CONFIG _ FILE2.

Valid Web server definition name

Default directive setting
-P pluginSettings.webServerDefinition="webserver1”

Valid setting
Validation verifies that spaces do not exist in the Web server definition name. If spaces
exist, validation fails.

Error identifier in temporaryPlugininstallLog.txt
INSTCONFFAILED : INVALID _ WEB _ SERVER _ DEFINITION _ NAME.

Verify that application mapping is true or false

Default directive setting
-P pluginSettings.mapWebserverToApplications="true"

Valid setting
If you set the directive to a value other than true or false, no error is generated or
recorded in the temporaryPluginInstalllLog.txt file. The Plug-ins installation wizard
defaults the value to true and continues the installation.

Error identifier in temporaryPlugininstallLog.txt
None

Valid Web server

Default directive setting
-P pluginSettings.webServerSelected="ihs"

Valid setting
You must specify the correct Web server for your operating system. Valid values include:

. m none, ihs, apache, domino6, sunone
. none, ihs, apache, domino6, sunone

. m none, ihs, apache, domino5, sunone
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. m none, ihs, apache, domino6, sunone
. m none, ihs, apache, domino®6, iis5, iis6, sunone

Error identifier in temporaryPlugininstallLog.txt
INSTCONFFAILED : INVALID _ WEBSERVER _ SELECTED.

Usage notes
» The file is not a read-only file.
» Edit this file directly with your flat file editor of choice, such as WordPad on a Windows platform.

» The file is updated when you specify the -options parameter when using the Plug-ins installation wizard.
* The file must exist to perform a silent installation. The installation program reads this file to determine

installation option values when you install silently. Provide the fully qualified file path.

» Save the file in a location that you can identify when you specify the fully qualified path as part of the

installation command.

Example responsefile.txt file
Edit the version of the file that ships with your WebSphere Application Server product. The following
example is not guaranteed to be an accurate representation of the file that ships with the product.

ifgdddadddadddgadddaaddssdspaddaddaagdgaddtaaddadstpdiddadddaagdsagdtaadddid

A common use of an options file is to run the wizard in silent mode. This lets
the options file author specify wizard settings without having to run the
wizard in graphical or console mode. To use this options file for silent mode
execution, use the following command line arguments when running the wizard:

install -options "responsefile.txt" -silent

ligatddsdddsaddgsddtaddssddssddssdddsaddsaddssdddsdddasddgsdadssddaadaadiati
Note: Synchronous Silent Installs

On non-Windows operating systems, silent installs will execute in a synchronous process.
The process will not return until the silent install has completed.

S S e 3 I S 3R I I

#

#

#

# For the silent install to run synchronously on Windows, you must run the
# executable in the following way:
#
#
#
#
#

START /WAIT install.exe -options "response_local.txt" -silent

idgadddadddgadddadddaddaaddadtadadgadipaddadspdgdpaddspaadgadaaaddadiati

lgddaddaddadtadadtadsastddatsdtsdtadtadadadadsataataadsdtagagagagadaadiaid
#

# TROUBLE SHOOTING TIP

#

# If no signs of an install are visible, reference the temporary Tog file

# (temporaryPluginInstalllog.txt)

# in the user's temporary directory for signs of cause.

#

lfggddasddssdddsaddszaddssddssdddsaddssdddsaddtsaddssddtsdddsaddssdddsaddsaddaid
Note: Default Web server Plugins install locations

Below are the default install Tocations for each supported operating system.
AIX: "/usr/IBM/WebSphere/Plugins"
HP-UX, Linux, and Solaris: "/opt/IBM/WebSphere/Plugins"

Windows: "C:\Program Files\IBM\WebSphere\Plugins"

S S e 3 3 S R 3R 3 I H

Note: On unix operating systems, spaces in the install location is not supported.
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lfgddzsddsaddtssddssadissdsssddsaddssddtsgaddssadtadissdddgaddsgsdddadisddtaai
iigdddzsddssdddssddssaddsadaasddtsdddssddtaddssddsssdipsdddssddgsddtgadiasddadind
License Acceptance

Valid Options : true Accepts the Ticense. Will install the product.
false Declines the license. Install will not occur.

If no install occurs, this will be Togged to a temporary log file
(temporaryPluginInstalllog.txt)
in the user's temporary directory.

By changing the silentInstalllLicenseAcceptance.value in this response file to "true",

you agree that you

have reviewed and agree to the terms of the IBM International Program License Agreement
accompanying this

program, which is located at CD_ROOT\plugins\lafiles. If you do not agree to these terms,
do not change

the value or otherwise download, install, copy, access, or use the program and promptly
return the

program and proof of entitlement to the party from whom you acquired it to obtain a refund
of the amount you paid.

S S S 3 3 3R S S 3 3 I S S I I I Ik I I H

-W silentInstalllLicenseAcceptance.value="false"

iddddssdddddddsdddddassadddddsasadddddaaaddddssasddddadaadaddaaiii
#
# install Type

#

# Valid Options : Tocal WebSphere Application Server and Web server on same machine
# remote WebSphere Applicaiton Server and Web server on seperate machines.

#

-P pluginSettings.installType="Tocal"

lggzsdaddddasssddddddasssddddddsssaddddddssaddddddssadddddgssaddisdgiaaddiad
#

# pluginDestination

#

# Web server Plugins for IBM WebSphere Application Server V6 install Tlocation

#

-P pluginProductBean.installLocation="C:\Program Files\IBM\WebSphere\PTugins"

ldgdadd AR ZZZZZLZZZZZZZIZZdaaddasddaddsdddddadgddgsgssgdddiiid

i WAS V6 Existing Location

i Valid Options : Existing WebSphere Application Server Version 6.0 install home directory.
i Note : This option is valid for Tocal install type.

i The install will use the directory entered below.

-W webspherelLocationWizardBean.wasExistingLocation="C:\Program Files\IBM\WebSphere\AppServer"

lfgdddzsddsadddsaddssaddssdsssddtaaddssddtssddssadiadisdsdsadisgsdddsadisaddaai
#

# Web server to configure

#

# Valid options

# : none Install binaries only. No Web server configuration.

# : ihs IBM HTTP Server V6

# : apache Apache Web Server V2
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: domino5 Lotus Domino Web Server V5 (supported on HP-UX)

: domino6 Lotus Domino Web Server V6 or V6.5 (not supported on HP-UX)

: sunone Sun ONE Web Server 6.0 or Sun Java System Web Server V6.1

: 1ish Microsoft Internet Information Services V5 (supported on Windows)
: iis6 Microsoft Internet Information Services V6 (supported on Windows)

Note : Specify only one Web server to configure.

R E E L LS

-P pluginSettings.webServerSelected="ihs"
ldddaddsddaddsddadsddsddsddsddsddsddsdtsdtsdssdsddsddsdddddsdsadasdsddsddaddaddsd
Web server Configuration File 1

Valid options for Web server configuration file 1

ihs : httpd.conf

apache : httpd.conf

domino5 : Notes.jar

domino6 : Notes.jar

sunone : obj.conf

Note : File must exist

P e L L L

-P pluginSettings.webServerConfigFilel="C:\Program Files\IBM HTTP Server\conf\httpd.conf"
#H## AR AR AR AR AR AR AR AR A AR AR A A A
Web server Configuration File 2
Valid options for Web server configuration file 2
domino5 : names.nsf
domino6 : names.nsf

sunone : magnus.conf

Note : File must exist

S S e 3 I e R 3k I I H

-P pluginSettings.webServerConfigFile2=""

HEREERR AR AR AR AR AR AR AR AR AR
i Web server port number

% Specify the Web server port for the Web server selected to be configured.

-P pluginSettings.portNumber="80"

[fdddddsdsdddssddasdadsdsdsdsdadadaddddsdadsdsdsdsddsdtdgsdadsdaddgdagadaatdaa
Domino 6 User ID

Specify the Domino 6 User ID. (only specify value when configuring Domino 6 on
Linux, Solaris, and AIX platforms)

Note : Domino 6 is supported on Windows, but this value is not required on Windows.

oW SR SR SR SR HE Sk

-W domino6UserIDPanel.userID="notes"

ifgdddgadddadddgadadaaddssdatpaddaddtaaddgaddtaaddadapdddaddadddadaaaddaid
#
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Web server Definition Name

#

#

# A web server definition allows for Web server administration through the WebSphere
# admin console.
#
#
#

Note : No spaces are allowed in the Web server definition name.
-P pluginSettings.webServerDefinition="webserverl"

ligdidzaddgsdddaaddgsadassdapsddddddssdddsadassddtsaddssdddaddssdddadasdddaai
plugin-cfg.xml File Location
This file will be generated by the plugin installer.

Valid options:

" : leaving the string empty will result in installer generating the plugin-cfg.xml
file Tocation at install time and configuring Web server to use this location.
This is the recommended option.

"<file_location>" : User may enter an existing file Tocation. Web server will be
configured to use this existing plugin-cfg.xml file location.
If file is specified, it must exist, otherwise install will not proceed.

He e e S 3 I I S S I I I H H

-P pluginSettings.pluginCfgXmlLocation=""

ligdidzsddgsdddasddgsaddssdassddtsdddssdddsaddssddtaadipsdddaddgsdddadasddadai

#

# WebSphere Application Server Machine HostName

#

# remote install type : enter the hostname of the WebSphere Application Server machine.
# local install type : hostname of machine being installed to will be used.

#

-P pluginSettings.wasMachineHostName=""

gz zaddddasasddddddsssddaddddsssdddddddsaaddddddsdadddddasadddddgaadddad
#

# Advanced User Options available in silent installs only

#

Map all the existing deployed applications to the Web server.

Valid Options

true : Web server Definition is mapped as a target to
the existing deployed applications such as snoop and hitcount
(Recommended)

false : No applications are mapped to the Web server definition.

Note : If not set to a valid option of true or false, the installer will set to
true and continue install.

e S e 3 I I IR I I I

1
o

pluginSettings.mapWebserverToApplications="true"

Web server Hostname

In advanced scenarios where a user has multiple Web server hostnames on a machine,
set the entry

below to the Web server hostname used to configure.

Valid Options :
e : Install will resolve to hostname detected on machine (Recommended)

S e S 3 I I W I
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#  "<HOSTNAME>" : Where <HOSTNAME> is a Web server hostname on the machine.
#

-P pluginSettings.webServerHostName=""

Uninstalling the Web server plug-ins for WebSphere Application Server

You can uninstall Web server plug-ins for WebSphere Application Server without uninstalling the supported
Web server or the Application Server.

This topic describes uninstalling the Web server plug-ins for WebSphere Application Server.

If you used the IBM Key Management wizard to create SSL key files in the Web server Plug-ins home
directory, back up the files to a directory outside of the Web server P1ugins directory. After the uninstall
procedure is complete, you can delete the SSL key files if they are no longer required.

After uninstalling the Web server plug-ins for WebSphere Application Server, you can reinstall them using
any of the installation procedures described in[“Installing Web server plug-ins” on page 141

1. Open a command window.

2. Change directories to the _uninstPlugin directory in the installation root directory of the Web server
plug-ins for WebSphere Application Server.

This procedure occasionally refers to the installation root directory as the plugins_install_root
directory.

3. Issue the uninstall command. The Uninstall wizard displays a welcome panel.

4. Click Next on the Welcome panel. The Uninstaller wizard displays a confirmation panel for you to
confirm what is to be uninstalled. Each feature that displays in the panel is a separate Web server
installation. Each Web server installation is configured to use one of the binary plug-in modules that is
being deleted.

5. Click Next on the confirmation panel to begin uninstalling the plug-ins. The Uninstaller wizard displays
a summary panel that provides status.

6. Click Finish to close the Uninstaller wizard.

Uninstalling the Web server plug-ins for WebSphere Application Server removes many files in the

installation root directory, but leaves the following logs in the plugins_install_root/1og/uninstall

directory:

* ISMP uninstall log: 1og.txt

» Configuration uninstall log: masterConfigurationLog.txt

* Web server deconfiguration log: uninstallWeb_server_namePlugin.log, such as the
uninstalTApachePlugin.Tog.

7. -E'E. Uninstall the IBM Global Services Kit (GSKit) on Linux and UNIX systems.

The Plug-ins installation wizard does not uninstall GSKit 7 because there is no registry describing
products that are enrolled to use the GSKit. Without this critical information, uninstalling the GSKit
product might affect other products that use GSKit.

You can uninstall GSKit once it is no longer in use on your systems.
m On Solaris systems, you must also uninstall GSKit 4 in addition to GSKit 7.

8. m Uninstall GSKit on Windows systems.

The Plug-ins uninstaller program unregisters the GSKit. The registry key is HKEY_LOCAL_MACHINE
> SOFTWARE > IBM > GSK7 > REGAPPS > WASPIugins60_unique_key.

If the registry key WASP1ugins60_unique_key is the last remaining key in the GSKit registry entry, the
wizard also uninstalls the GSK7 product. If another product, such as IBM HTTP Server, is registered
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to use GSKit, the wizard does not uninstall the GSKit. The wizard always unregisters the registry key
for the Web server plug-ins for WebSphere Application Server, which is WASPTugins60_unique key.

The GSKit uninstall log is the plugins_install_root/1og/uninstall/uninstal1GSKit.1og file.
9. Delete files from the temporary directory.
Delete the following files:
* Install temporary log : temporaryPluginInstalllog.txt
e Uninstall temporary log : temporaryPTuginUnInstalllLog.txt
10. Delete the Web server definition in a stand-alone application server.

The uninstaller program for the Web server plug-ins for WebSphere Application Server does not
delete Web server definitions. However, you can delete a Web server definition using the following
wsadmin commands:

$AdminTask deleteServer { -serverName webserverl -nodeName webserverl node }
$AdminTask removeUnmanagedNode { -nodeName webserverl node }
$AdminConfig save

After you exit from the plugins_install_root/ uninstPlugin directory, the directory is removed. The only
remaining directory is the plugins_install_root/10gs directory. The logs directory contains the install process
log, the uninstall process log, and the Web server creation logs.

Important: SSL key files might exist if you used the IBM Key Management Wizard. Move these files to a
safe location before using the manual uninstalling procedure, if necessary.

To reinstall the Web server plug-ins for WebSphere Application Server, launch the installation procedure
again.

To reinstall the Web server plug-ins for WebSphere Application Server into the original directory, delete the
existing installation root directory for the plug-ins before reinstalling.

The default location is:

. -JE- /usr/IBM/WebSphere/Plugins

. m m /opt/IBM/WebSphere/Plugins
. mc:\Program Files\IBM\WebSphere\Plugins

Manually uninstalling Web server plug-ins for WebSphere Application Server
You can use this manual procedure for uninstalling Web server plug-ins for WebSphere Application Server
when the uninstaller program is not available for some reason.

This topic describes uninstalling the Web server plug-ins for WebSphere Application Server.

After uninstalling the Web server plug-ins for WebSphere Application Server, you can reinstall them using
any of the installation procedures that are described in |“Insta|ling Web server plug-ins” on page 141|

1. Delete the installation root directory for Web server plug-ins for WebSphere Application Server.
2. Delete the Web server definition in the application server configuration.
You can delete a Web server definition using the following wsadmin commands:

$AdminTask deleteServer { -serverName webserverl -nodeName webserverl node }
$AdminTask removeUnmanagedNode { -nodeName webserverl node }
$AdminConfig save

3. Reconfigure any Web servers that were configured to use the binary plug-ins that you deleted.
See ['Editing Web server configuration files” on page 185)
4. Delete the following registry keys using the platform-specific steps described in [‘Uninstalling manually’]
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Operating system Registry keys

AIX, Linux and Windows WSPAAB0, WSPAAB0DefineglobalconstantsComponent,
WSPAA60DefinelocalvariablesComponent,
WSPAAB60LicensingComponent, WSPAA60Webserverplugins,
WSPAAB0WebserverpluginsComponent, WSPAAB0AddBYytes,
WSPAAG0gskit, WSPAAB0gskitComponent

HP-UX WSPAAG0, WSPAA6ODGCC, WSPAA6ODLVC, WSPAAGOLC,
WSPAAGOWSPC, WSPAAB0AddBytesHS, WSPAAB0gskitHP,
WSPAAG0gskitHPC, WSPAAG0jdkHP

Solaris WSPAAG0, WSPAABGOAC, WSPAABOBC, WSPAABOCC, WSPAAB0ODC,
WSPAAGOFC, WSPAAGOFB, WSPAAGOGC, WSPAAGOHC

Deleting the installation root directory for the Web server plug-ins for WebSphere Application Server
removes the binary plug-ins. Any Web servers that are configured to use the deleted binary modules do
not work. Reinstall the Web server plug-ins for WebSphere Application Server and reconfigure the Web
servers to restore their functionality.

Editing Web server configuration files

The Plug-ins installation wizard automatically configures supported Web servers during the installation of
the binary plug-in modules. Use this topic to understand how the wizard configures the Web server
configuration files.

If you must change a configuration for some reason, you can run the Plug-ins installation wizard again to
reconfigure the Web server, or you can edit the files.

The recommended approach is to always use the Plug-ins installation wizard to configure the Web server
configuration file. However, sometimes you must edit the files. An example is when you are installing a
Web server definition for a non-default profile.

To support a non-default profile, edit the configuration to point the Web server to the correct location of the
plug-in configuration file (pTugin-cfg.xm1). In this case, you would change the profile path from the default
profile to the secondary profile.

This task shows you how to edit the Web server configuration files.

Select one of the following links that identifies the Web server that you must reconfigure.
« Configure Apache HTTP Server 2.0. See [‘Configuring Apache HTTP Server V2.0."]
« Configure Domino Web Server Version 5 and Version 6.x. See [‘Configuring Lotus Domino” on page|

* Configure IBM HTTP Server Version 6.0. See [‘Configuring IBM HTTP Server Version 6.0” on page 192

» Configure IBM HTTP Server Version 2.0. See“Configuring IBM HTTP Server powered by Apache 2.0°]
_n page 190.

« Configure Microsoft Internet Information Services (IIS). See [‘Configuring Microsoft Internet Information|
[Services (11S)” on page 193/
« Configure Sun Java System Web Server (formerly Sun ONE and iPlanet). See [‘Configuring the Sun|
[Java System Web Server’ on page 195)

Configuring Apache HTTP Server V2.0
This topic describes how to change configuration settings for Apache HTTP Server Version 2.0.

When you install the Web server plug-ins for WebSphere Application Server, as described in|‘Installing
[Web server plug-ins” on page 141) the Plug-ins installation wizard configures the Web server. This topic
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describes how to configure the Apache HTTP Server Version 2.0 Web server. Other procedures in
[Web server configuration files” on page 185|describe configuring other supported Web servers.

Testing verified that the WebSphere Application Server plug-in for Apache HTTP Server, Version 2.0 works
with Apache HTTP Server Version 2.0.48, the latest version of Apache 2.0. The plug-in was tested with the
threaded worker multi-processing module (MPM) on all platforms except Windows. The plug-in was tested
with the default threaded MPM on Windows.

The plug-in works with the Apache 2 prefork MPM but works best with the worker MPM. The plug-in
maintains connection pools to backend WebSphere Application Servers and uses in-memory caching.
These plug-in functions perform most efficiently when Apache 2.0 is configured to use a single child
process with the ThreadsPerChild value equal to the MaxClients value. The plug-in can be used with the
prefork MPM or the worker MPM that is configured with multiple child processes, but at reduced efficiency.

Compatibility Statement The plug-in works with versions of the Apache HTTP Server that claim full
binary compatibility with Apache 2.0.42 and later, which are built with compilers and compiler options that
are compatible with those used to build the plug-in.

Perform the step that configures Apache 2.0 for your operating system.

Examples and messages are shown on more than one line for clarity. Place each directive in a Web
server configuration file on one line.

Local file path means a file path to the plugin-cfg.xml file on an Application Server that is on the same
machine as the Web server. Remote file path means the file path to the plugin-cfg.xml file when the
Application Server is on a remote machine. The Plug-ins installation wizard installs a dummy
plugin-cfg.xml file during installation, but this file requires periodic propagation from the real file on the
Application Server machine.

The node_name in the following Application Server local file paths is Web_server_name node for a
stand-alone Application Server In each case, the remote file path is also shown.

The name of the Web server definition is webserveri.

. -:E- Configure entries in the httpd.conf file.
Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModule
was_ap20_module /usr/IBM/WebSphere/Plugins/bin/mod_was_ap20_http.so

Local stand-alone example:

WebSpherePTuginConfig
/usr/IBM/WebSphere/AppServer/profiles/default/config/cells/
sa_cell/nodes/webserverl_node/servers/webserverl/plugin-cfg.xml

Remote example:

WebSpherePluginConfig
/usr/IBM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml

. m Configure entries in the httpd.conf file.
Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModuTe
was_ap20_module /opt/IBM/WebSphere/Plugins/bin/mod was ap20_ http.so

Local stand-alone example:

WebSpherePluginConfig
/opt/IBM/WebSphere/AppServer/profiles/default/config/cells/
sa_cell/nodes/webserverl_node/servers/webserverl/plugin-cfg.xml
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Remote example:

WebSpherePluginConfig
/opt/1BM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml

N HP-UX Configure entries in the httpd.conf file.

Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModuTe
was_ap20_module /opt/IBM/WebSphere/Plugins/bin/mod_was_ap20_http.s]l

Local stand-alone example:

WebSpherePluginConfig
/opt/IBM/WebSphere/AppServer/profiles/default/config/cells/
sa_cell/nodes/webserverl_node/servers/webserverl/plugin-cfg.xml

Remote example:
WebSpherePTuginConfig
/opt/1BM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml
. m Configure entries in the httpd.conf file.

Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModuTe was_ap20_module
drive:\IBM\WebSphere\PTugins\bin\mod_was_ap20_http.d11

Local stand-alone example:

WebSpherePluginConfig
C:\IBM\WebSphere\AppServer\profiles\default\config\cells\
sa_cell\nodes\webserverl_node\servers\webserverl\plugin-cfg.xml

Remote example:

WebSpherePluginConfig
C:\IBM\WebSphere\Plugins\config\webserverl\plugin-cfg.xml

This procedure results in reconfiguring the Apache 2.0 Web server.

Configuring Lotus Domino
This task describes how to change configuration settings for Lotus Domino.

When you install the Web server plug-ins for WebSphere Application Server, as described in|‘Installing
[Web server plug-ins” on page 141 the Plug-ins installation wizard configures the Web server.

This topic describes how to reconfigure the Domino V6 Web server. Other procedures in [‘Editing Web
lserver configuration files” on page 185| describe reconfiguring other supported Web servers.

Use the following procedure to enable the Web server plug-in to work with Lotus Domino.
1. Start the Domino server.

2. Access the names.nsf file using your Web browser (for example,
http://tarheels2.raleigh.ibm.com/names.nsf). The browser prompts you for a password.

Give the administrator name and password.

Click Configuration on the left side of the page.

Click Servers on the left side of the page.

Click All Server Documents on the left side of the page.

Click the server that you intend to have work with WebSphere Application Server, Version 6.
Click Edit Server on the top-left of the center window.

Click Internet Protocols in the middle of the page.

© O N Ok
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10. Add the path to the Domino plug-in under the DSAPI Section in the middle-right of the page. The
plug-in is installed in the bin directory of the Web server plug-ins for WebSphere Application Server.

If specifications for filter files for the Domino Server Application Programming Interface (DSAPI)
already exist, use a space to delimit the Web server plug-in for WebSphere Application Server.

11. Click Save and Close in the upper-left of the center window.

12. Define the location of the pTugin-cfg.xml configuration file.
The location varies depending on how you have configured your system. If the Web server and the
Application Server are on separate machines, you have a remote installation.
If the two servers are on the same machine, you have a local installation.
In the following examples, webserveri is the Web server definition name. Setting the path to the
plug-in configuration file on a Linux or UNIX system

Set the WAS_PLUGIN_CONFIG_FILE environment variable to the location of the plug-in
configuration file using one of the following paths:

!f the type of installation Then use this command to set the environment variable:

is:

Remote WAS_PLUGIN_CONFIG_FILE=/opt/ IBM/ WebSphere/ Plugins/ config/ webserverl/
plugin-cfg.xml

Local stand-alone WAS_PLUGIN CONFIG FILE=/opt/ IBM/ WebSphere/ AppServer/ profiles/ default/

config/ cells/ sa_cell/ nodes/ webserverl_node/ servers/webserverl/
plugin-cfg.xml

-E'E- During the installation process, the Plug-ins installation wizard creates the
setupPluginCfg.sh file in two places:

* The plug-ins_install_root/bin directory
* The lotus_install_root/notesdata directory

-E'E- You can run the script from either location to set the
WAS_PLUGIN_CONFIG_FILE environment variable. However, if you are reconfiguring the Web
server, you might want to set the path yourself by setting the value of the environment variable with a
path from the preceding table.

mThe setupPluginCfg.sh script sets the file path value to the file path that the
wizard configured originally. If you are reconfiguring the Web server to change the original file path,
do not use this script. Setting the path to the plug-in configuration file on a Windows system

m Add the appropriate statement to your lotus_domino_install_roof\notes.ini file:

:fs.the type of installation Then use this command to set the WebSpherePluginCfg variable:

Remote WebSpherePTuginCfg="C:\ Program Files\ IBM\ WebSphere\ Plugins\ config\
webserverl\ plugin-cfg.xml”

Local stand-alone WebSpherePluginCfg="C:\ IBM\ WebSphere\ AppServer\ profiles\ default\ config\
cells\ sa_cell\ nodes\ webserverl_node\ servers\ webserverl\ plugin-cfg.xml”

13. Restart the Domino server. When the server starts, information similar to the following example is
displayed:
01/21/2005 01:21:51 PM JVM: Java virtual machine initialized

WebSphere Application Server DSAPI filter loaded
01/21/2005 01:21:52 PM HTTP Web Server started
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This procedure results in reconfiguring Version 6.x of Lotus Domino.

After configuring a Web server, you can install applications on it. See the Applications section of the
information center for more information.

For more information on configuring Lotus Domino to work with WebSphere Application Server, search the
|Lotus Support Services Web sitel Enter the search term WebSphere in the keyword search field.

Related technotes:
* |[Enabling single sign-on for Domino and WebSphere Application Server|
» |Extended Search installation: Using horizontal clusters in WebSphere Application Served

» |Prompted to authentication again when using single sign-on (SSO) for WebSphere Application Server|
and Domino|

* |Some CGlI Variables do not work with DSAP!I filter, Domino, and WebSphere Application Server
» |[WebSphere Application Server plug-in can hang when Domino encounters HTTP Error 500
+ [Must | install WebSphere Application Server Network Deployment before Lotus Workplace Messaging?|

Lotus Domino tips:

This topic describes configuration file locations, a Solaris configuration tip, and how to avoid a DSAPI
filter-loading error when starting the Lotus Domino Web server as a non-root user on Linux and UNIX
operating systems.

Lotus Domino Server file locations

Lotus Domino server file locations are:

. -3_ On AIX systems:

— /Jusr/lotus/notes/50091/1ibmpow/Notes. jar
— Jusr/notesdata/names.nsf

. m On the Solaris Operating Environment:
— /opt/lotus/notes/5080/sunspa/Notes.jar
— /opt/notesdata/names.nsf

. m On Windows systems:

— c¢:\Program Files\Totus\notes\Notes.jar
— c¢:\Program Files\Totus\notes\data\names.nsf

The Domino Server plug-in might fail to configure on a Solaris platformm

If this occurs during installation, a dsapi_stderr.txt file is created in the logs directory and you get the
following error messages:
Totus.notes.NotesException: Could not load d11 for system name SUNOS
at lotus.notes.NotesThread.load(NotesThread.java:210)
at Totus.notes.NotesThread.<clinit>(NotesThread.java:24)
java.lang.UnsatisfiedLinkError: NnotesInitThread
at lotus.notes.NotesThread.NnotesInitThread(Native Method)
at lotus.notes.NotesThread.initThread(NotesThread.java:99)
at lotus.notes.NotesThread.run(NotesThread.java:133)

You can configure the WebSphere Application Server or Domino Server plug-in manually using the Domino

Server Web administration tool. Use the following procedures:

1. Start the Domino Server.

2. Enter the URL for the Domino Server Web Administration site using a browser. For example,
http://host_name/names.nsf. Enter the administrator user name and password.
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http://www-3.ibm.com/software/lotus/support/
http://www-1.ibm.com/support/docview.wss?uid=swg21098010
http://www-1.ibm.com/support/docview.wss?uid=swg21115566
http://www-1.ibm.com/support/docview.wss?uid=swg21094096
http://www-1.ibm.com/support/docview.wss?uid=swg21094096
http://www-1.ibm.com/support/docview.wss?uid=swg21096476
http://www-1.ibm.com/support/docview.wss?uid=swg21085331
http://www-1.ibm.com/support/docview.wss?uid=swg21108448

Double-click Server-Servers.

Double-click WebServer to configure.

Double-click Edit Server.

Double-click Internet Protocol.

Add the WebSphere Application Server DSAPI plug-in to the DSAPI field. For example,
/opt/WebSphere/AppServer/bin/Tibdomino5 http.so Note: If there are already DSAPI filter files
specified use a space to delimit the WebSphere plug-in file.

No ok

8. Double-click Save and Close.
9. Restart the Domino Server.
Avoiding a DSAPI filter-loading error when the Lotus Domino Server starts -EJE.

On a Linux or UNIX operating system, if the Lotus Domino Web server starts using a non-root user, you
are likely to generate a DSAPI filter-loading error when the Lotus Domino Server starts:

Error loading DSAPI filter.

Filter not loaded: /usr/WebSphere/AppServer/bin/1ibdomino6_http.a

Manually change the WebSphere Application Server bin directory permissions from 750 to 755 to run Lotus
Domino Server as a non-root user and not generate the error.

You must also change permissions on the WebSphere Application Server 1ogs directory to 777 to allow
Lotus Domino Server to write to the log. However, this change poses a security risk.

If the Lotus Domino Server is started as root, the problem does not occur.

Configuring IBM HTTP Server powered by Apache 2.0
This topic describes how to change configuration settings for IBM HTTP Server powered by Apache 2.0.

When you install the Web server plug-ins for WebSphere Application Server, as described in [‘Installing]
[Web server plug-ins” on page 141 the Plug-ins installation wizard configures the Web server. This topic
describes how to configure the IBM HTTP Server, V2.x. Other procedures in[‘Editing Web server]
lconfiguration files” on page 185 describe configuring other supported Web servers.

Perform the step that configures IBM HTTP Server 6.0 version for your operating system.

Examples and messages are shown on more than one line for clarity. Place each directive in a Web
server configuration file on one line.

Local file path means a file path to the plugin-cfg.xml file on an Application Server that is on the same
machine as the Web server. Remote file path means the file path to the plugin-cfg.xml file when the
Application Server is on a remote machine. The Plug-ins installation wizard installs a dummy
plugin-cfg.xml file during installation, but this file requires periodic propagation from the real file on the
Application Server machine.

The Web server definition name in the following examples is webserver1.

. -:E- Configure entries in the httpd.conf file.
Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModule
was_ap20_module /usr/IBM/WebSphere/Plugins/bin/mod_was_ap20 http.so

Local stand-alone example:

WebSpherePluginConfig
/usr/IBM/WebSphere/AppServer/profiles/default/config/cells/
sa_cell/nodes/webserverl_node/servers/webserverl/plugin-cfg.xml
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Remote example:

WebSpherePluginConfig
/usr/1BM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml

. m Configure entries in the httpd.conf file.
Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModuTe
was_ap20_module /opt/IBM/WebSphere/Plugins/bin/mod_was_ap20_http.so

Local stand-alone example:

WebSpherePluginConfig
/opt/IBM/WebSphere/AppServer/profiles/default/config/cells/
sa_cell/nodes/webserverl_node/servers/webserverl/plugin-cfg.xml

Remote example:

WebSpherePTuginConfig
/opt/1BM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml

- HP-UX Configure entries in the httpd.conf file.
Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModuTe
was_ap20_module /opt/IBM/WebSphere/Plugins/bin/mod_was_ap20_http.sl

Local stand-alone example:

WebSpherePluginConfig
/opt/IBM/WebSphere/AppServer/profiles/default/config/cells/
sa_cell/nodes/webserverl_node/servers/webserverl/plugin-cfg.xml

Remote example:
WebSpherePluginConfig
/opt/IBM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml
. m Configure entries in the httpd.conf file.

Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModule was_ap20_module
drive:\IBM\WebSphere\PTugins\bin\mod_was_ap20_http.d11

Local stand-alone example:

WebSpherePluginConfig
C:\IBM\WebSphere\AppServer\profiles\default\config\cells\
sa_cell\nodes\webserverl_node\servers\webserverl\plugin-cfg.xml

Remote example:

WebSpherePluginConfig
C:\IBM\WebSphere\Plugins\config\webserverl\plugin-cfg.xml

This procedure results in editing and reconfiguring IBM HTTP Server powered by Apache 2.0.

If the IBM HTTP Server 1.3.2x directive, LoadModule ibm_app_server_http_module, is present in an IBM
HTTP Server 2.0 httpd.conf file, the IBM HTTP Server cannot start. You must comment or delete the
directive to start the Version 2 server.

The mod_was_ap20_http plug-in module requires the GSKIT Secure Sockets Layer (SSL) encryption

library if the plug-in is configured to support encrypted connections to back-end WebSphere Application
Servers.
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The Plug-ins installation wizard installs the GSKIT SSL encryption library at the required level if it is not
installed. If you manually copy the plug-in to a new machine, you might not have the required GSKIT
libraries for encrypting back-end connections. See the Security Guide PDF for more information on
configuring GSKIT.

After configuring a Web server, you can install applications on it. See the Applications section of the
information center for more information.

Configuring IBM HTTP Server Version 6.0
This topic describes how to change configuration settings for IBM HTTP Server 6.0.

When you install the Web server plug-ins for WebSphere Application Server, as described in
IWeb server plug-ins” on page 141 | the Plug-ins installation wizard configures the Web server. This topic
describes how to configure the IBM HTTP Server, V6. Other procedures in [‘Editing Web server]
|configuration files” on page 185| describe configuring other supported Web servers.

Perform the step that configures IBM HTTP Server 6.0 for your operating system.

Examples and messages are shown on more than one line for clarity. Place each directive in a Web
server configuration file on one line.

Local file path means a file path to the plugin-cfg.xml file on an Application Server that is on the same
machine as the Web server. Remote file path means the file path to the plugin-cfg.xml file when the
Application Server is on a remote machine. The Plug-ins installation wizard installs a dummy
plugin-cfg.xml file during installation, but this file requires periodic propagation from the real file on the
Application Server machine.

The node_name in the following Application Server local file paths is Web_server_name node for a
stand-alone Application Server In each case, the remote file path is also shown.

- T Configure entries in the httpd.conf file.
Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModuTe
was_ap20_module /usr/IBM/WebSphere/Plugins/bin/mod was ap20 http.so

Local stand-alone example:

WebSpherePluginConfig
/usr/IBM/WebSphere/AppServer/profiles/default/config/cells/
sa_cell/nodes/webserverl_node/servers/webserverl/plugin-cfg.xml

Remote example:

WebSpherePTuginConfig
/usr/IBM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml

. m Configure entries in the httpd.conf file.
Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModuTe
was_ap20_module /opt/IBM/WebSphere/Plugins/bin/mod_was_ap20_http.so

Local stand-alone example:

WebSpherePluginConfig
/opt/IBM/WebSphere/AppServer/profiles/default/config/cells/
sa_cell/nodes/webserverl_node/servers/webserverl/plugin-cfg.xml

Remote example:

WebSpherePluginConfig
/opt/IBM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml
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N HP-UX Configure entries in the httpd.conf file.
Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:

LoadModuTe
was_ap20_module /opt/IBM/WebSphere/Plugins/bin/mod was ap20 http.s]l
Local stand-alone example:

WebSpherePluginConfig
/opt/IBM/WebSphere/AppServer/profiles/default/config/cells/
sa_cell/nodes/webserverl_node/servers/webserverl/plugin-cfg.xml
Remote example:

WebSpherePluginConfig
/opt/1BM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml

. m Configure entries in the httpd.conf file.
Use the following examples of the LoadModule and the WebSpherePluginConfig directives as models
for configuring your file:
LoadModuTe was_ap20_module
drive:\IBM\WebSphere\Plugins\bin\mod_was_ap20_http.d11
Local stand-alone example:

WebSpherePluginConfig
C:\IBM\WebSphere\AppServer\profiles\default\config\cells\
sa_cell\nodes\webserverl_node\servers\webserverl\plugin-cfg.xml

Remote example:

WebSpherePluginConfig
C:\IBM\WebSphere\Plugins\config\webserverl\plugin-cfg.xml

This procedure results in editing and reconfiguring the IBM HTTP Server 6.0.

If the IBM HTTP Server 1.3.x directive, LoadModule ibm_app_server_http_module, is present in an IBM
HTTP Server 6.0 httpd.conf file, the IBM HTTP Server cannot start. You must comment or delete the
directive to start the Version 6 server.

The mod_was_ap20_http plug-in module requires the GSKIT Secure Sockets Layer (SSL) encryption
library if the plug-in is configured to support encrypted connections to back-end WebSphere Application
Servers.

The Plug-ins installation wizard installs the GSKIT SSL encryption library at the required level if it is not
installed. If you manually copy the plug-in to a new machine, you might not have the required GSKIT
libraries for encrypting back-end connections. See the Security Guide PDF for more information on
configuring GSKIT.

After configuring a Web server, you can install applications on it. See the Applications section of the
information center for more information.

Configuring Microsoft Internet Information Services (lIS)
This topic describes manual configuration settings for Internet Information Services (11S).

When you install the Web server plug-ins for WebSphere Application Server, as described in
|Web server plug-ins” on page 141 | the Plug-ins installation wizard configures the Web server. This topic
describes how to configure the Internet Information Services (11IS) Web server. Other procedures in
|Web server configuration files” on page 185| describe configuring other supported Web servers.

You must have read/write access to the plugins_install_root directory to perform this task.
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Use the following procedure to manually reproduce how the Installation wizard configures the Microsoft
Internet Information Services Web server.

« Configure IIS V5.0.
1.

Start the IIS application and create a new virtual directory for the Web site instance that you intend
to work with WebSphere Application Server. These instructions assume that you are using the
Default Web Site.

Expand the tree on the left until you see Default Web Site. Right-click Default Web Site, then click
New > Virtual Directory to create the directory with a default installation.

Type sePlugins in the Alias to be used to Access Virtual Directory field.

Browse to the WebSphere Application Server install_root\bin directory in the Enter the physical path
of the directory containing the content you want to publish field.

Select the Allow Execute Access check box in the What access permissions do you want to set for
this directory field.

Click Finish to add the sePTugins virtual directory to your default Web site.
Add the Internet Services Application Programming Interface (ISAPI) filter into the 1IS configuration.
Right-click the host name in the tree on the left and click Properties.

In the Properties dialog, perform the following steps:

a. Click the Internet Information Services tab.

b. Click WWW Service in the Master properties window.

c. Click Edit to open the WWW Service master properties window.

d. Click ISAPI Filters > Add to open the Filter properties window.

e. Type iisWASPTugin in the Filter Name field.

f. Click Browse in the Executable field.

g. Browse to the Plugins_install_roof\bin directory.

h. Click the iisWASPTugin_http.d11 file.

i. Click OK until all the open windows close.

» Configure 1IS V6.0.

1.

194

Start the IIS application and create a new virtual directory for the Web site instance that you intend
to work with WebSphere Application Server. These instructions assume that you are using the
Default Web Site.

Expand the tree on the left until you see Default Web Site. Right-click Default Web Site, then click
New > Virtual Directory to create the directory with a default installation.

Type sePlugins in the Alias to be used to Access Virtual Directory field.

Browse to the WebSphere Application Server install_rootf\bin directory in the Enter the physical
path of the directory containing the content you want to publish field.

Select the Allow Execute Access check box in the What access permissions do you want to set
for this directory field.

Click Finish to add the sePlugins virtual directory to your default Web site.
Add the Internet Services Application Programming Interface (ISAPI) filter into the 1IS configuration.

Right-click Default Web Site in the tree on the left and click Properties. In the Properties panel,
perform the following steps:

Click the Internet Information Services tab.
Click the ISAPI Filters tab.

Click Add to open the Filter properties window.
Type iisWASPTugin in the Filter Name field.
Click Browse in the Executable field.

Browse to the plugins_install_root\bin directory.

-0 o0 o
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g. Click the 1isWASP1ugin_http.d11 file.
h. Click OK until all the open windows close.

9. Copy the plug-in binaries to the directory C:\program
files\WebSphere\Plugins\bin\iis_webserverName The plugin-cfg.loc file resides in this directory. The
first line of the plugin-cfg.loc file is the location of the plugin-cfg.xml file.

10. Set the value of the Plugin Config variable to the location of the configuration file, which is the
plugins_install_root\config\webserver _name\plugin-cfg.xml directory.

The location varies, depending on how you have configured your system. If the Web server and
the Application Server are on separate machines, you have a remote installation.

If the two servers are on the same machine, you have a local installation.
Local stand-alone example:

"C:\IBM\WebSphere\AppServer\profiles\default\config\cells\
sa_cell\nodes\webserverl_node\servers\webserverl\plugin-cfg.xml"

Remote example:
"C:\IBM\WebSphere\Plugins\config\webserverl\plugin-cfg.xml"
11. Configure the Web server to run WebSphere Application Server extensions:

a. Expand the tree on the left until you see Web service extensions.
b. Click Web service extensions.
c. Click All Unknown ISAPI extensions on the right side of the page.
d. Click Allow.

» Optional: Configure multiple Web sites. Given:

There are two Web sites defined: website1, website2.

The DIl files are already created as bin/websitel/iisWASPTugin http.d11 and
bin/website2/iisWebsite2/iisWASPlugin_http.d11.

— The plugin-cfg.loc files are created in the same folder as the DLL file.

1. Run IIS in worker process isolation mode (default). To enable worker process in isolation mode:
a. Open the IS management console and expand the local computer by clicking the plus sign.
b. Right-click the Web Sites folder, click Properties, and then click the Service tab.

c. Under Isolation mode, clear the Run Web service in 1IS 5.0 isolation mode check box to enable
worker process isolation mode.

2. Define two application pools; one for website1 and the other for website2. Do not use the
pre-defined application pool DefaultAppPool.

3. Define the two Websites, including the filter setting, virtual host setting, and extension settings.
4. Assign an application pool for each website.

a. Under each Web site folder, right click on the Web site name.

b. Click Property, and select the Home Directory tab. 2.

c. At the bottom of the application settings, select the application pool you defined for website1
from the drop-down list of application pools.

d. Click OK.

Repeat the previous steps for the second Web site and select the application pool you defined
for website2.

5. Start the IS service and start each Web site.

This procedure results in reconfiguring the Internet Information Services (IIS) Web server.

Configuring the Sun Java System Web Server
This topic describes how to change configuration settings for the Sun Java System Web Server (formerly
Sun ONE Web Server and iPlanet Web Server), Version 6.0 and later.
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When you install the Web server plug-ins for WebSphere Application Server, as described in[Installing]
[Web server plug-ins” on page 141 the Plug-ins installation wizard configures the Web server. This topic
describes how to configure the Sun Java System Web Server if you must change something in the
existing configuration. Other procedures in [‘Editing Web server configuration files” on page 185/ describe
configuring other supported Web servers.

Configure the Sun ONE Web Server 6.0 or Sun Java System Web Server, V6.1 and later, on a Linux,
UNIX, or Windows platform.

Examples and messages are sometimes shown on more than one line for ease of presentation. Verify that
each directive in a Web server configuration file is on one line.

1. Configure entries in the obj.conf configuration file and in the magnus.conf configuration file for Version
6.0 and later of Sun Java System Web Server.

a. Add two directives to the obj.conf file after the <Object name=default> tag:

Service fn="as_handler"
AddLog fn="as_term"

b. Add two directives at the end of the magnus.conf file:

The location for the bootstrap.properties directive varies, depending on how you have configured
your system. If the Web server and the application server are on separate machines, you have a
remote installation.

If the two servers are on the same machine, you have a local installation.
Local stand-alone example:

Init fn="Toad-modules"
funcs="as_init,as_handler,as_term"
sh1ib="/opt/1BM/WebSphere/Plugins/bin/1ibns4l http.so"
Init fn="as_init"
bootstrap.properties="/opt/IBM/WebSphere/AppServer/profiles/default/config/
cells/sa_cell/nodes/webserverl node/servers/webserverl/plugin-cfg.xml"

Remote example:

Init fn="load-modules"
funcs="as_init,as_handler,as_term"
sh1ib="/opt/1BM/WebSphere/PTugins/bin/1ibns41l_http.so"

Init fn="as_init"
bootstrap.properties="/opt/IBM/WebSphere/Plugins/config/webserverl/plugin-cfg.xml"

Local stand-alone example:

Init fn="load-modules"
funcs="as_init,as_handler,as_term"
sh1ib="C:\IBM\WebSphere\PTugins\bin\ns41_http.d11"
Init fn="as_init"
bootstrap.properties=
"C:\IBM\WebSphere\AppServer\profiles\default\config\cells\
sa_cell\nodes\webserverl node\servers\webserverl\plugin-cfg.xml"

Remote example:

Init fn="Tload-modules"
funcs="as_init,as_handler,as_term"
sh1ib="C:\IBM\WebSphere\PTugins\bin\ns41_http.d11"

Init fn="as_init"
bootstrap.properties="C:\IBM\WebSphere\Plugins\config\webserverl\plugin-cfg.xml"

2. Set the shared library path on HP-UX machines. On some installations of Sun Java System Web
Server on an HP-UX machine, it is necessary to manually set the SHLIB_PATH variable to /usr/1ib
before starting Sun Java System Web Server with a plug-in that is configured for Secured Sockets
Layer (SSL). For example, in the korn shell, issue the following command before invoking the
command to start the Sun Java System Web Server:

export SHLIB_PATH=/usr/1ib:$SHLIB PATH
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3. Disable the feature of Sun Java System Web Server V6.1 that supports servilets and JavaServer
Pages files by default. Disable this feature so that the WebSphere Application Server plug-in can
handle the requests.

Perform the following steps to disable the feature:
a. Remove or comment out the following two lines from the obj.conf configuration file:

NameTrans fn="ntrans-j2ee" name="j2ee"
Error fn="error-j2ee"

b. Remove or comment out the following line from the magnus.conf configuration file:

Init fn="Toad-modules"
sh1ib="C:/Sun/WebServer6.1/bin/https/bin/j2eeplugin.so"
shlib_flags="(global |now)"

Init fn="Toad-modules"
sh1ib="C:\Sun\WebServer6.1\bin\https\bin\j2eeplugin.d11"
sh1ib_flags="(global|now)"

This procedure results in editing and reconfiguring the Sun Java System Web Server.

After configuring a Web server, you can install applications on it. See the Applications section of the
information center for more information.

Allowing Web servers to access the administrative console

This topic describes how to add the virtual host that servers the administrative console to the plug-in
configuration file so that you can access the administrative console through a Web server.

Install your Version 6 WebSphere Application Server product, a Web server, and the Web server plug-ins
for WebSphere Application Server. The Plug-ins installation wizard creates a Web server definition on the
Application Server system, either directly when they are on the same machine, or by a script for remote
scenarios. After creating the Web server definition, the plug-in configuration file exists within the Web
server definition.

This task gives you the option of configuring the admin_host so that Web servers can access the
administrative console. When the Web server plug-in configuration file is generated, it does not include
admin_host on the list of virtual hosts.

1. Use the administrative console to change the admin_host virtual host group to include the Web server
port (80 by default).

a. Click Environment > Virtual Host > admin_host > Host Aliases > New. The default port that
displays is 80, unless you specify a different port during installation orprofile creation.

b. Specify the IP address, or the name of the machine that is hosting the administrative console
application. For example, if you installed a WebSphere Application Server product on a machine
that is named wastricia.rtp.ibm.com, specify the name in this field.

2. Click Apply > Save.

3. Stop and restart the application server. For example, to access the administrative console of a
stand-alone application server, stop and restart the serveri process. To stop server1, open a command
window and navigate to the install_root/profiles/default/bin directory. Then issue the following
command:

./stopServer.sh serverl

After receiving the following message, you can restart the application server:

Server serverl stop completed.

To start the application server, issue the following command:

./startServer.sh serverl

When you receive a message that is similar to the following message, the server1 process is running:
Server serverl open for e-business; process id is 1719
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4. Edit the plugin-cfg.xml file to include the following entries:

<VirtualHostGroup Name="admin_host">
<VirtualHost Name="%:9060"/>
<VirtualHost Name="%:80"/>
<VirtualHost Name="*:9043"/>
</VirtualHostGroup>

<ServerCluster Name="serverl SERVERIHOSTserverl Cluster">
<Server LoadBalanceWeight="1" Name="SERVERIHOSTserverl_dmgr">
<Transport Hostname="SERVERIHOST" Port="9060" Protocol="http"/>
</Server>

<PrimaryServers>
<Server Name="SERVERIHOSTserverl_dmgr"/>
</PrimaryServers>
</ServerCluster>

<UriGroup Name="admin_host_serverl SERVERIHOSTserverl Cluster_URIs">
<Uri AffinityCookie="JSESSIONID"
AffinityURLIdentifier="jsessionid" Name="/ibm/console/*"/>
</UriGroup>
<Route ServerCluster="serverl SERVERIHOSTserverl Cluster"
UriGroup="admin_host_serverl SERVERIHOSTserverl Cluster_URIs" VirtualHostGroup="admin_host"/>
Replace SERVER1HOST with the host name of your deployment manager. For example, if the host
name is wastricia:

<ServerCluster Name="serverl wastriciaserverl Cluster">

You can configure your supported Web servers to access the administrative console application of a
stand-alone application server.

Installing Application Client for WebSphere Application Server

Running J2EE and Thin application clients that communicate with WebSphere Application Server requires
that elements of the Application Server are installed on the machine on which the client runs. However, if
the system does not have the Application Server installed, you can install Application Clients, which
provide a stand-alone client run-time environment for your client applications. See the

page for more information on supported product platforms.

This article describes how to install the Application Client for WebSphere Application Server using the
installation image on the product CD-ROM. The steps that follow provide enough detail to guide you
through preparing for, choosing, and installing the variety of options and features provided. To prepare for
installation and to make yourself familiar with installation options, complete the steps in this article and
read the related topics, before you start to use the installation tools. Specifically, read these topics before
installing the product:

+ [Installing silently|
« |Best practices for installing|

As a general rule, if you launch an installation and there is a problem such as not having enough
temporary space or not having the right packages on your Linux or UNIX systems, then cancel the
installation, and make the required changes. Restart the installation to initiate your changes.

Although it is not supported or recommended, you can install this product as a non-root user on a UNIX

operating system. However, you must use a user ID that is part of the administrator group on Windows
platforms.
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In Version 6, the Application Server for WebSphere Application Server is installable on a machine with a
previous version of Application Clients. However, you cannot install a Version 6 Application Client on top of
a previous version of the Application Client. For example, if a Version 5 Application Clients install under the
C:\WebSphere\AppClient directory, you can not choose the same install location for your V6 Application
Clients installation.

Note: For Application Client coexisting, there is a limitation on Applet client and ActiveX client on Windows
that can not be coexisted with V5.0.x and V4.x of the clients. For example, the Applet client feature
in Version 6 cannot coexist with the Applet client feature in any previous release. This coexistence
is not available because the installation of Applet client feature in Version 6 sets the browser default
Java Virtual Machine (JVM) using the Java Runtime Environment (JRE) from the Version 6
installation, which is Java Runtime Environment Version 1.4.2. Similarly, the ActiveX to EJB Bridge
feature in Version 6 sets the Windows system path to use the JRE from the Version 6 installation.

1. |Instal| Application Client for WebSphere Application Server using the Iaunchpadl The launchpad
program is available on the root directory of the product CD in the program, Taunchpad.sh, on Linux
and UNIX platforms and Taunchpad.bat on Windows platforms.

Note: The free download Application Client installation is not packaged with the launchPad program.

a. Click Launch the installation wizard for Application Client for WebSphere Application Server
from the launchpad tool to launch the InstallShield for MultiPlatforms installation wizard. This action
launches the installation wizard.

The Readme documentation to which the launchpad links is the readme.html file in the CD root
directory. The readme directory off the root of the CD has more detailed Readme files. The
Installation Guide is in the /docs directory of the CD root directory.

Note: Readme file names are based on product offerings.

When you install application clients, the current working directory must be the directory where the
installer binary program is located. This placement is important because the resolution of the class
files location is done in the current working directory. For example:

cd /install_root/AppClient

./install
or
cd <CD mount point>/AppClient

./install
Failing to use the correct working directory can cause ISMP errors that abort the installation.

The installation wizard does not upgrade or remove previous Application Clients installation
automatically. However, you must change the directory of any previously installed versions of the
Application Client because you cannot install Version 6 on top of previously existing Application
Client.

b. As indicated in the previous example, you can start the installation wizard from the product
CD-ROM, using the command line.
On other Linux platforms and UNIX-based platforms, run the ./install command.
On Windows platforms, run the Install.exe command.

c. You can also perform a|si|ent installation| using the -options responsefile parameter, which
causes the installation wizard to read your responses from the options response file, instead of
from the interactive graphical user interface. Customize the response file before installing silently.
After customizing the file, issue the command to silently install. Silent installation is particularly
useful if you install the product often.
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The rest of this procedure assumes that you are using the installation wizard. There are
corresponding entries in the response file for every prompt that is described as part of the wizard.
Review the description of the response file for more information. Comments in the file describe how
to customize its options.

2. Click Next to continue when the Welcome panel is displayed.

a. Click the radio button beside the | accept the terms in the license agreement message if you
agree to the license agreement, and click Next to continue.

3. Specify a destination directory. Click Next to continue.
a. Ensure that there is adequate space available in the target directory.
b. Specify a target directory for the Application Client product.

c. Enter the required target directory to proceed to the next panel. Deleting the default target location
and leaving an installation directory field empty prevents you from continuing the installation
process.

4. Choose a type of installation, and click Next.

If you use the GUI, you can choose a Typical installation type, which installs J2EE and Thin application
client, Samples and IBM Developer Kit, Java 2 Technology Edition or a Custom installation type.

The Custom installation type lets you select which features to install. However you can not install the
J2EE and Java Thin application client feature and the Pluggable application client feature together.

(Windows Only) If you select the ActiveX to EJB Bridge feature, then the following is displayed in a
dialog box: Do you want to add Java runtime to the system path and make it the default JRE? If
you answer Yes, then the Java run time is added to the beginning of the system path. If you answer
No, then the ActiveX to EJB Bridge does not function from the Active Server Pages (ASP), unless you
add the Java run time to the path. To add the Java run time later, see the topic [ActiveX application|
or reinstall the Application Client.(Windows Only) If you select the Applet client feature, then
the following message might be displayed: An existing JDK or JRE has been detected on your
computer. You chose to install the Applet Client, which will overwrite the registry entries
for this JDK or JRE. Do you want to continue and install the Applet Client? If you select Yes,
the installation overrides the registry on your machine. If you select No, the Applet client feature is not
installed, and you are directed back feature dialog box.

5. Install the Software Developer Kit, if you need to use any of the utilities that it provides, such as the
javaccompiler, the jarutility or the jarsinger utility. The Java 2 Development Kit that IBM provides has
two components, Java Runtime Environment (JRE) and a complete Software Developer Kit (SDK). The
JRE sub feature is selected by default when the J2EE or Thin application client feature is selected.
The SDK component is optional; however, you must install the SDK component to compile the sample.

6. Enter the host name of the WebSphere Application Server machine. Click Next to continue. The
default port number for product Version 6 server is 2809.
7. Review the summary information, and click Next to install the product code or you might also click
Back to change your specifications.
8. Click Finish to exit the wizard, after the Application Client installs.
9. Verify the success of the installer program by examining the Completion panel and the
<install root>/1ogs/WAS.Client.isntall.log file for installation status. The installer program records
the following indicators of success in the logs:
» INSTCONFSUCCESS indicates that the installation is successful and that no further log analysis is
required.
* INSTCONFFAILED indicates an installation failure that you cannot retry or recover from without
reinstalling.

You successfully installed the Application Client for WebSphere Application Server and the features you
selected.

If the installation is not successful, fix the error as indicated in the installation error message. For example,
if you do not have enough disk space, add more space, and reinstall the Application Client.
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Best practices for installing application clients
The following table offers tips for installing application clients on multiple platforms.

Operating environment

Tip

Linux and UNIX systems

Spaces are not supported in the name of the installation directory on
Linux and UNIX platforms.

UNIX systems

When the application client installations are successful, the return
code 1 is issued from the UNIX shell where you issued the /install
command. Any other return code indicates an unsuccessful
installation.

Solaris systems

Double-byte character set (DBCS) characters are not supported in the
name of the installation directory on Solaris systems.

All platforms Reserve at least 4 to 5MB free space in the target platform temporary
directory.

All platforms When specifying a different temporary directory while installing
application clients, the following message is displayed if the target
platform default temporary directory does not have enough free space
to install application clients:

Error writing file = There may not be enough
temporary disk space.
Try using -is:tempdir to use a temporary
directory on a partition with more disk
space.
Use the -is:tempdir installation option to specify a different
temporary directory. For example, the following command uses /swap
as a temporary directory during installation:
./install -is:tempdir /swap
All platforms After the installation, when changing the installation settings for the

WebSphere Application Server host name and the port number, edit
the setupClient.bat for Windows or setupClient.sh for UNIX.
Change the DEFAULTSERVERNAME and SERVERPORTNUMBER to the new
WebSphere Application Server host name and port number,
respectively. If the SERVERPORTNUMBER is not set, then the default is
2809. Review the following example:

set DEFAULTSERVERNAME=NDServerName

set SERVERPORTNUMBER=9810

The setupClient.bat file or setupClient.sh file is located in the bin
sub-directory under the application clients installation destination.

Installing application clients silently

Use these steps to perform a silent installation, which uses the installation wizard to install the product.
Instead of displaying a user interface, the silent installation provides interaction between you and the
wizard by reading all of your responses from a file that you must customize.

1. Verify that the user ID that you are using to run the silent installation has sufficient authority to perform

the task.

2. Customize the option response file.

a. Locate the sample options response file. The file name is setup.response in the operating system
platform directory on the product CD-ROM.

b. Make a copy to preserve the original response file. For example, copy the file as myoptionsfile.
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c. Edit the copy in your flat file editor of choice, on the target operating system. Read the directions
within the response file to choose appropriate values.

Note: To prepare the file for a silent installation on AlIX, use UNIX line-end characters (OXODOA) to
terminate each line of the options response file.

d. Make a non-commented option to have a silent install.

e. Include custom option responses that reflect parameters for your system.
f. Follow the instructions in the response file to choose appropriate values.
g. Save the file.

3. Issue a command to use your custom response file: Install.exe -options myoptionsfile for
Windows platforms and install -options ./myoptionsfile for Linux and UNIX platforms.

The sample options response file is located in the operating-system platform directory on the product
CD-ROM.

a. Issue the following command from a command prompt to update your response file: -W
silentInstalllLicenseAcceptance.value="true’.

Issuing this command changes the value for silentInstalllLicenseAcceptance.value from false to
true, which is necessary for installing application clients.

4. Optional: Restart your machine in response to the prompt that appears on Windows platforms when
the installation is complete.

You installed application clients silently by using the response file.

To verify the silent install, look for the string RC=INSTCONFSUCCESS in the log file for successful installation
and RC=INSTCONFFAILED for a failed install installation.

For UNIX platforms, the install command returns a return code of 1 to indicate a successful installation.
Any other return code means that the installation failed.

Uninstalling Application Client for WebSphere Application Server

This task describes using the uninstaller program to uninstall the Application Client for WebSphere
Application Server.

Before uninstalling, verify that you have no open Web browsers that are accessing the administrative
console.

If you want to uninstall Application Clients manually, see the topic, [‘Manually uninstalling on a Windows|
lsystem” on page 287
1. Stop any browsers and any Java processes related to WebSphere Application Server products as
described in [Appendix A, “Uninstalling the product,” on page 271
2. Change directories to the _uninst directory before issuing the ['uninstall command” on page 272 The
command file is located in the install_root/product/_uninst directory on a Linux or UNIX platform, and
in the install_roof\product\_uninst directory on a Windows system.
For example, to change directories before uninstalling the product from a Linux platform, issue this
command if your installation root is /opt/IBM/WebSphere/AppServer:
cd /opt/IBM/WebSphere/AppServer/product/ uninst

3. lIssue the uninstaller command. The command file is named uninstaller.bin for Linux and UNIX
platforms and uninstaller.exe on Windows platforms.

-mE. On Linux and UNIX platforms, issue the uninstaller.bin command from the
install_root/product/_uninst directory:

./uninstaller.bin
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m On Windows platforms, call the uninstaller.exe command:
install_root\product\_uninst\uninstaller.exe

m Call the program directly from the install root\product\_uninst directory. For example, if
the installation root is C:\IBM\WebSphere\AppServer, issue the following command:

C:\IBM\WebSphere\AppServer\product\_uninst> uninstaller.exe
The Uninstaller wizard begins and displays the Welcome panel.

4. Click Next to begin uninstalling the product. The Uninstaller wizard displays a Confirmation panel that
lists the product and features that you are uninstalling.

5. Click Next to continue uninstalling the product. The Uninstaller wizard deletes existing profiles first.
After deleting profiles, the Uninstaller wizard deletes core product files by component.
6. Click Finish to close the wizard after the wizard removes the product.

Application Client for WebSphere Application Server is uninstalled.

Verify the uninstall procedure by viewing the install_root/product/1ogs/uninstlog.txt log file for errors.
Look for the INSTCONFSUCCESS, indicating a successful uninstall in the log file:

Uninstall, com.ibm.ws.install.ni.ismp.actions.ISMPLogSuccessMessageAction, msgl,
INSTCONFSUCCESS
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Part 4. Configuring
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Chapter 10. Configuring the product after installation
This topic summarizes how to configure the application serving environment.

Use the First steps console to configure and test the WebSphere Application Server environment after
installation.

This procedure uses the First steps console to launch the installation verification test (IVT) that tests and
verifies your WebSphere Application Server - Express environment. This procedure also uses the First
steps console to launch the Profile creation wizard to create an additional Application Server.

1. Start the First steps console by selecting the check box on the last panel of the wizard.

The First steps console can start automatically at the end of the installation. Select the check box on
the last panel of the Installation wizard.

The First steps console is an easy way to start using the product. The console provides one-stop
access to the administrative console, Samples Gallery, Profile creation wizard, installation verification
test, Migration wizard, and other activities.

See the description of the [‘firststeps command’|for more information.
2. Click Installation verification on the First steps console.

The installation verification test starts the Application Server process named server1 and runs several
tests to verify that the server1 process can start without errors.

See ['Using the installation verification test” on page 228 for more information.
3. Click Profile creation wizard on the First steps console to create an Application Server profile.
You can create multiple Application Servers on your system without installing the product again.
See ['Using the Profile creation wizard to create an application server” on page 212
4. Start the First steps console by selecting the check box on the last panel of the Profile creation wizard.

This First steps console belongs to the Application Server profile that you just created. Each profile has
its own First steps console.

5. Click Installation verification on the First steps console.

The installation verification test starts the new Application Server process named server1 and runs
several tests to verify that the server1 process can start without error.

This procedure results in configuring and testing the Application Server environment.

firststeps command

The firststeps command starts the First steps console.
The First steps console

The First steps console is a post-installation ease-of-use tool for directing WebSphere Application Server
elements from one place. Options display dynamically on the First steps console, depending on features
you install. With all of the options present, you can use the First steps console to start or stop the
application server, verify the installation, access the information center, access the administrative console,
launch the Migration wizard, or access the Samples gallery.

Select the check box to start the First steps console at the end of the product installation.

You can also start the First steps console from the command line as described later.

Installation verification
This option starts the installation verification test (IVT). The test consists of starting and monitoring
the application server during its start up.
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If this is the first time that you have used the First steps console since creating an application
server profile, click Installation verification to verify that all is well with your installation. The
verification process starts the application server.

If you select the Installation verification option, the Start the server option is grayed out while
the IVT is running.

The IVT provides the following useful information about the application server:
* The server name: serveri

* The name of the profile

* The profile file path

* The type of profile: default

* The cell name

* The node name

* The current encoding

* The port number for the administrative console

» Various informational messages that include the location of the SystemOut.1og file and how
many errors are listed within the file

« A completion message

Start the server

This option toggles to Stop the server when the application server is running.

After selecting the Start the server option, an output screen displays with status messages. The
success message informs you that the server is open for e-business. Then the menu item
changes to Stop the server.

If you select the Start the server option, the Installation verification option is grayed out while
the application server is running.

Administrative console

This option is grayed out until the application server is running.

The administrative console is a configuration editor that runs in a Web browser. The administrative
console lets you work with XML configuration files for the application server. To launch the
administrative console, click Administrative console. You can also point your browser to
[ttp://localhost:9060/ibm/console| to start the administrative console. Substitute your own host
name in the address if the localhost variable does not resolve correctly. As the administrative
console opens, it prompts you for a login name. This is not a security item, but merely a tag to
identify configuration changes that you make during the session. Secure signon is also available.

Profile creation wizard

This option starts the Profile creation wizard. The wizard lets you create additional application
servers. A profile consists of files that define the run-time environment for the application server.
Each environment has its own administrative interface. This means that the new application server
has its own administrative console.

Each application server has its own First steps console. The location of the command is within the
set of files in the profile. A prompt to launch the First steps console displays on the last panel of
the Profile creation wizard.

Samples gallery
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This option starts the Samples gallery. The option is grayed out until you start the application
server. The option displays when you have installed the Samples during installation. The typical
installation includes the Samples by default.

From the First steps console, click Samples gallery to explore the application Samples.
Alternatively you can point your browser directly to [http://localhost:9080/WSsamples. Substitute
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your own host name in the address if the localhost variable does not resolve correctly. The Web
address is case sensitive. Substitute your own host name in the address.

Information center for WebSphere Application Server
This option links you to the online information center at the
Ihttp://publib.boulder.ibm.com/infocenter/ws60help/index.jsp| IBM Web address.

Migration wizard
This option starts the Migration wizard. The Migration wizard is a new graphical interface to the
migration tools.

See [WASPreUpgrade command| and|WASPostUpgrade command| for more information.

Exit  This option closes the First steps console.
Location of the command file

Installing the product creates a default profile for the server1 application server. The location of the First
steps console for the default profile is:

. -E'JE- install_root/profiles/default/firststeps/firststeps.sh
. minstall_root\proﬁ1es\defau1t\ﬁrststeps\ﬁrststeps.bat

The location of the firststeps.sh or firststeps.bat script for any profile is:
. -E'E- install_root/profiles/profile_name/firststeps/firststeps.sh
. m install_root\profiles\profile_name\firststeps\firststeps.bat

Parameters
No parameters are associated with this command.
Syntax for the firststeps command

Use the following syntax for the command:

. -EE. ./firststeps.sh
. m firststeps.bat

Usage tips

The following links exist on the First steps console for the WebSphere Application Server - Express
product:

Option Link

Installation verification Calls the ivt command.

The location of the installation verification test varies per platform:
. install_root/profiles/profile_name/bin/ivt.sh

. minstal/_root/profi1es/profile_name/bin/ivt.sh

. m install_roof\profiles\profile_name\bin\ivt.bat
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Option

Link

Start the server

Calls the startServer command.
The location of the startServer command varies per platform:

. m install_root/profiles/profile_name/bin/startServer.sh
serveri

. LUNIX install_root/profiles/profile_name/bin/startServer.sh
serveri

o WUUIEEY jnstall_roof\profiles\profile name\bin\startServer.bat
serveri

When you have more than one application server on the same machine, the
command starts the same application server that is associated with the First
steps console.

Stop the server

Calls the stopServer command.
The location of the stopServer command varies per platform:

. m install_root/profiles/profile_name/bin/stopServer.sh
serveri

. LUNIX install_root/profiles/profile_name/bin/stopServer.sh
serveri

o WEEE install_roof\profiles\profile name\bin\stopServer.bat
serveri

Administrative console

Opens the default browser to the |htip:/localhost:9060/ibm/console| Web
address.

When you have more than one application server on the same machine, the
port varies. The First steps console starts the administrative console that is
associated with the First steps console.

Profile creation wizard

Calls the pctplatform command.

The command is in the install_root/bin/ProfileCreator directory. The name
of the command varies per platform:

. m pctAIX.bin

. m pctHPUX.bin

. m 64-bit platforms: pctHPUXIA64.bin
. :I—-‘_'—- pctLinux.bin

. :I—-_'—'- 64-bit platforms: pct.bin

. :I—-_'—'- Power platforms: pctLinuxPPC.bin
. m pctSolaris.bin

. pctWindows.exe

o BUUIEEY 64-bit platforms: pctWindowsIAG4. exe
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Option Link

Samples Gallery Opens the default browser to the http://localhost:9080/WSsamples| Web
address.

If you do not install Samples, the option does not appear on the First steps
console. If you do not install the Samples during the initial installation of the
product, the option does not display on the First steps console. You can
perform an incremental installation to add the Samples feature. After adding
the Samples, the options displays on the First steps console.

When you have more than one profile on the same machine, the port
varies. The First steps console starts the Samples gallery that is associated
with the First steps console.

Information center for WebSphere Opens the default browser to the online information center at the
Application Server products [http://publib.boulder.ibm.com/infocenter/ws60help/index.jsp| Web address.

Migration wizard Calls the migration command.

The location of the migration command is:

. minstall_root/bin/migration.sh
. minsta/l_root\bin\migration.bat

The migration tools are also in the /migration folder on the product disc.

Using the Profile creation wizard

This topic describes how to create run-time environments for WebSphere Application Server. Each
run-time environment is created within a profile. A profile is the set of files that define the run-time
environment. The Profile creation wizard creates the profile for each run-time environment.

Before using the Profile creation wizard, install the core product files.

The Profile creation wizard is the wizard interface to the profile creation tool, wasprofile. See the
description of the [‘wasprofile command” on page 217|for more information.

An error can occur when you have not provided enough system temporary space to create a profile. Verify
that you have a minimum of 40 MB of temp space available before creating a profile.

You must have 200 MB of available disk space in the directory where you create an Application Server
profile.

-3_ Manually verify that the required space for creating a profile is available on AIX. A known
problem in the underlying InstallShield for Multiplatforms (ISMP) code prevents proper space checking on
AlIX systems at the time that the product disc was created.

Important: Concurrent profile creation is not supported at this time for one set of core product files.
Concurrent attempts to create profiles result in a warning about a profile creation already in
progress.

The installation procedure creates one profile named default for an application server named serverl.
You can use the Profile creation wizard to create more application server processes. For example, a
second profile can allow two different teams in a department to test independently of one another using
the same machine.

Each use of the Profile creation wizard or the wasprofile command line tool creates one profile.
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1. Install the product to create the core product files.
2. Start the Profile creation wizard to create a new run-time environment.
Several ways exist to start the wizard.
One way to start the wizard is to issue the command directly from a command line.

The command is in the install_root/bin/ProfileCreator directory. The name of the command varies
per platform:

pctAIX.bin

T
. BMEETE octvpux.bin
[ HP-UX

64-bit platforms: pctHPUXIA64.bin

. pctLinux.bin
. 64-bit platforms: pct.bin
. Power platforms: pctLinuxPPC.bin

. m pctSolaris.bin
. m pctWindows.exe

. m 64-bit platforms: pctWindowsIA64.exe
Another way to start the Profile creation wizard is to select the wizard from the First steps console.
a. Open a command window.
b. Change directories to the firststeps directory in the installation root directory:
The installation root varies by platform:

. m/usr/IBM/WebSphere/AppServer/f1'rststeps
- HP-UX | m/opt/IBM/WebSpher‘e/AppServer‘/ﬁr‘ststeps

. m C:\Program Files\IBM\WebSphere\AppServer\firststeps
c. lIssue the firststeps command to start the console:

. -E'E. ./firststeps.sh
. m firststeps.bat

d. Select the Profile creation wizard option on the console.

The Profile creation wizard is an InstallShield for Multiplatforms application. The wizard loads the
Java 2 SDK and then displays its Welcome panel.

See the description of the [“firststeps command” on page 207|for more information.
3. Create another stand-alone application server.
See ['Using the Profile creation wizard to create an application server.’|

The installation procedure creates a stand-alone application server during installation. However, you
can use the Profile creation wizard to create additional stand-alone application servers.

Using the Profile creation wizard to create an application server

The Profile creation wizard can create an application server profile on any machine where the core product
files exist.

Before using the Profile creation wizard, install the core product files.
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The Profile creation wizard is the wizard interface to the profile creation tool, wasprofile. See the
description of the [‘wasprofile command” on page 217|for more information.

An error can occur when you have not provided enough system temporary space to create a profile. Verify
that you have a minimum of 40 MB of temp space available before creating a profile.

You must have 200 MB of available disk space in the directory where you create an Application Server
profile.

-JE- Manually verify that the required space for creating a profile is available on AIX. A known
problem in the underlying InstallShield for Multiplatforms (ISMP) code prevents proper space checking on
AlIX systems at the time that the product disc was created.

The Installation wizard creates an application server profile with a server named server1. You can create
additional profiles. Each additional profile is an application server named server1.

This procedure describes creating an application server profile using the graphical user interface provided
by the Profile creation wizard.

You can also use the wasprofile command to create an application server profile. See the description of
the [‘wasprofile command” on page 217|for more information.

1. Start the Profile creation wizard to create a new run-time environment.
Several ways exist to start the wizard.
One way to start the wizard is to issue the command directly from a command line.

The command is in the install_root/bin/ProfileCreator directory. The name of the command varies
per platform:

pctAIX.bin

T
. IMCCETE octvpux.bin
[ HP-UX_

64-bit platforms: pctHPUXIA64.bin

. pctLinux.bin
. 64-bit platforms: pct.bin
. Power platforms: pctLinuxPPC.bin

. m pctSolaris.bin
. m pctWindows.exe

. m 64-bit platforms: pctWindowsIA64.exe
Another way to start the Profile creation wizard is to select the wizard from the First steps console.
a. Open a command window.
b. Change directories to the firststeps directory in the installation root directory:
The installation root varies by platform:

. m/usr/IBM/WebSphere/AppServer/ﬁrststeps
. m m/opt/IBM/WebSphere/AppServer/ﬁrststeps

. m C:\Program Files\IBM\WebSphere\AppServer\firststeps
c. lIssue the firststeps command to start the console:
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. -EE. ./firststeps.sh
. Mﬁrststeps.bat

d. Select the Profile creation wizard option on the console.

The Profile creation wizard is an InstallShield for Multiplatforms application. The wizard loads the
Java 2 SDK and then displays its Welcome panel.

See the description of the r‘firststeps command” on page 207| for more information.
2. Click Next on the Welcome panel.

The wizard displays the Profile type selection panel.
3. Click Next.

The wizard displays the Profile name panel.

Each profile that you create must have a name. The name is the name of the folder that contains all
of the files that define the run-time environment for the profile. When you have more than one profile,
you can tell them apart at their highest level by this name.

4. Specify a name for the profile, then click Next.

Profile naming guidelines: The profile name can be any unique name with the following restrictions.
Do not use any of the following characters when naming your profile:

e Spaces

« lllegal special characters that are not allowed within the name of a directory on your operating
system, such as *&?

» Slashes (/) or (\)
Double-byte characters are allowed.
The default profile

The first profile that you create on a machine is the default profile. The default profile is the default
target for commands issued from the bin directory in the product installation root. When only one
profile exists on a machine, every command works on the only server process in the configuration.

Addressing a profile in a multi-profile environment

When two or more profiles exist on a machine, certain commands require that you specify the profile
to which the command applies. These commands use the -profileName parameter to identify which
profile to address. You might find it easier to use the commands that in the bin directory of each
profile.

A command in the profiles/profile name/bin directory has two lines. The first line sets the
WAS_USER_SCRIPT environment variable for the command window. The variable sets up the
command environment to address the profile. The second line calls the actual command in the
install_root/bin directory.

The actual command queries the command shell to determine the calling profile and to autonomically
address the command to the calling profile.

The wizard then displays the Profile directory panel.

5. Accept the default directory or specify a non-default location, then click Next. Or click Browse to
select a different location.

If you click Back and change the name of the profile, you must manually change the name on this
panel when it displays again.

The wizard displays the Node and host name panel.
6. Specify the characteristics for the application server, then click Next.
Use unique names for each application server that you create.

Reserved names: Avoid using reserved folder names as field values. The use of reserved folder
names can cause unpredictable results. The following words are reserved:

e cells
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* nodes

* servers

e clusters

» applications
* deployments

Field name Default value Constraints Description
Node name Name of your Avoid using the reserved Pick any name you want. To help organize
machine words. your installation, use a unique name if you

plan to create more than one application
server on the machine.

Host name DNS name of your | Addressable through your |Use the actual DNS name or IP address of

machine network. your machine to enable communication with
your machine. See additional information
about the host name following this table.

Node name considerations:

m The installation directory path must be no longer than 60 characters.
Host name considerations:

The host name is the network name for the physical machine on which the node is installed. The host
name must resolve to a physical network node on the server. When multiple network cards exist in
the server, the host name or IP address must resolve to one of the network cards. Remote nodes use
the host name to connect to and to communicate with this node. Selecting a host name that other
machines can reach within your network is extremely important. Do not use the generic localhost
identifier for this value.

If you define coexisting nodes on the same computer with unique IP addresses, define each IP
address in a domain name server (DNS) look-up table. Configuration files for stand-alone Application
Servers do not provide domain name resolution for multiple IP addresses on a machine with a single
network address.

The value that you specify for the host name is used as the value of the hostName property in
configuration documents for the stand-alone Application Server. Specify the host name value in one of
the following formats:

* Fully qualified domain name servers (DNS) host name string, such as
xmachine.manhattan.ibom.com

* The default short DNS host name string, such as xmachine
* Numeric IP address, such as 127.1.255.3

The fully qualified DNS host name has the advantage of being totally unambiguous and also flexible.
You have the flexibility of changing the actual IP address for the host system without having to
change the Application Server configuration. This value for host name is particularly useful if you plan
to change the IP address frequently when using Dynamic Host Configuration Protocol (DHCP) to
assign IP addresses. A format disadvantage is being dependent on DNS. If DNS is not available, then
connectivity is compromised.

The short host name is also dynamically resolvable. A short name format has the added ability of
being redefined in the local hosts file so that the system can run the Application Server even when
disconnected from the network. Define the short name to 127.0.0.1 (local loopback) in the hosts file to
run disconnected. A format disadvantage is being dependent on DNS for remote access. If DNS is
not available, then connectivity is compromised.

A numeric IP address has the advantage of not requiring name resolution through DNS. A remote
node can connect to the node you name with a numeric IP address without DNS being available. A
format disadvantage is that the numeric IP address is fixed. You must change the setting of the
hostName property in Express configuration documents whenever you change the machine IP
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address. Therefore, do not use a numeric IP address if you use DHCP, or if you change IP addresses
regularly. Another format disadvantage is that you cannot use the node if the host is disconnected
from the network.

After specifying application server characteristics, the wizard displays the Port value assignment
panel.

7. Verify that the ports specified for the stand-alone application server are unique, then click Next.

m After specifying port assignments, the wizard displays the Windows service definition
panel, if you are installing on a Windows platform.

8. m Choose whether to run the application server as a Windows service on a Windows
platform and click Next.

Version 6 attempts to start Windows services for application server processes started by a
startServer command. For example, if you configure an application server as a Windows service and
issue the startServer command, the wasservice command attempts to start the defined service.

If you chose to install a local system service, you do not have to specify your user ID or password.
you create a specified user type of service, you must specify the user ID and the password for the
user who is to run the service. The user must have Log on as a service authority for the service to
run properly.

To perform this installation task, the user ID must not have spaces in its name. The ID must also
belong to the administrator group and must have the advanced user rights Act as part of the
operating system and Log on as a service. The Installation wizard grants the user ID the advanced
user rights if it does not already have them, if the user ID belongs to the administrator group.

You can also create other Windows services after the installation is complete, to start other server
processes. See the Administration: Setting up PDF for more information.

The installation wizard shows which components are selected for installation in a pre-installation
summary panel.

9. Click Next to create the application server or click Back to change the characteristics of the
application server.

The wizard displays the Installation status panel that shows which components are installing.
When the installation is complete, the wizard displays the Profile creation is complete panel.

10. Click Finish to exit, then click Profile creation wizard on the First steps console to start the wizard
again to create other application servers.

f

You can create an application server profile. The node within the profile has an application server named
servert.

Refer to the description of the [‘wasprofile command” on page 217] to learn about creating this type of
profile using a command instead of a wizard.

Deleting a profile
This topic describes how to manually delete a profile.

Before using the manual procedure to remove a profile, try the wasprofile command with the -delete
option. For example, issue one of the following commands:

./wasprofile.sh -delete
-profileName profile name | -profilePath profile path
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wasprofile.bat -delete
-profileName profile name | -profilePath profile_path

See [‘wasprofile command.’]

If the command does not work, use this procedure to delete the profile.

This procedure describes how to manually delete a profile when the wasprofile -delete command results
in the following message:

INSTCONFFAILED: Cannot delete profile
1. Delete the profiles_install_root/ profile_name directory.

2. If the install_root/properties/profileRegistry.xml file exists, edit the file in a flat-file editor to delete
the entry for the profile, if the entry is present.

The entry resembles the following example:

<profile isDefault="true"
name="BadProfile"
path="E:\IBM\WebSphere\AppServer\profiles\BadProfile"
template="E:\IBM\WebSphere\AppServer\profileTemplates\default"/>

3. -IEE. Compare the two batch files, install_root/ properties/ fsdb/
_was_profile_default/ default.sh and install_root/ properties/ fsdb/ bad profile name.sh.

If the files are identical, delete the install_root/ properties/ fsdb/ _was_profile_default directory
and the install_root/ properties/ fsdb/ bad_profile_name.sh file.

If the files are not identical, delete only the install_root/ properties/ fsdb/ bad_profile name.sh file.

4. MCompare the two batch files, install_root\ properties\ fsdb\ was profile default\
default.bat and install_roof\ properties\ fsdb\ bad profile_name.bat.

If the files are identical, delete the install_root\ properties\ fsdb\ was profile default directory
and the install_roof\ properties\ fsdb\ bad_profile_name.bat file.

If the files are not identical, delete only the install_root\ properties\ fsdb\ bad profile_name.bat file.

See the description of the [‘wasprofile command’| to learn more about the command-line method of working
with profiles.

See [‘Using the Profile creation wizard” on page 211|for more information about creating profiles with the
Profile creation wizard.

wasprofile command

The wasprofile command line tool creates all Application Server run-time environments in Version 6. The
command creates a profile, which is the set of files that define the run-time environment for a stand-alone
Application Server.

The wasprofile command is also referred to as the profile creation tool.

Introduction to terms that describe Version 6 profiles

The wasprofile command creates the run-time environment for a WebSphere Application Server process
in a set of files called a profile. The profile defines the run-time environment and includes all of the files
that the server processes in the run-time environment can change. The profile creation tool and its
graphical user interface, the Profile creation wizard, are the only ways to create run-time environments in
V6.

The Profile creation wizard is an InstallShield for Multiplatforms (ISMP) application. You can use the wizard
to enter most of the parameters that are described in this topic. Some parameters, however, require you to
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use the wasprofile command. You must use the wasprofile command to delete a profile, for instance,
because the Profile creation wizard does not provide a deletion function.

However, the Profile creation wizard also performs tasks that the wasprofile command does not. For
instance, the wizard can create a Windows service for each profile that it creates. It can also assign
non-conflicting ports based on previous Version 6 port assignments.

Core product files
The core product files are the shared product binaries. The binary files are shared by all profiles.

The directory structure for V6 has two major divisions of files in the installation root directory for the
product:

» The core product files are shared product binary files that do not change unless you install a refresh
pack, a fix pack, or an interim fix. Some log information is also updated.

* The profiles directory is the default directory for creating profiles. The configuration for every defined
Application Server process is within the profiles directory unless you specify a new directory when you
create a profile. These files change as often as you create a new profile, reconfigure an existing profile,
or delete a profile.

All of the folders except for the profiles directory and a few others such as the 1ogs directory and the
properties directory do not change unless you install service fixes. The profiles directory, however,
changes each time you add, change, or delete a profile. The profiles directory is the default repository for
profiles. However, you can put a profile anywhere on the machine provided there is enough available disk
space.

If you put a profile in another existing folder in the installation root directory, a risk exists that the profile
might be affected by the installation of a service fix that applies maintenance to the folder. Use a directory
outside of the installation root directory when using a directory other than the profiles directory for
creating profiles.

WebSphere Application Server profile
The wasprofile command line tool defines each Application Server instance of a Version 6 product.

You must run the wizard or the command line tool each time that you want to create a stand-alone
Application Server. A need for more than one stand-alone Application Server on a machine is common.

Administration is greatly enhanced when using V6 profiles instead of multiple product installs. Not only is
disk space saved, but updating the product is simplified when you only maintain a single set of product
core files. Also, creating new profiles is faster and less prone to error than full product installs, allowing a
developer to create new disposable profiles of the product for development and testing.

You can run the Profile creation wizard or the profile creation tool to create a new Application Server
environment on the same machine as an existing one. Simply define unique characteristics (such as
profile name and node name) for the new profile. Each profile has its own administrative console and
administrative scripting interface. Each Application Server process shares all run-time scripts, libraries, the
Software Development Kit, and other core product files.

The installation program for WebSphere Application Server - Express uses the profile creation tool to
create an Application Server profile named default.

Installed file set

You decide where to install the files that define a profile. The default location is in the profiles directory in
the installation root directory. But you can change the location on the Profile creation wizard or in a
parameter when using the command line tool. For example, assume that you create two profiles on a
Linux platform with host name devhost1. The profile directories resemble the following example if you do
not relocate them:
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/opt/1BM/WebSphere/AppServer/profiles/devhost1Profile0l
/opt/1BM/WebSphere/AppServer/profiles/devhost1Profiled2

Suppose that you specify a different directory, such as /opt/profiles, for the profile directory field in the
wizard. The profile directories resemble the following example:

/opt/profiles/devhost1Profiledl
/opt/profiles/devhost1Profiled2

The following directories exist within a profile. This example assumes that a profile named
devhost1ProfileO1 exists:

/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/bin
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/config
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/etc
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/firststeps
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/installableApps
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/installedApps
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/installedConnectors
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/installedFilters
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/logs
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/properties
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/samples
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/temp
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/tranlog
/opt/IBM/WebSphere/AppServer/profiles/devhost1Profile01/wstemp

The profile repository
The profile repository is the default location of profile-related metadata. The repository is the default
location for new profiles, which is often referred to as the profiles installation root directory.

However, you can decide where to install a profile. The default location of the profile repository is the
install_root/profiles directory. In the earlier example, creating two profiles on a Linux platform with host
name devhost1 results in the following example directories in the profile repository:

/opt/1BM/WebSphere/AppServer/profiles/devhost1Profiledl
/opt/1BM/WebSphere/AppServer/profiles/devhost1Profiled2

When you specify a directory, such as /opt/profiles, the profiles are no longer in the default repository,
which is not a problem. For example, the following locations are valid:

/opt/profiles/devhost1Profile0l
/opt/profiles/devhost1Profile02

Location of the command file

The command file is located in the install_root/bin directory. The command file is a script named
wasprofile.sh for Linux and UNIX platforms or wasprofile.bat for Windows platforms.

The Profile creation wizard is the graphical user interface to the command line tool. The file name of the
command that calls the Profile creation wizard varies per operating system platform. See [‘Using the Profile]
lcreation wizard” on page 211|for more information.

Logging

The wasprofile command creates a log for every profile that it creates. The logs are in the
install_root/1ogs/wasprofile directory. The files are named in this pattern:
wasprofile_create_profile_name.log.
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The command also creates a log for every profile that it deletes. The logs are in the
install_root/1ogs/wasprofile directory. The files are named in this pattern:
wasprofile_delete profile name.log.

Required disk space

m Manually verify that the required space for creating a profile is available on AIX. A known
problem in the underlying InstallShield for Multiplatforms (ISMP) code prevents proper space checking on
AIX systems at the time that the product disc was created.

An error can occur when you have not provided enough system temporary space to create a profile. Verify
that you have a minimum of 40 MB of temp space available before creating a profile.

You must have 200 MB of available disk space in the directory where you create an Application Server
profile.

Concurrent profile creation

Important: Concurrent profile creation is not supported at this time for one set of core product files.
Concurrent attempts to create profiles result in a warning about a profile creation already in
progress.

Entering lengthy commands on more than one line

The length of the wasprofile command can exceed the normal shell window limit for one line of 256
characters. If your command is longer than the limit, issue the command on multiple lines by ending a line
with a backward slash, pressing Enter, and continuing the command on the next line.

For example, on a Solaris system, the following command requires input on multiple lines:

./wasprofile.sh \

-create -profileName bladetcbbprofile \

-profilePath /usr/IBM/WebSphere/AppServer/profiles/bladetcbbprofile \
-templatePath /usr/WebSphere/AppServer/profileTemplates/default \
-nodeName bladetcb6node \

-cel1Name bladetcb6Cell \

-hostName bladetcb6.rtp.raleigh.ibm.com

Omit the line continuation character from the last line to signal the end of the command to the operating
system.

wasprofile.sh command syntax
Get help for the command:
# ./wasprofile.sh -help

# ./wasprofile.sh -create -help

# ./wasprofile.sh -delete -help

# ./wasprofile.sh -getName -help

# ./wasprofile.sh -getPath -help

# ./wasprofile.sh -validateRegistry -help

# ./wasprofile.sh -validateAndUpdateRegistry -help

List existing profiles:
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# ./wasprofile.sh -TistProfiles
[-debug]

Delete profiles:
# ./wasprofile.sh -delete

-profileName profile name | -profilePath profile_path
[-debug]

Create new profiles:

wasprofile.sh -create
-profileName profile_name
-profilePath fully qualified profile_path
-templatePath template path
-nodeName node_name
-cel1Name cell_name
-hostName host_name
-server iSeries_server_name
[-startingPort starting port | -portsFile filepath]
-winserviceCheck true | false
-winserviceAccountType specifieduser | localsystem
-winserviceUserName yourusername
-winservicePassword yourpassword
-winserviceStartupType manual | automatic | disabled
[-debug]

Get name of existing profile from path:

# ./wasprofile.sh -getName
-profilePath profile_path
[-debug]

Get path of existing profile from name:

# ./wasprofile.sh -getPath
-profileName profile_name
[-debug]

Check the integrity of the profile registry:

# ./wasprofile.sh -validateRegistry
[-debug]

Check the integrity of the profile registry, removing profiles that are not found:

# ./wasprofile.sh -validateAndUpdateRegistry
[-backup file name]
[-debug]

wasprofile.bat command syntax
Get help for the command:
# ./wasprofile.bat -help

# ./wasprofile.bat -create -help

# ./wasprofile.bat -delete -help

# ./wasprofile.bat -getName -help

# ./wasprofile.bat -getPath -help

# ./wasprofile.bat -validateRegistry -help

# ./wasprofile.bat -validateAndUpdateRegistry -help
List existing profiles:
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wasprofile.bat -listProfiles
[-debug]

Delete profiles:
wasprofile.bat -delete

-profileName profile name | -profilePath profile path
[-debug]

Create new profiles:

wasprofile.bat -create
-profileName profile_name
-profilePath fully qualified profile_path
-templatePath template path
-nodeName node_name
[-cel1Name cell_name]
-hostName host_name
-serverName server_name
[-startingPort starting port | -portsFile filepath]
-winserviceCheck true | false
-winserviceAccountType specifieduser | localsystem
-winserviceUserName yourusername
-winservicePassword yourpassword
-winserviceStartupType manual | automatic | disabled
[-debug]

When the -startingPort parameter is not used, the profile creation tool uses the default port settings
specified in the serverindex.xml file.

Get name of existing profile from path:
wasprofile.bat -getName
-profilePath fully qualified profile_path
[-debug]
Get path of existing profile from name:
wasprofile.bat -getPath
-profileName profile_name
[-debug]
Check integrity of profile registry:
wasprofile.bat -validateRegistry
[-debug]

Check integrity of profile registry, removing unfound profiles:

wasprofile.bat -validateAndUpdateRegistry
[-backup file_name]
[-debug]

Parameters
Supported arguments include:

-augment
Refreshes or augments the given profile using the template in the templatePath parameter.

-backup file_name
Backs up the profile registry file to a file with the file name specified.

-cellname file_name
Specifies the cell name of the profile.

This is an optional parameter for WebSphere Application Server - Express.

If you omit the parameter, a default cell name is assigned.
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-create
Creates the profile.

-debug
Turns on the debug function of the Ant utility, which the wasprofile command uses.

-delete
Deletes the profile.

-getName
Gets the name for a profile registered at a given file system path. Requires the —profilePath parameter.

-getPath
Gets the file system location for a profile of a given name. Requires the —profileName parameter.

-help
Displays command syntax.

-hostName host_name
Specifies the host name where you are creating the profile. This should match the host name that you
specified during installation of the initial product.

-listProfiles
Llists all defined profiles.

-nodeName node_name
Specifies the node name for the node that is created with the new profile. Use a unique value or on
the machine. Each profile that shares the same set of product binaries must have a unique node
name.

-portsFile file_path
An optional parameter that specifies the path to a file that defines port settings for the new profile.
When omitted, the wasprofile tool looks for the install_root /profileTemplates/profile type
/actions/portsUpdate/bin/portdef.props file.

Do not use this parameter when using the startingPort parameter.

-profileName profile_name
Specifies the name of the profile. Use a unique value when creating a profile. Each profile that shares
the same set of product binaries must have a unique name.

-profilePath profile_path
Specifies the fully qualified path to the profile.

m If the fully qualified path contains spaces, enclose the value in quotation marks.

Specifies the name of the application server. If not specified, the default application server name is
server1. This parameter is supported only on the OS/400 operating system.

-startingPort startingPort
Specifies the starting port number for generating all ports for the profile. If not specified, the
wasprofile command uses default ports specified in the serverindex.xml file.

-templatePath ftemplate_path
Specifies the path to the templates in the shared binaries.

-validateAndUpdateRegistry registry_file backup_file
Checks all of the profiles that are listed in the profile registry to see if the profiles are present on the
file system. Removes any missing profiles from the registry. Returns a list of the missing profiles that
were deleted from the profile.
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-validateRegistry registry_file
Checks all of the profiles that are listed in the profile registry to see if the profiles are present on the
file system. Returns a list of missing profiles.

m -winserviceAccountType type_of owner_account
The type of the owner account of the Windows service created for the profile can be either
specifieduser or localsystem. The Windows service can run under the local account of the user who is
creating the profile.

m winserviceCheck value

The value can be either true or false. Specify true to create a Windows service for the server process
that is created within the profile. Specify false to not create the Windows service.

m -winservicePassword yourpassword
Specify the password for the specified user or the local account that is to own the Windows service.

m -winserviceStartupType startup_type
Possible startup_type values are:

* manual
e automatic
e disabled

See the Administration: Setting up PDF for more information.

m -winserviceUserName user_ID
Specify your user ID so that Windows can verify you as an ID that is capable of creating a Windows
service. Your user ID must belong to the administrator group and have the following advanced user
rights, Act as part of the operating system and Log on as a service

Use case scenarios
Use cases are a description of common tasks for which the tool is used.

Scenario: Deleting a profile
The following command is on more than one line for clarity. Enter the command on one line to delete the
profile named shasti:

wasprofile.sh -delete
-profileName shasti

Scenario: Using predefined port numbers
When you use the wasprofile tool without the -startingPort parameter, the tool uses the
/profileTemplates/profile type /actions/portsUpdate/bin/portdef.props file to set the initial ports.

Example of using the -portsFile parameter

Copy the file, edit the port settings, and use your copy by using the -portsFile parameter as shown in the
following example:

wasprofile.bat

-create

-profileName Wow_Profile

-profilePath
C:\ExpressV6\IBM\WebSphere\AppServer\profiles\Wow Profile

-templatePath
C:\ExpressV6\IBM\WebSphere\AppServer\profileTemplates\default

-nodeName Wow_node

-ceT1Name Wow_cell

-hostName ToyAllen

-portsFile C:\temp\ports\portdef.props
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Suppose that the portdef.props file has the following values:

WC_defaulthost=39080

WC_adminhost=39060
WC_defaulthost_secure=39443
WC_adminhost_secure=39043
BOOTSTRAP_ADDRESS=32809
SOAP_CONNECTOR_ADDRESS=38880
SAS_SSL_SERVERAUTH_LISTENER_ADDRESS=39401
CSIV2_SSL_SERVERAUTH_LISTENER ADDRESS=39403
CSIVZ2_SSL_MUTUALAUTH_LISTENER_ADDRESS=39402
ORB_LISTENER_ADDRESS=39100
DCS_UNICAST_ADDRESS=39353
SIB_ENDPOINT_ADDRESS=37276

SIB_ENDPOINT SECURE_ADDRESS=37286
SIB_MQ_ENDPOINT_ADDRESS=35558
SIB_MQ_ENDPOINT_SECURE_ADDRESS=35578

As you run the command, messages similar to the following appear in the output stream:

replaceRegExpAllInstances0fGivenTokenWithGivenValueForTheGivenFile:
[echo] File C:\ExpressV6\IBM\WebSphere\AppServer\profiles\
Wow_Profile/config/templates/default/serverentry-template.xml:
setting CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS to 39403

replaceRegExpAllInstancesOfGivenTokenWithGivenValueForTheGivenFile:
[echo] File C:\ExpressV6\IBM\WebSphere\AppServer\profiles\
Wow_Profile/config/templates/default/serverentry-template.xml:
setting CSIVZ2_SSL_MUTUALAUTH_LISTENER_ADDRESS to 39402

The resulting serverindex.xml file looks similar to the following example:

<?xml version="1.0" encoding="UTF-8"?>
<serverindex:ServerIndex xmi:version="2.0" xmins:xmi="http://www.omg.org/XMI"

<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="BOOTSTRAP_ADDRESS">
<endPoint xmi:id="EndPoint_..." host="IBMmachine" port="32809"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint ...
endPointName="SOAP_CONNECTOR_ADDRESS">
<endPoint xmi:id="EndPoint_..." host="IBMmachine" port="38880"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="SAS_SSL_SERVERAUTH_LISTENER ADDRESS">
<endPoint xmi:id="EndPoint_..." host="IBMmachine" port="39401"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS">
<endPoint xmi:id="EndPoint_..." host="IBMmachine" port="39403"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="CSIV2_SSL _MUTUALAUTH_LISTENER_ADDRESS">
<endPoint xmi:id="EndPoint ..." host="IBMmachine" port="39402"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_...
endPointName="WC_adminhost">
<endPoint xmi:id="EndPoint_..." host="*" port="39060"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="WC_defaulthost">
<endPoint xmi:id="EndPoint_..." host="*" port="39080"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="DCS_UNICAST_ADDRESS">
<endPoint xmi:id="EndPoint_..." host="IBMmachine" port="39353"/>
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</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="WC_adminhost_secure">
<endPoint xmi:id="EndPoint_..." host="*" port="39043"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="WC_defaulthost_secure">
<endPoint xmi:id="EndPoint_..." host="*" port="39443"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint ...
endPointName="SIB_ENDPOINT_ADDRESS">
<endPoint xmi:id="EndPoint_..." host="*" port="37276"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="SIB_ENDPOINT_ SECURE_ADDRESS">
<endPoint xmi:id="EndPoint_..." host="*" port="37286"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_..."
endPointName="SIB_MQ_ ENDPOINT_ADDRESS">
<endPoint xmi:id="EndPoint_..." host="*" port="35558"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint ..."
endPointName="SIB_MQ_ENDPOINT_SECURE_ADDRESS">
<endPoint xmi:id="EndPoint_..." host="*" port="35578"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint ...
endPointName="0RB_LISTENER_ADDRESS">
<endPoint xmi:id="EndPoint_..." host="IBMmachine" port="39100"/>
</specialEndpoints>
</serverEntries>
</serverindex:ServerIndex>

The wasprofile command creates a copy of the current portdefs.props file in the
install_roof\profiles\profile_name\1ogs directory.

Do not use the portsFile parameter when using the startingPort parameter. The two parameters are
mutually exclusive.

Scenario: Incrementing default port numbers from a starting point

The wasprofile command can assign port numbers based on a starting port value that you give on the
command line, using the -startingPort parameter. The tool assigns port numbers sequentially from the
starting port number value.

The order of port assignments is arbitrary. Predicting assignments is not possible.
For example, ports created with -startingPort 20002 would appear similar to the following example:

Assigned ports for an Application Server profile

WC_defaulthost=20002

WC_adminhost=20003
WC_defaulthost_secure=20004
WC_adminhost_secure=20005
BOOTSTRAP_ADDRESS=20006
SOAP_CONNECTOR_ADDRESS=20007
SAS_SSL_SERVERAUTH_LISTENER_ADDRESS=20008
CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS=20009
CSIVZ2_SSL_MUTUALAUTH_LISTENER_ADDRESS=20010
ORB_LISTENER_ADDRESS=20011
DCS_UNICAST_ADDRESS=20012
SIB_ENDPOINT_ADDRESS=20013
SIB_ENDPOINT_SECURE_ADDRESS=20014
SIB_MQ_ENDPOINT_ADDRESS=20015
SIB_MQ_ENDPOINT_SECURE_ADDRESS=20016
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Example of startingPort parameter use

The following example of using the wasprofile command creates ports from an initial value of 20002, with
the content shown in the previous example:

wasprofile.bat -create

-profileName shasti

-profilePath G:\shasti\WebSphere
-templatePath template_path
-nodeName W2K03

-celTName W2K03_Cel101

-hostName planetnt

-startingPort 20002

Scenario: Setting up and using the profile environment
Most tasks that you perform in a profile are done using the -profileName attribute on the command line
tools that you use. Such a scenario might be:

1.

Create the server process using the install_root/bin/wasprofile.sh (or wasprofile.bat) script from the
original installation. Assume that you create the Profile02 profile.

In that command window or in another, change directories to the /bin directory of the new server
process.

Establish a temporary override for the normal WebSphere Application Server environment by using the
-profileName attribute on a command you issue. In the same window, start server1 by changing
directories to the install_root/bin directory of the original installation and issuing the command.
There is no such command in the /bin directory of the server process:

startServer.sh serverl -profileName Profile02

Notice the changes in the environment. Display all of the ports for the machine to see the ports that
you set for the server process. For example, in a Linux bash shell or in the command window on a
Windows platform, type:

netstat -a

Open a browser window and point it at the port defined for the HTTP_TRANSPORT_ADMIN port of
the new process. For example, suppose the setting is HTTP_TRANSPORT_ADMIN=20003. Open the
administrative console for server1 by pointing your browser at:
http://hostname_orIP_address:20003/ibm/console/

Scenario: Profile creation for a non-root user
Two methods exist for a non-root user to create a profile:

» The root user creates the profile and assigns ownership to the non-root user.
* A non-root user creates a profile after getting write permission to the appropriate directories.

Remember: An ease-of-use limitation exists for non-root users who create profiles. Mechanisms within

the Profile creation wizard that suggest unique names and port values are disabled for
non-root users. The non-root user must change the default field values in the Profile creation
wizard for the profile name, node name, and port assignments. Consider assigning non-root
users a range of values for each of the fields. You can assign responsibility to the non-root
profilers for adhering to their proper value ranges and for maintaining the integrity of their
own definitions.

Root creates the profile and assigns ownership to a non-root user: The root user can create a
profile and assigns ownership of the profile directory to a non-root user.

1.

2.

The root user creates the profile with the following command:
./wasprofile.sh -create -profileName profile0l -profilePath install _root/profiles/profiledl

The root user changes ownership of the directory for the profile to the non-root user with the following
command:
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chown -R userl install _root/profiles/profiledl

A non-root user creates the profile (advanced option): The root user can grant write permission to the
appropriate files and directories to a non-root user. The non-root user can then create the profile. You can
create a group for users who are authorized to create profiles. Or you can give everyone the ability to
create profiles. The following example shows how to create a group that is authorized to create profiles.

Log on to the Application Server system as root.

Create the profilers group that you can use to create profiles.

Create a user named userl to create profiles.

Add users root and userl to the profilers group.

Log off and back on as root to pick up the new group.

As root, use operating system tools to change file permissions.

The following example assumes that the installation root directory is /opt/IBM/WebSphere/AppServer:

mkdir /opt/IBM/WebSphere/AppServer/logs/wasprofile

chgrp profilers /opt/IBM/WebSphere/AppServer/logs/wasprofile

chmod g+wr /opt/IBM/WebSphere/AppServer/logs/wasprofile

chgrp profilers /opt/IBM/WebSphere/AppServer/properties

chmod g+wr /opt/IBM/WebSphere/AppServer/properties

chmod g+wr /opt/IBM/WebSphere/AppServer/properties/profileRegistry.xml

You might have to change the permissions on additional /opt/IBM/WebSphere/AppServer directories if
you encounter permission problems.

7. The non-root user who belongs to the profilers group can then create a profile in any directory to which
the non-root user has write permission.

If the non-root user does not have write access to any directories, it is up to the root user to change
that situation. If the non-root user does not have write access to the /tmp directory, it is up to the root
user to change that as well.

The commands listed in step 6 give users assigned to the profilers group the ability to write to the
/opt/IBM/WebSphere/AppServer/logs/wasprofile directory and to the
/opt/IBM/WebSphere/AppServer/properties directory. It is not necessary to write to any other
directories in the installation root of your WebSphere Application Server product.

Have non-root users create a profiles directory in their own area, not in the installation root directory
of the product.

o0, whd =

Using the installation verification test

This topic describes how to use the installation verification test (IVT). The IVT verifies that the installation
of the application server profile was successful. A profile consists of files that define the run-time
environment for an application server. Each profile has its own IVT command.

After installing the product, you are ready to use the installation verification test (IVT).

The IVT program scans product log files for errors and verifies core functionality of the product installation.
After installing the product, the Installation wizard displays a prompt for starting the First steps console.
Installation verification is the first option on the First steps console.

The test consists of starting and monitoring the application server during its start up.
1. Select Installation verification on the First steps console after installing the product.

You can also start the First steps console from the command line, as described in [firststep
fcommand” on page 207 ]

You can also start the [ivt command” on page 229 directly from the bin directory of the profile:
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. -E'JE- install_root/profiles/default/bin/ivt.sh

. minstall_root\profi1es\defau1t\b1‘n\1’vt.bat
If you create additional profiles, the ivt script location is within the profile_home/bin directory.
2. Observe the results in the First steps status window.

The log file for installation verification is the install_root/profiles/default/logs/ivtClient.log file. If
you create additional profiles, the file path is profile_home/logs/ivtClient.log.

The IVT provides the following useful information about the application server:
* The application server name

* The name of the profile

* The profile file path

* The type of profile

* The node name

* The current encoding

* The port number for the administrative console

» Various informational messages that include the location of the SystemOut.1og file and how many
errors are listed within the file

* A completion message

As the IVT starts the application server on a Windows platform, the IVT attempts to start the Windows
service for the application server, if a Windows service exists. This is true even though the Windows
service might have a manual startup type.

3. If the log shows that errors occurred during the installation verification, correct the errors and run the
IVT again. If necessary, create a new profile after correcting the error, and run the IVT on the new
profile.

The IVT program starts the server process automatically if the server is not running. Once the server
initializes, the IVT runs a series of verification tests. The tool displays pass or fail status in a console
window. The tool also logs results to the profile_home/1ogs/ivtClient.log file. As the IVT verifies your
system, the tool reports any detectable errors in the SystemOut.1og file.

ivt command

The ivt command starts the installation verification test (IVT) program. The IVT verifies that the installation
of the application server profile was successful. A profile consists of files that define the run-time
environment for an application server. Each profile has its own IVT command.

The IVT program starts the application server automatically if the server process is not already running.
After the server process initializes, the IVT runs a series of verification tests and displays pass or falil
status in a console window.

The IVT program scans the SystemOut.1og file for errors and verifies core functionality of the profile.
You can start the IVT program from the command line or from the First steps console.

Location of the command file

Installing the product creates a default profile for the server1 application server. The location of the
installation verification test program for the default profile is:

. minsta//_root/profﬂes/defau]t/bin/ivt.sh
. minstall_root\proﬁ1es\defau1t\b1‘n\1’vt.bat

The location of the ivt.sh or ivt.bat script for any profile is:
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. m install_root/profiles/profile_name/bin/ivt.sh
. m install_root\profiles\profile_name\bin\ivt.bat

Parameters

The following parameters are associated with this command.

server_name
Required parameter that identifies the name of the server process, such as serveri.

profile_name
Required parameter that identifies the name of the profile that contains the server definition.

-p server_port_number
Optional parameter that identifies the default_host port when the port is not 9080, which is the default.

-host machine_host_name
Optional parameter that identifies the host machine of the profile to test. The default is localhost.

Syntax for the ivt command

Use the following syntax for the command:

. -E'E. install_root/profiles/profile name/bin/ivt.sh

. minstall_root\proﬁ1es\profiZe_name\bin\ivt.bat

Logging

The ivt command logs results to the install_root/profiles/profile name/1ogs/ivtClient.1og file.

Example

The following examples test the server1 process in the profileO1 profile on the myhost machine using the
default_host on port 9081.

ivt.bat serverl profiledl -p 9081 -host myhost

ivt.sh serverl profile0l -p 9081 -host myhost
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Chapter 11. Communicating with Web servers

The WebSphere Application Server works with a Web server to route requests for dynamic content, such
as servlets, from Web applications. The Web servers are necessary for directing traffic from browsers to
the applications that run in WebSphere Application Server. The Web server plug-in uses the XML
configuration file to determine whether a request is from the Web server or the Application Server.

The Web server plug-ins for distributed platform Web servers are provided on a separate CD from the
WebSphere Application Server products. A Web Server Plug-in Installation Wizard is also provided on that
CD. [‘Installing Web server plug-ins” on page 141| describes how to install a Web server plug-in and create
a Web server definition.

1.

Install your Web server if it is not already installed. If you want to use an IBM HTTP Server, see
[‘Installing IBM HTTP Server’ on page 139.|Otherwise, see the installation information provided with
your Web server.

Ensure that your Web server is configured to perform operations required by Web applications, such

as GET and POST. Typically, this involves setting a directive in the Web server configuration file (such

as the httpd.conf file for an IBM HTTP Server). Refer to the Web server documentation for instructions.

If an operation is not enabled when a servlet or JSP file requiring the operation is accessed, an error

message displays, such as this one from the IBM HTTP Server:

HTTP method POST is not supported by this URL.

Use the |Plug-in Installation wizard| to install the appropriate plug-in file to your Web server and run the

script configureWeb_server_name created by the wizard to create and configure the Web server

definition in the WebSphere configuration repository. The following substeps are performed during the

plug-in installation process. See the Plug-in Installation Roadmap for additional information.

a. A Web server definitions is created. You can also use either use the administrative console or use
the ConfigureWebServerDefintion.jacl script to create a Web server definition.

If you use the administrative console:

1) Select the node that was created in the preceding step, and in the Server name field, enter the
local name of the Web server for which you are creating a Web server definition.

2) Use the wizard to complete the Web server definition.

b. |An application or modules are mapped to a Web server| If an application that you want to use with
this Web server is already installed, the application is automatically mapped to the Web server. If
the application is not installed, select this Web server during the Map modules to servers step of
the application installation process.

c. Master repository is updated and saved.

Optional: Configure the plug-in. Use either the administrative console, or issue the GenPluginCfg
command to create your pTugin-cfg.xml file.

When setting up your Web server plug-in, you must decide whether or not to have the configuration
automatically generated in response to a configuration change. When the Web server plug-in
configuration service is enabled and any of the following conditions occur, the plug-in configuration file
is automatically generated:

* When the Web server is created or saved.
* When an application is installed.

* When an application is uninstalled.

* When the virtual host definition is updated

Generating or regenerating the configuration file might take a while to complete. After it finishes, all
objects in the administrative cell use their newest settings, which the Web server can access. If the
Application Server is on the same physical machine as the Web server, the regeneration usually takes
about 30 to 60 seconds to complete. The regeneration takes longer if they are not both on the same
machine.
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Important: When the plug-in configuration file is first generated, it does not include admin_host on the
list of virtual hosts. [‘Allowing Web servers to access the administrative console” on page]
describes how to add it to the list.

To use the administrative console:
a. Select Servers > Web Servers > webserver > plug-in properties.

b. Select Automatically generate plug-in configuration file or click on one or more of the following
topics to manually configure the plugin-cfg.xml file:
» Caching
* Request and response
* Request routing
» Service

|Web server plug-in configuration properties| maps each property to one of these topics.
c. Click OK.

d. You might need to stop the application server and then start the application server again to enable
the Web server to locate the plugin-cfg.xml file.

5. If you want to use Secure-socket layer (SSL) with this configuration, use the plug-in’s installation
wizard to install the appropriate |GSKIT installation image file| on your workstation. See the Security
Guide PDF for information on how to configure GSKIT.

6. If you want to enable the Web server plug-in to use private headers, define an SSL configuration
repertoire that defines a trust file. Then in the administrative console, select Application servers >
serverl > Web Container Settings > Web Container Transport Chains > fransport_chain > SSL
Inbound Channel (SSL_2) and specify this repertoire for that transport chain. If you try to use private
headers without setting up an SSL configuration repertoire that does not include a trust file definition,
the private headers will be ignored. If the private headers are ignored, the application server might not
locate the requested application.

After you enable the use of private headers, the transport chain’s SSL inbound channel trusts all
private headers it receives. Therefore, you must ensure that all paths to the transport chain’s SSL
inbound channel are trusted.

7. Tune your Web server with Web server tuning parameters|
8. Propagate the plug-in configuration. The plug-in configuration file (plugin-cfg.xml) is automatically

propagated to the Web server if the Web server plug-in configuration service is enabled, and one of
the following is true:

* The Web server is a local Web server. (It are located on the same machine as an application
server.)

* The Web server is a remote IBM HTTP Server (IHS) Version 6.0 that has a running IHS
Administrative server.

If neither of these conditions is true, the plugin-cfg.xml file must be manually copied to the remote Web
server’s installation location.

The configuration is complete. To activate the configuration, stop and restart the Web server. If you
encounter problems restarting your Web server, check the http_plugin.log file for information on what
portion of the plugin-cfg.xml file contains an error. The log file states the line number on which the error
occurred along with other details that might help you diagnose why the Web server did not start. You can
then use the administrative console to update the plugin-cfg.xml file.

If applications are infrequently installed or uninstalled, which is usually the situation in a production
environment, or if you can tolerate the performance impact of generating and distributing the plug-in
configuration file each time any of the previously listed actions occur, you should consider enabling this
service.

If you are making a series of simultaneous changes, like installing numerous applications, you might want
the configuration service disabled until after you make the last change. The Web server plug-in
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configuration service is enabled by default. To disable this service, in the administrative console click elect
Servers > Application Servers > server_name > Administration Services >Web server plug-in
configuration service and then unselect the Enable automated Web server configuration processing
option.

Tip: If your installation uses a firewall, make sure you configure the Web server plug-in to use a port that
has been opened. (See your security administrator for information on how to obtain an open port.

Web server plug-in properties settings

Use this page to view or change the settings of a Web server plug-in configuration file. The plug-in
configuration file, plugin_cfg.xml, provides properties for establishing communication between the Web
server and the Application Server.

To view this administrative console page, click Servers > Web Servers >Web_server_name Plug-in
Properties.

On the Configuration tab, you can edit fields. On the Runtime tab, you can look at read-only information.

The Runtime tab is available only when this Web server has accessed applications running on application
servers and there is an http_plugin.log file.

Plug-in log file name

Specifies the fully qualified path to the log file to which the plug-in will write error messages. The default
file path is plugin_install_root/10gs/web_server_name/http plugin.log .

If the file does not exist then it will be created. If the file already exists, it will be opened in append mode
and the previous plug-in log messages will remain.

This field corresponds to the RequestMetrics loggingEnabled element in the plugin-cfg.xml file.

Data type String
Default for Linux and UNIX platforms plugin_install_root/10gs/web_server_name/http_plugin.log
Default for Windows platforms plugin_install_root/10gs/web_server_name/http_plugin.log

Plug-in installation location
Specifies the fully qualified path to where the plug-in configuration file is installed.

Data type String
Default The default value is the installation root directory.

If you select a Web server plug-in during installation, the installer program configures the Web server to
identify the location of the pTugin-cfg.xml file, if possible. The Web server is considered installed on a
local machine if it is on the same machine as the application server. It is considered installed on a remote
machine if the Web server and the application server are on different machines.

» |If the Web server is installed on a remote machine, the plug-in configuration file, by default, will be
installed in the plugin_install_root/config/web_server_name directory.

» |If the Web server is installed on a local standalone machine, the plug-in configuration file, by default will
be installed in the profile_install_root/config/cells/cell_name/nodes/web_server_name
_node/servers/web_server_name directory.
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The installer program adds a directive to the Web server configuration that specifies the location of the
plugin-cfg.xml file.

For remote Web servers, you must copy the file from the local directory where the Application Server is
installed to the remote machine. This is known as propagating the plug-in configuration file. If you are
using an IBM HTTP Server (IHS) V6 for your Web server, WebSphere Application Server can automatically
propagate the plug-in configuration file for you to remote machines provided there is a working HTTP
transport mechanism to propagate the file.

Plug-in configuration file name

Specifies the file name of the configuration file for the plug-in. The Application Server generates the
plugin-cfg.xml file by default. The configuration file identifies applications, Application Servers, clusters,
and HTTP ports for the Web server. The Web server uses the file to access deployed applications on
various Application Servers.

Data type String
Default plugin-cfg.xml

If you select a plug-in during installation, the installer program configures the Web server to identify the
location and name of the plugin-cfg.xml file, if possible.

You can change the name of the plug-in configuration file. However, if you do change the file name, you
must also change the Web server configuration to point to the new plug-in configuration file.

Automatically generate plug-in configuration file

To automatically generate a plug-in configuration file to a remote Web server:
» This field must be checked.

* The plug-in configuration service must be enabled

When the plug-in configuration service is enabled, a plug-in configuration file is automatically generated for
a Web server whenever:

The WebSphere Application Server administrator defines new Web server.
* An application is deployed to an Application Server.

» An application is uninstalled.

» A virtual host definition is updated and saved.

Clear the check box if you want to manually generate a plug-in configuration file for this Web server.

Important: When the plug-in configuration file is generated, it does not include admin_host on the list of
virtual hosts. [‘Allowing Web servers to access the administrative console” on page 197
describes how to add it to the list.

Automatically propagate plug-in configuration file

To automatically propagate a copy of a changed plug-in configuration file to a Web server:
» This field must be checked.

» The plug-in configuration service must be enabled

* A WebSphere Application Server node agent must be on the node that hosts the Web server associated
with the changed plug-in configuration file.

Note: The plug-in configuration file can only be automatically propagated to a remote Web server if that
Web server is an IHS V6.0 Web server and its administration server is running.
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Ignore DNS failures during Web server startup
Specifies whether the plug-in ignores DNS failures within a configuration when starting.

This field corresponds to the IgnoreDNSFuilures element in the plugin-cfg.xml file.

When set to true, the plug-in ignores DNS failures within a configuration and starts successfully if at least
one server in each ServerCluster is able to resolve the host name. Any server for which the host name
can not be resolved is marked unavailable for the life of the configuration. No attempts to resolve the host
name are made later on during the routing of requests. If a DNS failure occurs, a log message is written to
the plug-in log file and the plug-in initialization continues rather than causing the Web server not to start.
When false is specified, DNS failures cause the Web server not to start.

Data type String
Default false

Refresh configuration interval

Specifies the time interval, in seconds, at which the plug-in should check the configuration file to see if
updates or changes have occurred. The plug-in checks the file for any modifications that have occurred
since the last time the plug-in configuration was loaded.

In a development environment in which changes are frequent, a lower setting than the default setting of 60
seconds is preferable. In production, a higher value than the default is preferable because updates to the
configuration will not occur so often. If the plug-in reload fails for some reason, a message is written to the
plug-in log file and the previous configuration is used until the plug-in configuration file successfully
reloads. If you are not seeing the changes you made to your plug-in configuration, check the plug-in log
file for indications of the problem.

Data type Integer
Default 60 seconds.

Plug-in logging
Specifies the location and name of the http _plugin.log file. Also specifies the scope of messages in the
log.

This field corresponds to the RequestMetrics traceLevel element in the plugin-cfg.xml file.

The log describes the location and level of log messages that are written by the plug-in. If a log is not
specified within the configuration file, then, in some cases, log messages are written to the Web server
error log.

On a distributed platform, if the log file does not exist then it will be created. If the log file already exists, it
will be opened in append mode and the previous plug-in log messages will remain.

Log file name - The fully qualified path to the log file to which the plug-in will write error messages.

Data type String
Default plugin_install_root/10gs/web_server_name/http_plugin.log

Specify the file path of the http_plugin.log file.

Log level- The level of detail of the log messages that the plug-in should write to the log. You can specify
one of the following values for this attribute:
» Trace. All of the steps in the request process are logged in detail.
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» Stats. The server selected for each request and other load balancing information relating to request
handling is logged.

* Warn. All warning and error messages resulting from abnormal request processing are logged.

» Error. Only error messages resulting from abnormal request processing are logged.

If a Log level is not specified, the default value Error is used.

Be careful when setting the level to Trace. A lot of messages are logged at this level which can cause the
disk spaceffile system to fill up very quickly. A Trace setting should never be used in a normally functioning
environment as it adversely affects performance.

Data type String
Default Error

Web server plug-in request and response optimization properties
settings

Use this page to view or change the request and response optimization properties for a Web server
plug-in.

To view this administrative console page, click Servers > Web Servers >web_server_name Plug-in
Properties > Request and Response.

On the Configuration tab, you can edit fields. On the Runtime tab, you can look at read-only information.

The Runtime tab is available only when this Web server has accessed applications running on application
servers and there is an http_plugin.log file.

Maximum chunk size used when reading the response body
Specifies the maximum chunk size the plug-in can use when reading the response body.

This field corresponds to the ResponseChunkSize element in the plugin-cfg.xml file.

The plug-in reads the response body in 64K chunks until all of the response data is read. This approach
causes a performance problem for requests whose response body contains large amounts of data.

If the content length of the response body is unknown, the values specified for this property is used as the
size of the buffer that is allocated. The response body is then read in this size chunks, until the entire body
is read. If the content length is known, then a buffer size of either the content length or the specified size
(whichever is less) is used to read the response body.

Data type Integer
Default 64 kilobytes

Specify the size in kilobytes (1024 byte blocks).

Enable Nagle algorithm for connections to the Application Server
When checked, the Nagle algorithm is enabled for connections between the plug-in and the Application
Server.

This field corresponds to the ASDisableNagle element in the plugin-cfg.xml file.
The Nagle algorithm is named after engineer John Nagle, who invented this standard part of the

transmission control protocol/internet protocol (TCP/IP). The algorithm reduces network overhead by
adding a transmission delay (usually 20 milliseconds) to a small packet, which lets other small packets
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arrive and be included in the transmission. Because communications has an associated cost that is not as
dependent on packet size as it is on frequency of transmission, this algorithm potentially reduces overhead
with a more efficient number of transmissions.

Clear the check box to disable the Nagle algorithm.

Enable Nagle Algorithm for the IIS Web Server
When checked, the Nagle algorithm is used for connections from the Microsoft Internet Informations
Services (IIS) Web Server to the Application Server.

This field corresponds to the IHSDisableNagle element in the plugin-cfg.xml file. It only appears if you are
using the Microsoft Internet Informations Services (11IS) Web server. Clear the check box to disable the
Nagle algorithm for this connection.

Chunk response to the client
When checked, responses to the client are broken into chunks if a Transfer-Encoding : Chunked
response header is present in the response.

This field corresponds to the ChunkedResponse element in the plugin-cfg.xml file. It only appears if you
are using a Microsoft Internet Informations Services (lIS) Web Server, a Java System Web server, or a
Domino Web server. The IHS Web server automatically handles breaking the response into chunks to
send to the client.

Clear the check box to if you do not want responses broken into chunks.

Accept content for all requests
This field corresponds to the AcceptAllContent element in the plugin-cfg.xml file.

When selected, users can include content in POST, PUT, GET, and HEAD requests when a
Content-Length or Transfer-encoding header is contained in the request header.

Virtual host matching
When selected, virtual host mapping is performed by physically using the port number for which the
request was received.

This field corresponds to the VHostMatchingCompat element in the plugin-cfg.xml file.
If this field is not selected, matching is done logically using the port number contained in the host header.

Use the radio buttons to make your physical or logical port selection.

Application server port preference
Specifies which port number the Application Server should use to build URI's for a sendRedirect.

This field corresponds to the AppServerPortPreference element in the plugin-cfg.xml file.
Specify:
* webserverPort if the port number from the host header of the HTTP request coming in is to be used.

* hostHeader if the port number on which the Web server received the request is to be used.

The default is webserverPort.

Priority used by the IIS Web server when loading the plug-in configuration file
Specifies the priority in which the Microsoft Internet Informations Services (IIS) Web server loads the
WebSphere Web server plug-in.
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This field corresponds to the IISPluginPriority element in the plugin-cfg.xml file. It only appears if you are
using the 1IS Web server. Because the IS Web server uses this value during startup, the Web server must
be restarted before a change to this field takes effect.

Select one of the following priorities:
* High

* Medium

* Low

The default value of High ensures that all requests are handled by the Web server plug-in before they are
handled by any other filter/extensions. If problems occur while using a priority of Medium or Low, you will
have to rearrange the order or change the priority of the interfering filter/extension.

Web server plug-in caching properties settings
Use this page to view or change the caching properties for a Web server plug-in.

To view this administrative console page, click Servers > Web Servers >Web_server_name Plug-in
Properties > Caching Properties.

On the Configuration tab, you can edit fields. On the Runtime tab, you can look at read-only information.

The Runtime tab is available only when this Web server has accessed applications running on application
servers and there is an http_plugin.log file.

Enable Edge Side Include (ESI) processing to cache the responses
Specifies whether to enable Edge Side Include processing to cache the responses.

This field corresponds to the esiEnable element in the plugin-cfg.xml file.

When selected, Edge Side Include (ESI) processing is used to cache responses. If ESI processing is
disabled for the plug-in, the other ESI plug-in properties are ignored. Clear the checkbox to disable Edge
Side Include processing.

Enable invalidation monitor to receive notifications
When checked, the ESI processor receives invalidations from the Application Server.

This field corresponds to the ESlInvalidationMonitor element in the plugin-cfg.xml file. It is ignored if Edge
Side Include (ESI) processing is not enabled for the plug-in.

Maximum cache size

Specifies, in 1K byte units, the maximum size of the cache. The default maximum size of the cache is
1024K bytes (1 megabyte). If the cache is full, the first entry to be evicted from the cache is the entry that
is closest its expiration time.

This field corresponds to the esiMaxCacheSize element in the plugin-cfg.xml file.

Data type Integer
Default 1024 kilobytes

Specify the size in kilobytes (1024 byte blocks).

Web server plug-in request routing properties settings
Use this page to view or change the request routing properties for a Web server plug-in.
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To view this administrative console page, click Servers > Web Servers >Web_server_name Plug-in
Properties > Plug-in server_cluster_name Properties.

On the Configuration tab, you can edit fields. On the Runtime tab, you can look at read-only information.

The Runtime tab is available only when this Web server has accessed applications running on application
servers and there is an http_plugin.log file.

Load balancing option
Specifies the load balancing option that the plug-in uses in sending requests to the various application
servers associated with that Web server.

This field corresponds to the LoadBalanceWeight element in the plugin-cfg.xml file.

Select the appropriate load balancing option:
* Round robin
* Random

The Round Robin implementation has a random starting point. The first application server is picked
randomly. Round Robin is then used to pick application servers from that point forward. This
implementation ensures that in multiple process based Web servers, all of the processes don’t start up by
sending the first request to the same Application Server.

The default load balancing type is Round Robin.

Retry interval
Specifies the length of time, in seconds, that should elapse from the time an application server is marked
down to the time that the plug-in retries a connection.

This field corresponds to the ServerWaitforContinue element in the plugin-cfg.xml file.

Data type Integer
Default 60 seconds

Maximum size of request content

Select whether there is a limit on the size of request content. If limited, this field also specifies the
maximum number of bytes of request content allowed in order for the plug-in to attempt to send the
request to an application server.

This field corresponds to the PostSizeLimit element in the plugin-cfg.xml file.
When a limit is set, the plug-in fails any request that is received that is greater than the specified limit.

Select whether to limit the size of request content:
* No limit

+ Set limit

If Set limit is selected, specify a limit size.

Data type Integer
Default -1, which indicates there is no limit for the post size.

Specify the size in kilobytes (1024 byte blocks).
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Remove special headers
When checked, the plug-in will remove any headers from incoming requests before adding the headers the
plug-in is supposed to add before forwarding the request to an application server.

This field corresponds to the RemoveSpecialHeaders element in the plugin-cfg.xml file.
The plug-in adds special headers to the request before it is forwarded to the application server. These
headers store information about the request that will need to be used by the application. Not removing the

headers from incoming requests introduces a potential security exposure.

Clear the check box to retain special headers.

Clone separator change
When checked, the plug-in expects the plus character (+) as the clone separator.

This field corresponds to the ServerClonelD element in the plugin-cfg.xml file.
Some pervasive devices cannot handle the colon character (:) used to separate clone IDs in conjunction
with session affinity. If this field is checked, you must also change the configurations of the associated

application servers such that the application servers separates clone IDs with the plus character as well.

Clear the checkbox to use the colon character to separate clone IDs.
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Chapter 12. Web server plug-in custom properties

If you are using a Web server plug-in, you can add the following custom property to the configuration
settings for that plug-in.

To add a custom property:

1. In the administrative console, click In the administrative console, click Servers > Web Servers >
Web_server_name > Plug-in properties > Custom properties > New

2. Under General Properties specify the name of the custom property in the Name field and a value for
this property in the Value field. You can also specify a description of this property in the Description
field.

3. Click Apply or OK.
4. Click Save to save your configuration changes.
5. Restart the server.

Following is a list of Web server plug-in custom properties that are provided with the Application Server.
These properties are not shown on the properties settings pages for the plug-in.

StashfileLocation

Use this element to set a value for the stashfile initialization parameter.

Data type String

KeyringLocation

Use this element to set a value for the keyring initialization parameter.

Data type String
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Chapter 13. Web server plug-in configuration service
properties settings

Use this page to view or change the configuration settings for the Web server plug-in configuration service.

To view this administrative console page, click Application Servers >server name > Administration
Services > Web server plug-in configuration service.

On the Configuration tab, you can edit fields. On the Runtime tab, you can look at read-only information.

Enable automated Web server configuration processing

When selected, the Web server plug-in configuration service automatically generates the plug-in
configuration file whenever the Web server environment changes. For example, the plug-in configuration
file is regenerated whenever one of the following activities occurs:

* A new application is deployed on an associated application server.
* The Web server definition is saved.

* An application is removed from an associated application server.

* A new virtual host is defined.

Whenever a virtual host definition is updated, the plug-in configuration file is automatically regenerated for
all of the Web servers.
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Chapter 14. Application Server property settings for a Web
server plug-in

Use this page to view or change application server settings for a Web server plug-in.

To view this administrative console page, click Application Servers >server_name > Web Server Plug-in.
On the Configuration tab, you can edit fields. On the Runtime tab, you can look at read-only information.

The Runtime tab is available only when this Web server has accessed applications running on application
servers and there is an http_plugin.log file.

Server role

Specifies the role this application server is assigned.

Select Primary to add this application server to the list of primary application servers. The plug-in initially
attempts to route requests to the application servers on this list.

Select Backup to add this application server to the list of backup application servers. The plug-in does not
load balance across the backup application servers. A backup server is only used if a primary server is not
available. When the plug-in determines that a backup application server is required, it goes through the list
of backup servers, in order, until no servers are left in the list or until a request is successfully sent and a
response received from one of the servers on this list.

Connect timeout

Specifies whether or not there is a limited amount of time the Application Server will maintain a connection
with the Web server.

You can select either No timeout or Set timeout. If you select Set timeout you, must specify, in seconds,
the length of time a connection with the Web server is to be maintained.

This property enables the plug-in to perform non-blocking connections with the application server.
Non-blocking connections are beneficial when the plug-in is unable to contact the destination to determine
whether or not the port is available. If no value is specified for this property, the plug-in performs a
blocking connect in which the plug-in sits until an operating system times out (which could be as long as 2
minutes depending on the platform) and allows the plug-in to mark the server unavailable.

A value of 0 causes the plug-in to perform a blocking connect. A value greater than 0 specifies the number
of seconds you want the plug-in to wait for a successful connection. If a connection does not occur after
that time interval, the plug-in marks the server unavailable and fails over to another application server
defined for the requested application.

Data type Integer

Maximum number of connections that can be handled by the
Application Server

Specifies the maximum number of pending connections to an Application Server that can be flowing
through a Web server process at any point in time.

This field corresponds to the ServerMaxConnections element in the plugin-cfg.xml file.
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You can select either No limit or Set limit. If you select Set limit you, must specify the maximum number
of connections that can exist between the Web server and the Application Server at any given point in
time.

If this attribute is set to either zero or -1, there is no limit to the number of pending connections to the
Application Servers.

Data type Integer
Default 1

Use extended handshake to check whether Application Server is
running

When selected, the Web server plug-in will use an extended handshake to check whether or not the
Application Server is running.
This field corresponds to the ServerExtendedHandshake element in the plugin-cfg.xml file.

Select this property if a proxy firewall is between the plug-in and the application server.

The plug-in marks a server as down when the connect() fails. However, when a proxy firewall is in
between the plug-in and the application server, the connect() will succeed, even though the back end
application server is down. This causes the plug-in to not failover correctly to other application servers.

If the plug-in performs some handshaking with the application server to ensure that it is started before it
sends a request it can failover to another application server if it detects that the application server with
which it is attempting to perform a handshake is down.

Send the header "100 Continue” before sending the request content

This field corresponds to the WaitForContinue element in the plugin-cfg.xml file.

When selected, the Web server plug-in will send the header "100 Continue” to the Application Server
before it sends the request content.
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Chapter 15. Web server plug-in configuration properties

The following table indicates which panel in the administrative console you need to use to manually
configure a Web server plug-in property.

Table 15. Web server plug-in configuration properties

Administrative console panel

Field name

Configuration property name

In the administrative console, click
Servers > Web Servers
>Web_server_name > Plug-in
properties

Refresh configuration interval

Refreshlinterval

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties

Plug-in log file name

Log->name

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties

Plug-in logging

Log->LogLevel

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties

Ignore DNS failures during Web
server startup

IgnoreDNSFailures

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Custom properties >
New

KeyringLocation

Keyring

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Custom properties >
New

StashfileLocation

Stashfile

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request routing

Load balancing option

LoadBalance

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request Routing

Clone separator change

CloneSeparatorChange

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request Routing

Retry interval

Retrylnterval

In the administrative console, click
Servers >Web server_name >
Plug-in properties > Request
routing

Maximum size of request content

PostSizeLimit

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request routing

Remove special headers

RemoveSpecialHeaders
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Table 15. Web server plug-in configuration properties (continued)

In the administrative console, click
Application Servers >server_name >
Web server plug-in properties

Server role

PrimaryServers and BackupServers
list

In the administrative console, click
Application Servers >server_name >
Web server plug-in properties

Connect timeout

Server ConnectTimeout

In the administrative console, click
Application Servers >server_name >
Web server plug-in properties

Use extended handshake to check
whether Application Server is running

Server Extended Handshake

In the administrative console, click
Application Servers >server_name >
Web server plug-in properties

Send the header "100 Continue”
before sending the request content

WaitForContinue

In the administrative console, click
Application Servers >server_name >
Web server plug-in properties

Maximum number of connections that
can be handled by the Application
Server

Server MaxConnections

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request and
Response

Application server port preference

AppServerPortPreference

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request and

Response

Enable Nagle algorithm for
connections to the Application Server

ASDisableNagle

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request and

Response

Enable Nagle Algorithm for the IIS
Web Server

IISDisableNagle

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request and

Response

Virtual host matching

VHostMatchingCompat

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request and

Response

Maximum chunk size used when
reading the response body

ResponseChunkSize

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request and

Response

Accept content for all requests

AcceptAllContent

In the administrative console, click
Servers > Web Servers >
Web_server_name > Plug-in
properties > Request and

Response

Chunk response to the client

ChunkedResponse
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Table 15. Web server plug-in configuration properties (continued)

In the administrative console, click

Servers > Web Servers >

Priority used by the IS Web server IISPluginPriority
when loading the plug-in configuration

Web_server_name > Plug-in file

properties > Request and

Response

In the administrative console, click Enable Edge Side Include (ESI) ESIEnable

Servers > Web Servers >
Web_server_name > Plug-in
properties > Caching

processing to cache the responses

In the administrative console, click

Servers > Web Servers >
Web_server_name > Plug-in
properties > Caching

Maximum cache size ESIMaxCacheSize

In the administrative console, click

Servers > Web Servers >
Web_server_name > Plug-in
properties > Caching

Enable invalidation monitor to receive | ESlInvalidationMonitor
notifications
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Chapter 16. Web server plug-in connections

The WebSphere Application Server Web server plug-ins are used to establish and maintain persistent
HTTP and HTTPS connections to Application Servers .

When the plug-in is ready to send a request to the application server, it first checks its connection pool for
existing connections. If an existing connection is available the plug-in checks its connection status. If the
status is still good, the plug-in uses that connection to send the request. If a connection does not exist, the
plug-in creates one. If a connection exists but has been closed by the application server, the plug-in closes
that connection and opens a new one.

After a connection is established between a plug-in and an application server, it will not be closed unless
the application server closes it for one of the following reasons:

» |If the Use Keep-Alive property is selected and the time limit specified on the Read timeout or Write
timeout property for the HTTP inbound channel has expired.

* The maximum number of persistent requests which can be processed on an HTTP inbound channel has
been exceeded. (This number is set using the HTTP inbound channel’s Maximum persistent requests
property.)

* The Application Server is shutting down.

Even if the application server closes a connection, the plug-in will not know that it has been closed until it
tries to use it again. The connection will be closed if one of the following events occur:

* The plug-in receives a new HTTP request and tries to reuse the existing connection.

* The number of httpd processes drop because the Web server is not receiving any new HTTP requests.
(For the IHS Web server, the number of httpd processes that are kept alive depends on the value
specified on the Web server's MinSpareServers directive.)

* The Web server is stopped and all httpd processes are terminated, and their corresponding sockets are
closed.

Note: Sometimes, if a heavy request load is stopped or decreased abruptly on a particular application
server, a lot of the plug-in’s connections to that application server will be in CLOSE_WAIT state.
Because these connections will be closed the first time the plug-in tries to reuse them, having a
large number of connections in CLOSE-WAIT state should not affect performance
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Chapter 17. Web server plug-in remote user information
processing

You can configure your Web server with a third-party authentication module and then configure the Web
server plug-in to route requests to the Application Server. If an application calls the getRemoteUser()
method, it relies on a private HTTP header that contains the remote user information and is parsed by the
plug-in. The plug-in sets the private HTTP header value whenever a Web server authentication module
populates the remote user in the Web server data structure. If the private HTTP header value is not set,
the application’s call to getRemoteUser() returns a null value.

* In the case of an Apache and IBM HTTP Server (IHS) Web server, the plug-in builds the private header
from the information contained in the associated request record.

* In the case of a Sun One Web server, the plug-in builds the private header from the information
contained in the auth_user property associated with the request. The private header is usually set to
the name of the local HTTP user of the Web browser, if HTTP access authorization is activated for the
URL.

* In the case of a Domino Web server, the plug-in builds the private header from the information
contained in the REMOTE_USER environment variable. The plug-in sets this variable to anonymous
for users who have not logged in and to the username for users who are logged into the application.

* In the case of an Internet Information Services (1IS) Web server, the plug-in builds the private header

from the information contained in the REMOTE_USER environment variable. The plug-in sets this
variable to the name of the user as it is derived from the authorization header sent by the client.

If the private header is not being set in the Sun One, IIS, or Domino Web server plug-in, make sure the
request record includes information about the user requesting the data.

Note: If an application’s call to getRemoteUser() returns a null value, or if the correct remote user
information is not being added to the Web server plug-in’s data structure, make sure the remote
user parameter within the WebAgent is still set to YES. (Sometimes this parameter gets set to NO
when service is applied.)
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Chapter 18. Web server plug-ins

Web server plug-ins enable the Web server to communicate requests for dynamic content, such as
servlets, to the application server. A Web server plug-in is associated with each Web server definition. The
configuration file (plugin-cfg.xml) that is generated for each plug-in is based on the applications that are
routed through the associated Web server.

A Web server plug-in is used to forward HTTP requests from a supported Web server to an application

server. Using a Web server plug-in to provide communication between a Web server and an application

server has the following advantages:

* XML-based configuration file

» Standard protocol recognized by firewall products

» Security using HTTPS, replacing proprietary Open Servlet Engine (OSE) over Secure Sockets Layer
(SSL)

Each of the supported distributed platform Web server plug-ins run on a number of operating systems.
See |Supported Hardware and Softwarel for the product for the most current information about supported
Web servers.
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Chapter 19. Checking your IBM HTTP Server version

At times, you might need to determine the version of your IBM HTTP Server installation.

1. Change directory to the installation root of the Web server. For example, this is /opt/IBMIHS on a
Solaris machine.

2. Find the subdirectory that contains apache.exe (on a Windows platforms) or apachectl (on a
UNIX-based platforms, such as z/OS, Solaris, Linux, and HP-UX)

3. On a Windows platform, issue:
apache.exe -V

4. On a UNIX-based platforms issue:
./apachectl -V 4

The version is shown in the "Server version:” field and will looks something like the following:

Server version: IBM_HTTP_Server/2.0.47 Apache/2.0.47
Server built: July 2 2004 20:38:36
Server's Module Magic Number: 20020903:4.
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Chapter 20. Web server tuning parameters

WebSphere Application Server provides plug-ins for several Web server brands and versions. Each Web
server operating system combination has specific tuning parameters that affect the application
performance.

* IBM HTTP Server

The IBM HTTP Server V6.0 is a multi-process, multi-threaded server.
— Access logs
- Description: Collects all incoming HTTP requests. Logging degrades performance because 10
operation overhead causes logs to grow significantly in a short time.
- How to view or set:
1. Open the IBM HTTP Server httpd.conf file, located in the directory
IBM_HTTP_Server_root_directory/conf.
Search for a line with the text CustomLog.
Comment out this line by placing # in front of the line.
Save and close the httpd.conf file.
Stop and restart the IBM HTTP Server.
- Default value: Logging of every incoming HTTP request is enabled.
- Recommended value: Disable the access logs.
— MaxClients
- Description: The MaxClients directive controls the maximum number of simultaneous connections
or users that the web server can service at any one time. If, at peak usage, your web server
needs to support 200 active users at once, you should set MaxClients to 220 (200 plus an extra
10% for load growth). Setting MaxClients too low could cause some users to believe the web
server is not responding. You should have sufficient RAM in your web server machines to support
each connected client. For IBM HTTP Server V6.0 on UNIX, you should allocate around 1.5MB
MaxClients of RAM for use by the IBM HTTP Server. For IBM HTTP Server V6.0 on Windows,
you should allocate around 300KB MaxClients of RAM for use by the IBM HTTP Server. Some
third party modules can significantly increase the amount of RAM used per connected client.
- How to view or set: Edit the MaxClients directive in the IBM HTTP Server httpd.conf file,
located in the directory IBM_HTTP_Server_root_directory/conf.
- Default value: 150
- Recommended value: The maximum number of users normally simultaneously connected to your
web server, plus an additional 10% for buffer. Note: The KeepAliveTimeout setting can affect how
long a user is connected to the webserver.
— MinSpareServers, MaxSpareServers, and StartServers
- Description: Pre-allocates and maintains the specified number of processes so that few
processes are created and destroyed as the load approaches the specified number of processes.
Specifying similar values reduces the CPU usage for creating and destroying HTTPD processes.
Adjust this parameter if the time waiting for IBM HTTP Server to start more servers, so that it can
handle HTTP requests, is not acceptable.
- How to view or set: Edit the MinSpareServers, MaxSpareServers and StartServers directives in
the httpd.conf file located in the IBM_HTTP_Server_root_directory/conf directory.
- Default value: MinSpareServers 5, MaxSpareServers 10, StartServers 5
- Recommended value: For optimum performance, specify the same value for the
MinSpareServers and the StartServers parameters. If MaxSpareServers is set to less than
MinSpareServers, IBM HTTP Server resets MaxSpareServer=MinSpareServer+1. Setting the
StartServers too high can cause swapping if memory is not sufficient, degrading performance.
— ListenBackLog
- Description: Sets the length of a pending connections queue. When several clients request
connections to the IBM HTTP Server, and all threads used, a queue exists to hold additional client
requests. However, if you use the default Fast Response Cache Accelerator (FRCA) feature of
IBM HTTP Server V6.0 on Windows, the ListenBackLog directive is not used since FRCA has its
own internal queue.

ok wn

© Copyright IBM Corp. 2004 259



How to view or set: For non-FRCA: Edit the IBM HTTP Server httpd.conf file. Then, add or
view the ListenBackLog directive.

Default value: For HTTP Server V6.0: 1024 with FRCA enabled, 511 with FRCA disabled
Recommended value: Use the defaults.

HTTP Server - Linux

— MaxRequestsPerChild

* IBM

Description: Sets the limit on the number of requests that an individual child server process

handles. After the number of requests reaches the value set for the MaxRequestsPerChild

parameter, the child process dies. Adjust this parameter if destroying and creating child processes

is degrading your Web server performance.

How to view or set:

1. Edit the IBM HTTP server httpd.conf file located in the IBM_HTTP_Server_root_directory/conf
directory.

2. Change the value of the parameter.

3. Save the changes and restart the IBM HTTP server.

Default value: 500

Recommended value: Should normally be set to 0. Non-zero settings can be useful if child

memory usage is observed to steadly increase over time. Memory leaks have occasionally been

observed in third party modules and various OS runtime libraries used by the IBM HTTP Server.

HTTP Server - Windows 2000 and Windows 2003

— ThreadsPerChild

Description: Sets the number of concurrent threads running at any one time within the IBM HTTP
Server.

How to view or set: Edit the IBM HTTP Server file httpd.conf file located in the directory
IBM_HTTP_Server _root_directory/conf. Change the value of the parameter. Save the changes and
restart the IBM HTTP Server.

There are two ways to find how many threads are used under load:
1. Use the Windows 2000 and Windows 2003 Performance Monitor under the desktop Start
menu:
a. Right-click the status bar on your desktop. Click Task Manager.
b. Select the Processes tab.
c. Click View > Select Columns.
d. Select Thread Count.
e. Click OK.

The Processes tab shows the number threads for each process under the column name

Threads, including Apache.

2. Use the IBM HTTP Server server-status (this choice works on all platforms, not just

Windows):

a. Edit the IBM HTTP Server httpd.conf file as follows: Remove the comment character #
from the following lines: #LoadModule status_module, modules/ApacheModuleStatus.dl11,
#<Location/server-status>, #SetHandler server-status, and #</Location>.

Save the changes and restart the IBM HTTP Server.

In a Web browser, go to the URL: http://yourhost/server-status. Alternatively,

Click Reload to update status.

(Optional) If the browser supports refresh, go to http://your _host/server-
status?refresh=5 to refresh every five seconds. You will see five requests currently
processing 45 idle servers.

Default value: 250 for IBM HTTP Server V6.0.

Recommended value: Set this value to prevent bottlenecks, allowing just enough traffic through
to the application server.

®ooo

— Web server configuration reload interval

260

Description: Tracks a variety of configuration information about WebSphere Application Server
resources. The Web server needs to understand some of this information, such as Uniform
Resource Identifiers (URIs) pointing to WebSphere Application Server resources. This
configuration data is pushed to the Web server through the WebSphere Application Server plug-in

IBM WebSphere Application Server - Express, Version 6: Installing your application serving environment



at intervals specified by this parameter. Periodic updates add new servlet definitions without
having to restart any of the WebSphere Application Server servers. However, the dynamic
regeneration of this configuration information is costly in terms of performance. Adjust this
parameter in a stable production environment.

- How to view or set:Use the Refresh configuration interval Web server plug-in property to change
the current setting for this parameter. In the administrative console, click Servers > Web Servers
>Web_server_name > Plug-in properties.

- Default value: The default reload interval is 60 seconds.

- Recommended value: Increase the reload interval to a value that represents an acceptable wait
time between the servlet update and the Web server update.

For more information about the plugin-cfg.xml file see the topic |Chapter 18, “Web server plug-ins,’|
* Sun Java System Web server, Enterprise Edition (formerly Sun ONE) - Solaris operating
environment

The default configuration of the Sun ONE Web server, Enterprise Edition provides a single-process,
multi-threaded server.
— Active threads

- Description: Specifies the current number of threads active in the server. After the server reaches
the limit set with this parameter, the server stops servicing new connections until it finishes old
connections. If this setting is too low, the server can become throttled, resulting in degraded
response times. To tell if the Web server is being throttled, consult its perfdump statistics. Look at
the following data:

* WaitingThreads count: If WaitingThreads count is getting close to zero, or is zero, the server
is not accepting new connections.

» BusyThreads count: If the WaitingThreads count is close to zero, or is zero, BusyThreads is
probably very close to its limit.

« ActiveThreads count: If ActiveThreads count is close to its limit, the server is probably limiting
itself.

- How to view or set: Use the Maximum number of simultaneous requests parameter in the
Enterprise Server Manager interface to control the number of active threads within Sun ONE Web
server, Enterprise Edition. This setting corresponds to the RgThrottle parameter in the
magnus.conf file.

- Default value: 512

- Recommended value: Increase the thread count until the active threads parameters show
optimum behavior.

* Microsoft Internet Information Server (lIS) - Windows NT and Windows 2000
— IS permission properties

- Description: The Web server has several properties that dramatically affect the performance of
the application server. The default settings are usually acceptable. However, because other
products can change the default settings without user knowledge, make sure to check the IIS
settings for the Home Directory permissions of the Web server. The permissions should be set to
Script and not to Execute. If the permissions are set to Execute, no error messages are returned,
but the performance of WebSphere Application Server is decreased.

- How to view or set: To check or change these permissions, perform the following procedure in
the Microsoft management console:

1. Select the Web site (usually default Web site).
2. Right-click and select the Properties option.
3. Click the Home Directory tab. To set the permissions of the Home Directory:
a. Inthe Application settings, select the Script check box in the Permissions list and clear
the Execute check box.
b. (Optional) Check the permissions of the sePlugin:
1) Expand the Web server.
2) Right-click the sePlugin and select Properties.
3) Confirm that the Execute permissions are set to Execute.
- Default value: Script
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- Recommended value: Script
— Number of expected hits per day
- Description: Controls the memory that IIS allocates for connections.
- How to view or set: Using the performance window, set the parameter to More than 100000 in
the Web site properties panel of the Microsoft management console.
- Default value: Fewer than 100000
- Recommended value: More than 100000
— ListenBackLog parameter
- Description: Alleviates failed connections under heavy load conditions, if you are using IS on

Windows NT and Windows 2000. Failure typically occurs when you are using more than 100

clients. ListenBackLog increases the number of requests that IIS keeps in its queue. Consider

raising this value if you see intermittent Unable to locate server errors in the Netscape
browser.
- How to view or set:

1. Use a command prompt to issue the regedit command to access the operating system
registry.

2. In the registry window, locate the parameter in the
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\
Inetinfo\Parameters\ListenBackLog directory.

3. Right-click the parameter to adjust the setting according to the server load.

- Default value: 25 (decimal)
- Recommended value: You can set the ListenBackLog parameter can be set as high as 200,
without negative impact on performance and with an improvement in load handling.

Modifying the WebSphere plug-in to improve performance

You can improve the performance of IBM HTTP Server V6.0 (with the WebSphere Web server plug-in) by
modifying the plug-in’s Retrylnterval configuration. The Retryinterval is the length of time to wait before
trying to connect to a server that has been marked temporarily unavailable. Making this change can help
the IBM HTTP Server V6.0 to scale higher than 400 users.

The plug-in marks a server temporarily unavailable if the connection to the server fails. Although a default
value is 60 seconds, it is recommended that you lower this value in order to increase throughput under
heavy load conditions. Lowering the Retrylnterval is important for IBM HTTP Server V6.0 on UNIX
operating systems that have a single thread per process, or for IBM HTTP Server 2.0 if it is configured to
have fewer than 10 threads per process.

How can lowering the Retrylnterval affect throughput? If the plug-in attempts to connect to a particular
application server while the application server threads are busy handling other connections, which
happens under heavy load conditions, the connection times out and the plug-in marks the server
temporarily unavailable. If the same plug-in process has other connections open to the same server and a
response is received on one of these connections, the server is marked again. However, when you use
the IBM HTTP Server V6.0 on a UNIX operating system, there is no other connection since there is only
one thread and one concurrent request per plug-in process. Therefore, the plug-in waits for the
RetryInterval before attempting to connect to the server again.

Since the application server is not really down, but is busy, requests are typically completed in a small
amount of time. The application server threads become available to accept more connections. A large
RetryInterval causes application servers that are marked temporarily unavailable, resulting in more
consistent application server CPU utilization and a higher sustained throughput.

Note: Although lowering the Retrylnterval can improve performance, if all the application servers are
running, a low value can have an adverse affect when one of the application servers is down. In
this case, each IBM HTTP Server V6.0 process attempts to connect and fail more frequently,
resulting in increased latency and decreased overall throughput.
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Chapter 21. Gskit install images files

The Global Security Kit (GSKit) installation image files for the WebSphere Web server plug-ins are
packaged on the CD with the Web server plug-in files. You can download the appropriate GSKIT file to the
workstation on which your Web server is running. Use the following table to assist you in selecting the
correct GSKIT installation image file.

Operating system GSKit 7 Installation image file
Windows No image name

AIX gskta.rte

HP-UX gsk7bas

Solaris Operating Environment gsk7bas

Linux gsk7bas_7.0.3.1.i386.rpm
Linux390 gsk7bas-7.0.3.1.s390.rpm
LinuxPPC gsk7bas-7.0.3.1.ppc.rpm
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Chapter 22. Plug-ins: Resources for learning

Use the following links to find relevant supplemental information about Web server plug-ins. The
information resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of
the information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

View links to additional information about:
+ [Programming model and decisions|
» |Programming instructions and examples|

Programming model and decisions
Best Practice: WebSphere Plug-in Configuration Regeneration|

Programming instructions and examples

+ [IBM HTTP Server documentation|

+ [WebSphere Application Server education|

« |Listing of all IBM WebSphere Application Server Redbooks|
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Chapter 23. Web server plug-in tuning tips

Balancing workloads:

In a distributed environment, you can limit the number of connections that can be handled by an
applications server. To do this, go to the Servers > Web Servers > webserver > Plug-in properties page
in the administrative console and select Set limit for the Minimum number of connections that can be
handled by the Application Server field. Then specify in the Connections field the maximum number of
connections you want to allow. When this maximum number of connections is reached, the plug-in returns
an HTTP 503 response code to the client. This code indicates that the server is currently unable to handle
the request because it is experiencing a temporary overloading or because maintenance is being
performed.

When this maximum number of connections is reached, the plug-in, when establishing connections,
automatically skips that application server, and tries the next available application server. If no application
servers are available, an HTTP 503 response code will be returned to the client. This code indicates that
the server is currently unable to handle the request because it is experiencing a temporary overloading or
because maintenance is being performed.

Limiting the number of connections that can be established with an application server works best for Web
servers that follow the threading model instead of the process model, and only one process is started.

The IBM HTTP Server V6.0.x follows the threading model. To prevent the IBM HTTP Server from starting
more than one process, change the following properties in the Web server configuration file (httpd.conf)
to the indicated values:

ServerLimit 1
ThreadLimit 4000
StartServers 1
MaxClients 1024
MinSpareThreads 1
MaxSpareThreads 1024
ThreadsPerChild 1024

MaxRequestsPerChild 0

m Improving performance in a high stress environment:

If you use the default settings for a Microsoft Windows operating system, you might encounter Web server
plug-in performance problems if you are running in a high stress environment. To avoid these problems,
consider tuning the the TCP/IP setting for this operating system. Two of the keys setting to tune are
TepTimedWaitDelay and MaxUserPort.

To tune the TcpTimedWaitDelay setting, change the value of the tcp_time_wait_interval parameter from the
default value of 240 seconds, to 30 seconds:

1. Locate in the Windows Registry:
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\tcpip\Parameters\TcpTimedWaitDelay

If this entry does not exist in your Windows Registry, create it by editing this entry as a new DWORD
item.

2. Specify, in seconds, a value between 30 and 300 inclusive for this entry. (It is recommended that you
specify a value of 30. )

To tune the MaxUserPort setting:
1. Locate in the Windows Registry:
HKEY _LOCAL_MACHINE\System\CurrentControlSet\Services\tcpip\Parameters\MaxUserPort
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If this entry does not exist in your Windows Registry, create it by editing this entry as a new DWORD
item.

2. Set the maximum number of ports to a value between 5000 and 65534 ports, inclusive. (It is
recommended that you specify a value of 65534,)

See the [Microsoft Web site| for more information about these settings.
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Chapter 24. Tuning Web servers

[Chapter 20, “Web server tuning parameters,” on page 259 lists tuning parameters specific to Web servers.
The listed parameters may not apply to all of the supported Web servers. Check your Web server
documentation before using any of these parameters.
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Appendix A. Uninstalling the product

This task describes how to uninstall WebSphere Application Server - Express.

The [‘uninstall command” on page 272 calls the uninstaller program that is created during installation. The
uninstaller program is customized for each product installation, with specific disk locations and routines for
removing installed features.

The uninstaller program removes registry entries, uninstalls the product, and removes all related features.
The uninstaller program does not remove log files in the installation root directory.

The uninstaller program removes all profiles, including all of the configuration data and applications in
each profile. Before you start the uninstall procedure, back up the config folder, the installableApps
folder, and the installedApps folder of each profile, if necessary. See the Administration: Operations PDF
for a description of managing configuration files. Back up all applications that are not stored in another
location.

This procedure uninstalls the WebSphere Application Server product.

See the following topics to uninstall other components on the product disc:

* [‘Uninstalling the Web server plug-ins for WebSphere Application Server” on page 183|
+ [Uninstalling IBM HTTP Server]
« [“Uninstalling Application Client for WebSphere Application Server’ on page 202|

Estimating the time required to uninstall The time required to uninstall is dependent on the processing
speed of your machine. As a rough guideline, uninstalling the core product files and one application server
profile takes approximately 10 minutes when using the uninstall command.

1. Log on as root on a Linux or UNIX system, or as a user who belongs to the administrator group on a
Windows system.

2. Run the uninstaller program for the Web server plug-ins for WebSphere Application Server.

If a Web server is configured to run with the Application Server, uninstall the plug-ins to remove the
configuration from the Web server. See[‘Uninstalling the Web server plug-ins for WebSphere]|
[Application Server’ on page 183

3. Stop each running Application Server with the stopServer command.

If security is disabled, the uninstaller program can stop all WebSphere Application Server processes
automatically. If servers are running and security is enabled, the uninstaller program cannot shut down
the servers and the uninstall procedure fails. Manually stop all servers before uninstalling.

Stop all server processes in all profiles on the machine. For example, issue the following command
from the /opt/IBM/WebSphere/AppServer/profiles/app_server profile/bin directory on a Linux
machine to stop the server1 process in the profile:

./stopServer.sh serverl
If servers are running and security is enabled, use the following commands:
./stopServer.sh serverl -user user_ID -password password

4. Optional: Back up configuration files and log files to refer to them later, if necessary.

The uninstaller program does not remove log files in the installation root directory. The uninstaller
program removes all profiles and all of the data in all profiles.

Back up the config folder and the Togs folder of each profile to refer to it later, if necessary. You
cannot reuse profiles so there is no need to back up an entire profile.

5. Uninstall the product.
[‘Uninstalling WebSphere Application Server - Express” on page 275|
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After running the uninstall command, the directory structure has only a few remaining directories. The
Togs directory is one of the few directories with files.

6. Review the install_root/1ogs/uninstlog.txt file.

The install_root/1ogs/uninstlog.txt file records file system or other unusual errors. Look for the
INSTCONFSUCCESS indicator of success in the log:

Uninstall, com.ibm.ws.install.ni.ismp.actions.
ISMPLogSuccessMessageAction, msgl,
INSTCONFSUCCESS

7. Uninstall manually before reinstalling.
The uninstaller program leaves some log files, including the install_root/10gs/uninstlog.txt file.

Manually uninstall the product to remove all artifacts of the product so that you can reinstall into the
same installation root directory. If you do not plan to reinstall, you do not need to manually uninstall.

See [‘Uninstalling manually” on page 277|for more information.

This procedure results in uninstalling the product.

After uninstalling the product and cleaning the system with the manual uninstall procedure, you can
reinstall.

uninstall command

The uninstall command uninstalls the product. When you uninstall the product, the uninstaller program
removes the core product files and all of the profiles.

Before you begin uninstalling the product

If servers are running and security is enabled, the uninstaller program cannot shut down the servers and
the uninstall procedure fails. Manually stop all servers before uninstalling the product.

You can disable security in the administrative console before uninstalling the product. Then the uninstaller
program can stop all server processes. Click Security > Global security and clear the check box for
enabling global security in the administrative console.

You can also modify the install_root/profiles/profile name/properties/soap.client.props file in each
profile to allow the uninstaller program to issue commands against the profile. After modifying the file, you
can run the uninstaller program in a secure environment without having to manually stop each server
process.

See|Appendix A, “Uninstalling the product,” on page 271|for more information about how to edit the
properties/soap.client.props file.

Location of the command file
The command file is located in the _uninst directory in the installation root directory.

The command file is named:

. -EE. uninstall
. MUninstaH.exe

Command syntax

Command parameters are described at the end of this topic. This section describes the recommended
command syntax, which starts the uninstaller wizard.
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. -EJE. Issue the uninstall command:

install_root/_uninst/uninstall

. m Run the uninstaller program in the installation root of the product that you intend to uninstall.
Issue a fully qualified command or change directories to the install root\_uninst directory and issue
the uninstall command. For example, if the installation root is C:\1BM\WebSphere\AppServer, issue the
following command:

"C:\IBM\WebSphere\AppServer\ uninst\uninstall.exe"

Uninstalling the product

See [‘Uninstalling WebSphere Application Server - Express” on page 275|for information about how to
uninstall the product.

Logging

Examine the install_root/1ogs/uninstlog.txt file to verify that there were no file system or other unusual
errors while uninstalling. If there are problems, correct them, and uninstall manually before reinstalling the
product.

After uninstalling a WebSphere Application Server product, delete the installation root directory before
reinstalling into the same directory. Deleting the old directory avoids XML configurations that are not valid
that result from retaining old files. To delete all files so that you can reinstall with a clean system, see
[‘Uninstalling manually” on page 277

vpd.properties file

The installer program for any WebSphere Application Server product uses the Install Shield for
Multiplatforms (ISMP) program to install code. ISMP uses the vpd.properties file to track WebSphere
products that it installs on all platforms but Solaris and HP-UX. The vpd.properties file lists program
components that are currently installed. The file helps ISMP and the installer programs of WebSphere
Application Server products to recognize previous installations of WebSphere Application Server products
and to control options for new installations.

Situations that require you to edit the vpd.properties file

Certain situations require you to edit the vpd.properties file before reinstalling a WebSphere Application
Server product. The uninstaller programs for WebSphere Application Server products edit the
vpd.properties while uninstalling a product, to remove entries for the product and any of its features that
might have entries in the file.

It is necessary to remove product entries in the vpd.properties file before you can reinstall the product.
Some situations that occur require manually removing entries from the vpd.properties file before you can
reinstall a product. These situations include:

» Bypassing the uninstaller program to uninstall a product manually
* Uninstalling a product manually when the uninstaller program is not present or is not working

If the vpd.properties file has entries for a product that you uninstalled, you must edit the file and remove
the entries. If you do not edit the vpd.properties file to remove entries for a product or features of a
product, you cannot reinstall the product into the same directory structure. If product entries in the
vpd.properties file are present, the installer program reads the vpd.properties file, determines that the
product is already installed, and displays the panel that prompts you to install additional features into the
existing product or to install the binaries a second time. Unfortunately, the existing binaries might not be
valid at that point. The installer program does not verify the products that it finds listed in the
vpd.properties file.
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Location of the vpd.properties file

The location of the vpd.properties file varies per operating platform:
» AIX platforms: The root directory or the usr/1ib/objrepos directory
* Linux platforms: The root directory

* Windows platforms: installation directory of the operating system, such as the C:\WINNT directory or the
C:\windows directory.

Example of the vpd.properties file

The following example shows all of the entries for the vpd.properties file for Version 6.0.0 of the Network
Deployment product on a Windows platform. The example shows entire lines but breaks each line for
formatting purposes. The identifier for the first component is highlighted. The installation location of the first
component is also highlighted.

WSBAAGO|6]0]0]0]6.0.0.0|1=WebSphere Application Server|
IBM WebSphere Application Server| |IBM| |6.0.0.0]
C:\Program Files\IBM\WebSphere\AppServer|0|0|1|
WSBAAG6O|6|0]0]0]6.0.0.0]1|0]false]

" uninst" "uninstall.jar" "uninstall.dat" ""|true|3|
WSBAA60|6]0[0]0]6.0.6.0]1

WSBAAGONDOn1yComponent| | |
ND Only| |IBM| |6.0.0.0
C:\Program Files\IBM\WebSphere\AppServer\properties\version\install\
6.0.0.0\componentmaps|0]0]|1]

| |1=NDOn1y.ismp.component|

WSBAAGONDONn1y|6]0]|0]|0[6.0.0.0]|1|0|false| |true|3|
WSBAA6ONDONnTyComponent| | | | | |1
WSBAA6OJavadocsComponent|6|0|0]0]6.0.0.0|1=Javadocs.ismp.component |

Javadocs| |IBM| |6.0.0.0]
C:\Program Files\IBM\WebSphere\AppServer\properties\version\install\
6.0.0.0\componentmaps [0]0]1]
WSBAA6OJavadocs |6]0]0]0]6.0.0.0|1|0|false| |true|3|
WSBAA6OJavadocsComponent |6|0]0]0]6.0.0.0]1
WSBAA6OJavadocs|6]0]|0|0]6.0.0.0|1=Javadocs|
Javadocs|$L(com.1bm.ws.1nsta11.resourcebund]e.WSResourceBund]e,
Features.javadoc.description) |IBM| |6.0.0.0]
C:\Program Files\IBM\WebSphere\AppServer|0|0|1
WSBAAGOCoreRuntime|6]0]0]|0|6.0.0.0|1]0]false
WSBAA6OJavadocs |6]0]0]0]6.0.0.0]1
WSBAAGOL1icensingComponent| | | | | |1=LAP Component|
LAP Component|This bean will work with the licensing files| | | |
C:\Program Files\IBM\WebSphere\AppServer|0|0|1|
WSBAAG6O|6|0]0]0]6.0.0.0|1]|0|false| |true|3
WSBAA6OLicensingComponent 1
WSBAAG6OCoreRuntime|6]0]0]0]6.0.0.0|1=CoreRuntime|
Core Runtime|$L(com.1bm.ws.insta11.resourcebund]e.WSResourceBund]e,
Features.coreruntime.description) |IBM| |6.0.0.0]
C:\Program F11es\IBM\WebSphere\AppServer 0]1]
WSBAAGO|6(0]0]0]6.0.0. 0|1|0|fa1se| true|3
WSBAA6OCoreRuntime |6 0/6.0.0.0]|1
WSBAA6OSamplesComponent |6 0(6.0.0.0 1=Samp1es.1smp.component|
Samples| |IBM| |6.0.0. 0
C:\Program F11es\IBM\WebSphere\AppServer\propert1es\version\insta]1\
6.0.0.0\componentmaps |0|0]1]
WSBAAGOSamples|6|0]0]0]6.0.0.0|
WSBAA6OSamplesComponent |6]0|0]0
WSBAA6OCoreRuntimeComponent |6]0]0|0|
Core Runtime| |IBM| |6.0.0.0
C:\Program Files\IBM\WebSphere\AppServer\properties\version\install\
6.0.0.0\componentmaps |0|0]1]
WSBAAGOCoreRuntime|6|0]0]|0|6.0.0.0|1]|0|false| |true|3]
WSBAA6OCoreRuntimeComponent|6]0|0]0]6.0.0.0]1
WSBAAGONDON1y|6|0|0]0|6.0.0.0|1=NDOn1y
Invisible ND Only Feature| |IBM|

true|3|

1
[6.0.0.0]1
6.0.0.0]|1=CoreRuntime.ismp.component |

6.0.0.0|
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C:\Program Files\IBM\WebSphere\AppServer|0|0|1
WSBAA6OCoreRuntime|6]0]0]0]6.0.0.0|1]|0]false
WSBAAGONDON1y|6]0]0]06.0.0.0]1

WSBAA6OSamples|6|0[0]0]6.0.0.0|1=Samples|
Samp]es|$L(com.1bm.ws.1nsta11.resourcebund1e.WSResourceBund]e,
Features.samples.description) |IBM| |6.0.0.0]
C:\Program Files\IBM\WebSphere\AppServer|0|0|1
WSBAAGOCoreRuntime 6|0 0]0]6.0.0.0|1|0]|false

WSBAAGOSamples|6|0]0]0]6.0.0.0]1

true|3|

true|3|

Identifying entries in the vpd.properties file

Use the following table to help identify product entries.

Table 16. Identifers in the vpd.properties file for WebSphere products

Identifier Product

WSB...60 All Version 6 products use this identifier to identify the core product files:
* WebSphere Application Server - Express, Version 6

» WebSphere Application Server, Version 6

* WebSphere Application Server Network Deployment, Version 6

WSP...60 Web server plug-ins for WebSphere Application Server, Version 6

WSC... WebSphere Application Server Clients, Version 6

Web server plug-ins for WebSphere Application Server installs the following packages:

Operating system Registry keys

AlX, Linux, and Windows « WSPAABO

* WSPAABODefineglobalconstantsComponent
* WSPAAG0DefinelocalvariablesComponent
» WSPAAG60OLicensingComponent

» WSPAAB60Webserverplugins

* WSPAAB0WebserverpluginsComponent
 WSPAAB0AddBYytes

» WSPAAB0gskit

* WSPAAB0gskitComponent

Uninstalling WebSphere Application Server - Express

This task describes using the uninstaller program to uninstall WebSphere Application Server - Express.

The uninstaller program removes registry entries, uninstalls the product, and removes all related features.
The uninstaller program does not remove log files in the installation root directory.

The uninstaller program removes all profiles, including all of the configuration data and applications in
each profile. Before you start the uninstall procedure, back up the config folder, the installableApps
folder, and the installedApps folder of each profile, if necessary. See the Administration: Operations PDF
for a description of managing configuration files. Back up all applications that are not stored in another
location.

This procedure uninstalls the WebSphere Application Server - Express product.

See the following topics to uninstall other components on the product disc:
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[‘Uninstalling the Web server plug-ins for WebSphere Application Server’ on page 183]
[Uninstalling IBM HTTP Server|
[‘Uninstalling Application Client for WebSphere Application Server’ on page 202|

1. Log on as root on a Linux or UNIX system, or as a user who belongs to the administrator group on a
Windows system.

2. Run the uninstaller program for the Web server plug-ins for WebSphere Application Server.

If a Web server is configured to run with the Application Server, uninstall the plug-ins to remove the

configuration from the Web server. See |“Uninstal|ing the Web server plug-ins for WebSphere|

IApplication Server” on page 183/
3. Stop each running Application Server with the stopServer command.

If security is disabled, the uninstaller program can stop all WebSphere Application Server processes

automatically. If servers are running and security is enabled, the uninstaller program cannot shut down

the servers and the uninstall procedure fails. Manually stop all servers before uninstalling.

Stop all server processes in all profiles on the machine. For example, issue the following command
from the /opt/I1BM/WebSphere/AppServer/profiles/app_server profile/bin directory on a Linux
machine to stop the server1 process in the profile:

./stopServer.sh serverl
If servers are running and security is enabled, use the following commands:
./stopServer.sh serverl -user user ID -password password
4. Optional: Back up configuration files and log files to refer to them later, if necessary.
The uninstaller program does not remove log files in the installation root directory. The uninstaller
program removes all profiles and all of the data in all profiles.

Back up the config folder and the Togs folder of each profile to refer to it later, if necessary. You
cannot reuse profiles so there is no need to back up an entire profile.

5. Issue the uninstall command. The command file is named uninstall for Linux and UNIX platforms
and uninstall.exe on Windows platforms.

-IEE- On Linux and UNIX platforms, issue the uninstall command from the
install_root/_uninst directory:

./uninstall

m On Windows platforms, call the uninstall command:

install_root\_uninst\uninstall.exe

m Call the program directly from the install_root\_uninst directory. For example, if the
installation root is C:\IBM\WebSphere\AppServer, issue the following command:

C:\IBM\WebSphere\AppServer\_uninst> uninstall.exe
The Uninstaller wizard begins and displays the Welcome panel.

6. Click Next to begin uninstalling the product. The Uninstaller wizard displays a confirmation panel that
lists the product and features that you are uninstalling.

7. Click Next to continue uninstalling the product. The Uninstaller wizard deletes existing profiles first. For
this reason, back up any profiles or data in profiles that you want to retain before uninstalling the
product.

After deleting profiles, the Uninstaller wizard deletes the core product files in component order.
8. Click Finish to close the wizard after the wizard removes the core product files.
9. Review the install_root/1ogs/uninstlog.txt file.

The install_root/1ogs/uninstlog.txt file records file system or other unusual errors. Look for the
INSTCONFSUCCESS indicator of success in the log:

Uninstall, com.ibm.ws.install.ni.ismp.actions.
ISMPLogSuccessMessageAction, msgl,
INSTCONFSUCCESS
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This procedure uninstalls the WebSphere Application Server - Express product.

After running the uninstall command, the directory structure has only a few remaining directories. The
logs directory is one of the few directories with files.

The install_root/1ogs/uninstlog.txt file records file system or other unusual errors. Look for the
INSTCONFSUCCESS indicator of success in the log:

Uninstall, com.ibm.ws.install.ni.ismp.actions.
ISMPLogSuccessMessageAction, msgl,
INSTCONFSUCCESS

If you plan to reinstall, perform the manual uninstall procedure for your system.
The uninstaller program leaves some log files, including the install_root/10gs/uninstlog.txt file.

Manually uninstall the product to remove all artifacts of the product so that you can reinstall into the same
installation root directory. If you do not plan to reinstall, you do not need to manually uninstall.

See [‘Uninstalling manually’] for more information.

Uninstalling manually

The uninstaller program leaves some files that can prevent you from reinstalling into the original directory.
Delete files and registry entries to clean the machine so that you can reinstall into any directory. If you are
not planning to reinstall, do not uninstall manually.

You can reinstall without a clean machine. Such an installation creates a coexistence scenario that can
prevent you from installing into the original directory.

The uninstaller program removes all profiles, including all of the configuration data and applications in
each profile. Before you start the uninstall procedure, back up the config folder, the installableApps
folder, and the installedApps folder of each profile, if necessary. See the Administration: Operations PDF
for a description of managing configuration files. Back up all applications that are not stored in another
location.

Cleaning the machine means deleting everything from the previous installation, including log files that are
left behind by the uninstall command. Before you start the procedure, back up log files, if necessary. See
[Appendix B, “Troubleshooting installation,” on page 291|for the location of log files.

This procedure uninstalls your WebSphere Application Server product.

Run one of the following procedures to produce a clean machine on your operating system.
* |Uninstall manually on an AIX system.|

* |Uninstall manually on an HP-UX system.l

* |Uninstall manually on a Linux system.
» |Uninstall manually on a Solaris system|

* |Uninstall manually on a Windows system.l

Manually uninstalling produces a clean system. A clean system has no evidence of a previously deleted
installation.

Appendix A. Uninstalling the product 277



Manually uninstalling on an AIX system

This procedure uninstalls a WebSphere Application Server product from an AlX system. After running the
uninstaller program, manual steps remove log files and registry entries that can prevent you from
reinstalling the product into the original directory. If you are not planning to reinstall, do not uninstall
manually.

The uninstaller program removes all profiles, including all of the configuration data and applications in
each profile. Before you start the uninstall procedure, back up the config folder, the installableApps
folder, and the installedApps folder of each profile, if necessary. See the Administration: Operations PDF
for a description of managing configuration files. Back up all applications that are not stored in another
location.

Determine the installation root directory for the product so that you remove the correct product and
produce a clean system.

Reinstalling the product into a new directory when files remain from a previous installation can create a
coexistence scenario. However, you can delete all files and registry entries to completely remove a
WebSphere Application Server product. A clean system lets you reinstall the product into the original
directory without coexistence.

Default directories are shown in the following planning table:

Identifier Directory Actual location

install_root /usr/IBM/WebSphere/AppServer

profiles_install_root | /usr/IBM/WebSphere/AppServer/profiles

plug-ins_install_root | /usr/IBM/WebSphere/Plugins

The Installation wizard and the Profile creation wizard let you specify your own locations for installation
root directories. Examine the following files to determine the actual locations:

* The ~/.WASRegistry file identifies the installation root for all installed WebSphere Application Server
products.

» The install_root/10gs/wasprofile/wasprofile_create profile _name.log file for each created profile
identifies the installation location in the stanza with the <method>invokeWSProfile</method> tag.

Uninstalling the product leaves the profiles_root/profile_name directory with the pctLog.txt file.

Perform the following procedure to produce a clean system.
1. Log on as root.
2. Run the uninstaller program for the Web server plug-ins for WebSphere Application Server.

If a Web server is configured to run with the application server, uninstall the plug-ins to remove the
configuration from the Web server. See [‘Uninstalling the Web server plug-ins for WebSphere]
[Application Server” on page 183

3. lIssue the uninstall command.

If you have already run the uninstaller program or if you cannot run the uninstaller program, simply
skip this step.

install_root/_uninst/uninstall
See the description of the [‘uninstall command” on page 272| for more information.
The Uninstaller wizard begins and displays the Welcome panel.

4. Use the kill command to kill all Java processes that are running.
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10.

If running Java processes are not related to WebSphere Application Server products and it is not
possible to stop them, stop all WebSphere Application Server product-related processes. Use the
following command to determine all processes that are running:

ps -ef | grep java

Stop all WebSphere Application Server-related processes with the kill -9 java_pid_1
java_pid_2...java_pid_n command.

List WebSphere Application Server components that are installed.

Type the following command to search for related packages:

1slpp -1| grep -i WS

Do not remove packages for WebSphere Application Server products that you are not uninstalling.

Version 6 package names have a prefix of WSB or WSP and a suffix of 60. WSC package names do
not have a suffix of 60.

Use the geninstall command to remove registry information for each component that displays in the
list.

For example, issue the follow command to display packages with a prefix of WS:
TsTpp -1 | grep -i WS

The system displays the list of matching packages:

WSBAA6OCoreRuntime 6.0.0.0 COMMITTED Installs the core product run
Issue the follow command to remove the registry entry:

geninstall -u WSBAA6OCoreRuntime

Change directories to the /usr/IBM directory.

Type rm -rf WebSphere to delete this WebSphere Application Server-related directory, but only if the
AppServer directory is the only directory within the WebSphere directory. Delete the directory if the only
products contained in the directory are products that you intend to delete.

Edit the .WASRegistry file.

The file location is the home directory, ~/.WASRegistry.

The .WASRegistry file contains a one-line entry for each WebSphere Application Server product
installation.

You can delete the file if there is just one line that identifies the product that you are removing.
Otherwise, use a flat-file editor to remove the line that identifies the installation root directory of the
product that you are removing. Leave the other lines intact. Do not delete the .WASRegistry file
unless you are removing all of the installations listed in the file.

The following example shows a .WASRegistry file for a system with five installations:

/usr/1BM/WebSphere/AppServer
/usr/I1BM/ND/AppServer
/usr/ExpressV6/1BM/WebSphere/AppServer
/usr/ND/IBM/WebSphere/AppServer
/usr/Express/IBM/WebSphere/AppServer

Run the odmclean.sh and aixclean.sh scripts.
Do not run the aixclean.sh script if the WebSphere MQ product is installed.

a. Obtain the scripts from the technote document titled, [Manual uninstall On AIX requireg
|odmc1ean.sh and aixc1ean.sh| on the WebSphere Application Server Support site.

b. Edit the odmclean.sh script and replace every instance of the string /usr/WebSphere/AppServer
with the actual installation root directory.

c. Run the aixclean.sh script from the command line:
./aixclean.sh
d. Run the odmclean.sh script from the command line:

./odmclean.sh
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This procedure results in having a clean system. You can reinstall into the same directories now. A clean
system has no trace of a previously deleted installation.

Example of displaying package names beginning with WS, for WebSphere Application
Server-related products

==>1s1pp -1 | grep WS

WSBAA6O 6.0.0.0 COMMITTED ISMP installed entry
WSBAA6OAddBytesNonHP 6.0.0.0 COMMITTED 1ISMP installed entry
WSBAA6OCoreRuntime 6.0.0.0 COMMITTED Installs the core product run
WSBAA6OCoreRuntimeComponent

WSBAA6OJavadocs 6.0.0.0 COMMITTED Installs the public Java API
WSBAA60JavadocsComponent  6.0.0.0 COMMITTED ISMP installed entry
WSBAA6OLicense 6.0.0.0 COMMITTED 1ISMP installed entry
WSBAA6OLicenseComponent 0.0.0.0 COMMITTED ISMP installed entry
WSBAA6OLicensingComponent 0.0.0.0 COMMITTED This bean will work with the
WSBAA6OSamples 6.0.0.0 COMMITTED Includes Samples with source
WSBAA6OSamplesComponent 6.0.0.0 COMMITTED ISMP installed entry...
WSPAAGO 6.0.0.0 COMMITTED 1ISMP installed entry...

WSPAA6ODefineglobalconstantsComponent 6.0.0.0 COMMITTED ISMP installed entry...
WSPAA6ODefinelocalvariablesComponent 6.0.0.0 COMMITTED ISMP installed entry...
WSPAA6OLicensingComponent 6.0.0.0 COMMITTED ISMP installed entry...
WSPAA6OWebserverplugins  6.0.0.0 COMMITTED ISMP installed entry...
WSPAA6OWebserverpluginsComponent 6.0.0.0 COMMITTED ISMP installed entry...

WSPAA6OAddBytes 6.0.0.0 COMMITTED ISMP installed entry...
WSPAA6Ogskit 6.0.0.0 COMMITTED 1ISMP installed entry...
WSPAA60gskitComponent 6.0.0.0 COMMITTED ISMP installed entry...

Manually uninstalling on an HP-UX system

This procedure uninstalls a WebSphere Application Server product from an HP-UX system. After running
the uninstaller program, manual steps remove log files and registry entries that can prevent you from
reinstalling the product into the original directory. If you are not planning to reinstall, do not uninstall
manually.

The uninstaller program removes all profiles, including all of the configuration data and applications in
each profile. Before you start the uninstall procedure, back up the config folder, the installableApps
folder, and the installedApps folder of each profile, if necessary. See the Administration: Operations PDF
for a description of managing configuration files. Back up all applications that are not stored in another
location.

Determine the installation root directory for the product so that you remove the correct product and
produce a clean system.

Reinstalling the product into a new directory when files remain from a previous installation can create a
coexistence scenario. However, you can delete all files and registry entries to completely remove a
WebSphere Application Server product. A clean system lets you reinstall the product into the original
directory without coexistence.

Default directories are shown in the following planning table:

Identifier Directory Actual location

install_root /opt/IBM/WebSphere/AppServer

profiles_install_root | /opt/IBM/WebSphere/AppServer/profiles

plug-ins_install_root | /opt/IBM/WebSphere/PTugins

The Installation wizard and the Profile creation wizard let you specify your own locations for installation
root directories. Examine the following files to determine the actual locations:
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« The ™~/.WASRegistry file identifies the installation root for all installed WebSphere Application Server
products.

» The install_root/10ogs/wasprofile/wasprofile_create_profile name.log file for each created profile
identifies the installation location in the stanza with the <method>invokeWSProfile</method> tag.

Uninstalling the product leaves the profiles root/profile _name directory with the pctLog.txt file.

Perform the following procedure to produce a clean system.
1. Log on as root.
2. Run the uninstaller program for the Web server plug-ins for WebSphere Application Server.

If a Web server is configured to run with the application server, uninstall the plug-ins to remove the
configuration from the Web server. See |“Uninstal|ing the Web server plug-ins for WebSphere|
[Application Server” on page 183

3. lIssue the uninstall command.
If you have already run the uninstaller program or if you cannot run the uninstaller program, simply
skip this step.
install_root/_uninst/uninstall
See the description of the [‘uninstall command” on page 272| for more information.
The Uninstaller wizard begins and displays the Welcome panel.
4. Use the kill command to kill all Java processes that are running.

If running Java processes are not related to WebSphere Application Server products and it is not
possible to stop them, stop all WebSphere Application Server product-related processes. Use the
following command to determine all processes that are running:

ps -ef | grep java
Stop all WebSphere Application Server-related processes with the kill -9 java_pid_1
java_pid_2...java_pid_n command.

5. Use HP-UX System Administration Manager (SAM) to remove packages.

a. Start the SAM utility and verify that your DISPLAY and TERM environment variables are set
properly.
Click Software management.
Click View installed software.
Look for WebSphere Application Server entries or IBM HTTP Server entries in the SD list.
Close the SD list.
Click Remove local host software.
Click any of the following instances that display in the SD Remove List:
* IBM HTTP Server
WSBAAG0
WSPAA6G0

+ WSCAA
* gsk7bas

h. Click Actions > Mark for remove.

i. Click Actions > Remove.

j- Click OK in the Remove analysis dialog box.

k. Click Logs to display real-time removal of selected packages.

I. Click Done when all packages are removed.

m. Exit SAM.
6. Search for the packages to verify their removal.

Type swlist | grep WS to show packages for WebSphere Application Server.

@m0 ao0cx
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Package names for Web server plug-ins for WebSphere Application Server are:

WSPAAGO
WSPAA6ODGCC
WSPAAGODLVC
WSPAAGOLC
WSPAAGOWSPC
WSPAA60AddBytesHS
WSPAA6OgskitHP
WSPAA6OgskitHPC
WSPAA60jdkHP
7. Type rm -rf /opt/IBM/WebSphere/AppServer/ to remove WebSphere Application Server directories in
the /opt/IBM/WebSphere/AppServer installation root. Do not remove installation root directories for
products that you intend to keep. Remove all of the profile directories as well.

8. Edit the .WASRegistry file.
The file location is the home directory, ~/.WASRegistry.
The .WASRegistry file contains a one-line entry for each WebSphere Application Server product
installation.

You can delete the file if there is just one line that identifies the product that you are removing.
Otherwise, use a flat-file editor to remove the line that identifies the installation root directory of the
product that you are removing. Leave the other lines intact. Do not delete the .WASRegistry file unless
you are removing all of the installations listed in the file.

The following example shows a .WASRegistry file for a system with five installations:

/opt/IBM/WebSphere/AppServer
/opt/IBM/P1/AppServer
/opt/V6/1BM/WebSphere/AppServer
/opt/P2/1BM/WebSphere/AppServer
/opt/P3/1BM/WebSphere/AppServer

This procedure results in having a clean system. You can reinstall into the same directories now. A clean
system has no trace of a previously deleted installation.

Example of displaying package names for WebSphere Application Server products

Issue the following command:
swlist | grep WSBAA6O

The following package name is returned:
WSBAAGO 6.0.0 IBM WebSphere Application Server

Manually uninstalling on a Linux system

This procedure uninstalls a WebSphere Application Server product from a Linux system. After running the
uninstaller program, manual steps remove log files and registry entries that can prevent you from
reinstalling the product into the original directory. If you are not planning to reinstall, do not uninstall
manually.

The uninstaller program removes all profiles, including all of the configuration data and applications in
each profile. Before you start the uninstall procedure, back up the config folder, the installableApps
folder, and the installedApps folder of each profile, if necessary. See the Administration: Operations PDF
for a description of managing configuration files. Back up all applications that are not stored in another
location.

Determine the installation root directory for the product so that you remove the correct product and
produce a clean system.
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Reinstalling the product into a new directory when files remain from a previous installation can create a
coexistence scenario. However, you can delete all files and registry entries to completely remove a
WebSphere Application Server product. A clean system lets you reinstall the product into the original
directory without coexistence.

Default directories are shown in the following planning table:

Identifier Directory Actual location

install_root /opt/IBM/WebSphere/AppServer

profiles_install_root | /opt/IBM/WebSphere/AppServer/profiles

plug-ins_install_root | /opt/IBM/WebSphere/Plugins

The Installation wizard and the Profile creation wizard let you specify your own locations for installation
root directories. Examine the following files to determine the actual locations:

« The ™~/.WASRegistry file identifies the installation root for all installed WebSphere Application Server
products.

» The install_root/10gs/wasprofile/wasprofile_create profile_name.log file for each created profile
identifies the installation location in the stanza with the <method>invokeWSProfile</method> tag.

Uninstalling the product leaves the profiles_root/profile_name directory with the pctLog.txt file.

Perform the following procedure to produce a clean system.

1. Log on as root.

2. Run the uninstaller program for the Web server plug-ins for WebSphere Application Server.
If a Web server is configured to run with the application server, uninstall the plug-ins to remove the
configuration from the Web server. See[‘Uninstalling the Web server plug-ins for WebSphere]|
[Application Server” on page 183.|

3. lIssue the uninstall command.
If you have already run the uninstaller program or if you cannot run the uninstaller program, simply
skip this step.
install_root/_uninst/uninstall
See the description of the [‘uninstall command” on page 272 for more information.
The Uninstaller wizard begins and displays the Welcome panel.

4. Use the kill command to kill all Java processes that are running.
If running Java processes are not related to WebSphere Application Server products and it is not

possible to stop them, stop all WebSphere Application Server product-related processes. Use the
following command to determine all processes that are running:

ps -ef | grep java
Stop all WebSphere Application Server-related processes with the kill -9 java_pid_1
java_pid_2...java_pid_n command.

5. Search for related packages. Issue the following command to show packages for the WebSphere
Application Server products:

rpm -qa | grep WS
For example, after issuing the command, the following list of packages might display:

WSBAA6OCoreRuntimeComponent-6.0-0
WSBAA6OLicenseComponent-6.0-0
WSBAA60JavadocsComponent-6.0-0
WSBAAGONDON1yComponent-6.0-0
WSBAA6OAddBytesNonHP-6.0-0
WSBAA6OLicensingComponent-6.0-0
WSBAA60SamplesComponent-6.0-0
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WSPAAGO

WSPAA6ODefineglobalconstantsComponent

WSPAA6ODefinelocalvariablesComponent

WSPAA6OLicensingComponent

WSPAA6OWebserverplugins

WSPAA6OWebserverpluginsComponent

WSPAA6OAddBytes

WSPAA6Ogskit

WSPAA60OgskitComponent

Do not remove packages for WebSphere Application Server products that you are not uninstalling.
Version 6 package names have a prefix of WSB or WSP and a suffix of 60. WSC package names do
not have a suffix of 60.

6. If there are packages to delete, type rpm -e packagename to remove any packages for the product that
you are uninstalling.

Alternatively, you can search for packages to verify that everything in the list is something to delete:
rpm -qa | grep WS

If the list contains packages that you intend to delete and no others, remove all of the packages with
the following command:

rpm -qa | grep WS | xargs rpm -e

If there is a problem with package dependencies, you can use the following command to remove the
packages:

rpm -e packagename --nodeps --justdb

The nodeps option skips the dependency check. The justdb option updates only the package

database, and not the file system. Using only the nodeps option can cause a failure in package
removal if there is any mismatch in the dependent file system (files and directories).

7. Type rm -rf /opt/IBM/WebSphere/AppServer/ to remove WebSphere Application Server directories in
the /opt/I1BM/WebSphere/AppServer installation root. Do not remove installation root directories for
products that you intend to keep. Remove all of the profile directories as well.

8. Edit the .WASRegistry file.
The file location is the home directory, ~/.WASRegistry.

The .WASRegistry file contains a one-line entry for each WebSphere Application Server product
installation.

You can delete the file if there is just one line that identifies the product that you are removing.
Otherwise, use a flat-file editor to remove the line that identifies the installation root directory of the
product that you are removing. Leave the other lines intact. Do not delete the .WASRegistry file unless
you are removing all of the installations listed in the file.

The following example shows a .WASRegistry file for a system with five installations:

/opt/IBM/WebSphere/AppServer
/opt/IBM/P1/AppServer
/opt/V6/1BM/WebSphere/AppServer
/opt/P2/1BM/WebSphere/AppServer
/opt/P3/1BM/WebSphere/AppServer

This procedure results in having a clean system. You can reinstall into the same directories now. A clean
system has no trace of a previously deleted installation.

Manually uninstalling on a Solaris system

This procedure uninstalls the WebSphere Application Server product from a Solaris system. After running
the uninstaller program, manual steps remove log files and registry entries that can prevent you from
reinstalling the product into the original directory. If you are not planning to reinstall, do not uninstall
manually.

The uninstaller program removes all profiles, including all of the configuration data and applications in
each profile. Before you start the uninstall procedure, back up the config folder, the installableApps
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folder, and the installedApps folder of each profile, if necessary. See the Administration: Operations PDF
for a description of managing configuration files. Back up all applications that are not stored in another
location.

Determine the installation root directory for the product so that you remove the correct product and
produce a clean system.

Reinstalling the product into a new directory when files remain from a previous installation can create a
coexistence scenario. However, you can delete all files and registry entries to completely remove a
WebSphere Application Server product. A clean system lets you reinstall the product into the original
directory without coexistence.

Default directories are shown in the following planning table:

Identifier Directory Actual location

install_root /opt/IBM/WebSphere/AppServer

profiles_install_root | /opt/IBM/WebSphere/AppServer/profiles

plug-ins_install_root | /opt/IBM/WebSphere/Plugins

The Installation wizard and the Profile creation wizard let you specify your own locations for installation
root directories. Examine the following files to determine the actual locations:

* The ™/.WASRegistry file identifies the installation root for all installed WebSphere Application Server
products.

» The install_root/10gs/wasprofile/wasprofile_create profile _name.log file for each created profile
identifies the installation location in the stanza with the <method>invokeWSProfile</method> tag.

Uninstalling the product leaves the profiles_root/profile_name directory with the pctLog.txt file.

Perform the following procedure to produce a clean system.
1. Log on as root.
2. Run the uninstaller program for the Web server plug-ins for WebSphere Application Server.

If a Web server is configured to run with the application server, uninstall the plug-ins to remove the
configuration from the Web server. See [‘Uninstalling the Web server plug-ins for WebSphere]
[Application Server’ on page 183

3. Issue the uninstall command.

If you have already run the uninstaller program or if you cannot run the uninstaller program, simply
skip this step.

install_root/_uninst/uninstall
See the description of the [‘uninstall command” on page 272 for more information.
The Uninstaller wizard begins and displays the Welcome panel.

4. Use the kill command to kill all Java processes that are running.

If running Java processes are not related to WebSphere Application Server products and it is not
possible to stop them, stop all WebSphere Application Server product-related processes. Use the
following command to determine all processes that are running:

ps -ef | grep java
Stop all WebSphere Application Server-related processes with the kill -9 java_pid_1
java_pid_2...java_pid_n command.

5. Search for related packages. Type the following command to search for packages for WebSphere
Application Server products:

pkginfo | grep WS
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If no packages appear when using these commands, skip the next step. The resulting list of packages
has the following format:

application WSBAA6O WebSphere Application Server

6. Change directories to the directory where package information is registered.
cd /var/sadm/pkg

7. lIssue the following command to remove any WebSphere Application Server-related packages.
pkgrm packagenamel packagename? packagename3 ...

Do not remove packages for WebSphere Application Server products that you are not uninstalling.
Version 6 package names have a prefix of WSB or WSP and a suffix of 60. WSC package names do
not have a suffix of 60.

Issue the following commands from the /var/sadm/pkg directory to search for and remove any
WebSphere Application Server product-related packages that are registered in the /var/sadm/pkg
directory:

a. Change directories to the correct directory: cd /var/sadm/pkg

b. 1s |grep WSB|xargs -i pkgrm -n {} for WebSphere Application Server products

c. 1s |grep WSC|xargs -i pkgrm -n {} for WebSphere Application Server Clients

d. 1s |grep WSP|xargs -i pkgrm -n {} for Web server plug-ins for WebSphere Application Server

Package names for Web server plug-ins for WebSphere Application Server are:

WSPAAGO

WSPAAGOAC

WSPAAGOBC

WSPAA6OCC

WSPAA6ODC

WSPAA6OFC

WSPAAGOFB

WSPAA6OGC

WSPAAGOHC

If there is a problem removing the packages, remove the related package directories in the
/var/sadm/pkg directory, including the preremove files. For example, remove the following file before
issuing the pkgrm -n WSBAA6O command:

/var/sadm/pkg/WSBAA6O/install/preremove

8. Type rm -rf /opt/IBM/WebSphere/AppServer/ to remove WebSphere Application Server directories in
the /opt/IBM/WebSphere/AppServer installation root. Do not remove installation root directories for
products that you intend to keep. Remove all of the profile directories as well.

9. Edit the .WASRegistry file.
The file location is the home directory, ~/.WASRegistry.

The .WASRegistry file contains a one-line entry for each WebSphere Application Server product
installation.

You can delete the file if there is just one line that identifies the product that you are removing.
Otherwise, use a flat-file editor to remove the line that identifies the installation root directory of the
product that you are removing. Leave the other lines intact. Do not delete the .WASRegistry file unless
you are removing all of the installations listed in the file.

The following example shows a .WASRegistry file for a system with five installations:

/opt/1BM/WebSphere/AppServer
/opt/IBM/P1/AppServer
/opt/V6/1BM/WebSphere/AppServer
/opt/P2/1BM/WebSphere/AppServer
/opt/P3/1BM/WebSphere/AppServer

This procedure results in having a clean system. You can reinstall into the same directories now. A clean
system has no trace of a previously deleted installation.
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Manually uninstalling on a Windows system

This procedure uninstalls a WebSphere Application Server product from a Windows system. After running
the uninstaller program, manual steps remove log files and registry entries that can prevent you from
reinstalling the product into the original directory. If you are not planning to reinstall, do not uninstall
manually.

The uninstaller program removes all profiles, including all of the configuration data and applications in
each profile. Before you start the uninstall procedure, back up the config folder, the installableApps
folder, and the installedApps folder of each profile, if necessary. See the Administration: Operations PDF
for a description of managing configuration files. Back up all applications that are not stored in another
location.

Determine the installation root directory for the product so that you remove the correct product and
produce a clean system.

Reinstalling the product into a new directory when files remain from a previous installation can create a
coexistence scenario. However, you can delete all files and registry entries to completely remove a
WebSphere Application Server product. A clean system lets you reinstall the product into the original
directory without coexistence.

Default directories are shown in the following planning table:

Identifier Directory Actual location
install_root C:\ Program Files\ IBM\ WebSphere\
AppServer

profiles_install_root C:\ Program Files\ IBM\ WebSphere\
AppServer\ profiles

plug-ins_install_root |C:\ Program Files\ IBM\ WebSphere\
Plugins

2000 Windows 2000 consideration: If you move either installation root directory, move them to a
shorter path name. Windows 2000 has a length restriction of 258 characters for a command. A problem
can occur that prevents the successful creation of a profile when either path is too long. The maximum
length for the installation root directory is 60 characters. The maximum length for the profiles installation
root directory is 80 characters.

The Installation wizard and the Profile creation wizard let you specify your own locations for installation
root directories. Examine the following files to determine the actual locations:

» The %USERPROFILE%\.WASRegistry file identifies the installation root for all installed WebSphere
Application Server products.

» The install_roof\1ogs\wasprofile\wasprofile _create profile name.log file for each created profile
identifies the installation location in the stanza with the <method>invokeWSProfile</method> tag.

Perform the following procedure to produce a clean system.
1. Log on with a user ID that belongs to the administrator group.
2. Run the uninstaller program for the Web server plug-ins for WebSphere Application Server.

If a Web server is configured to run with the application server, uninstall the plug-ins to remove the
configuration from the Web server. See |“Uninsta|ling the Web server plug-ins for WebSphere|
[Application Server” on page 183

3. Issue the uninstall command.

If you have already run the uninstaller program or if you cannot run the uninstaller program, simply
skip this step.
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install_root\_uninst\uninstall
See the description of the [‘'uninstall command” on page 272| for more information.
The Uninstaller wizard begins and displays the Welcome panel.

Verify that you have an Emergency Recovery Disk. Instructions for creating this disk are in the
Windows help documentation.

This step is a safeguard. This procedure does not require the recovery disk.

Use the regback.exe program from the Windows Resource Kit to back up the registry.

This step is a safeguard. This procedure does not require the backup copy of the registry.

Delete product registry entries for the WebSphere Application Server product that you are uninstalling.
Invoke regedit.exe from a command prompt, to edit the Windows system registry.

Handle the Registry with care

Note: You can easily make a mistake while using the registry editor to view and edit registry
contents. The editor does not warn you of editing errors, which can be extremely dangerous. A
corrupt registry can disrupt your system to the point where your only option is to reinstall the
Windows operating system.

a. Use Ctrl-F to search for all instances of WebSphere, to determine whether you should delete

each entry. You might not be able to remove all of the entries related to WebSphere Application
Server, which is not a problem.

b. Expand and select keys related to WebSphere Application Server products.

Delete the following keys for the WebSphere Application Server product:

+ HKEY_CURRENT_USER\ Software\ Microsoft\ Windows\ CurrentVersion\ Explorer\ MenuOrder\
Start Menu\ Programs\ IBM WebSphere\ Application Server, Express v6

* HKEY_LOCAL_MACHINE\ SOFTWARE\ Microsoft\ Windows\ CurrentVersion\ Uninstall\
WSBAAGOEXPRESS

« HKEY_LOCAL_MACHINE\Software\IBM\WebSphere Application Server, Express\ 6.0.0.0

* HKEY_LOCAL_MACHINE\ Software\ IBM\ Web server Plug-ins for IBM WebSphere Application
Serven 6.0.0.0

c. Click Edit > Delete from the menu bar for each related key.

d. Click Yes when asked to confirm deletion of the key.

e. Click Registry > Exit from the menu bar when you are finished.

Delete the installation root directory for the product that you are uninstalling.
Determine all of the profile directories and remove the directories.

Open a Windows Explorer window and browse to the C:\Documents and Settings\A11 Users\Start
Menu\Programs\IBM WebSphere directory.

If you have one installation of a WebSphere Application Server product, delete the following folder:
Application Server, Express v6

Delete the SWINDIR%\IsUninst.exe file.

Edit the .WASRegistry file.

The file location is the home directory of the user ID who installed the product,
%USERPROFILE%\.WASRegistry.

The .WASRegistry file contains a one-line entry for each WebSphere Application Server product
installation.

You can delete the file if there is just one line that identifies the product that you are removing.
Otherwise, use a flat-file editor to remove the line that identifies the installation root directory of the
product that you are removing. Leave the other lines intact. Do not delete the .WASRegistry file unless
you are removing all of the installations listed in the file.

The following example shows a .WASRegistry file for a system with five installations:
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C:\Program Files\IBM\WebSphere\AppServer
C:\IBM\WebSphere\AppServer
C:\ExpressV6\IBM\WebSphere\AppServer

C:\ND_Install_9 25 2004 build\IBM\WebSphere\AppServer
C:\Express_09 25 _2004\IBM\WebSphere\AppServer

12. Restart your machine if a prompt displays that directs you to restart.

This procedure results in having a clean system. You can reinstall into the same directories now. A clean
system has no trace of a previously deleted installation.
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Appendix B. Troubleshooting installation

This topic describes troubleshooting the installation of the WebSphere Application Server - Express
product.

Use this topic after installing your WebSphere Application Server product.

A successful installation of a WebSphere Application Server product installs the core product files and
creates the server1 Application Server.

If an installation is not successful, use this troubleshooting information to correct the problems.

The install_root/1ogs/1og.txt file and the install_root/1ogs/wasprofile/wasprofile create default.log
file record installation status.

The installer program records the following indicators of success in the logs:
* INSTCONFSUCCESS

* INSTCONFPARTIALSUCCESS

* INSTCONFFAILED

If the error happens early in the installation, look for the Tog.txt file in the system temporary area. The
installation program copies the log from the temporary area to the 1ogs directory at the end of the
installation.

Perform the following procedure to troubleshoot an installation.
1. Use the First steps console to run the installation verification test (IVT).

The installation wizard can start the First steps console at the end of installation. Select Installation
verification. Check the install_root/profiles/default/logs/ivt.Tog file for a summary of test results.
Correct any errors and retry. If you performed a custom installation, the location of the default profile
is in the profiles installation root directory that you selected during the installation.

If you created another profile using the Profile creation wizard or the wasprofile command, the
location of the profile and the name of the profile are different than what is displayed in the example.

2. Check the installation log files for errors after installing:

During installation, a single entry in the install_root/1ogs/10g.txt file points to the temporary log file,
either $TEMP%\1o0g.txt on Windows platforms, or /tmp/Tog.txt on Linux and UNIX platforms. The
installation program copies the file from the temporary directory to the install_root/10gs/10g.txt
location at the end of the installation.

If the installation fails and the install_root/10gs/10g.txt has only this one pointer to the temporary
directory, open the Tog.txt file in the temporary directory. The log might have clues to the installation
failure. Uninstalling creates the install_root/1ogs/uninstlog.txt file.

Log more information when InstallShield for MultiPlatforms (ISMP) cannot start the Installation
wizard.

Verify or troubleshoot the installation if the install_root/1ogs/10g.txt file or the
profiles_install_root/profile_name/logs/pctLog.txt file does not contain a record of any problems,
but problems exist. If the profiles_install_root/profile_name directory exists, the pctlLog.txt file is in
the 1ogs directory. If the error happens early in the installation, look for the logs in the system
temporary area. The installation program copies the logs from the system temporary area to the 1ogs
directory at the end of the installation.

If the profiles_install_root/profile_name directory does not exist, the pctLog.txt file is in the
USER_HOME directory and is named .$“pctLog.txt. Issue the env command to display the
USER_HOME directory on Linux and UNIX systems. See the environment variable settings on
Windows system to display the value of the variable.
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Certain events can prevent ISMP from starting the Installation wizard. Such an event is not enough
disk space to launch the Installation wizard, for example. If your installation fails and there is no
information in the installation logs, use the -log parameter to record entries for events that cause the
ISMP program to fail to start the installation wizard. The syntax of the install command for logging
such events is:

install -options fully qualified options_response_file_name
-silent
-log # !fully qualified log _file name G@ALL

The following example is for AIX systems:

install -options "/usr/IBM/WebSphere/silentFiles/myresponsefile.txt"
-silent -log # !/usr/IBM/WebSphere/myOptionFiles/log.txt @ALL

The following example is for Linux systems, HP-UX systems, and Solaris systems:

install -options "/opt/IBM/WebSphere/silentFiles/myresponsefile.txt"
-silent -log # !/opt/IBM/WebSphere/myOptionFiles/log.txt @ALL

The following example is for Windows systems:

install.exe -options "C:\IBM\WebSphere\silentFiles\myresponsefile.txt"
-silent -log # !C:\IBM\WebSphere\silentFiles\log.txt G@ALL

Log file names and locations

The following information shows the log files for all of the installable components on the product disc.
Log files for IBM HTTP Server

The following table shows the installation log locations when installing IBM HTTP Server V6.

Table 17. Installation log locations when installing IBM HTTP Server

Windows system log path name Linux and UNIX operating system log path name

m/usr/ IBMHttpServer/ log.txt
m/usr/ IBMHttpServer/ ihsv6_install.log

/opt/ IBMHttpServer/ log.txt
C:\Program Files\ IBM HTTP Server\

log.txt /opt/ IBMHttpServer/ ihsv6_install.log
C:\Program Files\ IBM HTTP Server\
ihsv6_install.log m /opt/ IBMHttpServer/ log.txt

m /opt/ IBMHttpServer/ ihsv6_install.log

m/opt/ IBMHttpServer/ log.txt
m/opt/ IBMHttpServer/ ihsv6_install.log

Log files for Application Client for WebSphere Application Server

The following table shows the installation log locations when installing the application clients for
Version 6.
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Table 18. Installation log locations when installing the Application Clients for WebSphere Application Server

Windows system log path name

Linux and UNIX operating system log path name

m C:\Program Files\ IBM\

WebSphere\ AppClient\ Togs\
WAS.Client.install.Tlog

musr/ IBM/ WebSphere/ AppClient/ Togs/

WAS.Client.install.log

/opt/ IBM/ WebSphere/ AppClient/ logs/

WAS.Client.install.log

m/opt/ IBM/ WebSphere/ AppClient/ Tlogs/
WAS.Client.install.log

m/opt/ IBM/ WebSphere/ AppClient/ Tlogs/
WAS.Client.install.log

Log files for WebSphere Application Server products: The following table shows the installation
logs, content, and indicators of success and failure for WebSphere Application Server products for

Version 6.

Table 19. Installation logs for WebSphere Application Server products

Log

Content

Indicators

install_root / logs / log.txt

Logs all installation events

INSTCONFFAIL
Total installation failure.

INSTCONFSUCCESS
Successful installation.

INSTCONFPARTIALSUCCESS
Installation errors occurred but the
installation is still usable. Additional
information identifies the errors.

install_root / logs /
wasprofile / wasprofile _
create _ profile_name.log

Traces all events that occur
during the creation of the
named profile

Created when using the Profile
creation wizard or the
wasprofile command

INSTCONFFAIL
Total profile creation failure.

INSTCONFSUCCESS
Successful profile creation.

INSTCONFPARTIALSUCCESS
Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

install_root / logs /
wasprofile / wasprofile _
delete _ profile_name.log

Traces all events that occur
during the deletion of the
named profile

Created when using the Profile
creation wizard or the
wasprofile command

INSTCONFFAIL
Total profile deletion failure.

INSTCONFSUCCESS
Successful profile deletion.

INSTCONFPARTIALSUCCESS
Profile deletion errors occurred but the
profile is still deleted. Additional
information identifies the errors.
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Table 19. Installation logs for WebSphere Application Server products (continued)

Log Content Indicators
install_root / profiles / Logs all profile creation events
profile_name / logs / that occur when using the Profile INSTCONI_F::?IL il tion fail
pctLog.txt creation wizard otal protile creation failure.
INSTCONFSUCCESS
Successful profile creation.
INSTCONFPARTIALSUCCESS

Profile creation errors occurred but the
profile is still functional. Additional
information identifies the errors.

Description of the wasprofile_create_profile_name.log file

The wasprofile_create profile _name.log file is an XML file that contains a record of the events that
occur during the creation of the last profile.

In addition to the date tag at the beginning of the file, other tags of interest in the log files include the
sequence tag, the level tag, the method tag, and the message tag:

* The sequence tag records the sequence of events that occur during the creation of the profile.
* The level tag is an early indicator of event status:

INFO Indicates a normal event.

WARNING
Indicates an event that occurred with errors that do not prevent the creation of the profile.

ERROR
Indicates an event that prevents the creation of the profile.

* The method tag indicates the name of the routine that recorded the event.
* The message tag describes the event and contains any data returned by the method.
The following stanza is an example of how an event is documented in each log file:

<record>
<date>2004-09-08T11:51:39</date>
<mi11is>1094658699225</millis>
<sequence>0</sequence>
<logger>com.ibm.ws.profile.WSProfile</Togger>
<level>INFO</level>
<class>com.ibm.ws.profile.WSProfile</class>
<method>getRegistryFile</method>
<thread>10</thread>
<message>Returning registry file at:

C:\NDV6\IBM\WebSphere\AppServer\properties\profileRegistry.xml

</message>

</record>

Log files created during the creation of the Application Server profile

In addition to the logs created within the core product files, the following logs are created in the
install_root/profiles/default/1ogs directory when the Profile creation wizard or the wasprofile
command creates an Application Server profile:

activity.log
Compiled activity log from various installation activities

amjrte_config.log
Tivoli Access Manager configuration log for its Java Runtime Environment

collect_metadata.log
Collects metadata information about managed objects in the system to evaluate and prevent
potential installation conflicts
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createDefaultServer.log
A log from wsadmin recording the creation of the server1 process in the default profile

createshortcutforprofile.log
Windows tool log for creating menu entries and shortcuts

defaultapp_config.log
JACL script log from configuring default application resources

defaultapp_deploy.log
Application DefaultApplication installation log

Node_name Service.log
Start and stop events for server1

filetransfer_config.log
Application filetransfer installation log

hamanager_config.log
Configuration log for the high availability application

ivt_config.log
Application ivtApp installation log

mejb_config.log
Application ManagementEJB installation log

pctLog.txt

Log created when using the Profile creation wizard to create a profile. This log is not created

when using the wasprofile command directly.

query_config.log
Application Query installation log

samples_config.log
Configuration log for the PlantsByWebSphere Samples application

samples_install.log
Installation log for the SamplesGallery and PlantsByWebSphere Samples applications

scheduler.cal_config.log
Application SchedulerCalendars installation log

SIBDefineChains.log
Creation log for service integration bus endpoints, inbound channels and channel chains,
outbound thread pool, and outbound channel and channel chains

SIBDeployRA.log
Deployment log for the service integration bus function

webui_config.log
Application administrative console installation log

winservice_config.log
Node_name service log for the Windows service created for server1

The following logs are created in the install_root/profiles/default/logs/serverl directory:

startServer.log
Log of start server events

stopServer.log
Log of stop server events

SystemErr.log
Record system errors
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SystemOut.log
Log of all activity within the system

trace.log
Log of all traced events within the system
The following logs are created in the install_root/profiles/default/logs/ffdc directory:

serveri_exception.log
First failure data capture log for server1 errors

server1_numeric_identifier.txt
Any first failure data capture logs
3. Verify that no files exist in the install_root/classes directory.

IBM Support sometimes queues work for customers and provides test or debugging fixes. A common
location for the fixes is in the install_root/classes directory.

By default, the install_root/classes directory is picked up first in the WebSphere Application Server
class path to let it override other classes.

Putting a fix in the directory lets you verify that the fix does indeed solve your problem. After verifying
that the fix solves the problem, you are supposed to delete the fix from the install_root/classes
directory to return the system to a working state.

If you do not remove such fixes from the install_root/classes directory, you can experience errors.

4. Uninstall the product, if possible, and reinstall after turning on tracing if the error logs do not contain
enough information to determine the cause of the problem.
* Report the stdout and stderr logs to the console window, by adding the -is:javaconsole
parameter to the install command:

install -is:javaconsole

Capture the stream to a file with the following commands:
install -is:javaconsole > capturefileName.txt 2>&1
install.exe -is:javaconsole

Capture the stream to a file with the following commands:

install -is:javaconsole > drive:\capturefileName.txt
» Capture additional information to a log of your choice with the -is:1og file _name option.
e Turn on additional installation logging by passing the -W
Setup.product.install.logAlTEvents="true” parameter to the install command:

install -W Setup.product.install.logAl1Events="true"
install -W Setup.product.install.logAl1Events="true"
5. Use the First steps console or the command line method to start the Application Server.
Start the First steps console for a particular node:

. minstall_root/proﬁ1es/profiZe_name/ﬁrststeps/ﬁrststeps.sh

. m install_root\profiles\profile name\firststeps\firststeps.bat

Start the server from the command line:

a. Change directories to the install_root/profiles/profile_name/bin directory in the profile.
b. Start the server process.

. -IElE- ./startServer.sh serverl
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. m startServer serverl

6. Verify whether the server starts and loads properly by looking for a running Java process and the
Open for e-business message in the SystemOut.log and SystemErr.1og files.

If no Java process exists or if the message does not appear, examine the same logs for any
miscellaneous errors. Correct any errors and retry.

You can find the SystemOut.log and SystemErr.Tog files in the
install_root/profiles/default/logs/serverl (Linux and UNIX platforms) or
install_rootf\profiles\default\logs\serverl (Windows platforms) directory in an Application Server
profile.

7. Refer to the plug-in configuration documentation, if you have installed plug-ins and the Web server
does not come up properly.

8. Start the Snoop servlet to verify the ability of the Web server to retrieve an application from the
Application Server.

Test your environment by starting your Application Server, your Web server, and using the snoop
servlet with an IP address.

a. Start the Application Server.

Change directories to the install_root/profiles/profile_name/bin directory and run the
startServer command:

. -EE- ./startServer.sh serverl
. MStartServer serverl

b. Start the IBM HTTP Server or the Web server that you are using.

Use a command window to change the directory to the IBM HTTP Server installed image, or to
the installed image of your Web server. Issue the appropriate command to start the Web server,
such as these commands for IBM HTTP Server:

To start the IBM HTTP Server from the command line:
Access the apache and apachectl commands in the IBMHttpServer/bin directory.

. -EE- ./apachectl start
. Mapache

c. Point your browser to http://1ocalhost:9080/snoop to test the internal HTTP transport provided
by the Application Server. Point your browser to http://Host _name_of Web server _machine/snoop
to test the Web server plug-in.

The HTTP Transport port is 9080 by default and must be unique for every profile. The port is
associated with a virtual host named default_host, which is configured to host the installed
DefaultApplication and any installed Samples. The snoop servlet is part of the DefaultApplication.
Change the port to match your actual HTTP Transport port.

d. Verify that snoop is running.
Either Web address should display the Snoop Servlet - Request/Client Information page.

e. Remote IBM HTTP Server only: Verify that the automatic propagation function can work on a
remote IBM HTTP Server by using the following steps. This procedure is not necessary for local
Web servers.

1) Run the htpasswd command on the Web server machine to create the administrative user ID
and password information.

2) Use the administrative console of the Application Server to enter the User ID and password
information that you created for the administrative user of IBM HTTP Server. Go to Servers >
Web server > Web_server_definition > Remote Web server administration.

9. Start the WebSphere Application Server administrative console.
a. Start the Application Server.
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b. Point your browser to http://localhost:9060/ibm/console.

The HTTP Admin port is 9060 by default and must be unique for the administrative console of
each stand-alone Application Server. The port is associated with a virtual host named admin_host,
which is configured to host the administrative console, which is installed by default as a system
application. Change the port to match your actual HTTP Admin port.

If you have problems accessing the administrative console after installation, check the
installAdminConsole.log file for a failure indication. Clean up the system temporary directory and
reinstall the administrative console using the wsadmin scripting facility.

c. Type any ID and click OK at the administrative console window.

The server starts. The administrative console starts. You can access the administrative console
through the browser. The administrative console accepts your login.

10. Resolve any IP address caching problems.

By default, the Java 2 SDK caches the IP address for the domain name service (DNS) naming
lookup. After resolving the host name successfully, the IP address stays in the cache. By default, the
cache entry remains forever.

This default IP caching mechanism can cause problems, as described in the following problem
scenarios.

Problem scenario 1

Suppose the Application Server at host1.ibm.com has an initial IP address of 1.2.3.4. When a client at
host2.ibm.com conducts a DNS lookup of host1.ibm.com, the client stores the 1.2.3.4 address in the
cache. Subsequent DNS name lookups return the cached value, 1.2.3.4.

The cached value is not a problem until the host1.ibm.com IP address changes, to 5.6.7.8, for
example. The client at host2.ibm.com does not retrieve the current IP address, but always retrieves
the previous address from the cache.

If this scenario occurs, the client cannot reach host1.ibm.com unless you stop and restart the client
process.

Problem scenario 2

Suppose the Application Server at host1.ibm.com has an initial IP address of 1.2.4.5. Although the IP
address of the application server does not change, a network outage can record an exception code
as the IP address in the cache, where it remains until the client is restarted on a working network.

For example, if the client at host2.ibm.com disconnects from the network because of an unplugged
cable, the disconnected lookup of the Application Server at host1.ibm.com fails. The failure causes
the IBM Developer Kit to put the special exception code entry into the IP address cache.

Subsequent DNS name lookups return the exception code, which is java.net.UnknownHostException.
Using the IP address cache setting

You can always stop and restart a deployment manager process to refresh its IP address cache.
However, this process might be expensive or inappropriate.

The networkaddress.cache.ttl (public, JDK1.4) and sun.net.inetaddr.ttl (private, JDK1.3) parameters
control IP caching. The value is an integer that specifies the number of seconds to cache IP
addresses. The default value, -1, specifies to cache forever. A value of zero (0) is a specification to
never cache.

Using a zero (0) value is not recommended for normal operation. If you do not anticipate network
outages or changes in IP addresses, use the cache forever setting. The never caching setting
introduces the potential for DNS spoofing attacks.

For more information about the Java 2 SDK

The Java 2 SDK, Standard Edition 1.4 Web site at
[ttp://java.sun.com/j2se/1.4/docs/guide/net/properties.html| describes the private sun.net.inetaddr.ttl
property, which works in both Java 2 SDK, Standard Edition 1.3 (WebSphere Application Server
V5.0.0, V5.0.1, and V5.0.2) and Java 2 SDK, Standard Edition 1.4 (WebSphere Application Server
V5.1 and V6).
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This procedure results in using some simple procedures to debug errors that might be occurring in the
installation.

The [‘Troubleshooting installation problems” on page 308| contains more detailed debugging and reporting
instructions. See [“Installation component troubleshooting tips” on page 307|for more information about
troubleshooting the installation.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering the information that you need to resolve a
problem. Before opening a PMR, see the |IBM Support page.

Troubleshooting Web server plug-ins installation and removal

This topic describes troubleshooting the installation and removal of the Web server plug-ins for
WebSphere Application Server.

Use this procedure if you are having problems installing or uninstalling the Web server plug-ins for
WebSphere Application Server. Otherwise:

« If you are trying to install, see [‘Installing Web server plug-ins” on page 141

» If you are trying to uninstall the Web server plug-ins for WebSphere Application Server, see[‘Uninstalling
[the Web server plug-ins for WebSphere Application Server’ on page 183

« If you are trying to uninstall the WebSphere Application Server, see[Appendix A, “Uninstalling the|
[product,” on page 271

This procedure is divided into three parts:

+ [Troubleshooting plug-ins installation|

« [Troubleshooting plug-ins removall

+ [Miscellaneous messages, tips, and hints|

Log files for Web server plug-ins for WebSphere Application Server

The following log files are in the plug-ins plugins_install_root/logs/install directory:

log.txt
Records all of the ISMP events that occur during the installation. The log also describes whether
the installation was local or remote. Messages at the end of the file indicate whether manual
configuration steps are required to complete the installation.

masterConfigurationLog.txt
Records all of the configuration events that occur during the installation.

installGSKit.log
Records events that occur during the installation of the GSKit code.

install Web_serverPlugin.log
Records events that occur during the installation of a Web server plug-in. The name of the file
varies to reflect the Web server:

e instalTAPACHEPTugin.log
e instalTIHSPTugin.log
* installIISPTugin.log
* instalTSUNONEPTugin.log
* instal TDOMINOPlugin.Tog
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configure_Web_server_webserver.log

Records events that occur during the configuration of a Web server plug-in. The name of the file
varies to reflect the Web server:

* configure APACHE webserver.log
e configure_IHS_webserver.log
e configure IIS webserver.log
» configure_SUNONE_webserver.Tog
* configure DOMINO webserver.log

* Troubleshooting plug-ins installation

1.

300

Does the installation image have the proper directories?

The following directories are required for a successful installation:
— parent_directory/plugin

— parent_directory/JDK

— parent_directory/GSKit

Remember: The parent_directory variable is the directory where you can unpack the images. All of
the directories in the list must have the same parent directory.

If the directories are not present, or if the directories are empty, download a new installation image
or discuss the product CD that you are using with someone who is knowledgeable about its
creation. The IBM product discs are certified.

Reinstall using the IBM product disc.
Is there any sign that the installation occurred?

If not, look for the temporaryPluginInstalllog.txt file in the temporary directory of the user who
installed the plug-ins.

For example, the /tmp/temporaryPluginInstalllog.txt file might exist if the root user installed the
plug-ins on a Linux or UNIX system.

This log is of particular interest after a silent installation. Suppose that the silent installation
responsefile.txt file has incorrect entries. The installation cannot succeed. The cause of the
problem is recorded in the temporaryPluginInstalllog.txt file.

If the responsefile.txt does not pass validation, the failure is logged as an INSTCONFFAILED
entry. The installation does not occur. Correct the failure and run the silent installation again.

See [‘responsefile.txt” on page 173|for information about editing the file properly. You might have to
start with a new copy of the file that is on the product disc if you cannot get your copy to work.

Does the installation result in a INSTCONFPARTIALSUCCESS status?
a. Look for errors in the Tog.txt file.

b. Look for an entry in the Tog.txt file that shows the location of the masterConfigurationlLog.txt
file.

c. Edit the masterConfigurationLog.txt file.

d. Starting at the end of the file, scan towards the front of the file looking for configuration scripts
that could not run.

For example, the following stanza shows a configuration script that could not run:

<record>

<date>2004-10-08T10:31:43</date>

<mil11is>1097245903200</mil1lis>

<sequence>189</sequence>
<logger>com.ibm.ws.install.configmanager.ConfigManager</logger>
<level>INFO</level>
<class>com.ibm.ws.install.configmanager.ConfigManager</class>
<method>dumpNonFatalFailedActionsInfoToLogFile</method>
<thread>10</thread>
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<message>This action failed to execute:
C:\PTugins\properties\version\install\plugin\6.0.0.0\
config\full\instal1\99SGSKitInstall.ant</message>

</record>

e. A configuration script that fails to run is likely the cause of a partially successful installation
status. To debug the example, look at the instal1GSKit.log, which is the log file for GSKit. Look
for signs of a failed installation to determine if you can correct the problem.

Configuration script log files and recovery procedures: The following configuration scripts run
during the configuration of supported Web servers.

Configuration script:98SConfigurelebserverDefinition.ant

Log file to investigate for error

Recovery

configurelleb_server type webserver.log

For example, the file might be named:

configure_IHS_webserver.log

Logs the Web server definition creation.

1. If the Web server definition partially exists, delete the Web
server definition.

2. Run the Web server definition script manually. The Web server
definition is referenced in the script. The script is in the
plug-ins_install_root/bin directory, with a name similar to
the following convention:

m configureleb_server_definition_name.sh
. configureleb_server_definition_name.bat

Configuration script:99SBootStrapPluginsSunOne.ant

Log file to investigate for error

Recovery

installSunOnePlugin.log

Investigate the log file to determine what failed:

1.

If the error is due to plugin-cfg.xml not
existing, investigate why this file is not
present.

If the error is due to the Web server definition
creation failing, address this as discussed
under the
98SConfigurelWebserverDefinition.ant
description.

If the Web server configuration files do not
update, investigate the files to verify that they
exist and that the file permissions are correct.

* You can manually configure the Web server by following the
procedure documented in|“Configuring the Sun Java System|
[Web Server’ on page 195.|

* You can rerun the Plug-ins installation wizard. Select the existing
plug-ins installation root directory. Doing so results in the Web
server being configured to use the existing binaries.
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Configuration script:99SBootStrapPluginsDomino6.ant

Log file to investigate for error

Recovery

installDomino6Plugin.log

Investigate the log file to determine what failed:

1.

If the error is due to plugin-cfg.xml not
existing, investigate why this file is not
present.

If the error is due to the Web server definition
creation failing, address this as discussed
under the
98SConfigurelWebserverDefinition.ant
description.

If the Web server configuration files do not
update, investigate the files to verify that they
exist and that the file permissions are correct.

* You can manually configure the Web server by following the
procedure documented in [‘Configuring Lotus Domino” on page]

* You can rerun the Plug-ins installation wizard. Select the
existing plug-ins installation root directory. Doing so results in
the Web server being configured to use the existing binaries.

Configuration script:99SBootStrapPluginsDomino5.ant

Log file to investigate for error

Recovery

installDomino5Plugin.log

Investigate the log file to determine what failed:

1.

If the error is due to plugin-cfg.xml not
existing, investigate why this file is not
present.

If the error is due to the Web server definition
creation failing, address this as discussed
under the
98SConfigurelWebserverDefinition.ant
description.

If the Web server configuration files do not

update, investigate the files to verify that they
exist and that the file permissions are correct.

* You can manually configure the Web server by following the
procedure documented in [‘Configuring Lotus Domino” on page|

* You can rerun the Plug-ins installation wizard. Select the
existing plug-ins installation root directory. Doing so results in
the Web server being configured to use the existing binaries.

Configuration script:99SBootStrapPluginsIIS6.ant

Log file to investigate for error

Recovery

install1IIS6PTugin.Tlog

Investigate the log file to determine what failed:

* You can manually configure the Web server by following the
procedure documented in [‘Configuring Microsoft Internef]
[Information Services (I1S)” on page 193

1o t.he_ erroris dge 1o p]ugm_—cfg._xm] not * You can rerun the Plug-ins installation wizard. Select the
existing, investigate why this file is not existing plug-ins installation root directory. Doing so results in
present. the Web server being configured to use the existing binaries.

2. If the error is due to the Web server definition
creation failing, address this as discussed
under the
98SConfigurelWebserverDefinition.ant
description.

3. Start the Internet Information Services (IIS)
application and investigate the 1IS
configuration.
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Configuration script:99SBootStrapPluginsIIS5.ant

Log file to investigate for error

Recovery

installIIS5PTugin.Tog

Investigate the log file to determine what failed:

1.

If the error is due to plugin-cfg.xml not
existing, investigate why this file is not
present.

If the error is due to the Web server definition
creation failing, address this as discussed
under the
98SConfigurelWebserverDefinition.ant
description.

Start the IIS application and investigate the IIS
configuration.

* You can manually configure the Web server by following the
procedure that is documented in [‘Configuring Microsoft Internet]

|Information Services (I1S)”

on page 193

* You can rerun the Plug-ins installation wizard. Select the
existing plug-ins installation root directory. Doing so results in
the Web server being configured to use the existing binaries.

Configuration script:99SBootStrapPluginsApache.ant

Log file to investigate for error

Recovery

installApachePTugin.log

Investigate the log file to determine what failed:

1.

If the error is due to plugin-cfg.xml not
existing, investigate why this file is not
present.

If the error is due to the Web server definition
creation failing, address this as discussed
under the
98SConfigurelWebserverDefinition.ant
description.

If the Web server configuration files do not
update, investigate the files to verify that they
exist and that the file permissions are correct.

* You can manually configure the Web server by following the
procedure documented in [‘Configuring Apache HTTP Server

[V2.0” on page 185

* You can rerun the Plug-ins installation wizard. Select the
existing plug-ins installation root directory. Doing so results in
the Web server being configured to use the existing binaries.

Configuration script: 99SBootStrapPTuginsIHS.ant

Log file to investigate for error

Recovery

instal1IHSPlugin.log

Investigate the log file to determine what failed:

1.

If the error is due to plugin-cfg.xml not
existing, investigate why this file is not
present.

If the error is due to the Web server definition
creation failing, address this as discussed
under the
98SConfigureWebserverDefinition.ant
description.

If the Web server configuration files do not

update, investigate the files to verify that they
exist and that the file permissions are correct.

* You can manually configure the Web server by foIIowing_’lthe

procedure documented in

‘Configuring IBM HTTP Serve

[Version 6.0” on page 192.

* You can rerun the Plug-ins installation wizard. Select the
existing plug-ins installation root directory. Doing so results in
the Web server being configured to use the existing binaries.
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Configuration script:99SGSKitInstall.ant

Log file to investigate for error

Recovery

instal1GSKit.log

Investigate the log file to determine what failed:

1. In cases where the CD layout is not correct,
then the gskit installer program cannot be
found. GSKit fails to install.

2. In cases where GSKit is already installed, the
installation might incorrectly report a failure. If
the logs show that an installation already
existed, you can safely ignore the error.

Manually install GSKit by running the installer program. The
instal1GSKit.1og file shows the installer program that runs to
install GSKit.

m Run the following command from the

/cdrom/GSKit directory:
e /cdrom/GSKit/gskit.sh

m Run the following command from the "E:\GSKit\
directory, assuming the E drive is the CD-ROM drive:

» "E:\GSKit\Setup.exe” WASPLUGIN60_041008085014
"C:\Program Files" -s -z -f1"E:\\GSKit\setup.iss"

m Configuration script: 99SSolarisGSKitInstall4.ant

Log file to investigate for error

Recovery

On Solaris, the installation is logged to the
install1GSKit.log file.

Investigate the log file to determine what failed:

1. In cases where the CD layout is not correct,
then the gskit installer program cannot be
found. GSKit fails to install.

2. In cases where GSKit is already installed, the
installation might incorrectly report a failure. If
the logs show that an installation already
existed, you can safely ignore the error.

Manually install GSKit by running the installer program.

m Run the following command from the /cdrom/GSKit
directory:

e /cdrom/GSKit/gskit4.sh

m Configuration script:90SCreateWinRegPlugin.ant

Log file to investigate for error

Recovery

This script does not have an associated log file.

The script creates the Windows registry entry for
the Web server plug-ins for WebSphere
Application Server.

HKEY_LOCAL_MACHINE > Software > IBM >
Web server Plug-ins for IBM WebSphere
Application Server > 6.0.0.0

Add the HKEY_LOCAL_MACHINE > Software > IBM > Web
server Plug-ins for IBM WebSphere Application Server > 6.0.0.0
key manually with the actual value of the installation location.

Set the following registry values under this key:
Name: plug-ins_install_root

* Type: REG_SZ

» Data: plug-ins_install_root

Configuration script:99SModi fySetupCmdLine.ant

Log file to investigate for error

Recovery

This script does not have an associated log file.

Investigate the plug-
ins_install_root/bin/setupCmdLine.sh script to
verify that the PLUGIN_HOME variable is set to
the Web server plug-ins installation root directory.

Verify that file permissions are 755 (rwxr-xr-x) on
Linux and UNIX systems.

* You can edit the setupCmdLine file, replacing $(PLUGIN_HOME)
with the location to the plug-ins installation root directory.

» Change the file permissions to 755. Issue the following
command from the plug-ins_install_root/bin directory:

chmod 755 setupCmdLine.sh
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1.

If you do not find the cause of the problem, open the plug-ins_install_root/10gs/Web_server_name
directory. The directory is empty until the Web server loads the plug-in and errors occur. The plug-in
then creates the http _plugin.log file to record the errors. If no errors occur, the directory is empty.
Examine any relevant files for error entries. Correct any errors and reinstall.

Does the installation result in a INSTCONFFAILED status?

© o0 oo

This is a serious failure of the installation.
Analyze the log files to determine the problem.
Uninstall the plug-ins.

Delete the plug-ins installation root directory.
Install the plug-ins again.

Do errors occur when you start the snoop application?
See ['Start the Snoop servlet” in the installation troubleshooting file.|

If errors occur, look at the plug-ins_install_root/1ogs/Web_server_name/http plugin.log file for
causes.

Also investigate the WebSphere Application Server installation logs and the logs for your supported
Web server.

-mE. Do you have the correct file permissions for the

configure Web_server_definition_name script?

On Linux and UNIX systems, copying the configurelleb_server definition_name.sh script from one
operating system, such as AlX, to another, such as HP-UX, can cause the file permissions of the
script to be invalid for running the script.

Verify that file permissions are 755 (rwxr-xr-x) on Linux and UNIX systems.
* Troubleshooting plug-ins removal

Does the plug-ins_install_root/10gs/uninstall directory have any log files?
If log files exist, examine them, correct the errors, and reinstall.

Is there any sign that the removal occurred?

If not, look for the temporaryPTuginUnInstalllLog.txt file in the temporary directory of the user who
installed the plug-ins.

For example, the /tmp/temporaryPluginUnInstalllog.txt file might exist if the root user uninstalled
the plug-ins on a Linux or UNIX system.

Does the installation result in a INSTCONFPARTIALSUCCESS status?

a.
b.

Look for errors in the 1og.txt file.

Look for an entry in the log.txt file that shows the location of the masterConfigurationLog.txt
file.

Edit the masterConfigurationLog.txt file.

Starting at the end of the file, scan towards the front of the file looking for configuration scripts
that could not run.

For example, the following stanza shows a configuration script that could not run:

<record>

<date>2004-10-08T10:31:43</date>

<mi11is>1097245903200</mi11is>

<sequence>189</sequence>
<logger>com.ibm.ws.install.configmanager.ConfigManager</logger>
<level>INFO</level>
<class>com.ibm.ws.install.configmanager.ConfigManager</class>
<method>dumpNonFatalFailedActionsInfoToLogFile</method>
<thread>10</thread>
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<message>This action failed to execute:
C:\PTugins\properties\version\install\plugin\6.0.0.0\
config\full\uninstal1\99SGSKitUnInstall.ant</message>
</record>
e. A script that fails to run is likely the cause of a partially successful installation status. To debug
our example, look at the instal1GSKit.Tog, which is the log file for GSKit. Look for signs of a
failed removal to determine if you can correct the problem.

Configuration script Log file to investigate for error

99SBootStrapPluginsSunOneUninstalluniquelD.ant uninstalliWeb_server_typePlugin.log

99SBootStrapPluginsDomino6UninstalluniquelD.ant For example, the file might be named:

99SBootStrapPluginsDomino5UninstalluniquelD.ant uninstal1IHSPlugin.log

99SBootStrapPluginsIIS6UninstalluniquelD.ant Logs the Web server deconfiguration events for the Web
server.

99SBootStrapPluginsIIS5UninstalluniquelD.ant
99SBootStrapPluginsApacheUninstalluniquelD.ant

99SBootStrapPluginsIHSUninstalluniquelD.ant

99SGSKitUnInstall.ant uninstallGSKit.log

On Windows only, the Web server plugins GSKit key will
be unregistered. GSKit is uninstalled if no other product is
registered to use GSKit.

On Linux and UNIX; it is your responsibility to uninstall
GSKit when no other products are using it.

90SDeleteWinRegPlugin.ant This script does not have an associated log file.

The script deletes the Windows registry entry for the Web
server plug-ins for WebSphere Application Server.

HKEY_LOCAL_MACHINE > Software > IBM > Web
server Plug-ins for IBM WebSphere Application Server >
6.0.0.0

4. Did the uninstall procedure fail?

If the uninstall failed in any way, follow the manual uninstall steps to verify the system is clean and if
necessary, remove Web server plug-in entries.

* Miscellaneous messages, tips and hints

Option Description
SAFE_BROWSER_EXCEPTION_CAUGHT This SAFE_BROWSER_EXCEPTION_CAUGHT error
means that:

» If you do not have a browser, this error is thrown and
the roadmap is not launched when it is selected during
the installation of the plug-ins.

. -EE. If you have a supported

browser that is not the Konqueror browser, the
roadmap is launched. This message is thrown with the
supported browser when it is not the Konqueror
browser. You can safely ignore this exception and open
the roadmap in a supported browser.
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Option Description

m number.tmp.sorted m A limitation in ISMP does not remove

temporary working files in the / root directory on Solaris
operating systems. You can safely ignore or delete the
files that follow this naming convention.

This procedure results in troubleshooting the installation or removal of the Web server plug-ins for
WebSphere Application Server.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering the information that you need to resolve a
problem. Before opening a PMR, see the |IBM Suppor page.

Installation component troubleshooting tips

If you are having problems installing your WebSphere Application Server product, follow these steps to
resolve the problem:
+ If possible, follow the steps that are outlined in [Appendix B, “Troubleshooting installation,” on page 291
» Browse the relevant log files for clues:
— The main installation log file: install _root/logs/log.txt.
— The Profile creation wizard log file: install_root/profiles/profile_name/logs/pctLog.txt when
you create a profile with the Profile creation wizard.
— The profile creation log for creating the profile:
install_root/logs/wasprofile/wasprofile create profile name.log.
— IBM HTTP Server log: ihs_install _root/log.txt and ihs_install root/ihsv6_install.log.
— The log files produced when the default application .ear file is installed are:
install _root/profiles/profile_name/1ogs/defaultapp _config.log and
install_root/profiles/profile name/1ogs/defaultapp _deploy.1log.
— Other logs for other applications for a profile in the install _root/profiles/profile_name/10ogs
directory.
» Verify that you have installed the correct level of dependent software, such as operating system version
and revision level, by reviewing |http://www.ibm.com/software/webservers/appserv/doc/latest/prereq.htmil

If none of these steps solves the problem:

Check to see if the problem is identified and documented using the links in [Diagnosing and fixing
[oroblems: Resources for learning.|

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem,|contact IBM support| for further assistance.

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Support] page.
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Troubleshooting installation problems

Select the problem that you are having with the WebSphere Application Server installation:
« | need information about [Troubleshooting Web server plug-ins installation and removal,
“Installation either completes with errors or warnings, or hangs.”|

 There are ['Messages issued during installation and profile creation” on page 309|

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, see IAppendix B, “Troubleshooting installation,” on page 291 |

If you did not find your problem listed, [contact IBM support)

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |IBM Suppori] page.

Installation either completes with errors or warnings, or hangs

Errors while installing the product

If the WebSphere Application Server installation program indicates that errors were encountered while

installing the product:

» Browse the log files in the install_root/10gs directory and in the
install_root/profiles/profile_name/1ogs directory for clues. Pay particular attention to the main
installation log file, Tog.txt.

* Check the command prompt from which the installation panel was launched for error messages.

* Look up any error or warning messages in the message reference table by selecting the "Reference”
view in the information center navigation and expanding the "Messages” heading.

 Review[Appendix B, “Troubleshooting installation,” on page 291 |

Problems installing or starting Apache or IBM HTTP Server

What kind of error are you seeing?

- [’Failed to initialize GSK environment’| error appears when trying to start Apache

« [IBM HTTP Server (IHS) on Windows does not start,| error WSADuplicateSocket failed for socket
appears in error.log.

If you did not find your problem listed, |contact IBM support

"Failed to initialize GSK environment" error appears when trying to start Apache

The following messages may appear in Apache’s error log file when you attempt to start Apache:

[Wed Aug 27 19:21:59 2003] [error] 1ib_security:
initializeSecurity: Failed to initialize GSK environment

[Wed Aug 27 19:21:59 2003] [error] ws_transport:
transportInitializeSecurity: Failed to initialize security

[Wed Aug 27 19:21:59 2003] [error] ws_server:
serverAddTransport: Failed to initialize security

These messages are most common after building Apache from the downloadable source code and
installing Apache separately from WebSphere Application Server.
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If SSL Transport (HTTPS) is defined in the plugin-cfg.xml file, the plug-in will try to load the Global Security
Kit (GSKit) library libgsk7ssl.so. The error messages appear in the error log file if the level 7 GSKit
libgsk7ssl.so is not installed on your system. To correct these errors, try one of the following:

* Remove the transport section that has "https” in the plugin-cfg.xml file

* Install the level 7 GSKit

Note: The GSKit installs automatically if you install either the IBM HTTP Server (IHS) product or the
Web server plug-ins for WebSphere Application Server from the product disc.

For details and help on the Apache Web server, visit the Apache Web site|http://httpd.apache.org4

IBM HTTP Server on Windows does not start, error WSADuplicateSocket failed for socket appears
in error.log

If your installation of IBM HTTP Server (IHS) on a Windows platform will not start, you may find a
message similar to the following in the log\error.log file of your IHS installation:

[crit] (10045)
The attempted operation is not supported for the type of object referenced:
Parent: WSADuplicateSocket failed for socket nnnn

This problem occurs when IHS is run on a system with a Virtual Private Networking client such as Aventail
Connect. Aventail Connect is a Layered Service Provider (LSP) that intercepts calls between the Winsock
2 APl and Window’s native Winsock 2 implementation. The failure occurs because Aventail Connect does
not implement WASDuplicateSocket(). The interception still takes place when Aventail Connect is shut
down.

To correct the problem try one of the following:
* Reboot the machine, or
* Uninstall the LSP product

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.

Before opening a PMR, see the [IBM Supporf page.

Messages issued during installation and profile creation

What kind of problem are you having?

* [“Error: The input line is too long” on page 310|

* [“Note: The following file systems will be expanded during the installation” on page 311|

« [“The disk space is nn Mbyte less than required. The installation cannot continue.” on page 311|
« [“Specify a different directory or perform a manual uninstall” on page 311|

« [“Error: /usr/opt/ibm/gskta/bin/gsk7ikm: not found” on page 311|

* |“Error writing file = There may not be enough temporary disk space.” on page 311|

« [‘Error: localhost is not a valid host name for remote access” on page 312|

» [YINFO: Created system preferences directory in java.home” on page 313

» |“The installer could not successfully add the product information into the RPM database.” on page 313|
« [‘Error: java.io.lOException: konqueror: not found” on page 313

If you did not find your problem listed, [contact IBM support)
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Error: The input line is too long
This is a profile creation error.

It can occur during installation or when using the Profile creation wizard.
Installation problem

The following error within a log in the install_roof\profiles\default\logs directory indicates that a
wsadmin action has failed to create a profile. The failure is because the length of the file path and the
node name on the command string has caused the entire command to exceed the operating system limit
for command length.

The input line is too long.

mme installation directory path must be no longer than 60 characters.

« Option 1: If the installation failed, reinstall the WebSphere Application Server product using a shorter
directory path and a shorter node name.

The node name field is available during a custom installation. The length of the default node name is
usually short enough. Avoid using a node name that is longer than 10 characters if possible.

» Option 2: If the installation was successful but the ISMPWSProfileLaunchAction failed, use the Profile
creation wizard to create the profile. Use a shorter profile directory path and a shorter node name when
creating the profile.

You can select your own profiles path. It could be C:\profiles, for example.
Verify from the 1og.txt file that the ISMPConfigManagerLaunchAction is successful.

Examine the following messages in the 1og.txt file to determine whether the installation was
successful. If so, you can run the Profile creation wizard to create the default profile.
(date time), Install,

com.ibm.ws.install.ni.ismp.actions.ISMPConfigManagerLaunchAction,
msgl, INSTCONFSUCCESS: Post-installation configuration is successful.

(date time), Install,
com.ibm.ws.install.ni.ismp.actions.ISMPWSProfileLaunchAction,
err, INSTCONFFAILED: Cannot complete required configuration actions
after the installation. The configuration failed. The installation is
not successful. Refer to
C:\Program Files\IBM\WebSphere\AppServerl234567890\1ogs\wasprofile\
wasprofile_create_default.log for more details.

(date time), Install,
com.ibm.ws.install.ni.ismp.actions.ISMPLogFileAction,
msgl, Profile Creation Tool (PCT) is executed.

(date time), Install,
com.ibm.ws.install.ni.ismp.actions.ISMPLogSuccessMessageAction,
msgl, INSTCONFFAILED

Profile creation wizard problem
The following error within a log in the install_roof\profiles\default\logs directory indicates that a
wsadmin action has failed to create a profile. The failure is because the length of the file path, the cell

name, and the node name on the command string has caused the entire command to exceed the
operating system limit for command length.

The input Tine is too long.

MThe profiles directory path must be no longer than 80 characters.
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If your directory path is 80 characters or less and you still have a problem, edit the
install_roof\bin\setupCmdLine.bat file to make it use the Windows subst command. The subst command
maps an entire path to a virtual drive. After editing the file, run the Profile creation wizard again. If
changing the setupCmdLine.bat file does not fix the problem, you can install the WebSphere Application
Server product using a shorter installation path, such as C:\WAS.

See "The input line is too long” section of |Problems starting or using the wsadmin command for a
description of how to edit the setupCmdLine.bat file.

Note: The following file systems will be expanded during the
installation

You can allocate expansion space for directories on AIX. If the Installation wizard does not have enough
space, InstallShield for MultiPlatforms (ISMP) issues a system call for more space that increases the
space allocation dynamically. The message you might see when this occurs for the /usr directory is similar
to the following example:

NOTE: The following file systems will be expanded during the installation:
/usr

The disk space is nn Mbyte less than required. The installation cannot

continue.

If the file system is not dynamically expandable, an insufficient amount of disk space results in a message
that is similar to the following example:

The disk space is 33 Mbyte Tess than required. The installation cannot continue.

Specify a different directory or perform a manual uninstall

This error indicates that you deleted the installation root directory before using the uninstaller program to
remove the product. Now you attempting to reinstall into the same directory.

To correct the problem, perform a manual uninstall. See [‘Uninstalling manually” on page 277| for an
introduction to manually uninstalling. The topic has a link to the manual uninstall procedure for your
operating system.

The warning entry in the $TMP/1og. txt file is:

(Month day, year time), Install,
com.ibm.ws.install.ni.ismp.actions.ISMPWarningDialogAction,
wrn, Specify a different directory or perform a manual uninstall
to remove all packages before reinstalling to the same directory.

Error: /usr/opt/ibm/gskta/bin/gsk7ikm: not found

This error indicates that the x1C.rte 6.0 run-time code has not been installed. You must install the x1C.rte
6.0 run-time code before you install Global Security Kit 7 (GSKit7).

To correct this problem, download the run-time code from the AIX Support site at
|https://techsupport.services.ibm.com/server/aix.fdcl If you have AIX 5.2, you can install the x1C.rte 6.0
run-time code from the AIX 5.2 CD.

For a complete list of installation prerequisites, see
Ihttp://www.ibm.com/software/webservers/appserv/doc/latest/prereq.html.

Error writing file = There may not be enough temporary disk space.

Searching for Java(tm) Virtual Machine...
A suitable JVM could not be found.
Please run the program again using the option
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-is:javahome <JAVA HOME DIR>
Error writing file = There may not be enough temporary disk space.
Try using -is:tempdir to use a temporary directory on a partition with more disk space.

This error can occur when you have not provided enough temp space to create a profile. Verify that you
have a minimum of 40 MB of temp space available before creating a profile.

See |“Using the Profile creation wizard” on page 211|for more information about creating profiles.

Error: localhost is not a valid host name for remote access

This error occurs when you enter localhost as the value for the Host name field in the Profile creation
wizard.

The error can also occur during product installation if you enter localhost as the value of the host name
field.

The host name is the network name for the physical machine on which the node is installed. The host
name must resolve to a physical network node on the server. When multiple network cards exist in the
server, the host name or IP address must resolve to one of the network cards. Remote nodes use the host
name to connect to and to communicate with this node. Selecting a host name that other machines can
reach within your network is extremely important. Do not use the generic localhost identifier for this value.

If you define coexisting nodes on the same computer with unique IP addresses, define each IP address in
a domain name server (DNS) look-up table. Configuration files for stand-alone Application Servers do not
provide domain name resolution for multiple IP addresses on a machine with a single network address.

The value that you specify for the host name is used as the value of the hostName property in
configuration documents for the stand-alone Application Server. Specify the host name value in one of the
following formats:

* Fully qualified domain name servers (DNS) host name string, such as xmachine.manhattan.ibm.com
* The default short DNS host name string, such as xmachine
* Numeric IP address, such as 127.1.255.3

The fully qualified DNS host name has the advantage of being totally unambiguous and also flexible. You
have the flexibility of changing the actual IP address for the host system without having to change the
Application Server configuration. This value for host name is particularly useful if you plan to change the IP
address frequently when using Dynamic Host Configuration Protocol (DHCP) to assign IP addresses. A
format disadvantage is being dependent on DNS. If DNS is not available, then connectivity is
compromised.

The short host name is also dynamically resolvable. A short name format has the added ability of being
redefined in the local hosts file so that the system can run the Application Server even when disconnected
from the network. Define the short name to 127.0.0.1 (local loopback) in the hosts file to run disconnected.
A format disadvantage is being dependent on DNS for remote access. If DNS is not available, then
connectivity is compromised.

A numeric IP address has the advantage of not requiring name resolution through DNS. A remote node
can connect to the node you name with a numeric IP address without DNS being available. A format
disadvantage is that the numeric IP address is fixed. You must change the setting of the hostName
property in Express configuration documents whenever you change the machine IP address. Therefore, do
not use a numeric IP address if you use DHCP, or if you change IP addresses regularly. Another format
disadvantage is that you cannot use the node if the host is disconnected from the network.
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Warning: Cannot convert string "<type_name>"to type FontStruct

If you install the Web server plug-ins for WebSphere Application Server, you also install the ikeyman utility.
The ikeyman utility is part of the Global Services Kit 7 (GSKit7).

If you issue the ikeyman.sh script on a Linux system, you might see the following message:
Warning: Cannot convert string

"-monotype-arial-regular-r-normal--*-140-*-%-p-*-is08859-1"
to type FontStruct

You can safely ignore the warning and use the ikeyman utility.

INFO: Created system preferences directory in java.home

The Key Man Utility (ikeyman) on Linux Redhat Enterprise 3.0 displays the following message after your
first use of the utility.

[root@benson12 bin]# ./ikeyman.sh
Oct 19, 2004 10:47:26 AM java.util.prefs.FileSystemPreferences$3 run
INFO: Created system preferences directory in java.home.

The utility is logging preferences. The message does not display when you use the utility again.

You can safell ignore the message.

The installer could not successfully add the product information into
the RPM database.

If the last line in the Tog.txt file is something similar to the following example, the problem might be a
corrupt RedHat Package Manager (RPM) database:

(Oct 17, 2004 4:02:16 PM),

PTugin.Install,
com.ibm.wizard.platform.Tinux.LinuxProductServicelImpl,

wrn, The installer could not successfully add the product
information into the RPM database. Installation will continue
as this is not critical to the installation of the product.

Run the following command to verify that the problem is a corrupt RPM database:
rpm -q --all

If the command hangs, the problem is a corrupt RPM database.

Error: java.io.lOException: konqueror: not found
The ISMP Launch Browser action throws the following exception on Linux and UNIX systems:

com.installshield.wizardx.actions.LaunchBrowserAction, err, java.io.IOException:
kongueror: not found
STACK_TRACE: 11
java.io.IOException: konqueror: not found

at java.lang.UNIXProcess.forkAndExec(Native Method)

at java.lang.UNIXProcess.<init>(UNIXProcess.java:72)

at java.lang.Runtime.execInternal(Native Method)

at java.lang.Runtime.exec(Runtime.java:602)

at java.lang.Runtime.exec(Runtime.java:524)

at java.lang.Runtime.exec(Runtime.java:490)

at com.installshield.util.BrowserLauncher.openURL(BrowserLauncher.java:578)

at com.installshield.wizardx.actions.LaunchBrowserAction.execute(LaunchBrowserAction
.java:62)

at com.installshield.wizard.RunnableWizardBeanContext.run(RunnableWizardBeanContext.
java:21)
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This action searches for a Netscape, Mozilla, or Konqueror browser for displaying an HTML page or a
Web site. In the case of the Web server plug-ins for WebSphere Application Server, the target page is the
Plug-ins roadmap. Even though the ISMP Launch Browser action might find Mozilla or Netscape, the
exception is thrown and a log entry occurs.

You can safely ignore this error.
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Appendix C. Notices

References in this publication to IBM products, programs, or services do not imply that IBM intends to
make these available in all countries in which IBM operates. Any reference to an IBM product, program, or
service is not intended to state or imply that only IBM’s product, program, or service may be used. Any
functionally equivalent product, program, or service that does not infringe any of IBM’s intellectual property
rights may be used instead of the IBM product, program, or service. Evaluation and verification of
operation in conjunction with other products, except those expressly designated by IBM, is the user’s
responsibility.

IBM may have patents or pending patent applications covering subject matter in this document. The
furnishing of this document does not give you any license to these patents. You can send license inquiries,
in writing, to:

IBM Director of Licensing

IBM Corporation

500 Columbus Avenue

Thornwood, New York 10594 USA
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Appendix D. Trademarks and service marks

For trademark attribution, visit the IBM Web site (http://www.ibm.com/legal/us/).
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